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소개 1
소프트웨어 개요
SCIEX OS 소프트웨어에는 기기 제어, 데이터 획득, 데이터 처리 및 보고 기능이 모두 하나의
패키지로 포함되어 있습니다.

소프트웨어 열기
1. Start 메뉴에서 소프트웨어를 선택합니다.

• Windows 7: Start > All Programs > SCIEX > SCIEX OS > SCIEX OS

• Windows 10: Start > SCIEX OS > SCIEX OS

참고: LibraryViewServiceHost 서비스가 실행 중이 아니면 User Account Control 대화
상자가 표시됩니다. Yes를 클릭하여 서비스를 시작합니다.

소프트웨어가 Integrated Mode로 구성된 경우 홈 페이지가 열립니다.

소프트웨어가 Mixed Mode로 구성된 경우 Logon 대화 상자가 열립니다. 다음 단계를 진행
합니다.

2. Central Administrator Console (CAC) 소프트웨어를 사용 중이고 SCIEX OS가 중앙 집중
식 관리용으로 구성된 경우 로그온할 작업 그룹을 선택합니다.

3. Logon 대화 상자가 열리면 소프트웨어 사용 권한이 있는 사용자의 이름과 비밀번호를 입
력한 후 OK를 클릭합니다.
홈 페이지가 열립니다.

홈 페이지 정보
홈 페이지는 기능별로 그룹화된 작업 영역 타일, 상태 패널, 리본 및 시작 관리자로 구성됩니
다. 작업 영역에 대한 액세스 권한은 사용자에게 할당된 역할 및 라이선스에 의해 결정됩니다.
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그림 1-1 홈 페이지

항목 설명

1 진한 파란색 타일 왼쪽의 연한 파란색 세로선은 해당 작업 영역이 열려 있
고, 작업이 진행 중이며, 사용자가 기능에 액세스할 수 있음을 나타냅니다.
열린 작업 영역의 상태가 타일에 표시됩니다.

2 진한 파란색 타일은 작업 영역이 닫혀 있음을 나타냅니다.

3 회색 타일은 작업 영역을 사용할 수 없음을 나타냅니다.

4 작업 영역이 열리면 타일의 오른쪽 위에 닫기 아이콘(×)이 표시됩니다.

5 시작 관리자에 액세스합니다. 시작 관리자는 모든 작업 영역 목록을 포함
합니다. 시작 관리자를 열려면 아이콘 오른쪽의 을 클릭합니다.

6 리본. 자세한 정보는 리본 및 시작 관리자 정보 섹션을 참조하십시오. 다른
작업 영역을 탐색하려면 목록에서 작업 영역을 클릭합니다. 현재 열려 있
는 작업 영역은 활성 상태를 유지하고 작업 영역 아이콘이 리본에 표시됩

니다. 활성화된 작업 영역을 닫으려면 를 클릭합니다. 홈 페이지로 돌

아가려면 을 클릭합니다.

7 기능: 획득, 처리 및 관리. 액세스는 사용자에게 할당된 역할 및 라이선스
에 따라 다릅니다.

8 시스템 상태. 상태 패널을 표시하거나 숨기려면 제목 표시줄을 클릭합니
다.

9 상태 패널. 자세한 정보는 상태 패널 정보 섹션을 참조하십시오.
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표 1-1 기능

레이블 설명

Acquisition (획득) Acquisition 그룹의 기능을 사용하여 방법과 배치를 생
성하고 획득을 위한 샘플을 제출할 수 있습니다. 사용자는 MS
Tune을 사용하여 질량 분석계를 조정할 수도 있습니다.

Processing (처리) Processing 그룹의 기능을 사용하여 정량적 또는 정성
적 방법으로 데이터를 처리할 수 있습니다.

Management (관리) Management 그룹의 기능을 사용하여 장치를 구성하
고, 소프트웨어에 대한 액세스를 구성하고, 이벤트 로그를 볼
수 있습니다.

표 1-2 타일

레이블 설명

Batch (배치) Batch 작업 영역을 사용하여 배치를 생성하고 대기열
에 제출할 수 있습니다. 자세한 정보는 Batch 작업 영역 섹션
을 참조하십시오.

Queue (대기열) Queue 작업 영역을 사용하여 획득 및 처리 상태를
모니터링하고 대기열의 샘플을 관리할 수 있습니다. 자세한
정보는 Queue 작업 영역 섹션을 참조하십시오.

MS Method (MS 방법) MS Method 작업 영역을 사용하여 MS 방법을 생성
하고 편집할 수 있습니다. 자세한 정보는 MS Method 작업 영
역 섹션을 참조하십시오.

LC Method (LC 방법) LC Method 작업 영역을 사용하여 LC 방법을 생성
하고 편집할 수 있습니다. 자세한 정보는 LC Method 작업 영
역 섹션을 참조하십시오.

MS Tune (MS 조정) MS Tune 작업 영역을 사용하여 질량 분석계를 최
적화할 수 있습니다. 자세한 정보는 MS Tune 작업 영역 섹션
을 참조하십시오.

Explorer (탐색기) Explorer 작업 영역을 사용하여 획득 데이터를 검사
할 수 있습니다. 자세한 정보는 Explorer 작업 영역 섹션을 참
조하십시오.

Analytics (분석) Analytics 작업 영역을 사용하여 획득 데이터를 처리하
고 검토할 수 있습니다. 자세한 정보는 Analytics 작업 영역 섹
션을 참조하십시오.

Configuration (구성) Configuration 작업 영역을 사용하여 소프트웨어 구성,
장치 추가 및 활성화, 사용자 역할 할당, 감사 맵 생성 및 할당
등의 작업을 수행할 수 있습니다. 자세한 정보는 도움말 시스
템 문서를 참조하십시오.

Library (라이브러리) Library 작업 영역을 사용하여 화합물 라이브러
리를 관리할 수 있습니다.
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표 1-2 타일 (계속)

레이블 설명

Event Log (이벤트 로그) Event Log 작업 영역을 사용하여 오류 및 경고
를 포함한 시스템 이벤트를 볼 수 있습니다. 자세한 정보는 실
험실 책임자 안내서를 참조하십시오.

Audit Trail (감사 내역) Audit Trail 작업 영역을 사용하여 구성 변경 및 데
이터 처리와 같은 소프트웨어 이벤트 레코드를 볼 수 있습니
다. 자세한 정보는 실험실 책임자 안내서를 참조하십시오.

리본 및 시작 관리자 정보
그림 1-2 리본

항목 설명

1 사용자가 목록에서 다른 작업 영역을 선택하여 열 수 있습니다. 이 작업 영
역이 활성 작업 영역이 됩니다. 이전에 활성화된 작업 영역은 계속 열려 있
습니다. 자세한 정보는 그림 1-3에서 확인하십시오.

2 활성 작업 영역의 이름을 표시합니다.

3 홈 페이지를 엽니다.

4 열린 작업 영역을 표시합니다. 활성 작업 영역은 흰색으로 표시됩니다. 열
린 작업 영역을 활성화하려면 작업 영역 아이콘을 클릭하십시오.

5 현재 로그인된 사용자를 표시합니다.

6 시스템 상태를 표시합니다. 자세한 정보는 상태 패널 정보 섹션을 참조하
십시오.

7 도움말 시스템을 엽니다. ?를 클릭하십시오.
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그림 1-3 시작 관리자

항목 설명

1 작업 영역 목록을 표시합니다. 을 클릭하십시오.

2 활성 작업 영역의 이름을 표시합니다.

3 작업 영역 상태를 표시합니다. 진한 파란색 배경은 작업 영역이 닫혀 있음
을 나타냅니다. 왼쪽의 연한 파란색 세로 막대는 작업 영역이 열려 있음을
나타냅니다. 연한 파란색 배경은 작업 영역이 활성 상태임을 나타냅니다.

4
열린 작업 영역을 닫습니다. 을 클릭하십시오.

5
활성 작업 영역을 닫습니다. 을 클릭하십시오.

상태 패널 정보
이 패널을 열려면 상태 패널 제목 표시줄을 클릭합니다. 자세한 정보는 그림 1-2에서 확인하십
시오.
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상태 제목 표시줄의 아이콘, 텍스트 및 색이 변경되어 시스템 상태를 나타냅니다. 상태 패널을
사용하여 다음을 수행할 수 있습니다.

• 프로젝트를 추가하거나 선택합니다.

• Queue에 남아 있는 샘플과 획득할 batch 획득에 남은 예상 시간을 봅니다.

• Queue에 남아 있는 샘플의 수와 완료될 queue에 남은 예상 시간을 봅니다.

• 시스템 상태 또는 Configuration 작업 영역의 Devices 목록에서 활성화된 개별 장치의 상태
를 봅니다.

• 직접 장치 제어에 액세스하여 장치를 시작하거나 중지합니다.

• 장치 세부 정보를 봅니다.

• 질량 분석계 또는 LC 시스템을 Standby 상태로 전환합니다.

• TOF MS 및 TOF MS/MS 모드를 확인하고 교정합니다.

• 시스템을 평형화합니다.
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그림 1-4 SCIEX OS 상태 패널
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항목 설명

1 시스템 상태를 표시합니다. 상태 패널을 표시하거나 숨기려면 제목 표시
줄을 클릭합니다.

• 준비 상태는 녹색으로 표시됩니다.

• 오프라인 상태는 회색으로 표시됩니다.

• 평형화/실행/로드 중 상태는 파란색으로 표시됩니다.

• 중지됨/중단 중 상태는 노란색으로 표시됩니다.

• 오류 상태는 빨간색으로 표시됩니다.

2 현재 프로젝트를 표시합니다. 기존 프로젝트를 변경하려면 목록에서 프로

젝트를 선택합니다. 프로젝트를 추가하려면 Create Project( )를 클
릭하고 프로젝트 이름을 입력한 후 OK를 클릭합니다.

3 대기열의 샘플 상태를 표시합니다.

4 장치 상태를 표시합니다. Device Details 대화 상자를 열어 세부 정보를 보
려면 장치 제목을 클릭합니다. 장치가 비활성 상태인 경우 상태 패널의 이
섹션에 Activate Devices 버튼이 표시됩니다. 이 버튼을 클릭하여 장치를
활성화할 수 있습니다.

5 장치 제어에 액세스하려면 Direct Device Control 아이콘을 클릭합니다.
Device Control 대화 상자에서 옵션 주사기를 시작 또는 중단할 수 있습니
다.

6 장치 상태를 표시합니다. 아이콘은 장치 상태를 나타내는 보기 전용 표시
기입니다.

7 MS Tune 절차에 액세스하려면 클릭합니다.

8 시스템을 평형화하거나 Standby 상태로 전환하려면 적절한 버튼을 클릭
합니다. 자세한 정보는 시스템 평형화 섹션을 참조하십시오.

표 1-3 상태 패널 섹션

레이블 설명

Projects (프로젝트) 현재 프로젝트를 표시합니다. 프로젝트를 생성하려면

Create Project( )를 클릭합니다. 자세한 정보는 프로젝트 추
가 섹션을 참조하십시오.
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표 1-3 상태 패널 섹션 (계속)

레이블 설명

Queue (대기열) 대기열의 샘플 상태를 표시합니다. 다음과 같은 상태 정
보가 제공됩니다.

• Samples waiting(대기 중인 샘플)

• Sample time remaining(남은 샘플 시간)

• Acquisition time remaining(남은 획득 시간)

자세한 정보는 대기열 관리 섹션을 참조하십시오.

Devices (장치) 활성 구성의 장치를 나열합니다. 이 목록에서 다음과 같은
방법으로 장치를 관리할 수 있습니다.

• Device Details 대화 상자를 열고 보려면 장치 이름을 클릭합니
다.

• 장치 상태를 표시하려면 아이콘 상태를 보거나 상태 아이콘 위
로 커서를 움직입니다.

• Device Control 대화 상자를 열려면 Direct device

control( )을 클릭합니다.

MS Check (MS 확인) 양성(+) 또는 음성(–) 모드에서 MS 조정 절차를 수행합
니다.

Direct Control (직접 제어) 사용자가 장치를 수동으로 제어할 수 있습니다. 시스
템을 Standby 상태로 전환하려면 Standby를 클릭합니다.
Equilibrate 대화 상자를 열려면 Equilibrate를 클릭합니다. 자세한
정보는 시스템 평형화 섹션을 참조하십시오.

표 1-4 상태 패널 기능

수행할 작업 방법

상태 패널 표시 최소화된 상태 패널의 맨 위에서 상태 패널 제목 표시줄을 클릭합
니다. 자세한 정보는 그림 1-2에서 확인하십시오.

상태 패널 숨기기 상태 패널이 표시되어 있을 때 제목 표시줄을 클릭합니다.

활성 프로젝트 변경 상태 패널의 Projects 목록에서 프로젝트를 선택합니다.

팁! 프로젝트를 생성하려면 Create Project( )를 클릭합니다.
그런 다음 프로젝트 이름을 입력하고 OK를 클릭하십시오.
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표 1-4 상태 패널 기능 (계속)

수행할 작업 방법

장치 상태 제어 1. 상태 패널에서 장치 제목 오른쪽의 Direct device

control( )을 클릭합니다.

Device Control 대화 상자가 열립니다.

2. 필요에 따라 장치를 시작, 중지 또는 업데이트합니다.

3. OK를 클릭합니다.

이 절차를 사용해 장치 상태에 대한 자세한 피드백을 받습니다. 예
를 들어, 온도, 압력 및 전압이 있습니다. 장치 상태를 모니터링하
려면 장치 제목 맨 오른쪽에 있는 아이콘을 클릭합니다.

Data Acquisition 패널
Data Acquisition 패널을 사용하여 실시간 데이터 획득을 시작하고 모니터링할 수 있습니다.
또한 사용자는 실시간 데이터 획득 중에 획득 방법 매개 변수를 편집하고 Explorer 작업 영역
에서 데이터를 열거나 데이터를 저장할 수 있습니다.

팁! Data Acquisition 패널의 위쪽을 클릭한 후 위 또는 아래로 끌면 콘텐츠 크기를 변경할 수
있습니다.

그림 1-5 Data Acquisition 패널

항목 설명

1 TIC와 스펙트럼 또는 XIC를 표시합니다. 검출기가 활성 상태이면 DAD 또
는 UV 데이터도 표시됩니다.

2 MS 방법. 커서로 가리키면 실행 중인 MS 방법의 이름이 표시됩니다.

3 LC 방법. 커서로 가리키면 실행 중인 LC 방법의 이름이 표시됩니다.
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항목 설명

4 수동 획득을 시작하려면 Start를 클릭합니다. Start > Start with LC를 클
릭하여 Start with LC 대화 상자를 엽니다.

5 수동 획득을 중지하려면 클릭합니다.

6 데이터를 저장하려면 클릭합니다.

7 실시간으로 데이터를 탐색하려면 클릭합니다.

화면 잠금
워크스테이션이 무인 상태일 때 소프트웨어에 대한 무단 액세스를 방지하려면 소프트웨어를
잠그십시오. 소프트웨어가 잠겨 있어도 진행 중인 획득 및 처리는 계속됩니다.

자동 로그오프 시간이 만료되면 사용자가 로그오프됩니다. 획득은 계속됩니다.

참고: 처리가 진행 중이거나 Results Table이 저장되지 않은 경우 자동 로그오프가 발생하지
않습니다.

1. Ctrl+Q를 누릅니다.

그림 1-6 Lock Screen 대화 상자

2. OK를 클릭합니다.
SCIEX OS is Locked 대화 상자가 열립니다.

소프트웨어 잠금 해제
소프트웨어가 잠겨 있으면 현재 로그온한 사용자가 잠금을 해제할 수 있습니다.

참고: 다른 사용자는 소프트웨어 잠금을 해제할 수 없지만 Force User Logoff 권한이 있는 사
용자가 현재 사용자를 로그오프할 수 있습니다.

SCIEX OS is Locked 대화 상자에서 현재 사용자의 비밀번호를 입력한 후 Unlock을 클릭합니
다.
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전자 연구 노트 지원
SCIEX는 특정 전자 연구 노트(ELN) 솔루션을 지원하지 않습니다. 그러나 SCIEX는 ELN 시스
템과의 통합을 위해 데이터를 쉽게 가져오고 내보낼 수 있도록 제품, 도구 및 서비스를 제공합
니다.

• 배치 생성: SCIEX OS는 csv 및 txt 형식으로 배치 파일을 가져올 수 있습니다. 자세한 정보
는 Batch 작업 영역에서 확인하십시오.

• 결과 업로드: SCIEX OS는 LIMS 시스템에서 사용할 수 있는 txt 파일로 데이터를 내보낼 수
있습니다. 자세한 정보는 Analytics 작업 영역에서 확인하십시오.

설명서 기호 및 표기 규칙
이 안내서 전체에서 다음 기호와 표기 규칙이 사용됩니다.

위험! 위험은 심한 부상이나 사망을 초래하는 행동을 나타냅니다.

경고! 경고는 주의 사항을 따르지 않을 경우 부상을 초래할 수 있는 행동을 나타냅니다.

주의: 주의는 주의 사항을 따르지 않을 경우 시스템 손상 또는 데이터 손상이나 손실을 초래할
수 있는 작업을 나타냅니다.

참고: 참고는 절차나 설명에서 중요한 정보를 강조합니다.

팁! 팁은 특정 요건에 대한 설명에서 기술과 절차를 적용하는 데 도움이 되는 유용한 정보와 손
쉬운 방법을 제공하지만, 절차의 완료하는데 꼭 필요하지 않을 수도 있습니다.
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작동 지침—장치 구성 2
구성 작업 영역을 사용해 다음을 지원합니다:

• 장치 활성화 및 비활성화

• 장치 추가 및 삭제

• 장치 설정 편집

• 장치 테스트

장치 추가
참고: 활성화 문제를 방지하려면 다른 장치를 추가하기 전에 항상 질량 분석계를 먼저 추가하
십시오.

1. Configuration 작업 영역을 엽니다.

2. Devices를 클릭합니다.

3. 활성 상태인 장치가 있으면 Deactivate를 클릭합니다.

4. Add를 클릭합니다.
Device 대화 상자가 열립니다.

5. Type 목록에서 필요한 유형을 선택합니다.

6. Model 목록에서 필요한 모델을 선택합니다.

7. Settings를 클릭하여 설정을 편집하거나 기본값을 복원합니다.

8. Test Device를 클릭하여 장치가 올바르게 구성되고 사용 가능한지 확인합니다.

9. Save를 클릭합니다.

10. 필요에 따라 4단계에서 9단계를 반복합니다.

11. 활성화할 각 장치 옆의 Activate 확인란을 선택한 후 Activate Devices를 클릭합니다.
선택한 모든 장치가 활성화됩니다.

12. 장치를 편집하거나 삭제하려면 도움말 시스템을 참조합니다.

장치 삭제
참고: 삭제되는 장치가 통합 시스템의 일부일 경우, 통합 시스템의 모든 장치가 삭제됩니다. 사
용자는 통합 시스템에서 하나의 장치를 삭제할 수 없습니다.

1. Configuration 작업 영역을 엽니다.

2. Devices을 클릭합니다.

3. Deactivate를 클릭합니다.
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4. 장치를 선택합니다.

5. Delete를 클릭합니다.

6. 활성화할 각 장치 옆의 Activate 확인란을 선택한 후 Activate Devices를 클릭합니다.
선택한 모든 장치가 활성화됩니다.

장치 설정 편집
1. Configuration 작업 영역을 엽니다.

2. Devices를 클릭합니다.

3. 장치가 활성화되어 있으면 Deactivate를 클릭합니다.

4. 편집할 장치를 선택합니다.

5. Edit를 클릭합니다.
Device 대화 상자가 열립니다.

6. (선택 사항) Device Display Names 섹션에서 장치 속성을 편집합니다. 속성에 대한 정보
는 도움말 시스템 문서를 참조하십시오.

7. (선택 사항) Settings를 클릭하여 추가 장치 정보를 보고 변경합니다. Settings 대화 상자
를 사용하여 다음 작업을 수행할 수 있습니다.

• Restore Defaults를 클릭하여 장치의 기본 설정을 복원합니다.

• Test Device를 클릭하여 장치가 올바르게 구성되고 사용 가능한지 확인합니다. 테스트
에 성공하면 Settings 대화 상자가 닫힙니다.

8. Test Device를 클릭하여 장치가 올바르게 구성되고 사용 가능한지 확인합니다.
테스트에 성공하면 녹색 메시지가 나타납니다. 그렇지 않으면 구성이 올바르지 않고 업데
이트가 필요하다는 메시지가 나타납니다.

9. Save를 클릭합니다.

10. 활성화할 각 장치 옆의 Activate 확인란을 선택한 후 Activate Devices를 클릭합니다.
선택한 모든 장치가 활성화됩니다.
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작동 지침—소프트웨어 구성 3
사용자 및 역할 구성에 대한 정보는 실험실 책임자 안내서를 참조하십시오.

프로젝트 및 루트 디렉토리 정보
루트 디렉토리는 하나 이상의 프로젝트를 포함하는 폴더입니다. 소프트웨어는 이 폴더에서 프
로젝트 데이터를 찾습니다. 미리 정의된 루트 디렉토리는 C:\SCIEX OS Data입니다.

프로젝트 정보를 안전하게 저장하려면 SCIEX OS를 사용하여 프로젝트를 생성해야 합니다.
자세한 정보는 프로젝트 추가 섹션을 참조하십시오.

프로젝트 데이터를 하위 폴더에 구성할 수 있습니다. SCIEX OS를 사용하여 하위 폴더를 생성
합니다. 자세한 정보는 하위 폴더 추가 섹션을 참조하십시오.

참고: Central Administrator Console (CAC) 소프트웨어에서 관리하는 작업 그룹의 경우 CAC
소프트웨어 구성은 SCIEX OS로 프로젝트를 관리하는 기능을 제어합니다. CAC 소프트웨어
에서 Use central settings for projects 옵션을 선택하면 Projects 페이지가 읽기 전용입니다.

루트 디렉토리 추가
루트 디렉토리는 하나 이상의 프로젝트가 저장되는 폴더입니다.

참고: 소프트웨어는 최대 10개의 루트 디렉토리를 저장합니다.

1. Configuration 작업 영역을 엽니다.

2. Projects를 클릭합니다.

3. Advanced 섹션에서 Current root directory 필드 옆의 Create Root( )를 클릭합니
다.

4. 루트 디렉토리 폴더의 전체 경로를 입력합니다.
폴더가 생성됩니다.

팁! 경로를 입력하는 대신 Browse를 클릭한 후 루트 디렉토리를 생성할 폴더를 선택하십
시오. 경로 끝에 "\"와 루트 디렉토리 폴더의 이름을 입력합니다.

팁! 파일 탐색기에서 폴더를 생성한 후 해당 폴더를 찾아 선택할 수도 있습니다.

참고: 처리 라이선스가 있는 SCIEX OS 설치의 경우 루트 디렉토리는 Analyst 소프트웨어
의 Analyst Data\Projects 폴더일 수 있습니다.

5. OK를 클릭합니다.
새 루트 디렉토리가 현재 프로젝트의 루트 디렉토리가 됩니다.
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루트 디렉토리 제거
소프트웨어는 마지막으로 사용한 10개의 루트 디렉토리 목록을 유지 관리합니다. 사용자는 이
목록에서 루트 디렉토리를 제거할 수 있습니다.

참고: Current root directory는 삭제할 수 없습니다.

1. Configuration 작업 영역을 엽니다.

2. Projects를 클릭합니다.

3. Advanced 섹션에서 Current root directory 필드 옆의 을 클릭합니다.
Clear Root Directory 대화 상자가 열립니다.

4. 루트 디렉토리 목록에서 제거할 폴더를 선택한 후 OK를 클릭합니다.

보안 네트워크 계정 지정
프로젝트가 네트워크 리소스에 저장된 경우 워크스테이션의 모든 사용자가 네트워크 리소스
에 액세스할 수 있도록 SNA를 지정할 수 있습니다.

1. Configuration 작업 영역을 엽니다.

2. Projects를 클릭합니다.

3. Advanced 섹션에서 Credentials for Secure Network Account를 클릭합니다.

4. 네트워크 리소스에 정의된 보안 네트워크 계정의 사용자 이름, 비밀번호 및 도메인을 입
력합니다.

5. OK를 클릭합니다.

프로젝트 추가
프로젝트에는 어큐지션 메소드, 데이터, 배치, 처리 방법, 처리 결과 등이 저장됩니다. 각 프로
젝트마다 별도의 프로젝트 폴더를 사용하는 것이 좋습니다.

팁! 상태 패널의 Create Project( )를 클릭하여 프로젝트를 생성할 수도 있습니다.

SCIEX OS를 사용하지 않고 프로젝트 생성, 파일 복사 또는 붙여넣기 등을 수행하지 마십시
오.

1. Configuration 작업 영역을 엽니다.

2. Projects를 클릭합니다.

3. Current Project 필드 옆의 Create Project( )를 클릭합니다.
New Project 대화 상자가 열립니다.

4. 프로젝트 이름을 입력합니다.

5. OK를 클릭합니다.
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하위 폴더 추가
프로젝트 내에서 하위 폴더에 데이터를 구성할 수 있습니다.

1. Configuration 작업 영역을 엽니다.

2. Projects를 클릭합니다.

3. Add Data Sub-Folders to any Project를 클릭합니다.
Add Data Sub-Folders 대화 상자가 열립니다.

4. SCIEX OS Project 필드에서 하위 폴더를 추가할 프로젝트를 선택합니다.

5. Project Data Sub-Folders 섹션에서 상자 위의 Add a new data sub-folder( )를 클
릭합니다.
Data Sub-Folder Name 대화 상자가 열립니다.

6. 하위 폴더 이름을 입력합니다.

7. Save를 클릭합니다.

8. Add Data Sub-Folders 대화 상자를 닫습니다.

대기열 옵션 선택
소프트웨어는 목록에 제출된 샘플을 순차적으로 처리하며 선택한 어큐지션 메소드로 각 샘플
을 실행합니다. 모든 샘플을 획득한 후에는 queue가 중지되고 시스템은 Ready 상태로 전환됩
니다. Instrument Idle Time 필드에 설정된 시간이 모두 경과한 후에는 시스템이 Standby 상태
로 전환됩니다. Standby 상태에서는 LC 펌프 및 컬럼 오븐이 꺼지고 일부 질량 분석계 전압도
꺼집니다. 샘플 성질 저하를 방지하기 위해 오토샘플러 온도 제어는 켜진 상태로 유지됩니다.

대기열 관리 권한이 할당된 사용자만 마지막 획득이 완료된 후 기기가 Standby 상태로 전환되
기 전에 대기열이 실행되는 시간을 수정할 수 있습니다.

1. Configuration 작업 영역을 엽니다.

2. Queue를 클릭합니다.

3. 필요에 따라 대기열 옵션을 선택합니다. 옵션에 대한 설명은 도움말 시스템 문서를 참조
하십시오.

4. Save를 클릭합니다.

실험실 정보 관리 시스템(LIMS) 설정 선택
이 기능을 사용하여 LIMS 서버에 연결할 수 있습니다. 사용자는 LIMS에서 배치 정보를 가져
오고 결과를 LIMS로 내보낼 수 있습니다.

참고: Watson LIMS에 연결할 때는 이 절차가 필요하지 않습니다.

1. Configuration 작업 영역을 엽니다.

2. LIMS Communication을 클릭합니다.
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3. LIMS와 통신하려면 LIMS Server 필드에 LIMS 서버의 URL을 입력한 후 Enable import
from the specified LIMS server를 선택합니다.

참고: 고객 IT 부서 또는 미들웨어 공급자가 LIMS 서버를 구성합니다. 서버 URL 또는 위
치는 해당 부서나 공급자에게 문의하십시오.

4. Save을 클릭합니다.

전체 화면 모드 사용
SCIEX OS를 기본 어플리케이션으로 사용하려면 이 기능을 선택합니다. 사용자는 소프트웨어
를 닫거나 다른 소프트웨어 프로그램에 액세스할 수 없습니다.

1. Configuration 작업 영역을 엽니다.

2. General을 클릭합니다.

3. General에서 Enabled 확인란을 선택하여 Full Screen Mode를 사용하도록 설정합니다.

4. Save를 클릭합니다.

지역 설정 선택
이 기능은 Control Panel에서 선택된 지역 및 언어 설정을 적용합니다. 마침표 "." 또는 쉼표
","만 소수점 구분 기호로 사용될 수 있습니다. 자릿수 구분 단위는 지원되지 않습니다.

1. Configuration 작업 영역을 엽니다.

2. General을 클릭합니다.

3. Regional Settings에서 Apply를 클릭합니다.
컴퓨터를 다시 시작하면 Windows 운영 체제에 구성된 지역 설정이 소프트웨어에 적용됩
니다.

4. Save를 클릭합니다.

5. 컴퓨터를 다시 시작합니다.

화합물 라이브러리 관리
LibraryView 소프트웨어 패키지 가져오기
1. Manage 창에서 Compounds 목록을 확장합니다.

2. All Compounds를 클릭합니다.

3. Import 아이콘을 클릭합니다.

4. Library Importer 대화 상자에서 LibraryView Package (*.lbp)를 클릭합니다.

5. Open 대화 상자에서 해당 파일을 탐색합니다.

6. 파일을 선택한 후 Open을 클릭합니다.

7. Library Importer 대화 상자에서 다음 중 하나를 수행합니다.

• Compound 열 위의 All을 클릭하여 모든 화합물을 가져옵니다.
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• 해당 행 안쪽을 클릭하여 개별 화합물을 가져옵니다.

팁! 화합물을 찾으려면 Search 필드를 사용하십시오. 검색 기준을 입력하면 표시된 열
을 검색하고 지정된 기준과 일치하는 정보만 표시되도록 새로 고쳐집니다.

8. 다음 중 하나를 수행하여 라이브러리에 화합물을 추가합니다.

• Add to Compound Library 목록에서 적절한 라이브러리를 선택합니다.

• Add to Compound Library 목록 필드에 라이브러리 이름을 입력합니다.

9. Next를 클릭합니다.

참고: 화합물이 모두 데이터베이스에 복사되기 전에 사용자가 가져오기를 취소하더라도
이미 가져오기가 완료된 화합물은 데이터베이스에 남아 있습니다. 소프트웨어는 데이터
베이스를 가져오기 전 상태로 되돌리지 않습니다.

10. 필요한 경우 충돌을 해결합니다.

11. Finish를 클릭합니다.

화합물 데이터베이스 가져오기
1. Manage 창에서 Compounds 목록을 확장합니다.

2. All Compounds를 클릭합니다.

3. Import 아이콘을 클릭합니다.

4. Library Importer 대화 상자에서 다음 중 하나를 수행합니다.

• DiscoveryQuant Compound Database (*.mdb)를 클릭합니다.

• Analyst Compound Database (*.mdb)를 클릭합니다.

5. Open 대화 상자에서 해당 파일을 탐색합니다.

6. 파일을 선택한 후 Open을 클릭합니다.

7. Library Importer 대화 상자에서 다음 중 하나를 수행합니다.

• Compound 열 위의 All을 클릭하여 모든 화합물을 가져옵니다.

• 해당 행 안쪽을 클릭하여 개별 화합물을 가져옵니다.

팁! 화합물을 찾으려면 Search 필드를 사용하십시오. 검색 기준을 입력하면 표시된 열
을 검색하고 지정된 기준과 일치하는 정보만 표시되도록 새로 고쳐집니다.

8. 다음 중 하나를 수행하여 라이브러리에 화합물을 추가합니다.

• Add to Compound Library 목록에서 적절한 라이브러리를 선택합니다.

• Add to Compound Library 목록 필드에 라이브러리 이름을 입력합니다.

9. Next를 클릭합니다.
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참고: 화합물이 모두 데이터베이스에 복사되기 전에 사용자가 가져오기를 취소하더라도
이미 가져오기가 완료된 화합물은 데이터베이스에 남아 있습니다. 소프트웨어는 데이터
베이스를 가져오기 전 상태로 되돌리지 않습니다.

10. 필요한 경우 충돌을 해결합니다.

11. Finish를 클릭합니다.

Cliquid 소프트웨어 패키지 가져오기
1. Manage 창에서 Compounds 목록을 확장합니다.

2. All Compounds를 클릭합니다.

3. Import 아이콘을 클릭합니다.

4. Library Importer 대화 상자에서 Cliquid Package (*.clq)를 클릭합니다.

5. Open 대화 상자에서 해당 파일을 탐색합니다.

6. 파일을 선택한 후 Open을 클릭합니다.

7. Library Importer 대화 상자에서 다음 중 하나를 수행합니다.

• Compound 열 위의 All을 클릭하여 모든 화합물을 가져옵니다.

• 해당 행 안쪽을 클릭하여 개별 화합물을 가져옵니다.

팁! 화합물을 찾으려면 Search 필드를 사용하십시오. 검색 기준을 입력하면 표시된 열
을 검색하고 지정된 기준과 일치하는 정보만 표시되도록 새로 고쳐집니다.

8. 다음 중 하나를 수행하여 라이브러리에 화합물을 추가합니다.

• Add to Compound Library 목록에서 적절한 라이브러리를 선택합니다.

• Add to Compound Library 목록 필드에 라이브러리 이름을 입력합니다.

9. Next를 클릭합니다.

10. 필요한 경우 Instrument Name 대화 상자의 Instrument Name 필드에 질량 분석계 이름
을 입력합니다.

11. OK를 클릭합니다.

참고: 화합물이 모두 데이터베이스에 복사되기 전에 사용자가 가져오기를 취소하더라도
이미 가져오기가 완료된 화합물은 데이터베이스에 남아 있습니다. 소프트웨어는 데이터
베이스를 가져오기 전 상태로 되돌리지 않습니다.

12. 필요한 경우 충돌을 해결합니다.

13. Finish를 클릭합니다.

Excel 파일 가져오기
1. Manage 창에서 Compounds 목록을 확장합니다.

2. All Compounds를 클릭합니다.
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3. Import 아이콘을 클릭합니다.

4. Library Importer 대화 상자에서 Excel file (*.xls)을 클릭합니다.

5. Open 대화 상자에서 해당 파일을 탐색합니다.

6. 파일을 선택한 후 Open을 클릭합니다.

7. Library Importer 대화 상자에서 적절한 Excel worksheet to import를 클릭합니다.

8. 워크시트에 열 머리글이 포함된 경우 Selected Excel Worksheet has headers 옆의 확
인란을 선택합니다.

9. 필요한 경우 Instrument Name 대화 상자의 Instrument Name 필드에 질량 분석계 이름
을 입력합니다.

10. 각 정보 열에 적절한 머리글을 선택합니다.

팁! Compound:CompoundId 및 Compound:Name은 필수 선택 항목입니다. 필요하지
않은 정보의 경우 ---[not used]---를 선택하십시오.

11. Next를 클릭합니다.

12. Library Importer 대화 상자에서 다음 중 하나를 수행합니다.

• Compound 열 위의 All을 클릭하여 모든 화합물을 가져옵니다.

• 해당 행 안쪽을 클릭하여 개별 화합물을 가져옵니다.

팁! 화합물을 찾으려면 Search 필드를 사용하십시오. 검색 기준을 입력하면 표시된 열
을 검색하고 지정된 기준과 일치하는 정보만 표시되도록 새로 고쳐집니다.

13. 다음 중 하나를 수행하여 라이브러리에 화합물을 추가합니다.

• Add to Compound Library 목록에서 적절한 라이브러리를 선택합니다.

• Add to Compound Library 목록 필드에 라이브러리 이름을 입력합니다.

14. Next를 클릭합니다.

참고: 화합물이 모두 데이터베이스에 복사되기 전에 사용자가 가져오기를 취소하더라도
이미 가져오기가 완료된 화합물은 데이터베이스에 남아 있습니다. 소프트웨어는 데이터
베이스를 가져오기 전 상태로 되돌리지 않습니다.

15. 필요한 경우 충돌을 해결합니다.

16. Finish를 클릭합니다.

라이브러리 데이터베이스 스냅샷 가져오기
주의: 잠재적 데이터 손실. 이 절차를 수행하기 전에 현재 LibraryView 소프트웨어 데이터베
이스를 백업하십시오. 이 패키지의 정보는 LibraryView 소프트웨어 데이터베이스의 기존 데
이터를 모두 덮어씁니다. 가져오기가 시작되면 취소 옵션을 사용할 수 없습니다.

1. Manage 창에서 Compounds 목록을 확장합니다.

2. All Compounds를 클릭합니다.
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3. Import 아이콘을 클릭합니다.

4. Library Importer 대화 상자에서 Overwrite Database with Library Snapshot (*.lbp)을
클릭합니다.

5. Warning 대화 상자에서 Yes를 클릭합니다.

6. Open 대화 상자에서 해당 파일을 탐색합니다.

7. 파일을 선택한 후 Open을 클릭합니다.

8. Finish를 클릭합니다.

제삼자 라이브러리 패키지 가져오기
1. Manage 창에서 Compounds 목록을 확장합니다.

2. All Compounds를 클릭합니다.

3. Import 아이콘을 클릭합니다.

4. Library Importer 대화 상자에서 Third Party Library Package (*.tplp)를 클릭합니다.

5. Open 대화 상자에서 해당 파일을 탐색합니다.

6. 파일을 선택한 후 Open을 클릭합니다.

7. Library Importer 대화 상자에서 다음 중 하나를 수행합니다.

• Compound 열 위의 All을 클릭하여 모든 화합물을 가져옵니다.

• 해당 행 안쪽을 클릭하여 개별 화합물을 가져옵니다.

팁! 화합물을 찾으려면 Search 필드를 사용하십시오. 검색 기준을 입력하면 표시된 열
을 검색하고 지정된 기준과 일치하는 정보만 표시되도록 새로 고쳐집니다.

8. 다음 중 하나를 수행하여 라이브러리에 화합물을 추가합니다.

• Add to Compound Library 목록에서 적절한 라이브러리를 선택합니다.

• Add to Compound Library 목록 필드에 라이브러리 이름을 입력합니다.

9. Next를 클릭합니다.

참고: 화합물이 모두 데이터베이스에 복사되기 전에 사용자가 가져오기를 취소하더라도
이미 가져오기가 완료된 화합물은 데이터베이스에 남아 있습니다. 소프트웨어는 데이터
베이스를 가져오기 전 상태로 되돌리지 않습니다.

10. 필요한 경우 충돌을 해결합니다.

11. Finish를 클릭합니다.

라이선스가 있는 LibraryView 소프트웨어 패키지 설치
참고: LibraryView 소프트웨어는 반드시 설치되어야 합니다.
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참고: LibraryView 소프트웨어 라이선스를 획득하려면 인터넷에 액세스해야 합니다. 컴퓨터에
서 인터넷에 액세스할 수 없으면 생성된 컴퓨터 ID의 복사본을 만듭니다. 인터넷 액세스가 가
능한 컴퓨터에서 SCIEX 웹 사이트의 라이선스 페이지로 이동한 후 지침에 따라 라이선스를
획득하십시오.

라이선스가 있는 라이브러리는 DVD 또는 SCIEX 웹 사이트에서 다운로드한 zip 어플리케이션
파일을 사용하여 설치할 수 있습니다. 어플리케이션 파일에는 화합물 이름, 화합물 전환 정보,
화합물 라이브러리 스펙트럼이 포함될 수 있습니다.

1. 관리자 권한을 가진 Windows 사용자로 컴퓨터에 로그온합니다.

2. 다음 중 하나를 수행합니다.

• DVD에서 라이브러리를 설치하는 경우 DVD를 DVD 드라이브에 넣고 5단계를 진행합
니다.

• 다운로드한 파일에서 라이브러리를 설치하는 경우 3단계를 진행합니다.

3. SCIEX 웹 사이트에서 필요한 zip 파일을 다운로드합니다.

팁! 잠재적 설치 문제를 방지하기 위해 파일을 컴퓨터 데스크톱이 아닌 다른 위치에 저장
하십시오.

4. 다운로드가 완료되면 다운로드한 파일을 마우스 오른쪽 버튼으로 클릭한 후 Extract All
을 클릭합니다.

5. 추출된 파일 또는 DVD를 찾아 Library.exe를 두 번 클릭합니다.

팁! User Account Control 대화 상자가 열리면 Yes를 클릭하십시오.

팁! LibraryView Setup (Not Responding) 메시지 대화 상자가 열리면 대화 상자를 닫고
Library.exe 파일을 마우스 오른쪽 버튼으로 클릭한 후 Run as administrator 옵션을 선
택하여 설치를 다시 시작하십시오.

6. LibraryViewPackages Feature Unavailable 대화 상자에서 Software Activation을 클릭합
니다.
LibraryViewPackages Activation 대화 상자가 열립니다.

7. 해당 필드에 라이선스 키를 표시된 대로 정확하게 입력합니다.
라이선스 키를 사용할 수 없는 경우 sciex.com/request-support에 문의하십시오.

8. Generate Computer ID를 클릭합니다.
워크스테이션에 대한 고유 식별자가 생성됩니다.

9. Copy ID to Clipboard를 클릭합니다.

10. 지침에 따라 라이선스를 획득합니다.

필요한 정보를 제출하면 제공된 모든 이메일 주소로 라이선스 파일이 전송됩니다.

11. 브라우저 창을 닫습니다.

12. 라이선스 파일이 포함된 이메일을 수신하면 라이선스 파일을 워크스테이션 바탕 화면에
복사합니다.

13. LibraryViewPackages Activation 대화 상자에서 Install License File을 클릭합니다.
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14. Select the new license file to be installed 대화 상자에서 라이선스 파일을 탐색하여 선택
합니다.

15. Open을 클릭합니다.
Select the new license file to be installed 및 LibraryViewPackage Activation 대화 상자가
모두 닫힙니다.

16. 다음 중 하나를 수행합니다.

• 모든 화합물을 가져오려면 Library Importer 대화 상자에서 Compound 열 위의 All을
클릭합니다.

• 개별 화합물을 가져오려면 Library Importer 대화 상자에서 적절한 행의 안쪽을 클릭합
니다.

팁! 화합물을 찾으려면 Search 필드를 사용하십시오. 검색 기준을 입력하면 표시된 열
을 검색하고 지정된 기준과 일치하는 정보만 표시되도록 새로 고쳐집니다.

17. Next를 클릭합니다.

참고: 화합물이 모두 데이터베이스에 복사되기 전에 사용자가 가져오기를 취소하더라도
이미 가져오기가 완료된 화합물은 데이터베이스에 남아 있습니다. 소프트웨어는 데이터
베이스를 가져오기 전 상태로 되돌리지 않습니다.

18. 필요한 경우 충돌을 해결합니다.

19. Finish를 클릭합니다.

화합물 충돌
화합물 그룹을 포함한 라이브러리를 설치하거나 개별 화합물을 설치할 때, 소프트웨어에서는
패키지의 화합물과 동일한 이름 또는 수식을 가진 화합물을 데이터베이스에서 검색합니다. 소
프트웨어는 화합물이 발견되는 경우에 패키지 내 해당 화합물에 플래그를 지정한 뒤 계속 진
행을 위해 사용자가 입력할 때까지 대기합니다.

사용자는 다음을 선택할 수 있습니다.

• 화합물 정보를 병합합니다. 패키지 화합물의 새 스펙트럼, 전환, 머무름 시간이 데이터베이
스에 저장된 화합물 정보에 추가됩니다.

• 화합물 정보를 덮어씁니다. 패키지의 화합물 정보가 데이터베이스에 저장된 화합물 정보를
대체합니다.

• 화합물 정보를 보관합니다. 데이터베이스의 화합물 정보를 보관하고 패키지의 화합물 정보
를 버립니다.

사용자가 올바른 선택을 할 수 있도록 충돌 정보가 제공됩니다.

화합물 충돌 보기
1. Library Importer 대화 상자에서에서 화합물 옆의 Resolve를 클릭하여 충돌 세부 정보를

표시합니다.

2. 다음 중 하나를 수행합니다.

• Keep Original을 클릭하여 기존 화합물 정보를 보관하고 새 정보를 버립니다.
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• Use New를 클릭하여 기존 화합물 정보를 새 정보로 교체합니다.

3. 각 화합물에 대해 1 및 2 단계를 반복합니다.

4. 모든 충돌이 해결된 후 Finish를 클릭합니다.

화합물 병합
1. Library Importer 대화 상자에서 다음 중 하나를 수행합니다.

• 가져오기 패키지에 있는 각 화합물의 새 스펙트럼, 전이 및 머무름 시간을 데이터베이
스에 저장된 해당 화합물 정보와 병합하려면 Merge를 클릭합니다.

• 가져오기 패키지에 있는 모든 화합물의 새 스펙트럼, 전이 및 머무름 시간을 데이터베
이스에 저장된 해당 화합물 정보와 병합하려면 Merge All을 클릭합니다.

2. 모든 충돌이 해결된 후 Finish를 클릭합니다.

화합물 정보 덮어쓰기
1. Library Importer 대화 상자에서 다음 중 하나를 수행합니다.

• 데이터베이스에 저장된 모든 화합물 정보를 가져오기 패키지의 해당 화합물 정보로 덮
어쓰려면 Overwrite All을 클릭합니다.

• 데이터베이스에 저장된 화합물 정보를 가져오기 패키지의 해당 화합물 정보로 덮어쓰
려면 해당 화합물 옆의 Resolve를 클릭한 후 Use New를 클릭합니다.

2. 모든 충돌이 해결된 후 Finish를 클릭합니다.

원래 화합물 보관
1. Library Importer 대화 상자에서 다음 중 하나를 수행합니다.

• 데이터베이스에 저장된 모든 화합물 정보를 보관하고 가져오기 패키지에서 화합물 정
보를 삭제하려면 Keep All Original을 클릭합니다.

• 데이터베이스에 저장된 개별 화합물 정보를 보관하고 가져오기 패키지에서 화합물 정
보를 삭제하려면 해당 화합물 옆의 Keep Original을 클릭합니다.

2. 모든 충돌이 해결된 후 Finish를 클릭합니다.

화합물 추가
참고: Edit Library 옵션을 사용하여 라이브러리에 화합물을 추가할 수도 있습니다.

1. Manage 창에서 Compounds 목록을 확장합니다.

2. All Compounds를 클릭합니다.

3. Add 아이콘을 클릭합니다.

참고: 화합물 이름은 필수 사항입니다. 이 밖의 모든 정보는 옵션 사항입니다.

4. Details 탭의 필드에 적절한 정보를 입력합니다.

5. Save을 클릭합니다.
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화합물에 질량 스펙트럼 추가
1. Manage 창에서 Compounds 목록을 확장합니다.

2. All Compounds를 클릭합니다.

3. 적절한 화합물을 두 번 클릭합니다.

4. MS Spectra 탭을 클릭합니다.

5. Edit Mode 아이콘을 클릭합니다.

6. Add Spectra 아이콘을 클릭합니다.

7. Add Mass Spectrum from *.wiff file to Compound 대화 상자에서 Open *.wiff file을 클릭
합니다.

8. Open 대화 상자에서 적절한 wiff 또는 wiff2 파일을 찾아 선택합니다.

9. Open을 클릭합니다.

10. 다음 중 하나를 수행하여 라이브러리에 화합물을 추가합니다.

• IDA 데이터의 경우 샘플을 확장한 후 왼쪽의 탐색 창에서 적절한 화합물을 선택합니다.

• EMS, MRM 및 루프 데이터의 경우 적절한 샘플을 선택합니다.

11. 다음 중 하나를 수행하여 화합물에 스펙트럼을 추가합니다.

• IDA 데이터의 경우 Acquired Spectrum 창에서 Add Spectrum을 클릭합니다.

• EMS, MRM 및 루프 데이터의 경우 TIC를 두 번 클릭한 후 Acquired Spectrum 창에서
Add Spectrum을 클릭합니다.

12. 추가할 각각의 스펙트럼에 대해 7 ~ 11단계를 반복합니다.

13. Save를 클릭합니다.

14. MS Spectra 탭에서 Save를 클릭합니다.
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작동 지침—사용자 워크플로 4
분석자
작업 참조

주 화면과 상태 패널을 검토하여 시
스템 상태 확인

홈 페이지 정보 및 상태 패널 정보

Microsoft Excel 스프레드시트 또는
LIMS를 사용하거나 수동으로 배치
생성 및 제출. 분석자가 배치를 생성
하고 제출하기 전에 방법 개발자가
LC 및 MS 방법을 잠가야 합니다.

Batch 작업 영역

대기열에서 샘플 보기 및 관리 Queue 작업 영역

Results Table의 데이터 처리 및 검
토

Analytics 작업 영역

데이터 탐색 Explorer 작업 영역

방법 개발자
작업 참조

시스템 구성 • 작동 지침—장치 구성

• 프로젝트에 대한 기본 처리 매개 변수 정의

• Results Table 사용자 지정

질량 분석계 조정 MS Tune 작업 영역.

액체 크로마토그래피(LC) 장치 구성 LC 장치의 문서.

LC 방법 생성 LC 방법 생성

MS(질량 분석계) 방법 생성 MS Method 작업 영역.

처리 방법 개발 처리 방법 생성.

관리자
작업 참조

Windows 파일 권한 설정 실험실 책임자 안내서

LIMS 구성. 실험실 정보 관리 시스템(LIMS) 설정 선택
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작업 참조

소프트웨어에 사용자 추가 및 역할
할당

실험실 책임자 안내서

로그 보관 로그 보관

검토자
작업 참조

처리된 결과 검토 Analytics 작업 영역

데이터 탐색 Explorer 작업 영역

로그 검토 로그 보기
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작동 지침—획득 5
다음 작업 영역을 사용하여 획득 작업을 수행할 수 있습니다.

• MS Method 작업 영역: MS 방법 생성 및 관리

• LC Method 작업 영역: LC 방법 생성 및 관리

• Batch 작업 영역: 배치를 생성하여 대기열에 제출

• Queue 작업 영역: 대기열의 샘플 관리

참고: 성능 문제 또는 데이터 손상을 방지하기 위해 샘플 획득 중에는 조각 모음, 디스크 정리,
바이러스 검사 또는 Windows 업데이트와 같은 컴퓨터 유지보수 절차를 수행하지 마십시오.

MS Method 작업 영역
이 작업 영역을 사용하여 MS(질량 분석계) 방법을 생성하고 관리할 수 있습니다.

MS Method 작업 영역에서 여러 개의 방법을 열 수 있습니다. 사용자는 Views 메뉴를 사용하
여 방법 창의 정렬 방식을 탭 보기, 세로 바둑판식, 가로 바둑판식 또는 부동 보기로 변경할 수
있습니다. 부동 보기에서는 창의 크기를 조정하고 최대화 또는 최소화하거나, SCIEX OS 창
외부 또는 다른 모니터로 이동할 수 있습니다.

방법 창의 제목 표시줄에는 방법 및 프로젝트 이름이 포함됩니다. 바둑판식 보기와 부동 보기
에서 활성 방법의 제목 표시줄은 파란색으로 표시되고 다른 방법의 제목 표시줄은 회색으로
표시됩니다. 탭 보기에서 활성 방법의 탭은 흰색으로 표시되고 다른 방법의 탭은 파란색으로
표시됩니다.

이 작업 영역의 기능에 대한 액세스는 사용자에게 할당된 역할로 제어됩니다. 자세한 정보는
실험실 책임자 안내서를 참조하십시오.

MS 방법 생성
필요에 따라 다음을 참조하십시오.

• MS 방법 실험

• MS Methods 정보

• MS 방법에 대한 동적 충돌 에너지 계산

1. MS Methods 작업 영역을 엽니다.

2. New를 클릭한 후 방법을 클릭합니다.

3. (선택 사항) Options를 클릭한 후 필요에 따라 다음을 선택합니다.
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표 5-1 Options 메뉴

매개 변수 설명

Apply experiment
scheduling

(실험 일정 적용) 실험이 실행될 때 머무름 시간 범위를 적용하려면
선택합니다. 반복 실험의 경우 실행 시작 시간 중 하나는 0이어야 하
고 실행 중지 시간 중 하나는 방법 지속 시간과 같아야 합니다.

Apply ionization
scheduling

(이온화 일정 적용) Ionization start time 및 Ionization stop time을
표시하려면 선택합니다.

Show EAD
parameters

(EAD 매개 변수 표시)(ZenoTOF 7600 시스템) EAD 매개 변수를 표
시하려면 선택합니다. EAD 단편화 모드를 사용 중인 경우 이 옵션을
선택하면 다음 필드가 활성화됩니다.

• Fragmentation mode: EAD

• Electron KE

• ETC

• Electron beam current

• Load time

• EAD RF

• Reaction time

Apply intact protein
mode

(원형 단백질 모드 적용)(X500 QTOF 시스템) Intact Protein mode
필드를 표시하려면 선택합니다.

Ramp (램프) 매개 변수를 램핑하려면 선택합니다. Ramp Compound
Parameters 대화 상자가 열립니다.

램핑을 사용하여 이온 매개 변수를 최적화할 수 있습니다.

매개 변수 램핑은 매개 변수의 값을 늘리거나 줄이면서 자동으로 실
행되는 실험으로 구성됩니다. 한 번에 하나의 매개 변수만 램핑할 수
있으며 스텝은 시작 및 중지 값 내에서 동일한 방향(증가 또는 감소)
이어야 합니다. 사용자는 시작 및 중지 전압과 중간의 스텝 크기를
설정할 수 있습니다.

TOF MS 방법의 경우 사용자는 DP 매개 변수를 램핑할 수 있습니다.
TOF MSMS 방법의 경우 사용자는 DP 또는 CE 매개 변수를 램핑할
수 있습니다. Apply ramping to the compound parameter를 선택하
여 램핑을 활성화할 수 있습니다.

Calibrate (교정) 획득하는 동안 스펙트럼 및 질량 분석계를 교정하려면 선택합
니다. Calibrate 대화 상자가 열립니다. 사용자는 이 대화 상자에서
교정을 위한 적절한 이온 참조표를 선택할 수 있습니다.

교정 기능은 대개 CDS(교정물질 전달 시스템)와 함께 사용됩니다.
교정 결과를 보려면 Queue 작업 영역으로 가서 교정 실행의 획득 상
태 아이콘을 두 번 클릭합니다. 교정에는 1.25분 정도가 걸립니다.
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표 5-1 Options 메뉴 (계속)

매개 변수 설명

Dynamic collision
energy

(동적 충돌 에너지) Dynamic Collision Energy 대화 상자를 열려면
클릭합니다.

Dynamic ETC (ZenoTOF 7600 시스템)(동적 ETC) Dynamic ETC 대화 상자를 열려
면 클릭합니다.

4. 필요에 따라 필드에 값을 입력합니다. 매개 변수에 대한 설명은 도움말 시스템 문서를 참
조하십시오.

5. (선택 사항) Add Experiment를 클릭합니다.

팁! 실험을 변경하거나 삭제하려면 Experiment 필드 옆의 목록을 사용하십시오.

6. 다음 중 하나를 수행합니다.

• Save > Lock Method를 클릭하여 MS 방법을 저장하고 잠급니다.

• Save > Save를 클릭합니다.

• Save > Save as를 클릭합니다.

Guided MRM HR을 사용하여 MRM HR 방법 생성
시작 및 중지 전압에 대한 제어가 더 필요한 경우 Guided 옵션을 사용합니다.

1. MS Method 작업 영역을 엽니다.

2. New > Guided MRM HR을 클릭합니다.
Preparation 페이지가 열립니다.

3. 모드를 선택합니다.

• Guided: 시작 및 중지 전압을 더 효과적으로 제어할 수 있습니다.

• Automatic: 소프트웨어에서 전압 시작 및 중지 값이 자동으로 선택됩니다.

4. Polarity를 선택합니다.

5. 알려진 전이를 사용하려면 다음을 수행합니다.

a. Use known transitions를 클릭합니다.

b. Compound ID, Precursor Ion (Da) 및 Fragment to Use (Da)를 입력합니다.

6. 알 수 없는 전이를 사용하려면 다음을 수행합니다.

a. Find transitions automatically를 클릭합니다.

b. 각 화합물에 대한 테이블에 Compound Name, Charge, Precursor Ion 및 Number
of Fragments to Use를 지정합니다.

7. Continue를 클릭합니다.
Initial Conditions 페이지가 열립니다.

8. 필요한 경우 Source and Gas Parameters를 조정합니다.
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9. 자동으로 처리되지 않으면 Start를 클릭합니다.

10. Optimize DP 페이지에서 Ramp를 클릭합니다.
소프트웨어에서 DP 매개 변수를 자동으로 램핑하고 각 전이에 대해 가장 높은 강도의 DP
값을 찾습니다.

11. (Automatic 모드) 각 생성 이온에 대해 최적의 DP와 최적의 CE가 식별되고 Review
Report 페이지가 표시될 때까지 기다립니다. 그런 다음 13단계로 이동합니다.

12. Optimize DP 페이지에서 Ramp를 클릭합니다.
소프트웨어에서 DP 매개 변수를 자동으로 램핑하고 각 전이에 대해 가장 높은 강도의 DP
값을 찾습니다.

13. (선택 사항) 다음 단계를 수행하여 보고서를 저장합니다.

a. Report 페이지에서 Save report as를 클릭합니다.

b. 보고서를 저장할 폴더로 이동하여 File name을 입력한 후 Save를 클릭합니다.

14. Continue를 클릭하여 MS Method 작업 영역에서 최적화된 방법을 엽니다.

15. Method Duration 필드에 필요한 방법 지속 시간을 입력합니다.

16. 다음 중 하나를 수행하여 MS 방법을 저장합니다.

• Save > Save를 클릭하여 방법을 동일한 프로젝트에 같은 이름으로 저장합니다.

• Save > Save As를 클릭하여 방법을 새 이름으로 저장하거나 다른 프로젝트에 저장합
니다.

• 일상적 분석을 위한 준비가 완료되면 Save > Lock Method를 클릭하여 방법을 잠급니
다.

참고: 권한이 없는 사용자가 편집할 수 없도록 방법을 잠그십시오. Lock/Unlock
methods 권한이 있는 사용자만 잠긴 방법을 편집할 수 있습니다. 다른 사용자는 방법을
제출만 할 수 있습니다.

Save As MS Method 대화 상자가 열립니다.

17. File Name 필드에 이름을 입력합니다.

18. Save을 클릭합니다.

MS 방법 실험
MS Method 작업 영역을 사용하여 MS 방법을 생성하고 편집할 수 있습니다. MS 방법은 하나
이상의 실험을 포함할 수 있습니다. 기본적으로 새 TOF MS 방법에는 하나의 실험이 포함됩니
다.

사용 가능한 MS 실험의 유형은 다음과 같습니다.

• 3가지의 기본 방법 실험: TOF MS, TOF MSMS 및 Q1

• 3가지의 조합된 방법 실험: IDA, SWATH 및 MRMHR

이 외에도 MRMHR 실험의 생성을 안내하는 단계별 절차를 사용할 수 있습니다. 절차가 완료되
면 매개 변수를 사용하여 MRMHR 방법을 채웁니다.
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표 5-2 기본 방법 실험

유형 정의

TOF MS TOF 영역을 사용하는 질량 분석입니다. 이온의 m/z 값은 TOF 영역에서
이온의 비행 시간을 기초로 유지됩니다.

TOF MSMS 사극자 질량 필터를 사용하여 전구체 이온이 선택됩니다. 그런 다음 TOF
MS 영역에서 이온의 비행 시간을 기초로 단편 이온의 m/z 값이 반환됩니
다. 이 실험은 화합물의 구조를 확인하는 데도 사용됩니다.

Q1 사극자 질량 필터를 사용하는 데이터 획득입니다. 스캔 범위에 있는 질량
에 대해 이온 강도가 반환됩니다.

표 5-3 조합된 방법 실험

유형 정의

IDA IDA(정보 의존적 획득) 실험은 데이터를 획득하면서 동시에 데이터를 분
석하고 분석 결과에 따라 실험 조건을 변경합니다. 결과의 분석을 통해 종
속 스캔을 수행할 질량을 결정합니다. 사용자는 IDA 실험을 활성화하는
기준 및 활성화된 IDA 실험의 매개 변수를 모두 제어할 수 있습니다.

SWATH SWATH 획득은 LC 시간 척도에서 넓은 질량 범위에 대해 모든 전구체 이
온의 MS/MS 분석을 가능하게 합니다. Q1 사극자는 기존 생성 이온 획득
에 사용된 것보다 더 넓은 선택 범위 폭(대개 10 Da ~ 50 Da)에 설정됩니
다. 여러 개의 순차적인 선택 범위를 단계적으로 거치면서 넓은 질량 범위
가 신속하게 처리됩니다. 결과 질량 스펙트럼은 각각의 Q1 선택 범위를
통과한 모든 전구체 이온 단편의 조합입니다. 이 기법을 통해 샘플 내 모든
성분에 대한 비대상 MS/MS 분석을 수행할 수 있습니다.

MRM HR MRMHR 실험은 알려진 질량과 유지 시간을 사용하여 화합물로부터 고품
질 MS/MS 데이터를 획득하는 데 도움을 줍니다. 이 획득은 또한 TOF
MSMS 스펙트럼에서 좁은 폭(0.02Da)을 가진 단편 질량 추출에도 사용할
수 있습니다. 좁은 폭의 추출은 더 나은 선택성을 제공합니다.

안내된 MRM HR MRMHR 방법의 생성을 안내하는 단계별 절차. 절차 단계가 완료되면 매개
변수를 사용하여 MRMHR 방법 유형을 채웁니다.

MS Methods 정보
MS method는 다음과 같은 요소로 구성됩니다.

• Source and Gas 매개 변수를 포함하여 전체 방법과 관련된 매개 변수

• 하나 이상의 실험

• 각 방법에는 최소한 하나의 실험이 포함되어야 합니다.

• 어떤 방법도 둘 이상의 실험을 포함할 수 있습니다. 이 경우를 반복 실험이라고 합니다.

• TOF MS 및 TOF MSMS 실험은 한 방법 내에서 최대 10개의 실험까지 반복 실행될 수
있습니다. Q1 실험은 반복 실행될 수 없습니다.
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• IDA, SWATH, MRMHR 실험은 한 방법 내에서 최대 2개의 실험까지 반복 실행될 수 있습
니다.

참고: 특정 실험 조합(예: IDA + IDA, IDA + MRMHR, IDA + SWATH 및 SWATH +
MRMHR)만 사용할 수 있습니다.

• 각 실험에는 특별한 고급 설정이 있습니다.

• 각 실험 내 개별 스캔

표 5-4 MS Methods 작업 영역 기능

수행할 작업 방법

둘 이상의 실험, 즉 반복 실험
을 통해 방법을 생성합니다.

Add Experiment를 클릭한 후 실험 유형을 클릭합니다.

기존 MS method 내에서 실험
을 전환합니다.

Experiment 옆의 목록을 클릭한 후 실험 유형을 클릭합니다.

TOF MSMS 실험을 IDA 실험
으로 변환

Experiment 옆의 목록을 클릭한 후 Add IDA criteria를 클릭
합니다.

MRMHR 실험에서, TOF MS
를 방법에서 제거

Experiment 옆의 목록을 클릭한 후 Delete TOF MS (of
MRM HR)를 클릭합니다.

참고: 반복 실험에만 적용됩니다.

한 방법 내에 여러 실험이 있
는 경우 하나의 실험 제거

Experiment 옆의 목록을 클릭한 후 Delete experiment.를
클릭합니다.

다음과 같은 방법의 구조 보
기
• 방법 내 실험 수

• 방법 내 각 실험의 일정 기
간

• 복수의 실험에서 TOF
MSMS 스캔 수

작업 영역의 왼쪽에 있는 Method Overview 패널을 확장하거
나 축소합니다.

MS 방법에 대한 동적 충돌 에너지 계산
1. MS Method 작업 영역을 엽니다.

2. IDA 기준 또는 SWATH 획득 기준이 포함된 MS 방법을 생성하거나 엽니다.

3. Options > Dynamic collision energy를 클릭합니다.

4. 필요 시 필드에서 정보를 수정합니다.

5. 다음 중 하나를 수행합니다.

• 동적 CE 계산을 위해 이전에 저장한 기본값을 사용하려면 Load Default Settings를
클릭합니다.
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• 새 방법에서 동적 CE 계산에 사용하기 위해 현재 값을 기본값으로 저장하려면 Save
as Default Settings를 클릭합니다.

• 동적 CE 계산을 위해 현재 값을 현재 방법에 적용하려면 Apply를 클릭합니다.

• 대화 상자를 닫고 변경 내용을 취소하려면 Cancel을 클릭합니다.

MS 방법 열기
이 절차를 사용하여 SCIEX OS로 생성된 MS 방법을 열 수 있습니다.

1. MS Method 작업 영역을 엽니다.

2. Open을 클릭합니다.
Open MS Method 대화 상자가 열립니다. 여기에는 현재 프로젝트에 있는 MS 방법의 목
록이 표시됩니다.

3. (선택 사항) 열려는 방법이 현재 프로젝트에 없으면 열려는 방법이 포함된 프로젝트를 선
택합니다.

4. 열려는 MS 방법을 선택한 후 Open을 클릭합니다.

팁! 여러 방법을 선택하려면 Shift 또는 Ctrl 키를 사용하십시오.

MS 방법을 수동으로 실행
선행 절차

• MS Method 작업 영역에서 MS 방법을 생성하거나 기존 방법을 엽니다. 자세한 정보는
MS Method 작업 영역 또는 MS 방법 열기 섹션을 참조하십시오.

이 절차를 사용하여 MS Method 작업 영역에서 활성 방법을 실행할 수 있습니다.

1. Data Acquisition 패널의 Start 버튼에서 아래쪽 화살표를 클릭한 후 다음 중 하나를 클릭
합니다.

• Start: 이 옵션은 LC 없이 MS 방법을 실행합니다.

• Start with LC

자세한 정보는 Data Acquisition 패널 섹션을 참조하십시오.

경고! 화재 위험. 이온 소스에 3mL/min을 초과하는 용매를 주입하지 마십시오.
LC 구성품은 최대 5mL/min의 유속을 제공할 수 있지만 3mL/min을 초과하는 용
매를 주입하면 용매가 이온 소스에 쌓일 수 있습니다. 이온 소스에 제공되는 최대
유속이 3mL/min을 초과하지 않도록 T자관으로 흐름을 분할할 수 있습니다.

사용자가 Start with LC를 클릭하면 Start with LC 대화 상자가 열립니다. 이 대화 상자의
필드에 대한 정보는 도움말 시스템 문서를 참조하십시오.

참고: LC 시스템을 활성화해야 하고 LC 방법이 생성 후 저장되어 있어야 합니다.
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그림 5-1 Start with LC 대화 상자

2. (선택 사항) Explorer 작업 영역에서 데이터를 보려면 Data Acquisition 패널에서 Open

data exploration to view real-time data( )를 클릭합니다.
실시간 획득은 Explore 창에서 샘플 제목에 Acquiring, Finished 또는 Aborted라는 단어
로 표시됩니다.

그림 5-2 실시간 획득—Acquiring

3. (선택 사항) 필요에 따라 MS 매개 변수를 최적화합니다. 매개 변수에 대한 설명은 도움말
시스템 문서를 참조하십시오.

4. Data Acquisition 패널에서 Stop을 클릭합니다.

5. (선택 사항) 데이터를 저장하려면 다음 단계를 수행합니다.

a. Save를 클릭하여 데이터를 저장합니다.
Save Data 대화 상자가 열립니다.

b. (선택 사항) 데이터를 저장할 프로젝트 및 하위 폴더(해당하는 경우)를 선택합니다.

c. File Name 필드에 이름을 입력합니다.

d. Save를 클릭합니다.

6. 다음 중 하나를 수행하여 MS 방법을 저장합니다.
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• Save > Save를 클릭하여 방법을 동일한 프로젝트에 같은 이름으로 저장합니다.

• Save > Save As를 클릭하여 방법을 새 이름으로 저장하거나 다른 프로젝트에 저장합
니다.

• 일상적 분석을 위한 준비가 완료되면 Save > Lock Method를 클릭하여 방법을 잠급니
다.

참고: 권한이 없는 사용자가 편집할 수 없도록 방법을 잠그십시오. Lock/Unlock
methods 권한이 있는 사용자만 잠긴 방법을 편집할 수 있습니다. 다른 사용자는 방법을
제출만 할 수 있습니다.

Save As MS Method 대화 상자가 열립니다.

7. File Name 필드에 이름을 입력합니다.

8. Save을 클릭합니다.

LC Method 작업 영역
이 작업 영역을 사용하여 LC 방법을 생성하고 관리할 수 있습니다.

LC Method 작업 영역에서 여러 개의 방법을 열 수 있습니다. 사용자는 Views 메뉴를 사용하
여 방법 창의 정렬 방식을 탭 보기, 세로 바둑판식, 가로 바둑판식 또는 부동 보기로 변경할 수
있습니다. 부동 보기에서는 창의 크기를 조정하고 최대화 또는 최소화하거나, SCIEX OS 창
외부 또는 다른 모니터로 이동할 수 있습니다.

방법 창의 제목 표시줄에는 방법 및 프로젝트 이름이 포함됩니다. 바둑판식 보기와 부동 보기
에서 활성 방법의 제목 표시줄은 파란색으로 표시되고 다른 방법의 제목 표시줄은 회색으로
표시됩니다. 탭 보기에서 활성 방법의 탭은 흰색으로 표시되고 다른 방법의 탭은 파란색으로
표시됩니다.

이 작업 영역의 기능에 대한 액세스는 사용자에게 할당된 역할로 제어됩니다. 자세한 정보는
실험실 책임자 안내서를 참조하십시오.

LC 방법 생성
LC 장치와 함께 제공되는 문서를 참조하십시오.

1. LC Method 작업 영역을 엽니다.

2. New를 클릭합니다.

3. 왼쪽 패널에서 장치를 클릭한 후 필요에 따라 필드를 편집합니다.

4. 다음 명령 중 하나를 클릭하여 LC 방법을 저장하고 선택적으로 잠급니다.

• Save: LC 방법을 저장합니다.

• Save > Lock Method: LC 방법을 저장하고 잠급니다.

Save As LC Method 대화 상자가 열립니다.

5. File Name 필드에 LC 방법의 이름을 입력한 후 Save를 클릭합니다.
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Batch 작업 영역
Batch 작업 영역에는 획득 및 처리(선택 사항)할 샘플 세트에 대한 정보가 포함되어 있습니다.
배치는 샘플을 획득하고 처리하는 순서를 소프트웨어에 알려 줍니다.

이 작업 영역의 기능에 대한 액세스는 사용자에게 할당된 역할로 제어됩니다. 자세한 정보는
실험실 책임자 안내서를 참조하십시오.

참고: 선택된 오토샘플러에서 랙 유형, 랙 위치, 플레이트 유형, 플레이트 위치 및 바이알 위치
는 서로 완전 종속 관계이며 특정 값만 유효합니다.

표 5-5 Batch 작업 영역 열

열 이름 정의 필드 값 요건

Sample and method information(샘플 및 방법 정보)( )

Sample Name (샘플 이름) 샘플 이름입니다. 252자 미만이어야 합니다.

Sample ID (샘플 ID) 샘플에 대한 사용자 지
정 숫자 또는 기타 식별자입니다.

252자 미만이어야 합니다.
Sample ID 필드에는 \ / : ; * ? " <
> |= 같은 유효하지 않은 문자를
사용할 수 없습니다.

Barcode ID (바코드 ID) 샘플의 고유 ID입니
다.

250자 미만이어야 합니다.

MS Method (MS 방법) 방법의 이름입니다. MS 방법이 현재 프로젝트에 있어
야 합니다. 이 필드는 대/소문자를
구분하지 않습니다.

LC Method (LC 방법) 액체 크로마토그래피
방법의 이름입니다.

LC 방법이 현재 프로젝트에 있어
야 합니다. 이 필드는 대/소문자를
구분하지 않습니다.

Rack Type (랙 유형) 오토샘플러의 랙 유형입
니다.

LC 방법에 지정된 오토샘플러에
대한 유효한 선택 항목 중 하나여
야 합니다.

Rack Position (랙 위치) 트레이에서 랙 위치입니
다.

숫자 값입니다.

Plate Type (플레이트 유형) 오토샘플러의 웰
플레이트 유형입니다.

참고: Rack Type이 바이알인 경
우 이 열을 사용할 수 없습니다.

LC 방법에 지정된 오토샘플러에
대한 유효한 선택 항목 중 하나여
야 합니다.

Plate Position (플레이트 위치) 랙에서 플레이트
의 위치입니다.

미리 정의된 오토샘플러 플레이
트 위치 중 하나와 일치해야 합니
다.
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표 5-5 Batch 작업 영역 열 (계속)

열 이름 정의 필드 값 요건

Vial Position (바이알 위치) (LC 방법) 랙 또는
플레이트에서 바이알의 위치입니
다.

숫자 값입니다. 가장 큰 값이 랙에
있는 바이알 개수보다 더 커서는
안 됩니다.

Injection Volume
(µL)

(주입량(µL)) 주입할 샘플의 양입
니다.

참고:

LC 방법의 경우에만 주입량을 LC
방법에서 가져옵니다. 사용자는
Batch 작업 영역 또는 가져온 배
치 파일에서 이 주입량을 재정의
할 수 있습니다. 배치가 제출되면
LC 장치에서 지원하는 범위를 기
준으로 주입량의 유효성을 검사
합니다.

LC 방법에 지정된 주입량을 되돌
리려면 이 필드의 내용을 삭제한
후 LC Method 필드에서 LC 방법
을 다시 선택합니다.

숫자 값입니다.

Sample Type (샘플 유형) 샘플 유형입니다. 미리 정의된 샘플 유형 중 하나와
일치해야 합니다. 일치하지 않는
유형은 자동으로 Unknown으로
대체됩니다.

Dilution Factor (희석배율) 개별 샘플의 희석배율
입니다.

SCIEX에서 개발한 방법의 경우
값이 1.000000이어야 합니다.

0보다 크고 소수점 이하 자릿수가
6인 값이어야 합니다. 기본값은
1.000000입니다. 이 필드를 비워
두지 마십시오.
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표 5-5 Batch 작업 영역 열 (계속)

열 이름 정의 필드 값 요건

Data File (데이터 파일) 획득한 데이터가 저
장되는 파일의 이름입니다. 파일
이 저장될 하위 폴더의 전체 경로
를 포함하십시오.

252자 미만이어야 합니다. 총 글
자수에는 데이터 하위 폴더 경로
의 글자수도 포함됩니다. 데이터
파일에는 \ / : ; * ? " < > |= 같은 유
효하지 않은 문자를 사용할 수 없
습니다.

팁! 화살표를 클릭하여 하위 폴더
를 선택하거나 새 하위 폴더의 이
름을 입력하십시오. 하위 폴더와
파일 이름 사이에 백슬래시(\)를
포함해야 합니다. 하위 폴더가 없
으면 배치가 실행될 때 생성됩니
다.

Processing Method (처리 방법) 방법의 이름입니다.
기존 Results File을 사용하는 경
우 이 필드를 비워 두십시오. 기존
Results File을 선택하면
*Embedded Method* 값이 이 필
드에 자동으로 표시됩니다.

참고: 처리 방법은 샘플에 지정된
MS 방법과 호환되어야 합니다.

프로젝트의 처리 방법 목록에서
처리 방법을 선택하십시오.

Results File (결과 파일) 처리한 결과가 저장되
는 파일의 이름입니다. 유효한
Results File을 지정하면 획득이
완료된 후 샘플 데이터가 자동으
로 처리됩니다. 파일 이름이 유효
하지 않으면 배치 제출 프로세스
를 완료할 수 없습니다.

참고: 기존 Results File을 선택하
면 선택한 결과 파일의 포함된 방
법이 처리에 사용되고
Processing Method 셀의 텍스트
가 *Embedded Method*로 바뀝
니다.

파일 이름에는 \ / ; : * ? " < > |= 같
은 유효하지 않은 문자를 사용할
수 없습니다.

파일 이름과 하위 폴더를 포함한
파일 경로는 252자 미만이어야 합
니다.

팁! 화살표를 클릭하여 목록에서
기존 결과 파일을 선택하십시오.
파일을 생성하려면 파일 이름을
입력합니다. 제출된 배치의 첫 번
째 샘플이 처리될 때 파일이 생성
됩니다.

Comment (메모) 텍스트입니다. 50자 미만이어야 합니다.
Comment 필드에는 \ / : ; * ? " <
> |= 같은 유효하지 않은 문자를
사용할 수 없습니다.
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표 5-5 Batch 작업 영역 열 (계속)

열 이름 정의 필드 값 요건

Custom columns (사용자 지정 열) (선택 사항) 텍스
트, 정수 또는 실수 형식의 사용자
정의 열입니다.

요구 사항은 형식에 따라 다릅니
다.

Component Concentrations(구성 요소 농도)( )

Component (구성 요소 이름) MS 방법, 처리
방법 또는 Results Table에 정의
된 구성 요소의 이름입니다.

배치에 최대 4,000개의 구성 요소
행을 포함할 수 있습니다.

구성 요소 이름은 MS 방법, 처리
방법(MRM 스캔의 경우) 또는
Results Table에서 가져옵니다.
방법을 생성하는 동안 이름 유효
성이 검사됩니다.

구성 요소를 테이블에 수동으로
추가할 수도 있습니다. 자세한 정
보는 구성 요소 농도 추가 섹션을
참조하십시오.

참고: 가져온 파일에 배치 그리드
의 열과 일치하지 않는 데이터 열
이 포함된 경우 해당 열은
Compound 또는 Component
Name 열로 처리됩니다. 농도 열
이 추가되고 이 데이터 열의 값으
로 채워집니다.

Component
concentration

표준 및 QC 샘플 유형에 대한 분
석 물질 또는 내부 표준 농도입니
다. 테이블에는 각 샘플에 대한 열
이 포함됩니다. 샘플 이름이 열 이
름으로 사용됩니다.

0보다 크거나 같은 숫자 값입니
다.

배치 관리
참고: 상태 패널에 올바른 프로젝트 이름이 선택되었는지 확인하십시오.

Batch 작업 영역에서 다음 기능을 사용하여 배치를 관리할 수 있습니다.

표 5-6 Batch 작업 영역 기능

수행할 작업 방법

열 표시 또는 숨기기 View를 클릭합니다. 자세한 정보는 열 표시 또는 숨기기 섹션
을 참조하십시오.

행 잘라내기 Manage Samples > Cut를 클릭합니다.

행 복사 Manage Samples > Copy를 클릭합니다.
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표 5-6 Batch 작업 영역 기능 (계속)

수행할 작업 방법

행 붙여넣기 Manage Samples > Paste를 클릭합니다.

행 삽입 Manage Samples > Insert sample를 클릭합니다.

행 삭제 Manage Samples > Delete sample를 클릭합니다.

열 선택 View를 클릭합니다. 자세한 정보는 열 표시 또는 숨기기 섹션
을 참조하십시오.

프로젝트에 하위 폴더 추가 Manage Samples > Add data sub-folders를 클릭합니다.
자세한 정보는 도움말 시스템 문서를 참조하십시오.

배치 인쇄 Print를 클릭합니다.

배치를 현재 프로젝트에 저장 Save > Save 또는 Save > Save As를 클릭합니다.

배치를 txt 또는 csv 파일로 내
보내기

Save > Export를 클릭합니다.

열 표시 또는 숨기기
1. Batch 작업 영역을 엽니다.

2. View를 클릭합니다.

3. 필요에 따라 View 대화 상자에서 열 확인란을 선택하거나 선택 취소합니다. 열에 대한 설
명은 표 5-5에서 확인하십시오.
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그림 5-3 View 대화 상자

4. OK를 클릭합니다.

사용자 지정 열 추가
이 절차를 사용하여 건조 중량과 같은 샘플 관련 추가 정보를 저장하기 위한 열을 배치에 추가
할 수 있습니다. 해당 정보는 예를 들어 수식과 계산 열에서 처리에 사용할 수 있습니다.

1. Batch 작업 영역을 엽니다.

2. 배치 그리드를 마우스 오른쪽 버튼으로 클릭한 후 Add Custom Column을 클릭합니다.
Add Custom Column 대화 상자가 열립니다.

3. Column name 필드에 열 이름을 입력합니다.
이름은 고유해야 합니다. 미리 정의된 열의 이름과 동일한 이름은 사용할 수 없습니다.

4. Column type 필드에서 다음 유형 중 하나를 선택합니다.

• Integer: 이 열에는 정수가 포함됩니다. 10진수 값은 가장 가까운 정수로 반올림됩니
다.

• Real: 이 열에는 소수점 이하 최대 6자리의 실수가 포함됩니다.
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• Text: 이 열에는 최대 128자의 텍스트가 포함됩니다.

5. Add를 클릭합니다.
Batch 작업 영역의 오른쪽에 새 열이 추가됩니다.

사용자 지정 열 이름 변경

참고: Column type은 변경할 수 없습니다.

1. Batch 작업 영역을 엽니다.

2. 변경할 열을 마우스 오른쪽 버튼으로 클릭한 후 Edit Custom Column을 클릭합니다.
Edit Custom Column 대화 상자가 열립니다.

3. Name 필드에 열의 새 이름을 입력합니다.
이름은 고유해야 합니다. 미리 정의된 열의 이름과 동일한 이름은 사용할 수 없습니다.

4. Apply를 클릭합니다.

사용자 지정 열 제거
1. Batch 작업 영역을 엽니다.

2. 배치 그리드를 마우스 오른쪽 버튼으로 클릭한 후 Delete Custom Column을 클릭합니
다.
Delete Custom Column 대화 상자가 열립니다.

3. 삭제할 열의 이름 옆에 있는 확인란을 선택합니다.

4. Delete를 클릭합니다.

파일에서 배치 가져오기
선행 절차

• 배치 파일을 생성합니다. 파일에 포함할 필드에 대한 설명은 표 5-5에서 확인하십시오.

참고: 가져올 Microsoft Excel 파일에서는 미리 정의된 열이 가장 먼저 오고 그 다음에 사
용자 지정 열이 와야 합니다. 미리 정의된 열의 열 머리글은 SCIEX OS의 열 이름과 일치
해야 합니다. 미리 정의된 열의 열 머리글이 올바르지 않으면 정보를 가져올 수 없습니다.
csv 또는 xsl 파일에서 마침표만 소수점 구분 기호로 지원됩니다.

참고: 배치 파일을 가져오기 전에 파일을 닫으십시오. 배치 파일이 Microsoft Excel에서 열
려 있으면 가져올 수 없습니다.

• (Watson LIMS에서 가져오기의 경우 선택 사항) LC Method 필드를 자동으로 채우려면
LC 방법 이름이 MS 방법 이름과 같아야 합니다.

참고: Watson LIMS에는 LC 방법 필드가 없습니다. LC 방법 이름이 MS 방법 이름과 다르
면 LC 방법 열을 수동으로 채워야 합니다.

샘플을 제출하기 전에 배치 내용을 검토하십시오.
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팁! 잘라내기, 복사, 붙여넣기, 행 추가/제거 기능에 액세스하려면 Manage Samples를 클릭하
십시오.

1. Batch 작업 영역을 엽니다.

2. (선택 사항) View를 클릭하여 Batch 작업 영역에 표시할 열을 선택합니다.

3. Open > Import from file을 클릭합니다.
Batch Import 대화 상자가 열립니다.

4. Browse를 클릭합니다.

5. 필요한 파일을 탐색합니다.

6. Open을 클릭합니다.

7. (선택 사항) 필요에 따라 Append to current batch 확인란을 선택하거나 선택을 취소합
니다.

참고: 사용자가 Append to current batch 옵션을 선택하지 않으면 그리드의 기존 데이터
를 덮어씁니다.

8. Import를 클릭합니다.

9. (선택 사항) 플레이트 레이아웃을 샘플 위치를 선택하거나 확인하기 위한 참조로 사용하
려면 Plate Layout을 클릭합니다.
Plate Layout은 미지정 샘플의 웰 및 바이알 위치를 자동으로 제공합니다.

10. 배치를 제출하기 전에 컬럼 오븐 온도에 도달했는지 확인합니다.

11. 다음과 같이 배치를 저장합니다.

a. Save As를 클릭합니다.
Save As Batch 대화 상자가 열립니다.

b. File Name을 입력한 후 Save를 클릭합니다.

12. 배치를 제출합니다. 자세한 정보는 배치 제출 섹션을 참조하십시오.

LIMS에서 배치 가져오기
선행 절차

• Configuration 작업 영역에서 LIMS를 구성합니다. 자세한 정보는 도움말 시스템 문서를
참조하십시오.

참고: Watson LIMS에서 배치를 가져오려면 파일에서 배치 가져오기 섹션을 참조하십시오.

1. Batch 작업 영역을 엽니다.

2. (선택 사항) View를 클릭하여 Batch 작업 영역에 표시할 열을 선택합니다.

3. Open > Import from LIMS를 클릭합니다.
Import a Batch File 대화 상자가 열립니다.

4. 파일 위치 또는 파일 이름을 입력합니다.
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5. Batch Identifier 필드에 배치 식별자를 입력합니다.

6. (선택 사항) 필요에 따라 Append to current batch 확인란을 선택하거나 선택을 취소합
니다.

참고: 사용자가 Append to current batch 옵션을 선택하지 않으면 그리드의 기존 데이터
를 덮어씁니다.

7. Import를 클릭합니다.

8. (선택 사항) 플레이트 레이아웃을 샘플 위치를 선택하거나 확인하기 위한 참조로 사용하
려면 Plate Layout을 클릭합니다.
Plate Layout은 미지정 샘플의 웰 및 바이알 위치를 자동으로 제공합니다.

9. (선택 사항) 배치에 교정 샘플을 포함하려면 다음을 수행합니다.

a. Batch-Automatic Calibration Editor 대화 상자를 열려면 Auto-Calibrate를 클릭합니
다.

b. 지정된 주기에 따라 자동으로 적용할 이온 참조 및 교정물질 전달 설정을 선택합니다.

c. OK를 클릭합니다.

d. Auto-Calibrate 버튼 왼쪽의 확인란을 선택합니다.

10. 배치를 제출하기 전에 컬럼 오븐 온도에 도달했는지 확인합니다.

11. 다음과 같이 배치를 저장합니다.

a. Save As를 클릭합니다.
Save As Batch 대화 상자가 열립니다.

b. File Name을 입력한 후 Save를 클릭합니다.

12. 배치를 제출합니다. 자세한 정보는 배치 제출 섹션을 참조하십시오.

수동으로 배치 생성
샘플을 제출하기 전에 배치 내용을 검토하십시오.

참고: 질량 분석계가 접점 폐쇄를 사용하여 외부 장치와 통신하는 경우 다음 지침을 따르십시
오.

• 배치에 정의된 샘플 시퀀스가 외부 장치에 정의된 시퀀스와 일치해야 합니다.

• 방법 지속 시간이 외부 장치에 정의된 주입 간격보다 작거나 같아야 합니다.

팁! 잘라내기, 복사, 붙여넣기, 행 추가/제거 기능에 액세스하려면 Manage Samples를 클릭하
십시오.

1. Batch 작업 영역을 엽니다.

2. (선택 사항) View를 클릭하여 Batch 작업 영역에 표시할 열을 선택합니다.

팁! 기존 배치를 사용하려면 Open > Open.을 클릭하십시오.
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3. New를 클릭합니다.

4. (선택 사항) 플레이트 레이아웃을 샘플 위치를 선택하거나 확인하기 위한 참조로 사용하
려면 Plate Layout을 클릭합니다.
Plate Layout은 미지정 샘플의 웰 및 바이알 위치를 자동으로 제공합니다.

5. 그리드에 배치 정보를 입력합니다.
그리드의 열에 대한 설명은 표 5-5에서 확인하십시오.

팁! Batch 작업 영역은 배치를 더 쉽게 만들 수 있도록 다음 기능을 제공합니다.

• Sample Type 셀과 같은 일부 셀의 콘텐츠는 셀의 목록에서 선택할 수 있습니다. 목록
을 표시하려면 셀의 오른쪽을 클릭합니다.

• 배치에 추가된 두 번째와 그 이후 행에는 자동으로 이전 행의 값이 채워집니다.

• 사용자는 셀을 선택하고 셀의 오른쪽 아래를 클릭한 후 셀 콘텐츠를 복사할 마지막 행
으로 끌어 단일 셀을 복사할 수 있습니다.

• 사용자는 여러 셀을 선택하고 맨 오른쪽 셀의 아래를 클릭한 후 셀 콘텐츠를 복사할 마
지막 행으로 끌어 같은 행의 셀 그룹을 복사할 수 있습니다.

• 사용자는 두 행에 순차적 값을 입력하여 두 셀을 모두 선택하고 아래쪽 셀의 오른쪽 아
래를 클릭한 후 시리즈의 마지막 행으로 끌어 일련의 값을 복사할 수 있습니다.

• 사용자는 복사(Ctrl+C) 및 붙여넣기(Ctrl+V) 명령을 사용하여 셀 또는 셀 그룹의 콘텐
츠를 복사한 후 새 위치에 붙여 넣을 수 있습니다.

참고: LC 방법을 선택할 때까지 LC 열을 사용할 수 없습니다.

팁! 샘플을 획득한 후 자동으로 처리하도록 배치를 구성하려면 다음 방법 중 하나를 사용
하십시오.

• 포함된 처리 방법을 사용하려면 기존 Results File을 선택합니다. 그러면 해당 결과 파
일의 포함된 방법으로 샘플이 처리됩니다.

• 새 처리 방법을 사용하려면 Results File 필드를 지웁니다. Results File 필드가 지워지
면 Processing Method 필드를 사용할 수 있게 됩니다. Processing Method를 선택한
후 새 Results File 이름을 입력합니다. 그러면 선택한 처리 방법으로 샘플이 처리됩니
다.

비표적 스크리닝 워크플로에서 처리할 때 자동 처리를 위해 비교 샘플을 선택할 수 없습
니다. AutoPeak 알고리즘을 사용하는 처리 방법의 경우 소프트웨어는 항상 해당 방법을
생성하는 데 사용한 샘플로 통합 모델을 구성합니다.

6. (선택 사항) 구성 요소 농도를 정의합니다. 자세한 정보는 구성 요소 농도 추가 섹션을 참
조하십시오.

7. (선택 사항) 결정 규칙을 배치에 적용하려면 다음 단계를 수행합니다.

a. Decision Rules 확인란을 선택합니다.

b. 배치에 적용할 각 결정 규칙에 대해 Decision Rules를 클릭한 후 Apply를 선택합니
다. 결정 규칙을 추가하려면 결정 규칙 추가 섹션을 참조하십시오.
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c. Save를 클릭합니다.

참고: Decision Rules 옵션을 선택하고 배치에 대해 하나 이상의 결정 규칙이 활성화된
경우 Queue 작업 영역의 배치 이름 옆에 Decision Rules: Active가 표시됩니다. 활성 프
로젝트가 네트워크에 있고 해당 네트워크를 사용할 수 없는 경우에는 Decision Rules:
Disabled라는 텍스트가 표시됩니다.

8. 다음과 같이 배치를 저장합니다.

a. Save As를 클릭합니다.
Save As Batch 대화 상자가 열립니다.

b. File Name을 입력한 후 Save를 클릭합니다.

9. 배치를 제출하기 전에 컬럼 오븐 온도에 도달했는지 확인합니다.

10. 배치에 사용된 MS 및 LC 방법으로 시스템이 평형화되어 있는지 확인합니다.

11. 배치를 제출합니다. 자세한 정보는 배치 제출 섹션을 참조하십시오.

Plate Layout 기능을 사용하여 배치 생성
Plate Layout 기능은 Batch 작업 영역에서 그리드를 채우는 데 사용할 수 있는 랙과 플레이트
의 그래픽 표현을 제공합니다.

1. Batch 작업 영역을 엽니다.

2. MS Method를 선택합니다.

3. LC Method를 선택합니다.
LC 시스템이 활성 상태여야 합니다.

4. 획득한 데이터를 저장할 Data File의 이름을 입력합니다.

5. 데이터를 획득한 후 처리하는 데 사용할 Processing Method를 선택합니다.

6. 처리한 데이터를 저장할 Results File의 이름을 입력합니다.

7. Plate Layout을 클릭합니다.
Plate Layout 창이 열리고 기본적으로 플레이트의 그래픽 표현이 표시됩니다.

8. 플레이트의 속성을 설정합니다.
창이 업데이트되어 선택한 플레이트 유형의 그래픽 표현이 표시됩니다.

9. 그래픽 표현에서 샘플 위치를 클릭합니다.
선택한 샘플 위치는 그래픽 표현에서 전체가 강조 표시됩니다. Batch 작업 영역이 업데이
트되어 샘플 위치가 완전히 정의되지 않은 첫 번째 행, 즉 Rack Type, Plate Type(웰이 사
용되는 경우) 및 Vial Position 값이 포함되지 않는 행으로 시작합니다. 이에 따라 그리드
에 샘플 위치가 표시됩니다.

10. 그래픽 표현에 필요한 만큼 샘플 위치를 계속 클릭하여 Batch 작업 영역의 그리드를 채웁
니다.
Batch 작업 영역의 그리드에 샘플 위치가 입력되면 이에 따라 그래픽 표현이 업데이트됩
니다.
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팁! 지정된 랙 유형과 연결된 모든 데이터를 제거하려면 Clear All을 클릭하십시오. 선택
한 랙 유형이 플레이트를 나타내는 경우 Clear All 아래의 메뉴에 Clear Front 및 Clear
Back이 포함됩니다.

11. 반복되는 샘플 위치를 지정하려면 그래픽 표현에서 샘플 위치를 클릭합니다.
플레이트 레이아웃의 그래픽 표현에는 반복되는 샘플 위치가 색 윤곽선으로 표시되고 이
에 따라 Batch 작업 영역의 그리드에 데이터가 표시됩니다.

그림 5-4 플레이트 레이아웃—반복되는 샘플 위치(위치 1)

참고: 선택하지 않은 위치는 회색으로 표시되고 한 번 선택한 위치는 회색 테두리의 파란
색으로 표시됩니다.

12. 그래픽 표현에서 샘플 색인을 보려면 강조 표시된 샘플 위치를 커서로 가리킵니다.
도구 설명에 샘플 색인이 표시됩니다.

13. 모든 위치가 할당 및 검토되면 Plate Layout 창에서 Close를 클릭한 후 Batch 작업 영역에
서 Save를 클릭합니다.

이온 참조표 생성
1. Batch 작업 영역을 엽니다.

2. Auto-Calibrate를 클릭합니다.
Batch - Automatic Calibration Editor 대화 상자가 열립니다.

3. Edit를 클릭합니다.
Ion Reference Table Editor 대화 상자가 열립니다.

4. New를 클릭합니다.

팁! Tab 키를 사용하여 셀 간에 이동하고 Enter 키를 눌러 행을 추가할 수 있습니다.

5. Reference Ions for TOF MS Calibration 그리드에서 전구체 질량을 입력합니다.
Compound Name 필드는 선택 사항입니다.

6. 필요한 만큼 행을 추가합니다.

7. Use 열에서 사용할 이온을 선택합니다.

8. MS/MS에 사용할 전구체 질량에 대해 Use for MS/MS 라디오 버튼을 선택합니다.
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9. 8단계에서 선택한 전구체 질량에 대한 CE for MS/MS 및 DP for MS/MS 필드에 값을 입
력합니다.

10. Reference Ions for MS/MS Calibration 그리드에서 두 개 이상의 단편 질량을 추가한 후
선택합니다.
Fragment Name 필드는 선택 사항입니다.

11. OK를 클릭합니다.

12. Save Reference Table 대화 상자에 이름을 입력한 후 OK를 클릭합니다.

참고: 사용자가 LC 방법을 교정물질 전달 방법으로 선택한 경우 머무름 시간 및 머무름 시
간 허용 오차를 참조 이온 표에 지정해야 합니다.

CDS를 사용하여 시스템 교정
참고: 질량 분석계가 접점 폐쇄 옵션으로 구성된 경우 접점 폐쇄로 구성된 시스템 교정 섹션을
참조하십시오.

1. Batch 작업 영역을 엽니다.

2. Auto-Calibrate를 클릭합니다.
Batch - Automatic Calibration Editor가 열립니다.

3. 이온 참조 표를 선택합니다.

참고: TOF MSMS 방법의 경우 참조 테이블에서 선택된 전구체 질량이 해당 방법의 최소
전구체 질량보다 커야 합니다.

4. 교정 사이에 획득할 샘플 수를 입력합니다.

5. CDS를 교정물질 전달 방법으로 선택합니다.
기본적으로 CDS 채널 1이 선택됩니다. 양성 용액에는 채널 1, 음성 용액에는 채널 2를 사
용합니다.

6. 대화 상자를 닫으려면 OK를 클릭하십시오.

7. Auto-Calibrate 버튼의 왼쪽에 있는 확인란이 선택되었는지 확인합니다.

8. Batch를 생성하여 제출합니다.

LC 방법을 사용하여 시스템 교정
참고: 질량 분석계가 접점 폐쇄 옵션으로 구성된 경우 접점 폐쇄로 구성된 시스템 교정 섹션을
참조하십시오.

1. Batch 작업 영역을 엽니다.

2. Auto-Calibrate를 클릭합니다.
Batch - Automatic Calibration Editor가 열립니다.

3. 이온 참조 표를 선택합니다.

4. 교정 사이에 획득할 샘플 수를 입력합니다.
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5. LC method를 교정물질 전달 방법으로 선택합니다.
MS method 필드뿐만 아니라 오토샘플러 랙, 플레이트 및 바이알 필드가 대화 상자의 오
른쪽에 표시됩니다.

6. MS method을 선택하고 적절한 랙, 플레이트 및 바이알 정보를 선택합니다.

7. 대화 상자를 닫으려면 OK를 클릭하십시오.

8. Auto-Calibrate 버튼의 왼쪽에 있는 확인란이 선택되었는지 확인합니다.

9. Batch를 생성하여 제출합니다.

구성 요소 농도 관리
구성 요소 농도 추가
배치에는 MS 방법, 처리 방법 또는 Results Table에 정의된 구성 요소 농도가 포함됩니다. 이
절차를 사용하여 구성 요소 농도를 더 추가할 수 있습니다.

참고: 이 절차를 사용하여 추가된 구성 요소 농도는 품질 관리 및 표준 유형의 샘플에 대해 편
집할 수 있습니다. 구성 요소를 포함하는 처리 방법이 샘플에 정의된 경우에도 구성 요소 농도
가 배치에 추가됩니다. 처리 방법을 통해 추가된 구성 요소 농도는 구성 요소가 포함된 처리 방
법이 있는 샘플에 대해서만 편집할 수 있습니다.

1. Batch 작업 영역에서 Component Concentrations( )를 클릭합니다.

2. Manage Components > Add Component를 클릭합니다.

3. Component 이름을 입력합니다.

4. OK를 클릭합니다.
새 구성 요소 농도가 현재 배치에 추가됩니다.

구성 요소 농도 삭제
이 절차를 사용하여 배치에서 구성 요소 농도를 제거할 수 있습니다.

1. Batch 작업 영역에서 Component Concentrations( )를 클릭합니다.

2. Manage Components > Remove Component를 클릭합니다.
요소 목록이 표시됩니다. 여기에는 Add Component Concentration 커맨드에 추가된 모
든 요소가 포함되며, MRM 방법이나 처리 방법이 batch에 추가된 경우에도 마찬가지입니
다.

3. 목록에서 구성 요소를 선택합니다.

4. OK를 클릭합니다.

결정 규칙 관리
결정 규칙 추가
이 절차를 사용하여 결정 규칙을 추가할 수 있습니다.

1. Batch 작업 영역에서 Decision Rules를 클릭합니다.
Decision Rules 대화 상자가 열립니다.

작동 지침—획득

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
59/325



2. Add Rule을 클릭합니다.
Decision Rule Configuration 대화 상자가 열립니다.

3. 결정 규칙 이름을 입력합니다.

4. 플래그 지정 규칙, 결정 규칙을 평가할 시기 및 반응을 포함하여 결정 규칙의 속성을 정의
합니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

5. Save를 클릭하여 결정 규칙을 저장합니다.

6. Save를 클릭하여 대화 상자를 닫습니다.

참고: 사용자가 Decision Rules 대화 상자에서 Save를 클릭하지 않으면 새 결정 규칙이
저장되지 않습니다.

결정 규칙 변경
1. Batch 작업 영역에서 Decision Rules를 클릭합니다.

Decision Rules 대화 상자가 열립니다.

2. 변경할 결정 규칙의 Decision Rule Name을 클릭합니다.
Decision Rule Configuration 대화 상자가 열립니다.

3. 플래그 지정 규칙, 결정 규칙을 평가할 시기 및 반응을 포함하여 결정 규칙에 대한
Decision rule name과 설정을 변경합니다. 자세한 정보는 도움말 시스템 문서를 참조하
십시오.

4. Save를 클릭하여 결정 규칙을 저장합니다.

5. Save를 클릭하여 대화 상자를 닫습니다.

참고: 사용자가 Decision Rules 대화 상자에서 Save를 클릭하지 않으면 새 결정 규칙이
저장되지 않습니다.

결정 규칙 삭제
이 절차를 사용하여 결정 규칙을 삭제할 수 있습니다.

1. Batch 작업 영역에서 Decision Rules.를 클릭합니다.
Decision Rules 대화 상자가 열립니다.

2. Flagging Rule Used를 클릭합니다.

3. Delete Rule을 클릭하여 결정 규칙을 삭제합니다.

4. Save를 클릭합니다.

중복 규칙 생성
이 절차를 사용하여 중복 규칙을 생성할 수 있습니다.

1. Batch 작업 영역에서 Decision Rules를 클릭합니다.
Decision Rules 대화 상자가 열립니다.

2. 복제할 결정 규칙을 클릭합니다.

3. Duplicate Rule을 클릭합니다.
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4. Save를 클릭합니다.

결정 규칙 가져오기
이 절차를 사용하여 결정 규칙을 가져올 수 있습니다.

1. Batch 작업 영역에서 Decision Rules를 클릭합니다.
Decision Rules 대화 상자가 열립니다.

2. Import List를 클릭합니다.

3. 가져올 텍스트 파일을 찾아 선택한 후 Open을 클릭합니다.

4. Save를 클릭합니다.

결정 규칙 내보내기
1. Batch 작업 영역에서 Decision Rules를 클릭합니다.

Decision Rules 대화 상자가 열립니다.

2. Export List를 클릭합니다.

3. 텍스트 파일을 저장할 폴더로 이동하여 파일 이름을 입력한 후 Save를 클릭합니다.

4. Cancel을 클릭합니다.

시스템 평형화
새 방법을 실행하거나 배치 제출 전 하루 시작 시 시스템을 평형화합니다. 평형화는 다음 샘플
또는 배치를 위해 질량 분석계와 LC 시스템을 예열하고 준비합니다.

1. 상태 패널에서 Equilibrate를 클릭합니다.
Equilibrate 대화 상자가 열립니다.

2. MS Method 목록에서 MS 방법을 선택합니다.

3. LC Method 목록에서 LC 방법을 선택합니다.

4. Time (min) 필드에 평형화 시간(분)을 입력합니다.

5. OK를 클릭합니다.
평형화가 완료되면 상태 패널의 시스템 상태는 Ready가 됩니다.

팁! Queue 작업 영역을 열어 평형화 진행 상황을 모니터링할 수 있습니다. Queue 작업 영
역은 평형화를 완료하는 데 필요한 시간을 나타냅니다. 평형화를 완료되기 전에 중지하려
면 Queue 작업 영역에서 Stop을 클릭하십시오.

배치 제출
선행 절차

• 시스템 평형화

• Batch 작업 영역에서 배치를 엽니다.
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1. Submit를 클릭합니다.
Submit Samples 대화 상자가 열립니다.

2. OK를 클릭하여 계속합니다.

참고: Auto-Calibrate 옵션을 선택하고 질량 분석계가 접점 폐쇄 옵션으로 구성된 경우 첫
번째 교정 실행이 자동으로 수행됩니다. 그런 다음 사용자가 외부 장치에서 주입을 시작
할 때까지 시스템이 Loading 상태로 전환됩니다.

화면 맨 위에 오류가 표시되면 오류를 해결한 후 Submit를 다시 클릭합니다. 모든 오류가
해결될 때까지 배치가 대기열에 추가되지 않습니다.

팁! 대기열이 시작되지 않은 경우 Queue 작업 영역으로 이동한 후 메뉴 표시줄에서 Start
를 클릭하십시오.

Batch 작업 영역에서 대기열에 단일 샘플 제출
선행 절차

• 시스템 평형화

• Batch 작업 영역에서 배치를 엽니다.

1. 샘플의 행 색인 번호를 선택합니다.

2. Submit를 클릭합니다.
Submit Samples 대화 상자가 열립니다.

3. OK를 클릭하여 계속합니다.

참고: Auto-Calibrate 옵션을 선택하고 질량 분석계가 접점 폐쇄 옵션으로 구성된 경우 첫
번째 교정 실행이 자동으로 수행됩니다. 그런 다음 사용자가 외부 장치에서 주입을 시작
할 때까지 시스템이 Loading 상태로 전환됩니다.

화면 맨 위에 오류가 표시되면 오류를 해결한 후 Submit를 다시 클릭합니다. 모든 오류가
해결될 때까지 배치가 대기열에 추가되지 않습니다.

팁! 대기열이 시작되지 않은 경우 Queue 작업 영역으로 이동한 후 메뉴 표시줄에서 Start
를 클릭하십시오.

Batch 작업 영역에서 대기열에 여러 샘플 제출
선행 절차

• 시스템 평형화

• Batch 작업 영역에서 배치를 엽니다.

1. 다음 중 하나를 수행합니다.
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• Ctrl 키를 누른 채로 각 샘플의 샘플 행 색인 번호를 클릭합니다.

• 색인 번호 목록을 위 또는 아래로 끕니다.

참고: 샘플은 배치에 표시된 순서가 아니라 선택된 순서대로 제출됩니다.

2. Submit를 클릭합니다.
Submit Samples 대화 상자가 열립니다.

3. OK를 클릭하여 계속합니다.

참고: Auto-Calibrate 옵션을 선택하고 질량 분석계가 접점 폐쇄 옵션으로 구성된 경우 첫
번째 교정 실행이 자동으로 수행됩니다. 그런 다음 사용자가 외부 장치에서 주입을 시작
할 때까지 시스템이 Loading 상태로 전환됩니다.

화면 맨 위에 오류가 표시되면 오류를 해결한 후 Submit를 다시 클릭합니다. 모든 오류가
해결될 때까지 배치가 대기열에 추가되지 않습니다.

팁! 대기열이 시작되지 않은 경우 Queue 작업 영역으로 이동한 후 메뉴 표시줄에서 Start
를 클릭하십시오.

Queue 작업 영역
Queue 작업 영역에는 다음 내용이 표시됩니다.

• 대기열 상태

• 배치 상태

• 샘플 획득 및 처리 상태

사용자는 이 작업 영역에서 대기열의 배치 및 샘플을 관리할 수 있습니다.

기본적으로 샘플은 대기열에 표시되지 않습니다. 샘플 정보는 배치 이름 아래에 축소되어 있
습니다. 배치 상태, 배치 이름, 배치 내의 샘플 수 및 현재 배치 획득을 위해 남아 있는 시간 등
이 표시됩니다. 배치에 포함된 교정 샘플은 대기열에서 Sample Name 열에 Cal로 표시됩니다.

이 작업 영역의 기능에 대한 액세스는 사용자에게 할당된 역할로 제어됩니다. 자세한 정보는
실험실 책임자 안내서를 참조하십시오.

참고: 샘플 획득 중 통합 디버터 밸브 위치를 수동으로 변경하지 마십시오.

그림 5-5 Queue 작업 영역
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표 5-7 Queue 작업 영역 열

레이블 설명

Batch Name 대기열에 제출된 배치의 이름, 배치의 샘플 수 및 결정 규칙 처리 상태
입니다.
대기열에는 각 배치에 대한 행이 포함됩니다. 기본적으로 배치는 축소
되어 있지만 배치의 모든 샘플을 표시하도록 확장할 수 있습니다. 각
샘플에 대한 정보가 다음 열에 표시됩니다.

참고: 처리 중인 결정 규칙이 있는 배치의 경우 현재 샘플 처리가 완료
될 수 있도록 다음 샘플 획득이 지연됩니다. 허용된 시간 내에 처리가
완료되지 않으면 결정 규칙이 비활성화됩니다. 지연 시간은 획득 시간
의 1.5배입니다.

Acquisition Status (획득 상태) 데이터 획득 상태입니다. 상태 아이콘에 대한 정보는 대기
열 아이콘 섹션을 참조하십시오.

Est. Start Time (예상 시작 시간) 이 샘플의 획득이 시작된 시간입니다.

Acquisition Time (획득 시간) 이 샘플을 획득하는 데 걸린 시간입니다.

Sample Name (샘플 이름) 배치에 지정된 샘플 이름입니다.

Sample ID (샘플 ID) 배치에 지정된 샘플 식별자입니다.

Barcode (바코드) 배치에 지정된 샘플 바이알의 바코드 번호입니다.

Rack Code (랙 코드) 배치에 지정된 LC 랙의 식별자입니다.

Rack Position (랙 위치) 배치에 지정된 LC 랙의 설치 위치입니다.

Plate Code (플레이트 코드) 배치에 지정된 LC 플레이트의 식별자입니다.

Plate Position (플레이트 위치) 배치에 지정된 LC 플레이트의 설치 위치입니다.

Vial Position (바이알 위치) LC 플레이트 또는 랙에서 샘플의 위치입니다.

MS Method (MS 방법) 배치에 지정된 MS 방법입니다.

LC Method (LC 방법) 배치에 지정된 LC 방법입니다.

Injection Volume (주입량) 주입된 샘플의 양입니다.

Data File (데이터 파일) 데이터를 획득할 데이터 파일의 이름입니다.

Scanned Barcode (스캔한 바코드) 바이알의 식별자입니다.

User (사용자) 배치를 제출한 사용자의 이름입니다.

Project (프로젝트) 데이터 파일을 저장할 프로젝트입니다.

Data File Status (데이터 파일 상태) 데이터 파일 상태입니다.

Auto Processing
Status

(자동 처리 상태) 데이터 처리 상태입니다. 상태 아이콘에 대한 정보는
대기열 아이콘 섹션을 참조하십시오.
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표 5-7 Queue 작업 영역 열 (계속)

레이블 설명

Processing Method (처리 방법) 획득한 데이터를 처리하는 데 사용할 처리 방법입니다. 기
존 결과 파일을 사용하는 경우 이 열에 *Embedded Method*라는 텍
스트가 포함됩니다.

Results File (결과 파일) 처리된 데이터를 기록할 파일입니다.

Decision Rule
Status

(결정 규칙 상태) 샘플의 플래그 지정 상태 및 결정 규칙에 따라 수행
되는 조치입니다.

Decision Rule
Summary

(결정 규칙 요약) 트리거되는 결정 규칙의 이름입니다.

대기열 관리
Batch 작업 영역에서 샘플이 제출된 후 획득이 시작됩니다. 배치 제출 전 시스템이 평형화되었
는지 확인합니다. 자세한 정보는 시스템 평형화 섹션을 참조하십시오.

참고: 샘플 획득 중 비정상적인 종료가 발생하면 샘플을 다시 실행하십시오. 전원 오류로 인해
비정상 종료가 발생하면 오토샘플러 트레이 온도가 유지되지 않으며 샘플 무결성이 손상될 수
있습니다.

다음 표의 기능을 사용하여 대기열의 샘플 및 배치를 관리할 수 있습니다.

표 5-8 Queue 작업 영역 기능

수행할 작업 방법

열 표시 또는 숨기기 Manage > Display Columns를 클릭합니다. 자세한 정보는
열 표시 또는 숨기기 섹션을 참조하십시오.

배치의 모든 샘플 보기
을 클릭합니다.

배치의 모든 샘플 축소 을 클릭합니다.

획득 시작 Start를 클릭합니다. 샘플을 실행하기 전 시스템을 평형화합
니다.

제출된 샘플의 상태 보기 배치 머리글을 두 번 클릭합니다.

선택한 샘플 다시 획득 1. 샘플을 클릭합니다.

2. Manage > Reacquire samples를 클릭합니다.

선택한 샘플 삭제 1. 샘플을 클릭합니다.

2. Manage > Delete samples를 클릭합니다.

선택된 샘플 아래의 모든 샘플
삭제

1. 샘플을 클릭합니다.

2. Manage > Delete samples below row selection을 클
릭합니다.
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표 5-8 Queue 작업 영역 기능 (계속)

수행할 작업 방법

획득한 모든 배치 또는 샘플의
대기열 지우기

Manage > Clear queue를 클릭합니다.

선택한 행에서 포커스 제거 Manage > Clear all selections를 클릭합니다.

선택한 배치 또는 샘플을 대기
열의 맨 위로 이동

1. 배치 머리글을 클릭합니다.

2. Manage > Move row to top을 클릭합니다.

참고: 획득되지 않은 단일 배치 또는 샘플만 이동할 수 있습니
다.

선택한 샘플을 대기열에서 위
로 이동

1. 샘플을 클릭합니다.

2. Manage > Move row up을 클릭합니다.

참고: 획득되지 않은 단일 샘플만 이동할 수 있습니다.

선택한 샘플을 대기열에서 아
래로 이동

1. 샘플을 클릭합니다.

2. Manage > Move row down을 클릭합니다.

참고: 획득되지 않은 단일 샘플만 이동할 수 있습니다.

모든 샘플과 배치 축소 Manage > Collapse all rows를 클릭합니다.

모든 샘플과 배치 표시 Manage > Expand all rows를 클릭합니다.

획득 중인 샘플의 데이터 보기 다음 중 하나를 수행합니다.
• 획득 중인 샘플을 두 번 클릭합니다.

참고: Processing Status 열 왼쪽의 열 중 하나를 두 번 클
릭하십시오.

• Data Acquisition 패널에서 Open data exploration to

view real time data( )를 클릭합니다.

획득한 샘플의 데이터 보기
Acquisition Status 열에서 녹색 확인 표시( )를 두 번 클
릭합니다.

생성된 결과 파일 보기
Processing Status 열에서 녹색 확인 표시( )를 두 번 클
릭합니다.
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표 5-8 Queue 작업 영역 기능 (계속)

수행할 작업 방법

스캔 중인 바코드 바이알 보기 1. Manage > Display Columns를 클릭합니다.

2. Select Columns 대화 상자에서 Barcode나 Scanned
Barcode 확인란 또는 둘 다 선택합니다. 자세한 정보는
열 표시 또는 숨기기 섹션을 참조하십시오.

3. OK를 클릭합니다.

대기열 중지 1. Stop을 클릭합니다.

2. Stop now 또는 Stop after the current tasks are
completed를 선택합니다.

3. OK를 클릭합니다.

대기열에 남아 있는 모든 샘플
의 처리 중지

1. Cancel remaining processing을 클릭합니다.

2. Yes를 클릭합니다.

대기열 인쇄 작업 영역 메뉴에서 Print를 클릭합니다.

열 표시 또는 숨기기
1. Queue 작업 영역에서 Manage > Display Columns.를 클릭합니다.

2. 필요에 따라 Display Columns 대화 상자에서 열 확인란을 선택하거나 선택을 취소합니다.
열에 대한 설명은 표 5-7에서 확인하십시오.
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그림 5-6 Display Columns 대화 상자

3. OK를 클릭합니다.

대기열 아이콘
표 5-9 대기열 아이콘

아이콘 이름 설명

확장 화살표 배치의 샘플을 표시합니다.

축소 화살표 배치의 샘플을 숨깁니다.
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표 5-10 획득 상태 아이콘

아이콘1 이름 설명

Completed 샘플 또는 전체 배치를 획득했습니다. 이 아이콘을 두 번
클릭하여 Explorer 작업 영역에서 샘플을 열 수 있습니다.

Warning 샘플을 획득했지만 사용자가 획득을 중지하거나 연장했
습니다.

Failed 샘플 또는 배치 내의 샘플을 획득하지 못했습니다.

Failed 교정 샘플이 수용 기준에 맞지 않습니다. 이 아이콘을 두
번 클릭하여 상태 보고서를 확인할 수 있습니다.

In Progress 샘플 또는 배치를 획득하는 중입니다.

Waiting 샘플 또는 배치가 아직 획득되지 않았거나 획득 중이 아
닙니다.

Barcode Warning 바코드 판독 오류 또는 바코드 스캔과 샘플의 불일치 문
제가 발생했습니다.

표 5-11 처리 상태 아이콘

아이콘2 이름 설명

Completed 샘플이 처리되었습니다. 이 아이콘을 두 번 클릭하여
Analytics 작업 영역에서 결과 파일을 열 수 있습니다.

Warning 사용자가 처리를 중지했습니다.

Failed 샘플이 처리되지 않았습니다.

In Progress 샘플이 처리되고 있습니다.

Waiting 샘플이 아직 처리되지 않았습니다.

1 결정 규칙을 사용하는 경우 획득 상태가 결정 규칙의 영향을 받을 수 있습니다. 예를 들어 결정 규칙에 따라
샘플을 중단하거나 대기열을 중지할 수 있습니다. 결정 규칙은 배치의 모든 샘플 및 관련 결과 파일(샘플이
다른 결과 파일에서 처리되는 경우)을 고려합니다. 대기열에 더 이상 표시되지 않는 샘플도 대상에 포함됩니
다.

2 Processing Status 열이 비어 있으면 샘플에 대해 처리 방법 또는 결과 파일이 선택되지 않은 것입니다.

작동 지침—획득

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
69/325



표 5-12 결정 규칙 상태 아이콘

아이콘3 4 이름 설명

Flagging rule
passed

샘플이 결정 규칙에 구성된 플래그 지정 규칙의 통과 기
준을 충족합니다.

Flagging rule
marginal

샘플이 결정 규칙에 구성된 플래그 지정 규칙의 한계 기
준을 충족합니다.

Flagging rule failed 샘플이 결정 규칙에 구성된 플래그 지정 규칙의 실패 기
준을 충족합니다.

Queue stopped 결정 규칙에 따라 대기열이 중지되었습니다. 대기열이 중
지되고 다음 배치를 획득할 때도 이 아이콘이 표시됩니
다.

Sample injected 결정 규칙에 따라 샘플이 다시 주입되거나 결정 규칙에
구성된 바이알에서 샘플이 주입됩니다.

표 5-13 데이터 파일 상태 아이콘

아이콘 이름 설명

Transfer Complete 샘플이 네트워크 프로젝트에 전송되었습니다.

Transfer in Process 샘플이 네트워크 프로젝트에 전송되고 있습니다.

Transfer Failed 샘플 처리에 실패했습니다. SCIEX OS에서 샘플을 다시
전송하려고 합니다.

MS Tune 작업 영역
기기 데이터가 저장되면 소프트웨어에서 dat 파일이 생성됩니다. 이 파일을 사용하여 이전 매
개 변수 상태를 복원할 수 있습니다. dat 백업 파일의 이름은 파일 백업 시간이 아니라 파일 생
성 시간을 사용하여 지정됩니다.

참고: APCI 프로브를 사용하는 경우 Quick Status Check 및 Advanced Troubleshooting 기능
만 사용할 수 있습니다. 다른 조정 절차를 수행하려면 ESI 프로브를 설치하십시오.

사용자가 MS Tune 절차를 로드할 때마다 모든 질량 분석계 매개 변수가 백업됩니다.

이 작업 영역의 기능에 대한 액세스는 사용자에게 할당된 역할로 제어됩니다. 자세한 정보는
실험실 책임자 안내서를 참조하십시오.

3 사용자가 결정 규칙 이름, 플래그 지정 규칙 이름 및 수행된 조치를 커서로 가리키면 플래그 지정 상태 아이
콘과 해당 도구 설명이 표시됩니다.

4 모든 표준이 획득된 후 사용자가 규칙을 평가하도록 선택하면 플래그 지정된 샘플의 상태가 소급 업데이트
됩니다.
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빠른 상태 점검 수행
선행 절차

• 올바른 프로브가 설치되어 있는지 확인하십시오.

이 절차를 사용하여 TOF MS 및 MS/MS 모드에서 분해능을 신속하게 확인하고 시스템을 교정
할 수 있습니다. 채널 얼라인먼트 질량 정확도가 사양을 만족하지 않을 경우 사용자는 해당 단
계를 반복하고 시스템을 교정할 수 있습니다. 분해능이 사양을 만족하지 않을 경우 사용자는
TOF 조정 절차를 수행하여 시스템을 최적화할 수 있습니다.

팁! 사용자는 상태 패널에서 MS Check를 클릭하여 이 절차를 평가할 수 있습니다.

참고: 질량 분석계가 CDS로 구성된 경우 Achieve Stable Spray 단계를 시작할 때 소프트웨어
에서 CDS가 자동으로 시작됩니다. 사용자가 MS Tune 작업 영역을 닫으면 CDS가 중지됩니
다.

1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures 목록에서 Positive Quick Status Check 또는 Negative Quick
Status Check을 선택합니다.

3. Next를 클릭합니다.

4. 각 단계의 화면 지침을 따릅니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

5. (선택 사항) 보고서를 검토하여 각 단계의 결과를 확인합니다.

6. (선택 사항) 보고서를 저장합니다.

7. 결과가 만족스러우면 Save Tuning Settings를 클릭합니다. 결과가 만족스럽지 않으면
다음 중 하나를 수행합니다.

• 해당 단계를 반복합니다.

• TOF MS 조정 절차를 실행합니다. 자세한 정보는 TOF 조정 섹션을 참조하십시오.

• MS Tune 작업 영역을 닫아 결과를 삭제합니다.

• Restore Instrument Data 메뉴에서 적절한 백업 파일을 선택하여 이전 설정을 복원합
니다.

검출기 최적화
시스템 감도가 낮은 경우 이 절차를 사용하여 검출기 전압이 최적화 되었는지 확인합니다. 이
절차 수행 과정에서 소프트웨어가 검출기 전압을 조정하여 최적의 감도를 제공합니다. 최적화
가 완료되면 사용자는 최적화된 값을 저장하거나 변경 사항을 취소할 수 있습니다.

참고: 높은 질량 모드와 낮은 질량 모드에서 모두 이 절차를 수행해야 합니다.

검출기를 한 달에 한 번 최적화하는 것이 좋습니다. 감도가 크게 떨어지거나 기기를 환기 및 청
소한 후에도 검출기를 최적화해야 합니다.
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참고: 검출기 에이징은 이온 노출에 대한 함수이므로 고농축 샘플을 사용하는 경우 더 자주 최
적화해야 할 수도 있습니다.

참고: 질량 분석계가 CDS로 구성된 경우 Achieve Stable Spray 단계를 시작할 때 소프트웨어
에서 CDS가 자동으로 시작됩니다. 사용자가 MS Tune 작업 영역을 닫으면 CDS가 중지됩니
다.

1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures 목록에서 다음 중 하나를 수행합니다.

• (ZenoTOF 시스템) Positive Detector Optimization 또는 Negative Detector
Optimization을 선택합니다.

• (X500 QTOF 시스템) Detector Optimization을 선택합니다.

Introduction 페이지가 표시됩니다. 이 페이지에는 최적화 프로세스의 목적, 선행 조건 및
지침이 설명되어 있습니다.

3. 주사기 펌프가 올바르게 구성되어 있는지 확인합니다. 자세한 정보는 시스템 사용자 안내
서를 참조하십시오. 그런 다음 Next를 클릭합니다.

4. 분무가 안정적인지 확인하고 Next를 클릭합니다.

5. 화면의 지침을 따릅니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.
최적화 보고서가 표시됩니다.

6. (선택 사항) 다음 단계를 수행하여 보고서를 저장합니다.

a. Report 페이지에서 Save report as를 클릭합니다.

b. 보고서를 저장할 폴더로 이동하여 File name을 입력한 후 Save를 클릭합니다.

7. Next를 클릭합니다.

8. Save Settings를 클릭합니다.

참고: 검출기가 2650V 이상에서 최적화되는 경우 sciex.com/request-support에 문의하여
검출기를 교체하십시오.

"Tuning settings were saved"라는 메시지가 표시됩니다.

Q1 단위 조정
MS/MS 실험에서 단편용 전구체 이온 선택을 위해 Q1 영역이 사용됩니다. Q1 단위 조정을 통
해 피크 폭을 최적화하고 Q1 질량을 교정합니다. Q1 단위는 단위 분해능에서 전구체 이온 선
택 범위의 폭을 나타냅니다. Q1 낮음 또는 개방은 낮은 분해능(넓은 범위) 또는 개방 분해능(개
방 범위)에서 전구체 이온 선택 범위의 폭을 나타냅니다. Q1 단위 조정 후, Q1 단위값에 따라
Q1 낮음 및 개방 설정이 계산됩니다.

참고: 질량 분석계가 CDS로 구성된 경우 Achieve Stable Spray 단계를 시작할 때 소프트웨어
에서 CDS가 자동으로 시작됩니다. 사용자가 MS Tune 작업 영역을 닫으면 CDS가 중지됩니
다.

1. MS Tune 작업 영역을 엽니다.
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2. Tuning Procedures 목록에서 Positive Q1 Unit Tuning 또는 Negative Q1 Unit Tuning
을 선택합니다.

3. Next를 클릭합니다.

4. 각 단계의 화면 지침을 따릅니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

5. (선택 사항) Edit Method를 클릭하여 매개 변수를 조정합니다.

6. 교정을 수행한 경우 Confirm을 클릭하여 확인 획득을 실행합니다.

7. Next를 클릭합니다.

8. (선택 사항) 보고서를 저장합니다.

9. Next를 클릭합니다.

10. Save Settings를 클릭합니다.

TOF 조정
TOF MS 조정 절차는 TOF MS 및 MS/MS 모드에서 분해능 및 감도 매개 변수를 최적화합니
다. 최적화는 조정을 수행하기 전 시스템 성능 확인을 먼저 시작하며 그 다음 최대 강도 및 분
해능을 얻기 위해 다양한 매개 변수를 램핑합니다. 채널 조정 후 시스템이 교정되고 시스템 성
능이 결정됩니다. 성능이 주어진 조건을 만족하면 사용자는 조정 설정을 시스템에 저장하거나
또는 설정을 버릴 수도 있습니다.

TOF MS 조정을 자동 또는 수동 모드로 수행할 수 있습니다. 수동 모드에서는 사용자가 최적
화된 매개 변수 값을 선택하거나 조정 단계가 끝날 때 일시 중지할 수 있습니다.

참고: 질량 분석계가 CDS로 구성된 경우 Achieve Stable Spray 단계를 시작할 때 소프트웨어
에서 CDS가 자동으로 시작됩니다. 사용자가 MS Tune 작업 영역을 닫으면 CDS가 중지됩니
다.

1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures 목록에서 다음 중 하나를 수행합니다.

• (X500 QTOF 시스템) Positive TOF MS Tuning 또는 Negative TOF MS Tuning을 선
택합니다.

• (ZenoTOF 시스템) Positive TOF Tuning 또는 Negative TOF Tuning을 선택합니다.

3. 분무가 안정적인지 확인합니다.

4. Next를 클릭합니다.

5. 각 단계의 화면 지침을 따릅니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

6. Next를 클릭합니다.

7. (선택 사항) 보고서를 저장합니다.

8. 결과가 만족스러우면 Save Settings를 클릭합니다. 결과가 만족스럽지 않으면 다음 중
하나를 수행합니다.

• 해당 단계를 반복합니다.

• MS Tune 작업 영역을 닫아 결과를 삭제합니다.
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• Restore Instrument Data 메뉴에서 적절한 백업 파일을 선택하여 이전 설정을 복원합
니다.

• sciex.com/request-support에 문의하십시오.

Q1 높음 조정
MS/MS 실험에서 단편용 전구체 이온 선택을 위해 Q1 영역이 사용됩니다. Q1 높음 조정을 통
해 피크 폭을 최적화하고 Q1 질량을 교정합니다. Q1 높음은 전구체 이온 선택 범위가 좁다는
것을 나타냅니다.

참고: 질량 분석계가 CDS로 구성된 경우 Achieve Stable Spray 단계를 시작할 때 소프트웨어
에서 CDS가 자동으로 시작됩니다. 사용자가 MS Tune 작업 영역을 닫으면 CDS가 중지됩니
다.

1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures 목록에서 Positive Q1 High Tuning 또는 Negative Q1 High
Tuning을 선택합니다.

참고: 양성 Q1 높음 절차가 한동안 실행되지 않은 경우 Copy를 클릭하여 Positive Q1
Unit 설정을 시작점으로 사용합니다.

3. 분무가 안정적인지 확인합니다.

4. Next를 클릭합니다.

5. 각 단계의 화면 지침을 따릅니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

6. (선택 사항) Edit Method를 클릭하여 매개 변수를 조정합니다.

7. 교정을 수행한 경우 Confirm을 클릭하여 확인 획득을 실행합니다.

8. Next를 클릭합니다.

9. (선택 사항) 보고서를 저장합니다.

10. Next를 클릭합니다.

11. Save Settings를 클릭합니다.

Zeno 교정(ZenoTOF 시스템)
1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures 목록에서 Positive Zeno Calibration 또는 Negative Zeno
Calibration을 선택합니다.
Introduction 페이지가 표시됩니다. 이 페이지에는 교정 프로세스의 목적과 선행 조건이 설
명되어 있습니다.

3. 분무가 안정적인지 확인하고 Next를 클릭합니다.

참고: 사용자는 Achieve Stable Spray/Modify 페이지에서 Source and Gas Parameters
를 수동으로 조정할 수 있습니다.

4. 각 단계의 화면 지침을 따릅니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.
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5. Next를 클릭합니다.

6. (선택 사항) 다음 단계를 수행하여 보고서를 저장합니다.

a. Report 페이지에서 Save report as를 클릭합니다.

b. 보고서를 저장할 폴더로 이동하여 File name을 입력한 후 Save를 클릭합니다.

7. Next를 클릭합니다.

8. 결과가 만족스러우면 Save Tuning Settings를 클릭합니다. 결과가 만족스럽지 않으면
다음 중 하나를 수행합니다.

• 해당 단계를 반복합니다.

• MS Tune 작업 영역을 닫아 결과를 삭제합니다.

• Restore Instrument Data 메뉴에서 적절한 백업 파일을 선택하여 이전 설정을 복원합
니다.

EAD 최적화 수행(ZenoTOF 시스템)
1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures 목록에서 EAD Optimization을 선택합니다.
Introduction 페이지가 표시됩니다. 이 페이지에는 최적화 프로세스의 목적과 선행 조건이
설명되어 있습니다.

3. Tuning process를 선택한 후 Next를 클릭합니다.

4. Filament Calibration Verification 페이지에서 Filament를 선택한 후 Calibrate Filament를
클릭합니다.

팁! 선택한 필라멘트를 변경하려면 Filament 필드에서 목록을 클릭한 후 필요한 필라멘트
를 선택합니다.

5. Next를 클릭합니다.

6. 분무가 안정적인지 확인하고 Next를 클릭합니다.

참고: 사용자는 Achieve Stable Spray/Modify 페이지에서 Source and Gas Parameters
를 수동으로 조정할 수 있습니다.

7. 각 단계의 화면 지침을 따릅니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

8. Next를 클릭합니다.

9. (선택 사항) 다음 단계를 수행하여 보고서를 저장합니다.

a. Report 페이지에서 Save report as를 클릭합니다.

b. 보고서를 저장할 폴더로 이동하여 File name을 입력한 후 Save를 클릭합니다.

10. Next를 클릭합니다.

11. Save Settings를 클릭합니다.
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EAD EI 배경 감소 수행(ZenoTOF 시스템)
1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures 목록에서 EAD EI Background Reduction을 선택합니다.
Introduction 페이지가 표시됩니다. 이 페이지에는 조정 절차의 목적과 선행 조건이 설명되
어 있습니다.

3. Next를 클릭합니다.

4. 각 단계의 화면 지침을 따릅니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

5. Next를 클릭합니다.

6. (선택 사항) 다음 단계를 수행하여 보고서를 저장합니다.

a. Report 페이지에서 Save report as를 클릭합니다.

b. 보고서를 저장할 폴더로 이동하여 File name을 입력한 후 Save를 클릭합니다.

EAD 진단 수행(ZenoTOF 시스템)
1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures 목록에서 EAD Diagnostics를 선택합니다.
Introduction 페이지가 표시됩니다. 이 페이지에는 EAD 진단의 목적과 선행 조건이 설명
되어 있습니다.

3. Next를 클릭합니다.

4. 각 단계의 화면 지침을 따릅니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

ADC 초기화 수행(ZenoTOF 시스템)
1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures > ADC Initialization을 선택합니다.
Introduction 페이지가 표시됩니다. 이 페이지에는 초기화 목적이 설명되어 있습니다.

3. Next를 클릭합니다.
ADC Initialization 페이지가 표시됩니다. 자세한 정보는 도움말 시스템 문서를 참조하십시
오.

고급 문제 해결 수행
선행 절차

• 올바른 프로브가 설치되어 있는지 확인하십시오.

조정 절차의 결과가 만족스럽지 않은 경우 고급 문제 해결 절차를 사용하여 질량 분석계와 관
련된 매개 변수를 최적화합니다. 사용자는 또한 획득 과정에서 TDC 채널 통계 및 스펙트럼을
볼 수 있습니다.

팁! Live Method 창을 사용하면 조정을 수행한 후 최적화된 매개 변수를 볼 수 있습니다.
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1. MS Tune 작업 영역을 엽니다.

2. Tuning Procedures 목록에서 Advanced Troubleshooting을 선택합니다.

3. 스캔 유형을 선택합니다.

4. Edit Method를 클릭한 다음 Live Method 창에서 필요 시 매개 변수를 편집합니다.

5. Start/Restart Method를 클릭합니다.

6. 데이터를 확인한 다음 필요 시 매개 변수를 조정합니다.

7. Stop을 클릭한 다음 필요 시 검출기 매개 변수 또는 TOF MS 매개 변수를 저장합니다.

기기 데이터 복원
소프트웨어는 기기 데이터 파일(dat)의 복사본을 생성한 후 사용자가 각 조정 절차의 마지막에
조정 설정을 저장할 때마다 현재 dat 파일을 업데이트합니다. 이전에 저장된 설정은 Restore
Instrument Data 기능을 사용하여 복원할 수 있습니다.

각 조정 절차가 수행되면 최적화된 결과를 추적하기 위해 보고서 및 데이터 파일이 생성됩니
다. 기본적으로 wiff2 데이터 파일과 보고서는 D:\SCIEX OS Data\Optimization에서 확인할 수
있습니다.

1. MS Tune 작업 영역을 엽니다.

2. Restore Instrument Data 메뉴에서 이전 타임스탬프를 사용하는 복원 대상 dat 파일을
선택합니다.

그림 5-7 Instrument Tuning and Optimization 대화 상자

3. (선택 사항) 다음 단계를 수행하여 복원할 dat 파일에 대한 보고서를 봅니다.

a. View Report를 클릭합니다.

b. 선택한 기기 데이터 파일에 대한 보고서가 생성된 경우 해당 보고서 파일을 찾은 후
두 번 클릭하여 엽니다.

4. Yes를 클릭합니다.
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작동 지침—처리 6
Explorer 작업 영역
이 작업 영역의 기능에 대한 액세스는 사용자에게 할당된 역할로 제어됩니다. 자세한 정보는
실험실 책임자 안내서를 참조하십시오.

샘플 열기
Explorer 작업 영역에서 데이터 검토 작업을 수행하려면 먼저 검토할 샘플을 열어야 합니다.

1. Explorer 작업 영역을 엽니다.

2. 단일 샘플을 열려면 다음 단계를 수행합니다.

a. File > Open Sample을 클릭합니다.
Select Sample 대화 상자가 열립니다.

b. 열려는 샘플을 찾아 선택합니다.

c. OK를 클릭합니다.

3. 여러 샘플을 열려면 다음 단계를 수행합니다.

a. File > Open Multiple Samples를 클릭합니다.

b. Select Samples 대화 상자에서 Available 목록의 샘플을 선택한 후 화살표를 클릭하
여 파일을 Selected 목록으로 이동합니다.

팁! 샘플을 하나만 선택하려면 파일을 확장하고 해당 샘플을 클릭한 후 화살표를 클
릭하십시오.

c. OK를 클릭합니다.

분석 물질이 있는지 확인
선행 절차

• 샘플 열기

1. 이온을 추출합니다. 자세한 정보는 이온 추출 섹션을 참조하십시오.

2. (선택 사항) Data and Peaks 테이블을 표시합니다. 자세한 정보는 데이터 및 피크 테이블
표시 섹션을 참조하십시오.

3. 화합물의 피크 면적, 강도, 질량 및 전하 상태를 검토합니다.
SCIEX Triple Quad 시스템의 경우 전하 상태는 전체 스캔 데이터 유형에만 사용할 수 있
습니다.
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이온 추출
선행 절차

• 샘플 열기

한 개 이상의 중첩된 추출 이온 크로마토그램(XIC) 계산에 사용되며 이는 주어진 질량 범위에
서 머무름 시간의 함수인 강도 합산에 대한 플롯으로 표시됩니다.

1. Show > Extract Ion Chromatogram (XIC)을 클릭합니다.

그림 6-1 Show 메뉴: Extracted Ion Chromatogram(XIC)

2. Specify XIC Ranges 대화 상자가 열리면 다음 단계를 수행합니다.

a. Center, Width 및 Compound 값을 입력하거나 값을 가져옵니다.

참고: XIC의 기본 제목은 지정된 행의 셀에 표시된 화합물 이름을 포함합니다.

팁! Center/Width 모드를 사용할 경우 질량 대신 화학식을 Center 값에 지정할 수 있
습니다. 중성 구성(예: H2O)을 사용할 경우에는 양성자가 자동으로 추가되거나
(Positive 모드) 감산됩니다(Negative 모드). 예를 들어 m/z 비율(H3O+의 비율)이
Positive 모드에 사용됩니다. 화학 구성의 끝에 '+n' 또는 '-n'을 추가하여 명시적 전하
상태를 지정합니다. 여기서 n은 전하 상태입니다. n을 생략하면 1로 간주됩니다. 예를
들어 H2ONa+가 지정되면 m/z 비율(H2ONa+의 비율)이 그대로 사용됩니다.

b. (선택 사항) 오른쪽 클릭 메뉴의 기능을 사용하여 이온 추출 옵션을 사용자 지정합니
다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

c. OK를 클릭합니다.
활성 그래프에 서로 다른 샘플로부터의 중첩된 시리즈가 포함된 경우 Process All
Overlays? 대화 상자가 열립니다.
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그림 6-2 Process All Overlays? 대화 상자

3. Select MRMs 대화 상자가 열리면 XIC에 포함할 MRM을 선택한 후 OK를 클릭합니다.

4. Process All Overlays? 대화 상자가 열리면 다음 단계를 수행합니다.

a. 다음 중 하나를 수행합니다.

• All Overlaid를 선택하여 사용 가능한 모든 샘플에 대한 중첩된 XIC를 생성합니다.

• Active Only를 선택하여 현재 활성화된 샘플에서만 XIC를 생성합니다.

b. OK를 클릭합니다.

Only show this dialog again if the shift key is down 확인란을 선택하면 사용자가
Shift 키를 눌러 옵션을 변경하는 경우 외에는 선택한 작업이 항상 사용됩니다.

총 이온 크로마토그램 열기
선행 절차

• 샘플 열기

총 이온 크로마토그램(TIC)은 일련의 질량 스캔에서 얻은 모든 이온 강도 기여도를 합하여 계
산됩니다. TIC를 사용하여 단일 창에서 전체 데이터 세트를 볼 수 있습니다. TIC는 크로마토그
래픽 창의 시간에 대해 플롯이 생성되는 스캔의 모든 이온에 대한 강도 합계로 구성됩니다.

1. Show > Total Ion Chromatogram (TIC)을 클릭합니다..
활성 그래프에 서로 다른 샘플로부터의 중첩된 시리즈가 포함된 경우 Process All
Overlays? 대화 상자가 열립니다.

2. Process All Overlays? 대화 상자가 열리면 다음 단계를 수행합니다.

a. 다음 중 하나를 수행합니다.

• 사용 가능한 모든 샘플에 대한 중첩된 TIC를 생성하려면 All Overlaid를 선택합니
다.

• 현재 활성화된 샘플에서만 TIC를 생성하려면 Active Only를 선택합니다.

b. OK를 클릭합니다.
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Only show this dialog again if the shift key is down 확인란을 선택하면 사용자가
Shift 키를 눌러 옵션을 변경하는 경우 외에는 선택한 작업이 항상 사용됩니다.

3. TIC를 마우스 오른쪽 버튼으로 클릭한 후 오른쪽 클릭 메뉴의 기능을 사용합니다.

그림 6-3 총 이온 크로마토그램 오른쪽 클릭 메뉴

항목 설명

1 이 기능은 중첩된 트레이스가 두 개 이상 있을 때 사용할 수 있습니다. 그
래프에서 현재 활성화된 트레이스를 제거합니다. 현재 활성화 상태가 아
닌 트레이스를 제거하려면 해당 트레이스를 먼저 활성화한 다음 이 기능
을 선택합니다.

2 이 기능은 중첩된 트레이스가 두 개 이상 있을 때 사용할 수 있습니다. 현
재 활성화된 트레이스를 제외한 모든 트레이스를 제거합니다. 보존할 트
레이스가 현재 활성화 상태가 아닌 경우 해당 트레이스를 먼저 활성화한
다음 이 기능을 선택합니다.

3 그래프에 텍스트를 추가합니다.

필요한 경우 Font를 클릭하여 글꼴 속성을 조정한 후 OK를 클릭합니다.
캡션은 사용자가 메뉴를 열기 위해 마우스 오른쪽 버튼을 클릭한 (x, y) 위
치에 추가됩니다.

캡션이 추가되면 사용자가 새 위치로 끌어다 놓을 수 있습니다. 사용자가
캡션을 X 또는 Y 축으로 끌면 끌기 작업이 취소됩니다.

문자 순서 '\d' 및 '\u'는 특별한 방식으로 처리됩니다. 전자의 경우 바로 다
음에 오는 문자 하나는 위첨자로 표시되고, 후자의 경우에는 모두 위첨자
로 표시됩니다. 두 가지 경우 모두 특수 문자는 표시되지 않습니다. 이 기
능은 특히 화학식에 유용하게 사용됩니다. 예를 들어 'H\d3O\u+'는
H3O+로 표시됩니다.
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항목 설명

4 선택한 캡션을 편집합니다. 사용자는 캡션을 더블 클릭해서도 이 대화 상
자를 열 수 있습니다.

5 선택한 캡션을 삭제합니다. 또는 캡션을 그래프 밖으로 끌면 캡션이 삭제
됩니다.

6 그래프에 최소한 하나의 캡션이 포함된 경우 사용할 수 있습니다. 모든
캡션을 한꺼번에 제거합니다.

7 그래프에 이미지를 붙여넣기합니다.

8 그래프에서 선택한 이미지를 삭제합니다.

기준 피크 크로마토그램 열기
선행 절차

• 샘플 열기

시간의 함수로서 각 스펙트럼에 있는 가장 큰 피크의 강도에 대한 플롯을 생성합니다.

1. Show > Base Peak Chromatogram (BPC)을 클릭합니다..

그림 6-4 BPC Options 대화 상자

2. BPC Options 대화 상자의 필드를 완성합니다. 필드에 대한 정보는 도움말 시스템 문서를
참조하십시오.
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참고: 기준 피크 크로마토그램 생성 시 1.0분을 넘는 단일 선택 영역을 가진 크로마토그램
이 활성화된 경우, 시간 범위는 기본적으로 선택 영역에 대한 시간 범위로 설정됩니다. 그
렇지 않은 경우 마지막 시간 범위가 사용됩니다. 시간 범위 제한은 사용자가 수동으로 범
위를 입력할 필요를 없애 줍니다.

활성 그래프에 서로 다른 샘플로부터의 중첩된 시리즈가 포함된 경우 Process All
Overlays? 대화 상자가 열립니다.

그림 6-5 Process All Overlays? 대화 상자

3. Process All Overlays? 대화 상자가 열리면 다음 단계를 수행합니다.

a. 다음 중 하나를 수행합니다.

• 사용 가능한 모든 샘플에 대한 중첩된 BPC를 생성하려면 All Overlaid를 선택합
니다.

• 현재 활성화된 샘플에서만 BPC를 생성하려면 Active Only를 선택합니다.

b. OK를 클릭합니다.

Only show this dialog again if the shift key is down 확인란을 선택하면 사용자가
Shift 키를 눌러 옵션을 변경하는 경우 외에는 선택한 작업이 항상 사용됩니다.

데이터 및 피크 테이블 표시
선행 절차

• 샘플 열기

Data and Peaks Table에는 서로 다른 두 개의 테이블이 포함되어 있습니다. Data 테이블은 데
이터 세트를 구성하는 원시 (X, Y) 값을 표시하고 Peaks 테이블은 피크 자체에 대한 정보를 표
시합니다. 테이블은 그래프가 활성화되어 있을 때 생성됩니다.

참고: 그래프에는 Y 축의 파란색 화살표를 사용하여 설정된 현재 임계값을 초과하는 피크만
표시됩니다. 자세한 정보는 그래프에서 데이터 사용 섹션을 참조하십시오.

이 기능은 현재 활성 데이터에 대한 두 개의 테이블, 즉 원시 (X, Y) 값 테이블과 피크 목록 테
이블을 포함하는 창을 표시하는 데 사용됩니다.
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1. Show > Data and Peaks Table을 클릭합니다..

그림 6-6 Show 메뉴: Data and Peaks Table

2. 다음 테이블의 기능을 사용합니다.

표 6-1 Data and Peaks Table 기능

수행할 작업 방법

해당 필드를 기준으로 테이블
을 정렬합니다.

열 제목을 클릭합니다.

현재 선택한 셀을 복사합니
다.

테이블을 마우스 오른쪽 버튼으로 클릭한 후 Copy를 클릭합
니다. Data 탭이 활성화된 경우 선택한 X 및 Y 값이 복사됩니
다. Peaks 탭이 활성화된 경우 선택한 피크 정보가 복사됩니
다.

선택한 행만 복사합니다. 먼저 행 선택기 열을 끌어 행을 선택하거나, Shift 또는 Ctrl
키를 사용하여 여러 행을 선택합니다. 그런 다음 테이블을 마
우스 오른쪽 버튼으로 클릭하고 Copy를 클릭합니다.

여러 열을 선택합니다. Ctrl 키를 누른 상태에서 열 머리글을 클릭합니다. 사용자가
열 머리글만 클릭하면 열이 정렬됩니다.

전체 테이블을 복사합니다. Edit > Select All을 클릭한 후 Edit > Copy를 클릭합니다.

데이터를 텍스트로 내보냅니
다.

창을 마우스 오른쪽 버튼으로 클릭한 후 Export Data as
Text를 클릭합니다.

전체 데이터 목록이 지정된 파일에 저장됩니다. X 및 Y 값은
탭으로 구분되고 각 (X, Y) 쌍 뒤에 하드 리턴이 있습니다.
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표 6-1 Data and Peaks Table 기능 (계속)

수행할 작업 방법

피크 목록 데이터를 텍스트로
내보냅니다.

창을 마우스 오른쪽 버튼으로 클릭한 후 Export Peak List
as Text를 클릭합니다.

전체 피크 목록이 지정된 파일에 저장됩니다. 연결된 그래프
의 Y 축에 설정된 현재 임계값 미만인 피크는 여기에 포함되
지 않습니다. 피크 메트릭은 탭으로 구분되고 각 피크 다음에
하드 리턴이 있습니다.

3. 화합물의 피크 면적, 강도, 질량 및 전하 상태를 검토합니다.

샘플 정보 표시
선행 절차

• 샘플 열기

Sample Information 창에는 활성 데이터를 획득하는 데 사용된 실험에 대한 텍스트 설명이 표
시됩니다. 이 정보는 샘플 이름 등의 샘플 관련 정보와 실험 횟수 및 유형과 같은 데이터 획득
정보를 포함합니다.

동일한 데이터 파일의 서로 다른 샘플과 연결된 Sample Information 창이 두 개 이상 표시된
경우 하나의 창에 대한 트리 보기에서 항목을 클릭하면 다른 모든 창이 해당 섹션으로 스크롤
됩니다. 이 기능은 동일한 이름을 가진 섹션이 모든 창에 존재함을 전제로 합니다. 이 기능은
사용자가 서로 유사하지만 동일하지는 않은 두 개의 Sample Information 창을 사용하려 할 때
유용합니다.

Show > Sample Information을 클릭합니다.

그래프 선택 영역 정보 표시
선행 절차

• 샘플 열기

Graph Selection Information 대화 상자는 크로마토그램 또는 스펙트럼의 선택 영역에 대한 정
보를 표시하고 포함된 창 중 하나가 활성화되면 생성됩니다.

1. Window > Graph Selection Window를 클릭합니다.
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그림 6-7 Graph Selection Info 대화 상자

2. 크로마토그램 또는 스펙트럼 그래프에서 하나 이상의 영역을 선택합니다.

그림 6-8 Graph Selection Info 대화 상자

3. 목록에서 Default Info, XY Info, Standard Deviations, Signal/Noise 또는 Manual
Reconstruct(해당하는 경우) 옵션을 선택합니다.
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그림 6-9 선택 영역 정보 옵션

대화 상자의 필드에 대한 설명은 도움말 시스템 문서를 참조하십시오.

4. (선택 사항) 신호 대 노이즈 비율을 수동으로 계산합니다.

a. 크로마토그래프를 선택하거나, 질량 재구성 워크플로에서 재구성 그래프를 선택합니
다.

b. 여러 항목을 선택하기 위해 Shift 키를 사용하여 노이즈 영역과 대상 피크를 모두 선
택합니다.

c. Default Info > Signal/Noise를 선택합니다.

5. (선택 사항) Options( )를 클릭하고 Graph Info 옵션을 설정한 후 OK를 클릭합니다. 옵
션에 대한 설명은 도움말 시스템 문서를 참조하십시오.
예를 들어 3시그마를 노이즈 승수로 사용하려면 Noise multipler for S/N을 3으로 설정합
니다.

6. (선택 사항) Fill Peaks( )를 클릭합니다.
그러면 활성 그래프에서 진한 색 채우기와 연한 색 채우기를 교대로 사용하여 피크를 채
우는 모드와 그렇지 않은 모드 간에 전환됩니다. 이 기능은 사용자가 Peak Width at Base
에 해당하는 피크 범위를 확인하려는 경우에 유용합니다.

7. (선택 사항) Show Point Symbols( )를 클릭합니다.
그러면 활성 창의 모든 스펙트럼이 데이터 요소가 점 기호로 표시되는 모드와 그렇지 않
은 모드 간에 전환됩니다. 이 기능은 사용자가 피크를 자세히 검토하고, 주 창에 표시된 텍
스트 정보만 사용하는 대신 이를 구성하는 데이터 요소의 수를 확인하려는 경우에 유용합
니다.

그래프의 설정 편집
선행 절차

• 샘플 열기

Edit를 클릭한 후 Edit 메뉴의 기능을 사용합니다.
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그림 6-10 Edit 메뉴: 옵션

항목 설명

1 현재 데이터를 클립보드에 복사합니다. 스펙트럼 또는 크로마토그램이
활성화되면 이 활성 그래프의 그림이 복사됩니다.

2 스펙트럼 또는 크로마토그램이 활성화되면 현재 그래프가 클립보드에 그
림으로 복사됩니다.

3 전체 활성 창의 이미지를 클립보드에 복사합니다. 창의 제목 표시줄과 여
러 내부 창의 도구 모음은 포함되지 않습니다.

4 클립보드의 데이터를 현재 보기에 붙여 넣습니다.

5 표가 활성화되면 표의 모든 행을 선택합니다. 텍스트 창이 활성화되면 모
든 텍스트를 선택합니다.

6 사용자가 그래프 모양, 피크 레이블 지정 및 찾기, 자동 처리, XIC 범위 계
산 등에 대한 옵션을 설정할 수 있습니다. 자세한 정보는 옵션 설정 섹션
을 참조하십시오.

7 기본 Explorer 옵션을 복원합니다. 자세한 정보는 옵션 재설정 섹션을 참
조하십시오.

그래프에서 데이터 사용
선행 절차

• 샘플 열기

1. 피크 레이블 지정 및 후속 기능(예: Data and Peaks 표)에 대한 임계값을 설정하려면 그
래프의 Y 축에 표시된 파란색 화살표를 끕니다.
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그림 6-11 Y 축의 파란색 화살표

2. Graph 메뉴의 기능을 사용합니다.
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그림 6-12 Graph 메뉴: 옵션

항목 설명

1 후속 작업에서 처리할 그래프의 일부를 선택합니다. 예를 들어 평균 스펙
트럼을 얻으려면 크로마토그램에서 영역을 선택한 후 두 번 클릭합니다.
Set Selection 기능을 사용하여 특정 X 범위를 입력하면 커서를 사용하
는 것보다 더 정확하게 선택 영역을 설정할 수 있습니다.

a. Graph > Set Selection을 클릭합니다.

Set Selection 대화 상자가 열립니다.

b. Center 및 Width 값을 입력합니다.

c. OK를 클릭합니다.

팁! 그래프에서 수동으로 선택 영역을 설정하려면 플롯 영역에서 커서를
끌어 선택하십시오. Shift 키를 누르고 있으면 현재 선택 영역이 유지됩니
다.
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항목 설명

2 플롯 표시를 위해 지정된 요인을 기준으로 범위 내에서 Y 값을 확장합니
다.

a. 하나 또는 여러 샘플을 엽니다.

b. 그래프의 일부를 선택합니다.

c. Graph > Expand Selected Y-Values by를 클릭합니다.

Expand Selection 대화 상자가 열립니다.

d. 확장 요인을 입력합니다.

e. OK를 클릭합니다.

3 확장 범위를 모두 제거합니다.
• 확장된 범위가 있는 그래프에서 Graph > Clear Expansion Ranges
를 클릭합니다.

4 그래프에서 현재 활성화된 트레이스를 제거합니다. 이 기능은 중첩된 트
레이스가 두 개 이상 있을 때 사용할 수 있습니다.
• 중첩된 트레이스가 두 개 이상 있는 그래프에서 Graph > Remove

Active Trace를 클릭합니다.

5 현재 활성화된 트레이스를 제외한 모든 트레이스를 제거합니다. 이 기능
은 중첩된 트레이스가 두 개 이상 있을 때 사용할 수 있습니다.
• 중첩된 트레이스가 두 개 이상 있는 그래프에서 Graph > Remove All

Traces Except Active를 클릭합니다.

6 그래프에서 모든 데이터 요소가 현재 임계값 설정 미만인 중첩된 트레이
스를 제거합니다.

사용자가 그래프를 확대하여 X 범위의 일부만 현재 표시된 경우 대화 상
자가 열립니다. 사용자는 임계값 미만의 트레이스를 제거할 때 전체 범위
를 사용할지 아니면 현재 표시된 부분만 사용할지 선택할 수 있습니다.

• 중첩된 트레이스가 두 개 이상 있는 그래프에서 Graph > Remove
Traces Below Threshold를 클릭합니다.

7 활성 그래프에 중첩된 트레이스가 두 개 이상 포함된 경우 현재 활성화된
트레이스를 제외한 모든 트레이스를 일반적인 경우보다 더 희미하고 연
한 색으로 그립니다. 이 기능을 사용하면 활성 트레이스에 집중할 수 있
으며 비활성 트레이스로 인한 혼란을 줄일 수 있습니다. 원래 스타일로
돌아가려면 이 기능을 다시 선택하십시오.
• 중첩된 트레이스가 두 개 이상 있는 그래프에서 Graph > Fade

Inactive Trace를 클릭합니다.

8 활성 그래프에 중첩된 트레이스가 두 개 이상 포함된 경우 두 번째 트레
이스를 반전합니다. 이 기능을 사용하면 비슷한 두 트레이스를 시각적으
로 더 쉽게 비교할 수 있습니다. 원래 보기로 돌아가려면 Invert Second
Overlay를 다시 선택하십시오.
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항목 설명

9 그래프를 모든 개별 트레이스의 합인 단일 트레이스로 대체합니다.
• 중첩된 트레이스가 두 개 이상 포함된 활성 그래프에서 Graph > Sum

Graph Traces를 클릭합니다.

10 각 중첩에 대해 별도의 그래프를 생성합니다. 예를 들어 사용자가 세 개
의 중첩된 트레이스가 있는 그래프로 시작한 후 이 기능을 선택하면 중첩
이 있는 원래 그래프와 각 데이터 세트마다 그래프가 하나씩 표시된 총
네 개의 창이 최종 결과에 포함됩니다.
a. 중첩된 트레이스가 두 개 이상 포함된 활성 그래프에서 Graph >

Split Traces into Separate Panes를 클릭합니다.

Number of Columns 대화 상자가 열립니다.

b. 출력의 열 수를 선택합니다.

필요한 행 수는 행 수와 중첩된 트레이스 수에 따라 결정됩니다.

c. 확인란을 선택하여 내부 창을 새 창에서 엽니다. 확인란을 선택하지
않으면 동일한 창에서 열립니다.

11 Set Titles 대화 상자를 엽니다. 이 옵션을 사용하여 트레이스 제목을 수동
으로 변경할 수 있습니다.

12 Color 대화 상자를 엽니다. 이 옵션을 사용하여 현재 활성화된 그래프 트
레이스의 색을 설정할 수 있습니다.

13 Set Trace Colors Using Titles 대화 상자를 엽니다. 그래프 트레이스가 여
러 개 중첩된 경우 소프트웨어는 중첩에 기본 색을 사용합니다. 이 옵션
을 사용하여 제목에 특정 텍스트가 포함된 트레이스에 특정 색을 설정할
수 있습니다.

14 현재 활성화된 그래프 데이터의 복사본을 생성한 후 같은 그래프에 추가
합니다. 이 기능을 사용하여 특정 데이터 처리 작업의 효과를 확인할 수
있습니다. 예를 들어 사용자가 이 기능으로 데이터를 복제한 후 두 트레
이스 중 하나에 다듬기 효과를 적용하면 결과 그래프에 처리 전후의 보기
가 중첩된 상태로 포함됩니다.

• 활성 그래프에서 Graph > Duplicate Active Data를 클릭합니다.

15 현재 활성화된 그래프의 복사본을 생성합니다. 이 기능을 사용하여 특정
데이터 처리 작업의 효과를 확인할 수 있습니다. 예를 들어 사용자가 이
기능으로 데이터를 복제한 후 두 트레이스 중 하나에 다듬기 효과를 적용
하면 처리 전후의 보기가 두 개의 개별 그래프에 표시됩니다. 한 그래프
를 확대/축소하면 다른 그래프가 자동으로 확대/축소되도록 X 축을 연결
하십시오.

• 활성 그래프에서 Graph > Duplicate Graph를 클릭합니다.

16 Offset Traces 대화 상자를 엽니다. 이 옵션을 사용하여 일련의 중첩된 그
래프 트레이스에서 3차원 누적 그래프를 생성할 수 있습니다.
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항목 설명

17 생성된 오프셋을 TIC에서 제거합니다.

2개 창 작업 도구 사용
선행 절차

• Explorer 작업 영역을 엽니다.

창의 오른쪽 가장자리에 있는 아이콘을 사용하여 두 개의 창, 즉 소스 창과 대상 창에서 작업을
수행할 수 있습니다. 자세한 정보는 표 6-2 섹션을 참조하십시오. 모든 경우에서 소스 창의 아
이콘을 클릭한 다음 이를 대상 창으로 끌어옵니다.

표 6-2 2개 창 도구

아이콘 이름 설명

창 이동 두 창의 상대 위치를 변경합니다. 각 창의 오른쪽 위에 표
시됩니다. 하나의 창에서 아이콘을 클릭하여 두 번째 창
의 위쪽, 아래쪽, 왼쪽 또는 오른쪽 부분으로 끕니다. 커
서를 놓은 위치에 따라 첫 번째 창의 위치가 두 번째 창을
기준으로 변경됩니다. 사용자가 창을 끌면 두 번째 창의
한 면이 빨간색으로 강조 표시되어 첫 번째 창이 이동할
위치를 나타냅니다.
참고: 또한 사용자는 하나의 창에서 다른 창으로 두 개의
내부 창을 끌 수도 있습니다.

데이터 추가 두 개의 데이터 세트를 하나씩 합산합니다. 원래 클릭한
소스 창의 데이터가 대상 창, 즉 끌어온 아이콘을 놓은 창
에 추가됩니다. 수정된 창의 제목이 업데이트되어 수정
되었음을 나타냅니다.
참고: 유형이 같은 두 데이터 세트만 추가할 수 있습니다.
예를 들어, 사용자는 스펙트럼을 크로마토그램에 추가할
수 없습니다.

팁! 대상 그래프에 하나 이상의 중첩된 트레이스가 포함
되어 있는 경우 소스 데이터는 기본적으로 활성화된 대
상 데이터에만 추가됩니다. 소스를 대상 창의 모든 데이
터 세트에 추가하려면 Ctrl 키를 계속 누르십시오.
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표 6-2 2개 창 도구 (계속)

아이콘 이름 설명

데이터 차감 질량 스펙트럼에서 배경을 뺍니다. 소스 데이터를 대상
데이터에서 뺀다는 점을 제외하면 Add Data 아이콘과
비슷합니다.

팁! 대상 그래프에 중첩된 트레이스가 두 개 이상 포함된
경우에는 기본적으로 활성 대상 데이터에서만 소스 데이
터를 뺍니다. 소스를 대상의 모든 데이터 세트에 추가하
려면 Ctrl 키를 계속 누르십시오.

팁! 일반적으로 소스의 강도가 대상보다 큰 데이터 요소
는 유지되지 않습니다. 즉, 음수 Y 값은 삭제됩니다. 음수
강도의 요소를 유지하려면 Shift 키를 계속 누르십시오.

데이터 중첩 소스 그래프의 활성 데이터를 대상 그래프에 중첩합니
다. 작업이 완료되면 대상 데이터의 복사본을 포함하는
새 시리즈가 대상 그래프에 추가됩니다.
팁! 소스 그래프에 중첩된 트레이스가 두 개 이상 포함된
경우에는 기본적으로 활성 데이터의 복사본만 대상 그래
프로 이동합니다. 소스 그래프에 있는 모든 데이터 세트
의 복사본을 대상 그래프에 중첩하려면 Ctrl 키를 계속
누르십시오.

창 또는 내부 창 이동
선행 절차

• 샘플 열기

Window를 클릭한 후 Window 메뉴의 기능을 사용합니다.

그림 6-13 Window 메뉴: 옵션
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항목 설명

1 활성 그래프의 선택 영역에 대한 정보를 표시하는 창을 엽니다. 예를 들
어 선택한 X 범위, 선택한 요소의 강도 범위 등이 포함됩니다. 이 창이 이
미 표시된 경우 메뉴 항목을 선택하면 창이 닫힙니다. 자세한 정보는 그
래프 선택 영역 정보 표시 섹션을 참조하십시오.

2 창의 정보 레이아웃을 행 형식에서 열 형식으로 변경합니다.

3 창에서 현재 활성화된 내부 창을 제거하여 새 창에 따로 배치합니다.

4 최소화되지 않은 열린 창이 한 행에 나란히 배치되도록 정렬합니다.

5 최소화되지 않은 열린 창이 한 열에서 서로 위 또는 아래에 배치되도록
정렬합니다.

가우스 다듬기 수행
선행 절차

• 샘플 열기

가우스 다듬기 알고리즘을 적용합니다. 이 알고리즘은 가중치 계수가 가우스 또는 정규 함수
를 따르는 지정된 폭의 필터입니다.

1. Process > Gaussian Smooth를 클릭합니다..

그림 6-14 Gaussian Smooth 대화 상자

2. Smoothing width 필드에 값을 입력합니다.
실제로 이 값은 최대 높이의 절반 지점에서 가우스 함수의 폭입니다. 가우스 분포의 양쪽
날개에서 계산이 수행되므로 총 폭은 더 큽니다. 가우스의 절반 폭이 1 포인트 미만인 경
우 소수 값이 허용됩니다.

3. 활성 그래프에 여러 트레이스가 있는 경우 Process all overlays (otherwise active data
only) 를 선택하여 해당 작업을 모든 트레이스에 적용합니다.
Only show this dialog again if the shift key is down 확인란을 선택하면 사용자가
Shift 키를 눌러 옵션을 변경하는 경우 외에는 선택한 작업이 항상 사용됩니다.
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4. OK를 클릭합니다.

임계값 데이터
선행 절차

• 샘플 열기

강도가 현재 임계값 설정 미만인 데이터 요소를 제거합니다. 그래프의 Y 축에 표시된 파란색
화살표를 끌어 임계값을 설정합니다.

1. Process > Threshold Data를 클릭합니다..
활성 그래프에 서로 다른 샘플로부터의 중첩된 시리즈가 포함된 경우 Process All
Overlays? 대화 상자가 열립니다.

그림 6-15 Process All Overlays? 대화 상자

2. Process All Overlays? 대화 상자가 열리면 다음 단계를 수행합니다.

a. 다음 중 하나를 수행합니다.

• 사용 가능한 모든 샘플에 대한 중첩된 TIC를 생성하려면 All Overlaid를 선택합니
다.

• 현재 활성화된 샘플에서만 TIC를 생성하려면 Active Only를 선택합니다.

b. OK를 클릭합니다.

Only show this dialog again if the shift key is down 확인란을 선택하면 사용자가
Shift 키를 눌러 옵션을 변경하는 경우 외에는 선택한 작업이 항상 사용됩니다.

그래프 선택을 사용하여 데이터 부분 집합 지정
선행 절차

• 샘플 열기
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이 기능은 선택한 영역이 정확히 하나뿐인 그래프가 활성화된 경우에만 사용할 수 있습니다.
선택한 영역에 포함되지 않는 데이터 요소를 제거합니다. 데이터 처리를 전체 데이터의 부분
집합에 초점을 둘 때 이 기능을 사용합니다.

1. 그래프에서 영역을 선택합니다.

2. Process > Subset Data (using graph selection)를 클릭합니다..
활성 그래프에 서로 다른 샘플로부터의 중첩된 시리즈가 포함된 경우 Process All
Overlays? 대화 상자가 열립니다.

그림 6-16 Process All Overlays? 대화 상자

3. Process All Overlays? 대화 상자가 열리면 다음 단계를 수행합니다.

a. 다음 중 하나를 수행합니다.

• 사용 가능한 모든 샘플에 대한 중첩된 XIC 또는 TIC를 생성하려면 All Overlaid를
선택합니다.

• 현재 활성화된 샘플에서만 XIC 또는 TIC를 생성하려면 Active Only를 선택합니
다.

b. OK를 클릭합니다.

Only show this dialog again if the shift key is down 확인란을 선택하면 사용자가
Shift 키를 눌러 옵션을 변경하는 경우 외에는 선택한 작업이 항상 사용됩니다.

기준선 감산 크로마토그램
선행 절차

• 샘플 열기

크로마토그램에서 상대적으로 천천히 변하는 배경을 제거합니다.

크로마토그램의 각 데이터 요소에 대해 범위의 중심은 해당하는 X 값이 되며 범위 내에서 왼
쪽 및 오른쪽에 있는 최소 강도의 데이터 요소를 찾습니다. 이러한 두 요소 사이에 직선이 연결
되며 범위의 중심에서 Y 값이 계산됩니다. 그러면 해당 요소의 데이터에서 제거되는 기준선이
됩니다.

1. Process > Baseline Subtract Chromatogram을 클릭합니다.
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그림 6-17 Baseline Subtract 대화 상자

2. Subtraction half window 필드에 값(분)을 입력합니다.

3. 활성 그래프에 여러 트레이스가 있는 경우 Process all overlays (otherwise active data
only) 를 선택하여 해당 작업을 모든 트레이스에 적용합니다.
Only show this dialog again if the shift key is down 확인란을 선택하면 사용자가
Shift 키를 눌러 옵션을 변경하는 경우 외에는 선택한 작업이 항상 사용됩니다.

4. OK를 클릭합니다.

크로마토그램 오프셋
선행 절차

• 샘플 열기

크로마토그램의 시간 값 오프셋에 사용합니다.

1. Process > Offset Chromatogram을 클릭합니다.

그림 6-18 Offset 대화 상자

2. Total offset 필드에 값(분)을 입력합니다.

3. 활성 그래프에 여러 트레이스가 있는 경우 Process all overlays (otherwise active data
only) 를 선택하여 해당 작업을 모든 트레이스에 적용합니다.

작동 지침—처리

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
98/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



Only show this dialog again if the shift key is down 확인란을 선택하면 사용자가
Shift 키를 눌러 옵션을 변경하는 경우 외에는 선택한 작업이 항상 사용됩니다.

4. Use incremental offset (to fan out overlays)을 선택하여 중첩을 시간 방향으로 분산시
킵니다.

5. OK를 클릭합니다.

스펙트럼 중심 생성
선행 절차

• 샘플 열기

질량 스펙트럼의 중심을 생성합니다. 즉, 검출된 피크에 대해서만 프로필 스펙트럼을 질량 및
강도 포인트로 대체합니다.

1. Process > Centroid Spectrum을 클릭합니다..

그림 6-19 Centroid 대화 상자

2. 중심 프로세스에 사용할 메트릭을 선택합니다.

• Intensity: 각 피크에 대해 중심 Y 값은 피크를 포함하는 가장 큰 데이터 요소의 강도입
니다.

• Height : 이 메트릭은 기준선 오프셋이 있는 경우 강도에서 기준선 강도를 감산한다는
점을 제외하고 Intensity 메트릭과 비슷합니다.

• Area: 각 피크에 대해 중심 Y 값은 피크의 총 면적입니다. 보고된 값은 강도 프로필과
피크 폭 둘 다에 따라 달라지므로 이 메트릭은 필수입니다.

• Intensity sum above 50%: 각 피크에 대해 Y 값은 피크를 포함하는 강도 중 피크 정점
강도의 50%를 초과하는 부분의 합계입니다. 이 값은 Intensity 및 Height 메트릭과 달리
단일 데이터 요소의 강도에만 의존하지 않으며, 노이즈가 심하거나 간섭이 있을 수 있
는 피크의 가장자리에 영향을 받지 않으므로 유용합니다.
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3. 활성 그래프에 여러 트레이스가 있는 경우 Process all overlays (otherwise active data
only) 를 선택하여 해당 작업을 모든 트레이스에 적용합니다.
Only show this dialog again if the shift key is down 확인란을 선택하면 사용자가
Shift 키를 눌러 옵션을 변경하는 경우 외에는 선택한 작업이 항상 사용됩니다.

4. OK를 클릭합니다.

데이터를 텍스트로 내보내기
선행 절차

• 샘플 열기

현재 활성화된 스펙트럼 또는 크로마토그램이 탭 구분 텍스트 파일로 저장됩니다.

1. File > Export > Data as Text를 클릭합니다.
스펙트럼 데이터를 내보내는 경우 Add Zero Intensity Points for Export 대화 상자가 열립
니다.

그림 6-20 Add Zero Intensity Points for Export 대화 상자

2. Add Zero Intensity Points for Export 대화 상자가 열리면 다음 중 하나를 수행합니다.

• 내보낸 파일에서 0 강도 포인트를 제외하려면 No, leave data as-is를 클릭합니다.

• 내보낸 파일에 0 강도 포인트를 포함하려면 Yes, add points with zero intensity를 클
릭합니다.

그런 다음 OK를 클릭합니다.

3. 내보낸 파일에 사용할 파일 이름을 입력합니다.

4. Save를 클릭합니다.
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피크 목록을 텍스트로 내보내기
선행 절차

• 샘플 열기

사용자는 현재 활성화된 스펙트럼 또는 크로마토그램의 피크 목록을 탭으로 구분된 텍스트 파
일에 저장할 수 있습니다. 이 파일에는 중심 X 값(질량 또는 시간), 피크 면적, 높이 등의 정보
가 포함됩니다.

1. File > Export > Peak List as Text를 클릭합니다..

2. 내보낸 파일에 사용할 파일 이름을 입력합니다.

3. Save를 클릭합니다.

데이터 인쇄
선행 절차

• 샘플 열기

1. File > Print를 클릭한 후 필요한 옵션을 선택합니다.
Print 대화 상자가 열립니다.

2. 프린터를 선택한 후 Print를 클릭합니다.

옵션 재설정
선행 절차

• Explorer 작업 영역을 엽니다.

사용자는 Explorer 작업 영역의 모든 옵션을 기본값으로 재설정할 수 있습니다. 여기에는 처리
옵션과 이전 절에서 설명한 옵션이 포함됩니다. 옵션 재설정은 현재 로그인한 Windows 사용
자에게만 적용되며 동일한 컴퓨터의 다른 사용자에게는 해당되지 않습니다.

1. Edit > Reset Options를 클릭합니다.
확인 대화 상자가 표시됩니다.

2. OK를 클릭합니다.

옵션 설정
선행 절차

• Explorer 작업 영역을 엽니다.

필요에 따라 각 탭의 기능을 사용하십시오.
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1. Edit > Options를 클릭합니다.

그림 6-21 Options 대화 상자: Graph Appearance 탭

2. 각 탭에서 옵션을 설정합니다(해당하는 경우). 옵션에 대한 설명은 도움말 시스템 문서를
참조하십시오.

3. OK를 클릭합니다.

Analytics 작업 영역
이 작업 영역의 기능에 대한 액세스는 사용자에게 할당된 역할로 제어됩니다. 자세한 정보는
실험실 책임자 안내서를 참조하십시오.

참고: Analytics 작업 영역에서 데이터를 출력하는 제어된 방법에는 Results Table 내보내기,
LIMS에 데이터 전송 및 보고서 생성이 포함됩니다. Results Table에서 복사하여 붙여넣기와
같은 다른 출력 데이터 소스는 제어되지 않습니다. 규제 목적으로 제어되지 않은 출력 방법을
사용하지 마십시오.

숫자 그룹화는 Analytics 작업 영역에서 지원되지 않습니다. 예를 들어 통합 매개 변수의 텍스
트 상자 또는 Results Table 그리드에서 숫자를 그룹화하지 마십시오.

처리 방법에는 통합을 위해 선택된 피크를 정량화하는 데 사용되는 기준이 포함됩니다.

검토자는 피크 통합 및 실험실 표준 작업 절차(SOP)의 데이터 수락 기준에 따라 데이터를 검
토해야 합니다.
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SCIEX OS는 SCIEX OS 또는 Analyst 소프트웨어에서 데이터를 획득하는 동안 데이터를 처리
할 수 있습니다. 획득한 샘플은 Results Table에 추가할 수 있습니다. 획득 중인 샘플을 추가하
려면 획득이 완료될 때까지 기다린 후 Results Table에 추가합니다.

프로젝트에 대한 기본 처리 매개 변수 정의
이 옵션은 처리 방법 생성 시 사용된 기본 피크 찾기 매개 변수를 설정합니다. 구성 요소의 수
가 여러 개일 때는 모든 구성 요소에 개별적으로 조정할 필요 없이 크로마토그래피에 기반하
여 기본값을 설정하십시오. 그러나 모든 구성 요소에 적합한 매개 변수 세트는 없으므로 일부
구성 요소에 대해 매개 변수 일부를 개별적으로 조정해야 할 수도 있습니다.

1. Analytics 작업 영역에서 Projects > Project default settings를 클릭합니다.

참고: 상태 패널에 올바른 프로젝트 이름이 선택되었는지 확인하십시오.

Project Default Settings 대화 상자가 열립니다.

2. Quantitative Processing 페이지에서 다음 단계를 수행합니다.

a. Signal to Noise Algorithm 목록에서 신호 대 노이즈 알고리즘을 선택합니다.

b. Integration Algorithm 목록에서 통합 알고리즘을 선택한 후 정량적 처리를 위한 기
본 매개 변수를 설정합니다.

매개 변수에 대한 설명은 도움말 시스템 문서를 참조하십시오.

3. Qualitative Processing 페이지의 Library Search Algorithm 목록에서 라이브러리 검색
알고리즘을 선택한 후 정성적 처리를 위한 기본 매개 변수를 설정합니다.
알고리즘에 대한 정보는 도움말 시스템 문서를 참조하십시오.

4. Mass Reconstruction Processing 페이지의 Integration Algorithm 목록에서 통합 알고리
즘을 선택한 후 질량 재구성을 위한 기본 통합 매개 변수를 설정합니다.
매개 변수에 대한 설명은 도움말 시스템 문서를 참조하십시오.

참고: MQ4 및 Summation 알고리즘만 사용할 수 있습니다.

5. Save을 클릭합니다.

6. Close를 클릭합니다.

작업 영역 레이아웃 사용
작업 영역 레이아웃 기능을 사용하여 Analytics 작업 영역에서 사용자 지정 작업 영역 레이아
웃을 저장할 수 있습니다. 사용자 지정 레이아웃은 결과 파일에 저장되어 파일을 열 때 자동으
로 적용됩니다. 이렇게 하면 사용자가 결과를 분석할 때 시간이 절약됩니다. 저장된 작업 영역
레이아웃을 다른 결과 파일에 적용할 수 있습니다. 또한 프로젝트의 기본 작업 영역 레이아웃
으로 설정하여 해당 프로젝트의 결과 파일을 열 때마다 적용할 수 있습니다. 작업 영역 레이아
웃은 로컬 네트워크를 포함하여 어디에나 저장할 수 있습니다.

사용자는 저장된 여러 레이아웃 간에 변경하여 결과 파일에 대해 다양한 유형의 데이터 분석
을 수행할 수 있습니다.

참고: 모든 작업 영역 레이아웃은 qlayout이라는 파일 이름 확장자를 사용하여 저장됩니다.

작동 지침—처리

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템

103/325



참고: 데이터를 직접 변경하는 설정은 작업 영역 레이아웃에 유지되지 않습니다.

다음 표에서는 작업 영역 레이아웃과 함께 저장되는 UI 요소 목록을 보여줍니다.

표 6-3 작업 영역 레이아웃과 함께 저장되는 UI 요소

창 저장된 UI 요소

Results Table • Qualify for Rules Filters 확인란

• 선별 행 필터

• 표 정렬 선택

• 강조 표시된 행과 열

• Table display settings

• 열 필터

참고: 작업 영역 레이아웃을 다른 Results Table에 적용할 때 열 필터
설정이 적용됩니다(가능한 경우). 필터링된 열이 Results Table에 없거
나 필터링 옵션을 사용할 수 없는 경우에는 설정이 적용되지 않습니다.

Views 메뉴 • Show hidden pane 설정

• Tabbed view 옵션의 선택 여부

Samples 또는
Components
and Groups

• Samples 또는 Components and Groups 목록이 열려 있는지 여부

• Results Table에 표시할 특정 샘플 또는 구성 요소를 선택했는지 여부

• Samples 목록의 Options > Synchronize Sample Selection 설정

• Components and Groups 목록의 All Internal Standards, All
Analytes, All Components 및 Groups (where applicable) 옵션 선택

• Components and Groups 목록의 Options > Show IS 설정

Peak Review • Peak Review 창이 열려 있고 고정되어 있는지 여부

• 현재 View

• Peak review display settings 옵션 및 XIC Graph Title 옵션을 포함하여
선택한 모든 Options

Calibration
Curve

• Calibration Curve 창이 열려 있는지 여부

• Options 메뉴의 Show excluded standards, Show quality controls,
Show legend, Use percent Y-axis 및 Log-log plot 설정
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표 6-3 작업 영역 레이아웃과 함께 저장되는 UI 요소 (계속)

창 저장된 UI 요소

Metric Plot • Metric Plot 창이 열려 있는지 여부

• Link 메뉴 설정

• Regression 대화 상자 설정

• Options 메뉴의 Display "N/A" as 0.0, Show sample names, Show
legend, Use percent Y-axis, Start Y-axis at 0 및 Connect with lines
설정

Statistics 창 • Statistics 창이 열려 있는지 여부

• 활성 Sample grouping 선택

• 활성 Metric 선택

현재 작업 영역 레이아웃 저장
1. Analytics 작업 영역을 엽니다.

2. Results Table을 엽니다.

3. 필요에 따라 작업 영역 레이아웃을 사용자 지정합니다.

4. Views > Save current layout을 클릭합니다.
Save Workspace Layout As 대화 상자가 열립니다.

5. 작업 영역 레이아웃의 이름을 입력한 후 Save를 클릭합니다.

현재 프로젝트에 다른 작업 영역 레이아웃 적용
사용자는 현재 결과 파일에 다른 작업 영역 레이아웃을 적용하여 동일한 데이터에 대해 다양
한 유형의 결과 분석을 빠르게 수행할 수 있습니다.

1. Analytics 작업 영역을 엽니다.

2. 결과 파일을 엽니다.

3. Views > Apply different layout to current results를 클릭합니다.
Apply a Workspace Layout 대화 상자가 열립니다.

4. Browse를 클릭하고 레이아웃을 선택한 후 Open을 클릭합니다.
Apply a Workspace Layout 대화 상자에 선택한 작업 영역 레이아웃의 미리 보기가 표시
됩니다.

5. OK를 클릭합니다.

팁! 최근에 사용한 작업 영역 레이아웃을 적용하려면 Views > Recent layouts을 클릭하
고 레이아웃을 선택하십시오.
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현재 작업 영역 레이아웃을 프로젝트 기본값으로 설정
프로젝트 기본 작업 영역 레이아웃을 설정하면 여러 세션 또는 사용자 간에 레이아웃이 유지
됩니다. 또한 프로젝트 내에서 생성되는 모든 새 결과 파일이 프로젝트 기본 작업 영역 레이아
웃으로 열립니다.

1. Analytics 작업 영역을 엽니다.

2. 결과 파일을 엽니다.

3. 프로젝트에 맞게 작업 영역 레이아웃을 사용자 지정합니다.

4. Views > Set current layout as project default를 클릭합니다.
Default Workspace Layout for the Project 대화 상자가 열립니다.

5. Default layout name 필드에 레이아웃 이름을 입력한 후 OK를 클릭합니다.

6. Results > Save를 클릭합니다.

프로젝트 보안 내보내기 설정
관리자 역할이 지정된 사용자만 이 작업을 수행할 수 있습니다.

이 옵션을 선택한 경우, 텍스트 파일에 있는 데이터가 내보내기 중 암호화됩니다. 암호화를 사
용하려면 비밀번호를 설정하십시오.

1. Analytics 작업 영역에서 Projects > Project secure export settings를 클릭합니다.

그림 6-22 Secure Export Settings 대화 상자

2. Encrypt Results Table when exporting for this project 확인란을 선택합니다.

3. Password 필드에 비밀번호를 입력합니다.

4. Confirm Password 필드에 비밀번호를 다시 입력합니다.

5. OK를 클릭합니다.
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프로젝트 수정 피크 경고 사용
기본적으로 이 옵션은 선택되어 있지 않습니다. 이 옵션을 선택한 경우 사용자가 Results
Table에서 크로마토그램을 변경한 후 저장하면 변경되었음을 알리는 경고 메시지가 나타납니
다. 사용자는 계속 저장하거나 Results Table로 돌아가도록 선택할 수 있습니다.

Analytics 작업 영역에서 Projects > Enable project modified peak warning을 클릭합니다.

처리 방법 생성
처리 방법에는 데이터 처리를 위한 정량적 및 정성적 설정이 있습니다. 비표적 워크플로는 알
수 없는 구성 요소에 사용됩니다.

팁! 기존 처리 방법을 편집하려면 Process Method > Open을 클릭하십시오.

1. Analytics 작업 영역을 엽니다.

2. Process Method > New를 클릭합니다.

팁! 현재 Results Table의 처리 방법을 편집하려면 Process Method > Edit embedded
method를 클릭한 후 3 단계를 진행하십시오.

3. Workflow 페이지에서 하나 이상의 워크플로 및 참조 샘플을 선택합니다. 이 페이지의 필
드에 대한 설명은 도움말 시스템 문서를 참조하십시오.

팁! 질량 재구성 워크플로를 사용하려면 Quantitation만 선택하십시오.

4. Components 페이지를 선택한 후 다음 단계를 수행합니다.

a. 해당하는 경우 Options > Mass Reconstruction을 클릭한 후 확인 대화 상자에서
Yes를 클릭하여 질량 재구성 워크플로를 선택합니다.

b. 구성 요소 테이블을 완성합니다. 이 테이블의 필드에 대한 설명은 도움말 시스템 문서
를 참조하십시오.

참고: 질량 재구성 워크플로는 통합 알고리즘이 MQ4 또는 Summation으로 설정된 경우
에만 사용할 수 있습니다.

팁! Components 테이블에 그룹이 정의된 경우 사용자는 전이에 대해 전구체 이온과 실험
인덱스가 달라도 그룹의 이온을 합산하도록 선택할 수 있습니다. 합산된 이온은 테이블에
표시되지 않지만 Integration 페이지 및 Results Table에 group name > Sum으로 표시됩
니다. 이 기능은 단백질 및 펩타이드의 정량화에 유용합니다.

팁! 구성 요소의 머무름 시간을 알 수 없는 경우 질량 또는 화학식의 Retention Time
Mode를 Find n peaks로 설정하십시오. 여기서 n은 1, 2, 5, 10 또는 모두입니다. 소프트
웨어는 피크 면적이 가장 큰 지정된 수의 형상을 식별하고 적절한 머무름 시간을 할당한
후 표적 피크 처리 워크플로를 수행합니다. 처리가 완료되면 Results Table의 포함된 방법
을 표적 방법으로 저장할 수 있습니다.
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팁! 텍스트 파일에서 하나 이상의 구성 요소 및 통합 매개 변수를 가져오려면 Import 메뉴
의 적절한 명령을 사용하십시오. 구성 요소 정보에 농도 단위가 포함되어 있지 않으면
Project Default Settings 대화 상자에 정의된 Concentration units가 사용됩니다.

참고: AutoPeak 통합 알고리즘을 사용하는 처리 방법에서 통합 매개 변수를 가져올 수 없
습니다.

참고: Analyst 소프트웨어 정량화 방법에서 통합 매개 변수를 가져올 수 있습니다. Analyst
소프트웨어 매개 변수는 해당하는 SCIEX OS 매개 변수에 매핑되며, 매핑할 수 없는 매개
변수에는 프로젝트 기본 설정이 사용됩니다.

참고: SignalFinder 알고리즘을 사용하지 않는 MultiQuant 소프트웨어 정량화 방법에서 통
합 매개 변수를 가져올 수 있습니다. MQ4 방법의 경우 S/N Integration Threshold가
MultiQuant 소프트웨어의 기본값인 0에서 프로젝트 기본값으로 변경됩니다. MultiQuant
소프트웨어의 매개 변수는 SCIEX OS의 해당 매개 변수에 매핑됩니다.

5. Integration 페이지를 선택한 후 다음 단계를 수행합니다.

a. 각 구성 요소의 통합 매개 변수를 선택합니다. 이 페이지의 필드에 대한 설명은 도움
말 시스템 문서를 참조하십시오.

팁! 이상값 자동 제거 규칙을 정의하려면 Options > Remove Outliers
Automatically를 클릭합니다. 자세한 정보는 도움말 시스템 문서를 참조하십시오.

b. (선택 사항) 노이즈 영역을 보려면 Options > Show Noise Regions를 클릭합니다.
자세한 정보는 노이즈 영역 사용 섹션을 참조하십시오.

참고: Show Noise Regions는 신호 대 노이즈 알고리즘이 Standard Deviation 또는
Peak to Peak로 설정된 경우에만 표시됩니다.

6. (해당하는 경우) Library Search 페이지를 선택한 후 라이브러리 검색 매개 변수를 정의합
니다. 이 페이지의 필드에 대한 설명은 도움말 시스템을 참조하십시오.

7. Calculated Columns 페이지를 선택한 후 사용자 지정 계산 열에 사용할 사용자 지정 식을
정의합니다. 이 페이지의 필드에 대한 설명은 도움말 시스템을 참조하십시오.

참고: 계산 열에 대한 자세한 정보는 계산 열 섹션을 참조하십시오.

8. Flagging Rules 페이지를 선택한 후 Results Table의 결과에 플래그를 지정하는 데 사용할
규칙을 선택합니다. 이 페이지의 필드에 대한 설명은 도움말 시스템 문서를 참조하십시
오.
원하는 경우 플래그 지정 규칙을 사용자 지정하거나, 미리 정의된 규칙에 대해 다음 값을
사용자 지정합니다.

• 다음 항목에 대한 수락 기준

• 표준 및 품질 관리 샘플의 정확도

• 알 수 없는 샘플의 계산된 농도 범위

• 피크 통합
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• 질량 정확도, 머무름 시간 신뢰도, 동위 원소 일치, 라이브러리 점수 및 수식 찾기 점수
에 대한 신호등 설정

• 이온비 수락에 대한 신호등 설정

이온비는 피크 반응 비율, 즉 정성자와 정량자의 면적 또는 높이입니다.

팁! 텍스트 파일에서 플래그 지정 규칙을 가져오려면 Import를 클릭하십시오.

9. Formula Finder 페이지를 선택한 후 수식 찾기 설정을 선택합니다. 이 페이지의 필드에 대
한 설명은 도움말 시스템 문서를 참조하십시오.

10. (비표적 워크플로가 선택된 경우) Non-targeted Peaks 페이지를 선택한 후 비표적 검색
매개 변수를 정의합니다. 이 페이지의 필드에 대한 설명은 도움말 시스템 문서를 참조하
십시오.

11. Save를 클릭합니다.

팁! 비표적 방법이 생성되면 현재 프로젝트 기본 매개 변수가 피크 통합에 사용되고 해당
매개 변수는 처리 방법 파일에 저장됩니다. 처리 방법에 표적 분석 물질이 포함된 경우 표
적 구성 요소에 대한 사용자 지정 통합 매개 변수는 비표적 피크 통합에 영향을 주지 않습
니다. 사용자가 나중에 프로젝트 기본 매개 변수를 변경하더라도 변경된 매개 변수는 방
법 생성 시점의 매개 변수를 계속 가지고 있는 기존 비표적 방법에는 영향을 주지 않습니
다. 새로 생성된 비표적 방법만 변경된 매개 변수를 사용합니다.

데이터 처리
1. Analytics 작업 영역을 엽니다.

2. Results > New를 클릭합니다.

3. Process New Results 대화 상자에서 화살표(  및 )를 사용하여 처리할 샘플을
선택합니다.

4. 다음 중 하나를 수행하여 처리 방법을 선택합니다.

• Browse를 클릭한 후 처리 방법을 선택하고 Open을 클릭합니다.

• New를 클릭한 후 새 처리 방법을 생성합니다. 자세한 정보는 처리 방법 생성 섹션을 참
조하십시오.

5. (선택 사항) Edit를 클릭하여 처리 방법을 편집합니다. 자세한 정보는 처리 방법 생성 섹션
을 참조하십시오.

6. 비표적 워크플로의 비교 샘플을 선택합니다.

7. Process를 클릭합니다.

참고: 비표적 분석에서는 부가물별 자동 그룹화가 수행됩니다. 그룹화 알고리즘은 머무름
시간이 같은 화합물 간의 질량 차이가 공통 부가물과 연관된 경우 해당 화합물에 부가물
변경자를 할당합니다. 이 기능은 전하 부가물이 서로 다른 중복 화합물의 조사를 방지하
는 데 도움이 됩니다.
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미리 정의된 Results Table 열 또는 기존 수식과 동일한 이름의 사용자 지정 배치 열이 데
이터에 포함되어 있으면 경고 메시지가 표시됩니다. OK를 클릭하여 계속합니다. 이러한
열 이름의 시작 부분에 밑줄(_)이 추가됩니다.

8. 샘플 유형을 표시하거나 숨기려면 Sample Type 열에서 필터 아이콘( )을 클릭한 후 필
요한 확인란을 선택하거나 선택을 취소합니다.

9. 수락 필터를 설정하려면 수락 열 중 하나에서 필터 아이콘( )을 클릭하고 Filter by Flag
를 선택한 후 Pass 또는 Fail을 선택합니다.

참고: Acceptance 열은 Accuracy, Accuracy Acceptance, Asymmetry Factor,
Calculated Concentration, Concentration Acceptance, Integration Acceptance,
Quality Retention Time Delta (min), Retention Time Error (%) 및 Total Width를 포함
합니다.

10. 정성적 신뢰도 필터를 선택하려면 Confidence 신호등을 클릭한 후 필요한 확인란을 선택
하거나 선택을 취소합니다.

참고: AutoPeak 알고리즘을 사용하여 Results Table을 생성한 후 사용자가 XIC 폭과 예상
RT를 변경할 경우 사용자가 새 XIC 폭과 예상 RT 값을 사용하여 모델을 업데이트하지 않
으면 이전 알고리즘을 사용하여 데이터가 다시 처리됩니다.

11. Results Table 열의 개별 값을 기준으로 필터링하려면 열 머리글에서 필터 아이콘( )을
클릭한 후 Results Table에 표시할 값의 확인란을 선택합니다.

팁! 추가 사용자 지정 필터를 적용하려면 Text Filters를 선택하십시오.

팁! 면적 계산을 변경하는 등 Results Table을 변경한 후 필터를 다시 적용하려면 Reapply

Filter( )를 클릭하십시오.

12. 다음 중 하나를 수행하여 결과 파일을 저장합니다.

• Results > Save를 클릭합니다.

• Results Table이 변경되지 않게 하려면 Results > Lock results file and save를 클릭
합니다.

샘플 추가

선행 조건

• Analytics 작업 영역에 Results Table이 열려 있습니다.

이 옵션은 추가 샘플을 현재 활성화된 Results Table에 추가합니다.

1. More > Add samples를 클릭합니다.

2. Select Samples 대화 상자에서 필요한 샘플을 선택합니다.

• Available 창에는 하위 폴더, wiff2 파일 및 현재 프로젝트의 Data 폴더에 있는 샘플이
표시됩니다.
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• 각 폴더를 확장하여 하위 폴더 또는 wiff2 파일을 표시합니다. wiff2 파일을 확장하면 파
일이 열려 사용 가능한 샘플이 표시됩니다.

• 화살표를 사용하여 샘플을 추가( )하거나 제거( )합니다.

• 다음과 같은 방법으로 샘플을 선택합니다.

• 각 샘플을 두 번 클릭합니다.

• 샘플 또는 데이터 파일을 선택한 후 을 클릭합니다.

• 왼쪽 창에 있는 샘플 또는 데이터 파일을 끌어 오른쪽 창에 놓습니다.

여러 파일 또는 샘플을 이동하려면 먼저 Shift 또는 Ctrl 키를 눌러 선택합니다.

3. OK를 클릭합니다.
새 샘플이 통합되고 기존 표에 추가되는 동안 진행률 표시줄이 표시됩니다.

Results Table 사용자 지정

선행 조건

• Analytics 작업 영역에 Results Table이 열려 있습니다.

Results Table에 나타날 숫자 형식과 열을 선택합니다. 열 설정은 프로젝트의 모든 Results
Table에 적용할 수 있습니다.

참고: Sample Name, Sample ID, Barcode 등 일부 중요한 열은 사용자가 Results Table 열
설정을 사용자 지정할 때 표시되어야 합니다.

팁! 열 이름이 잘린 경우 커서를 필드 위로 이동하면 열 이름이 도구 설명에 표시됩니다.

1. More > Table display settings를 클릭합니다.
Results Table Display Settings 대화 상자가 열립니다. Results Table의 열에 대한 설명은
Results Table 열 섹션을 참조하십시오.
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그림 6-23 Results Table Display Settings 대화 상자

항목 설명

1 Export 버튼을 이용하여 이전에 저장한 열 설정 파일을 선택하려면 클릭
하십시오. 선택한 파일의 정보를 사용하도록 대화 상자 필드가 업데이트
됩니다.

2 현재 대화 상자 설정을 파일에 저장하려면 클릭하십시오. Import 버튼을
사용해 이러한 설정값을 가져오고 사용합니다. 사용자는 이 옵션으로 서
로 다른 열 레이아웃 간에 전환할 수 있습니다.

3 사전 순으로 표시되는 열 이름입니다.
참고: 이 목록에는 Results Table을 생성하는 데 사용한 처리 방법에 정의
된 계산 열도 포함됩니다.

4 체크 표시는 열이 표시됨을 의미합니다.
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항목 설명

5 숫자 필드에서는 비과학적 표기법에 0.00 형식을 이용하고 과학적 표기
법에 0.00e0 형식을 이용하십시오. 표시되는 숫자의 정밀도를 나타내는
소수점을 변경하십시오. 마침표 "."만 소수점 구분 기호로 사용할 수 있습
니다.
참고: 숫자 그룹화는 지원되지 않습니다.

6 선택된 LIS Supported 행은 LIMS에서 미리 정의되며 열 선택을 변경할
수 없습니다.

7 클릭하면 이후 Results Table에 열 설정을 사용할 수 있습니다.

8 클릭하면 변경 사항이 적용되고 대화 상자가 닫힙니다.

9 클릭하면 변경 사항이 취소되고 대화 상자가 닫힙니다.

10 Results Table 열의 범주를 선택합니다. 사용자는 선택에 따라 Results
Table에 표시된 열을 필터링할 수 있습니다. 범주를 선택하면 사용자가
Results Table에서 열을 쉽게 찾을 수 있습니다.

2. 필요에 따라 Visible 열의 확인란을 선택하거나 선택을 취소합니다.

참고: Results Table에는 Results Table 열에 설명된 열 외에도 사용자 지정 계산 열 및 텍
스트 열이 포함될 수 있습니다. 계산된 열은 별표로 식별됩니다.

3. (선택 사항) Number Format 열에서 형식을 정수 또는 과학적 표기법으로 변경합니다.

4. (선택 사항) Number Format 열에서 표시할 소수점 수를 변경합니다.

5. OK를 클릭합니다.
그러면 Results Table에 새로운 설정이 적용됩니다. 이 설정은 새 Results Table을 생성하
거나 이전에 저장한 Results Table을 다시 열 때도 저장 및 적용됩니다.

팁! Results Table의 머리글 행을 사용하여 열 폭과 열 순서를 조정할 수 있습니다. 폭을 변
경하려면 머리글 경계를 끕니다. 열 순서를 변경하려면 Results Table에서 열 머리글을 다
른 위치로 끕니다. 필터를 열에 적용하려면 열 머리글에서 필터 아이콘( )을 클릭합니다.
Export 버튼을 사용하여 Results Table을 내보내면 열 폭, 순서 및 필터 설정이 내보낸 파
일에 저장됩니다.

보고서 생성

선행 조건

• Analytics 작업 영역에 Results Table이 열려 있습니다.

팁! 보고서에 포함할 분석 물질을 선택하려면 Results Table의 Reportable 열을 사용합니다.
자세한 정보는 Results Table 열 섹션을 참조하십시오.

1. Reporting > Create Report and Save Results Table를 클릭합니다.
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Create Report 대화 상자가 열립니다.

2. Template name 목록에서 템플릿을 선택합니다.

3. 보고서 형식을 선택합니다.

4. 파일 이름과 위치를 변경하려면 Browse를 클릭하고 다른 위치로 이동한 후 File name을
입력하고 Save를 클릭합니다.

참고: 기본적으로 보고서는 ProgramData\SCIEX\Analytics\Reporter\Reports
에 저장됩니다.

5. 필요한 경우 Create an individual report for each sample 확인란을 클릭합니다.

6. (선택 사항) 보고서에 사용할 다른 로고를 선택합니다.

a. Replace Logo를 클릭합니다.

b. Replace Logo 대화 상자의 옵션을 사용하여 필요에 따라 로고를 수정합니다.

c. Save을 클릭합니다.

d. Cancel을 클릭합니다.

7. View Pages를 클릭하여 보고서 레이아웃을 봅니다.

8. Create를 클릭합니다.

팁! Per Sample Quant, Per Sample Qual, Per Sample Visible Rows Using Visible
Analytes 또는 Positive Hits Qual과 같은 템플릿을 사용하여 선택한 결과를 보고하려면
Results Table에서 필터를 사용하거나 원치 않는 행을 숨기십시오.

팁! 보고서 템플릿 레이아웃을 보려면 Create Report 대화 상자의 Template View에 있는
예를 클릭합니다. 특정 템플릿을 보려면 사용자에게 템플릿과 이름이 같고 [Snapshot_X]
접미사(X는 시퀀스에서 스냅샷 번호)가 추가된 jpg 파일이 있어야 합니다. 파일 이름과 접
미사 사이에 공백을 사용하지 마십시오.

예를 들어 All Peaks Qual.docx 템플릿은 All Peaks Qual[Snapshot_1].jpg All Peaks
Qual[Snapshot_2].JPG All Peaks Qual[Snapshot_3].jpg로 이름이 지정됩니다.

Results Table 내보내기 및 저장

선행 조건

• Analytics 작업 영역에 Results Table이 열려 있습니다.

팁! 내보낼 분석 물질을 선택하려면 Results Table의 Reportable 열을 사용합니다. 자세한 정
보는 Results Table 열 섹션을 참조하십시오.

1. Reporting > Export results > Export and save Results Table를 클릭합니다.

Export 대화 상자가 열립니다.

2. 필요에 따라 옵션을 선택합니다.
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옵션에 대한 설명은 도움말 시스템 문서를 참조하십시오.

3. OK를 클릭합니다.

Results Table 내보내기 – 메트릭

선행 조건

• Analytics 작업 영역에 Results Table이 열려 있습니다.

참고: 제조업체는 간접적 또는 결과적 손해를 포함하여 Analytics 작업 영역에서 데이터를 내
보낸 후 발생하는 문제에 대해 책임 또는 불확정 책임이 없는 것으로 간주됩니다.

Results Table 내보내기는 Analytics 작업 영역에서 데이터 출력을 위한 제어된 방법 중 하나입
니다.

이 기능을 사용해 활성 Results Table의 정보가 포함된 탭 구분 텍스트 파일을 생성합니다. 모
든 샘플에 대한 정보와 모든 구성 요소 또는 선택한 한 메트릭이나 필드에 표시된 구성 요소에
대한 정보를 내보냅니다.

1. Reporting > Export results > Results Table - Metric을 클릭합니다..

Export Metric대화 상자가 열립니다.

2. Metric 필드에서 내보낼 열을 선택한 후 옵션을 설정합니다. 자세한 정보는 도움말 시스템
문서를 참조하십시오.

3. OK를 클릭합니다.

결과를 Watson LIMS로 전송

선행 조건

• Results Table이 열려 있고 잠금 상태입니다.

• Watson LIMS 소프트웨어가 열려 있습니다.

참고: 일부 숨겨진 열과 Reportable로 지정되지 않은 열을 포함하여 Results Table의 열 부분
집합이 전송됩니다.

1. Reporting > Initiate Transfer to Watson LIMS를 클릭합니다.
전송 대화 상자가 열립니다.

2. Watson LIMS 소프트웨어에서 데이터를 가져옵니다.

3. SCIEX OS의 전송 대화 상자에서 다음 중 하나를 수행합니다.

• 전송이 완료된 경우 Confirm을 클릭합니다.

• 전송이 완료되지 않은 경우 Decline을 클릭합니다.
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결과를 다른 LIMS로 전송

선행 절차

• Configuration 작업 영역에서 LIMS를 구성합니다. 자세한 정보는 실험실 정보 관리 시스
템(LIMS) 설정 선택 섹션을 참조하십시오.

• 잠긴 Results Table을 엽니다.

팁! 내보낼 분석 물질을 선택하려면 Results Table의 Reportable 열을 사용합니다. 자세한 정
보는 Results Table 열 섹션을 참조하십시오.

1. Reporting > Transfer Results to LIMS를 클릭합니다.
LIMS Transfer 대화 상자가 열립니다.

2. Template 목록에서 템플릿을 선택합니다.

3. Transfer를 클릭합니다.

Results Table 사용
Results Table에는 알 수 없는 각 샘플에서 교정 곡선을 기반으로 한 분석 물질의 계산된 농도
및 라이브러리 적중 수, Formula Finder 결과 등의 정성적 분석 결과가 요약되어 있습니다. 교
정 곡선 및 결과 통계도 Results Table에 포함됩니다. 사용자는 Results Table을 사용자 지정하
고 다양한 레이아웃으로 Results Table을 표시할 수 있습니다.

참고: 별표(*)가 있는 Results Table 열은 사용자 지정 텍스트 열 또는 계산된 열입니다.

Results Table의 데이터를 Microsoft Excel 같은 다른 어플리케이션에서 사용하기 위해 txt 파
일로 내보낼 수 있습니다. 사용자는 Results Table에서 모든 데이터를 내보내기할 수 있고 또
는 볼 수 있는 칼럼에서는 데이터만 내보내기할 수 있습니다.

팁! Results Table의 여러 세션이 세로 바둑판식 또는 가로 바둑판식으로 배열된 경우 Views >
Reset layout을 클릭하여 Results Table을 원래 레이아웃으로 되돌릴 수 있습니다.

오른쪽 클릭 메뉴를 사용하여 Results Table 행을 편집할 수 있습니다. 이 메뉴를 표시하려면
Results Table의 아무 곳이나 마우스 오른쪽 버튼으로 클릭하십시오.

그림 6-24 오른쪽 클릭 메뉴

작동 지침—처리

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
116/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



표 6-4 오른쪽 클릭 메뉴 명령

레이블 설명

Copy (복사) 현재 데이터를 클립보드에 복사하려면 이 옵션을 사용합
니다.

Paste (붙여넣기) 클립보드의 데이터를 현재 보기에 붙여 넣으려면 이
옵션을 사용합니다.

Copy Entire Table (표 전체 복사) 표 전체를 클립보드에 복사하려면 이 옵션을 사용
합니다.

Fill Down (아래로 채우기) (구성 요소) 처음 선택한 행의 정보를 이후에 선
택한 모든 행에 복제하려면 이 옵션을 사용합니다.

Select All Rows (모든 행 선택) 현재 활성화된 Results Table의 모든 행을 선택하
려면 이 옵션을 사용합니다. 이 옵션은 사용자가 Copy와 같이 선
택된 행에 대해 작동하는 명령을 이후에 적용할 때 유용합니다.

Apply Current Analyte's
Actual Concentrations
to All

(현재 분석 물질의 실제 농도를 모든 항목에 적용) (분석 물질) 분
석 물질이 두 개 이상이고 모든 분석 물질이 동일한 농도의 샘플
에 있는 경우 이 옵션을 사용하면 표준 샘플에 대한 모든 분석 물
질의 실제 농도 필드를 빠르게 설정할 수 있습니다. 이 기능을 사
용하려면 다음을 수행하십시오.

1. Components and Groups List를 사용하여 표에서 하나의
특정 분석 물질만 표시합니다. 자세한 정보는 구성 요소 및
그룹 목록 섹션을 참조하십시오.

2. (선택 사항) Sample Type 열을 필터링하여 표준 샘플만 표
시합니다.

3. 셀에 입력하거나, 열을 선택한 후 텍스트를 붙여 넣어 분석
물질의 실제 농도를 지정합니다.

4. Apply Current Analyte's Actual Concentrations to All을
선택합니다.

필요에 따라 모든 구성 요소 및 모든 샘플 유형 보기로 돌아갑니
다.
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표 6-4 오른쪽 클릭 메뉴 명령 (계속)

레이블 설명

Apply Current IS's
Actual Concentrations
to All

(현재 IS의 실제 농도를 모든 항목에 적용) (내부 표준) 내부 표준
이 두 개 이상이고 모든 내부 표준이 동일한 농도의 샘플에 있는
경우 이 옵션을 사용하면 표준 샘플에 대한 모든 내부 표준의 실
제 농도 필드를 빠르게 설정할 수 있습니다. 이 기능을 사용하려
면 다음을 수행하십시오.

1. Components and Groups List를 사용하여 표에서 하나의
특정 내부 표준만 표시합니다. 자세한 정보는 구성 요소 및
그룹 목록 섹션을 참조하십시오.

2. (선택 사항) Sample Type 열을 필터링하여 표준 샘플만 표
시합니다.

3. 셀에 입력하거나, 열을 선택한 후 텍스트를 붙여 넣어 내부
표준의 실제 농도를 지정합니다.

4. Apply Current IS's Actual Concentrations to All을 선택
합니다.

필요에 따라 모든 구성 요소 및 모든 샘플 유형 보기로 돌아갑니
다.

Results Table 필터
Results Table 맨 위의 필드를 사용하여 콘텐츠를 보고 필터링할 수 있습니다.

그림 6-25 필터링 컨트롤

표 6-5 Results Table 필터

레이블 설명

x of y rows (x/y 행) 전체 행 수(y) 중 보이는 행의 수(x)를 표시합니다.

Filters (필터) 필터가 적용되는 열 수를 표시합니다.

Qualify for
Rules Filters

(규칙 필터 조건) Results Table을 수락 기준 필터 또는 신뢰도 신호등 필
터와 일치하는 행 보기와 일치하지 않는 행 보기 간에 전환합니다. 수락 기
준 및 신뢰도 신호등은 처리 방법에 적용됩니다.
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표 6-5 Results Table 필터 (계속)

레이블 설명

Reapply Filter (필터 다시 적용) 면적 계산을 변경하는 등 Results Table을 변경한 후 필
터를 다시 적용합니다.

참고: 다른 필터를 추가하거나 변경하면 모든 필터가 자동으로 다시 적용
됩니다.

Clear (지우기) 모든 필터를 지웁니다.

Results Table 열

참고:

• 별표(*)가 있는 열은 사용자 지정 텍스트 열, 계산 열 또는 플래그 지정 규칙을 결합하여 생
성된 열입니다.

• 이름이 밑줄(_)로 시작하는 열은 미리 정의된 Results Table 열 또는 수식과 이름이 동일한
사용자 지정 배치 열입니다.

• Format 열은 수식에서 필드의 유효성을 검사하는 방법을 나타냅니다.

• 숫자가 포함된 열에서 사용자는 숫자 형식과 유효 자릿수를 변경할 수 있습니다. Number
Format 열에서 Decimal, Significant Digits 또는 Scientific Notation 중 하나를 선택한 다
음 Results Table Display Settings 대화 상자의 Number Format Precision 열에 유효 자릿
수를 입력합니다.

레이블 설명 형식 LIS 지원

Accuracy (정확도) 표준 및 품질 관리(QC) 샘플의
정확도를 표시합니다. 다른 샘플 유형의
경우 이 값은 N/A로 설정됩니다.

농도가 알려진 표준 샘플의 경우 표준 및
QC 샘플의 정확도는 100% ×
(Calculated Concentration)/(Actual
Concentration)으로 정의됩니다.

숫자 Y

Accuracy
Acceptance

(정확도 수락) 정확도의 수락 상태를 표시
합니다.

텍스트 N

Acq. Method
Name

(획득 방법 이름) 샘플 획득에 사용되는
획득 방법의 이름을 표시합니다.

텍스트 Y

Acquisition Date
& Time

(획득 날짜 및 시간) 샘플을 획득한 날짜
와 시간을 표시합니다.

텍스트 Y

Actual
Concentration

(실제 농도) 표준 및 QC 샘플의 경우 알려
진 예상 농도를 표시합니다.

숫자 Y
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레이블 설명 형식 LIS 지원

Adduct/ Charge (부가물/충전) 화합물의 부가물 또는 전하
상태를 표시합니다. 표적 워크플로에서는
이 값을 사용자가 설정합니다. 비표적 워
크플로에서 부가물별 그룹화 기능이 활성
화된 경우 이 값은 소프트웨어에 의해 자
동으로 설정됩니다.

텍스트 N

Area (면적) 검출된 피크 면적을 표시합니다.
피크가 검출되지 않은 경우 이 값은
N/A(해당 없음)로 설정됩니다.

숫자 Y

Area / Height (면적/높이) 검출된 피크 면적을 높이로
나눈 값을 표시합니다. 피크가 검출되지
않은 경우 이 값은 N/A(해당 없음)로 설정
됩니다.

숫자 N

Area Ratio (면적비) 내부 표준을 사용하는 분석 물질
의 경우 분석 물질 Area 대 IS Area 비율
을 표시합니다. 내부 표준 또는 내부 표준
이 없는 분석 물질의 경우 이 값은 N/A(해
당 없음)로 설정됩니다.

숫자 Y

Area Ratio of
comparison

(비교 면적비) 샘플/대조 샘플의 면적비를
표시합니다.

• 대조 샘플에서 피크가 발견되지 않는
경우 이 값은 N/A(해당 없음)입니다.

• 샘플에서 피크가 발견되지 않는 경우
이 값은 0입니다.

• 샘플의 모든 피크가 Area Ratio
Threshold 미만인 경우 이 값은
N/A(해당 없음)입니다.

• 비교 샘플이 사용되지 않는 경우 이 값
은 No control sample(대조용 샘플 없
음)입니다.

• 대조 샘플의 경우 발견된 피크의 면적
비는 항상 1입니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 N

Asymmetry
Factor

(비대칭 인자) 피크 중심선과 뒷면 기울기
사이의 거리를 피크 중심선과 앞면 기울
기 사이의 거리로 나눈 값을 표시합니다.
이때 모든 값은 최대 피크 높이의 10%에
서 측정됩니다.

숫자 Y
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레이블 설명 형식 LIS 지원

AutoPeak
Asymmetry

(AutoPeak 비대칭) 모델을 기반으로 통합
피크의 비대칭 대 예상 대칭 비율을 표시
합니다. 비율이 1이면 적합도가 양호하다
는 의미입니다. 이 값이 1이 아니면 이온
소스가 포화되었거나 통합이 올바르지 않
을 수 있다는 의미입니다.

AutoPeak 통합 알고리즘을 사용하는 처
리 방법에만 적용할 수 있습니다.

숫자 N

AutoPeak
Candidate
Model Quality

(AutoPeak 후보 모델 품질) 피크 모델 생
성에 사용할 피크의 적합성을 표시합니
다. 값이 1보다 훨씬 크면 정량화 방법을
생성하는 데 사용되는 샘플이 적합하지
않습니다. 반응이 더 큰 피크를 사용하여
모델을 생성하고 해당 피크를 모든 샘플
에 적용하십시오.

AutoPeak 통합 알고리즘을 사용하는 처
리 방법에만 적용할 수 있습니다.

숫자 N

AutoPeak Group
Confidence

(AutoPeak 그룹 신뢰도) 실제 피크 그룹
이 통합되고 이 통합에 가양성 노이즈 피
크가 포함되지 않을 확률을 표시합니다.

AutoPeak 통합 알고리즘을 사용하는 처
리 방법에만 적용할 수 있습니다.

숫자 N

AutoPeak
Integration
Quality

(AutoPeak 통합 품질) 데이터 품질을 표
시합니다. 품질은 0 ~ 1 사이의 값으로 나
타냅니다. 품질이 0.6 미만이면 통합을 더
조사하십시오.

AutoPeak 통합 알고리즘을 사용하는 처
리 방법에만 적용할 수 있습니다.

숫자 N

AutoPeak Model
Source

(AutoPeak 모델 소스) 피크 모델링에 사
용된 샘플과 구성 요소의 이름을 표시합
니다. 모델링에 사용된 구성 요소가 통합
된 구성 요소와 같지 않으면 모델이 적절
한지 검토하십시오.

AutoPeak 통합 알고리즘을 사용하는 처
리 방법에만 적용할 수 있습니다.

숫자 N

작동 지침—처리
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레이블 설명 형식 LIS 지원

AutoPeak Num
Peaks

(AutoPeak 피크 수) 알고리즘에서 검출된
인접 콘볼루션 피크의 수를 표시합니다.

AutoPeak 통합 알고리즘을 사용하는 처
리 방법에만 적용할 수 있습니다.

숫자 N

AutoPeak Peak
Width
Confidence

(AutoPeak 피크 폭 신뢰도) 피크 폭의 신
뢰 수준을 표시합니다. 값이 1이면 실제
피크 폭과 예상 피크 폭이 같음을 나타냅
니다. 값이 1보다 크면 실제 피크 폭이 예
상 피크 폭보다 크다는 것을 나타냅니다.
값이 1보다 작으면 실제 피크 폭이 예상
피크 폭보다 작거나, 크로마토그래픽 조
건의 변화로 인해 피크가 더 넓다는 것을
나타냅니다.

AutoPeak 통합 알고리즘을 사용하는 처
리 방법에만 적용할 수 있습니다.

숫자 N

AutoPeak
Saturated acc

(AutoPeak 포화) Saturation correction
옵션을 사용하고 해당 피크가 포화되어
적합 모델이 피크를 넘어 확장되면 이 필
드에 Yes(예)가 표시됩니다. 그렇지 않으
면 열이 비어 있습니다. 농도가 더 높은 샘
플의 정확도 및 %CV가 허용 범위 내에 없
으면 Saturation correction을 조정하십
시오.

AutoPeak 통합 알고리즘을 사용하는 처
리 방법에만 적용할 수 있습니다.

텍스트 N

Barcode (바코드) 샘플의 고유 ID를 표시합니다.
고유 ID는 데이터 획득에 사용되는 배치
에 원래 지정된 값에서 초기화됩니다.

Barcode는 최대 20자까지 포함할 수 있
습니다. Barcode에는 \ / : * ? " < > |= 같
은 유효하지 않은 문자 또는 ASCII 테이
블의 0 ~ 31 문자를 사용할 수 없습니다.

텍스트 Y

Baseline Delta/
Height

(기준선 델타/높이) 피크 시작 지점과 종
료 지점의 기준선 간 높이 차이의 절대값
과 실제 피크 높이를 표시합니다. 값이
0.1보다 크면 기준선이 올바르게 통합되
지 않았으며 피크를 검토해야 함을 나타
냅니다.

숫자 N
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레이블 설명 형식 LIS 지원

Calculated
Concentration

(계산된 농도) 농도가 알려진 표준 샘플의
경우 교정 곡선에서 역으로 계산된 농도
의 값을 표시합니다. 회귀 수식은 다양한
회귀 유형 및 가중치에 대해 회귀가 수행
되는 방식을 설명합니다.

숫자 Y

Combined Score (합계 점수) (선택 사항) 상대적 비교를 위
해 사용할 수 있는 단일 숫자 점수를 표시
합니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 N

Comparison (비교) 비교 샘플의 구성 요소를 표시합니
다.

숫자 N

Component
Comment

(구성 요소 메모) 모든 샘플에 적용되는
분석 물질 또는 내부 표준에 대한 임의의
메모를 표시합니다.

텍스트 N

Component
Group Name

(구성 요소 그룹 이름) 분석 물질 또는 내
부 표준과 관련된 그룹 이름을 표시합니
다.

텍스트 N

Component
Index

(구성 요소 색인) 원래 처리 방법에서 분
석 물질 또는 내부 표준의 색인을 표시합
니다.

숫자 Y

Component
Name

(구성 요소 이름) 분석 물질 또는 내부 표
준의 이름을 표시합니다.

이 열은 Results Table에 항상 표시됩니
다. Column Settings 대화 상자에서 확인
란을 사용할 수 없습니다.

Component Name은 최대 50자까지 포
함할 수 있습니다.

참고:

• Component Name은 처리 방법에서
만 변경할 수 있으며 Results Table에
서는 변경할 수 없습니다.

• 이 열은 실험실 정보 관리 시스템
(LIMS) 전송에 필수입니다.

텍스트 Y

Component
Type

(구성 요소 유형) 분석 물질 유형
(Quantifier, Qualifier 또는 Internal
Standard)을 표시합니다.

텍스트 N
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레이블 설명 형식 LIS 지원

Conc. Units (농도 단위) 농도 단위를 표시합니다. 텍스트 Y

Concentration
Acceptance

(농도 수락) 계산된 농도의 수락 상태를
표시합니다.

숫자 N

Concentration
Ratio

(농도비) 내부 표준을 사용하는 분석 물질
의 경우 Actual Concentration 대 IS
Actual Concentration 비율을 표시합니
다. 내부 표준 또는 내부 표준이 없는 분석
물질의 경우 이 값은 N/A(해당 없음)로 설
정됩니다.

숫자 N

Difference from
Average Sample
Time

(평균 샘플 시간과의 차이) 이 샘플의 분
석 시간과 모든 샘플의 평균 분석 시간 사
이의 차이를 표시합니다.

숫자 N

Dilution Factor (희석배율) 샘플이 희석된 기준 배율을 표
시합니다. 이 값은 교정 곡선 계산에 사용
됩니다.

숫자 Y

End Time (종료 시간) 검출된 피크의 종료 머무름
시간(분)을 표시합니다.

숫자 Y

End Time at 10% (10%에서 종료 시간) 피크 뒤쪽에서 강도
가 피크 높이의 10%일 때의 시간(분)을
표시합니다.

숫자 N

End Time at 5% (5%에서 종료 시간) 피크 뒤쪽에서 강도
가 피크 높이의 5%일 때의 시간(분)을 표
시합니다.

숫자 N

Expected Ion
Ratio

(예상 이온비) 알 수 없는 샘플, QC 샘플
및 표준 샘플의 예상 이온비를 표시합니
다.

그룹에 포함된 각 구성 요소의 경우,
Expected Ion Ratio는 해당 표준의 평균
이온비입니다. 다음과 같은 경우에는 구
성 요소의 Expected Ion Ratio 계산에 표
준이 포함되지 않습니다.

1. 피크 영역이 해당 없음인 경우

2. Use 열이 선택되지 않은 경우

숫자 Y

Expected RT (예상 RT) 처리 방법의 원래 예상 머무름
시간(분)을 표시합니다.

숫자 Y
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레이블 설명 형식 LIS 지원

Expected MW (예상 분자량) 처리 방법의 원래 예상 분
자량(Da)을 표시합니다.

질량 재구성 워크플로에만 적용할 수 있
습니다.

숫자 Y

Formula (수식) (선택 사항) 유효한 화학식을 표시
합니다. 잘못된 화학식은 소프트웨어에서
유지하지 않습니다. 화학식이 유효하면
Mass (Da) 및 Isotope 열이 자동으로 채
워집니다.

텍스트 Y

Formula
Confidence

(수식 신뢰도) Formula Finder Score의
신뢰 수준을 백분율로 표시합니다. 이 값
은 다음을 기반으로 계산됩니다.

• 현재 MS 스펙트럼이 질량을 기준으로
화합물에 대한 이론적 스펙트럼과 얼
마나 적합한지 확인

• 획득한 MS/MS 스펙트럼이
LibraryView 소프트웨어 데이터베이스
에서 발견한 MS/MS 스펙트럼과 얼마
나 적합한지 확인

MS 스펙트럼 점수는 MS/MS 스펙트럼 점
수의 두 배의 가중치를 갖습니다.

정성적 워크플로에만 적용할 수 있습니
다.

텍스트 N

Formula Finder (Formula Finder) 상대적 비교를 위해 사
용할 수 있는 단일 숫자 점수를 표시합니
다. 이 값은 Peak Review Formula Finder
Results Table의 데이터를 사용하여 업데
이트할 수 있습니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 N

Formula Finder
Results

(Formula Finder 결과) (선택 사항)
Formula Finder 결과에서 가장 일치하는
항목을 표시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

텍스트 N

Formula Finder
Score

(Formula Finder 점수) (선택 사항) 상대적
비교를 위해 사용할 수 있는 단일 숫자 점
수를 표시합니다.

숫자 Y

작동 지침—처리
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Found at
Fragment

(단편에서 발견) (선택 사항) 일치하는 스
펙트럼이 발견된 최적 요구 Fragment
Mass (Da)를 표시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 Y

Found at Mass (질량에서 발견) (선택 사항) 일치하는 스
펙트럼이 발견된 최적 요구 Extraction
Mass (Da)를 표시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 Y

Fragment Mass (단편 질량) (선택 사항) 방법에 지정된 단
편 질량을 표시합니다. 단편의 전구체는
Extraction Mass (Da) 열의 MS/MS에서
추출됩니다. 지정할 경우 이 값은 숫자여
야 합니다.

숫자 Y

Fragment Mass
Error (ppm)

(단편 질량 오차(ppm)) (선택 사항) Found
at Fragment와 Fragment Mass 간의 값
차이(ppm)를 표시합니다.

숫자 Y

Fragment Mass
Error (mDa)

(단편 질량 오차(mDa)) (선택 사항)
Found at Fragment와 Fragment Mass 간
의 값 차이(mDa)를 표시합니다.

숫자 Y

Fragment Mass
Error
Confidence

(단편 질량 오차 신뢰도) (선택 사항) 단편
질량 오차의 신뢰 수준을 표시합니다.

텍스트 Y

Height (높이) 검출된 피크 높이를 표시합니다.
피크가 검출되지 않은 경우 이 값은
N/A(해당 없음)로 설정됩니다.

숫자 Y

Height Ratio (높이비) 내부 표준을 사용하는 분석 물질
의 경우 Height 대 IS Height 비율을 표시
합니다. 내부 표준 또는 내부 표준이 없는
분석 물질의 경우 이 값은 N/A(해당 없음)
로 설정됩니다.

숫자 Y

Index (색인) 행 색인을 정렬되지 않은 원래 순
서로 표시합니다. 다른 열을 기준으로 테
이블이 정렬된 경우 이 열에서 정렬하여
원래 순서로 되돌릴 수 있습니다.

숫자 N

Injection Volume (주입량) 방법에 저장되어 있고 오토샘플
러로 주입한 샘플의 양을 표시합니다.

숫자 Y
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Integration
Acceptance

(통합 수용) 피크 통합이 수용 기준에 얼
마나 근접한지 보여줍니다. 이 값은 플래
그 지정 규칙에 구성된 다음 요소를 기반
으로 계산됩니다.

• 통합 품질

• 비대칭 인자

• 총 피크 폭(분)

• 머무름 시간 오차(백분율 또는 분 단위
로 측정됨)

숫자 N

Integration Type (통합 유형) 통합 유형을 표시합니다.

• Baseline: 일반적인 방식으로 통합된
독립형 피크입니다.

• Valley: 인접한 두 개의 피크가 있고 신
호가 두 피크 간의 기준선 값으로 돌아
오지 않았음을 나타냅니다.

• N/A(해당 없음): 피크가 검출되지 않았
음을 나타냅니다.

• Manual: 피크가 수동으로 통합되었음
을 나타냅니다.

텍스트 Y

작동 지침—처리
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Ion Ratio (이온비) 이온비를 표시합니다. 이온비는
단일 분석 물질에서 두 개 이상의 MRM
전이가 그룹에 수집될 때 결정됩니다.

그룹의 모든 분석 물질은 분석 물질 하위
그룹을 구성합니다. 그룹의 모든 내부 표
준은 IS 하위 그룹을 구성합니다. 하위 그
룹의 첫 번째 구성 요소는 정량자 이온으
로 사용됩니다. 하위 그룹의 나머지 구성
요소는 정성자 이온으로 사용됩니다.

이온비 = (정성자의 피크 면적 또는 높
이)/(정량자의 피크 면적 또는 높이)

피크 면적 또는 피크 높이에 대해 이온비
를 계산할 수 있습니다. 처리 방법이 첫 번
째 구성 요소, 즉 Results Table에서 구성
요소 색인이 1인 구성 요소의 회귀에 대해
면적을 사용하는 경우 피크 면적을 사용
하여 전체 Results Table의 이온비를 계산
합니다. 높이가 첫 번째 구성 요소의 회귀
에 사용되는 경우 피크 높이가 계산에 사
용됩니다.

• 구성 요소가 그룹에 포함되어 있지 않
으면 Ion Ratio 값이 N/A(해당 없음)로
설정됩니다.

• 피크가 발견되지 않으면 Ion Ratio 값
이 N/A(해당 없음)로 설정됩니다.

• 이온비가 분석 물질 하위 그룹과 IS 하
위 그룹 둘 다의 모든 구성 요소에 적용
되면 정성자가 정량자입니다.

• 정량자 피크 또는 정성자 피크에 대한
통합이 변경되면 이온비가 다시 계산
됩니다.

참고: 사용자는 이온비에 대한 플래그 지
정 규칙을 처리 방법에 정의할 수 있습니
다.

숫자 Y

Ion Ratio
Acceptance

(이온비 수락) 이온비의 수락 상태를 표시
합니다.

숫자 N

작동 지침—처리
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Ion Ratio
Confidence

(이온비 신뢰도) 이온비의 신뢰 수준을 표
시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

텍스트 N

IS (내부 표준) 행이 내부 표준인지 여부를
표시합니다. 확인란이 선택되면 행의 구
성 요소가 분석 물질이 아니라 내부 표준
임을 나타냅니다.

참고: 이름에 .heavy 또는 -cis가 포함된
샘플은 단백질체학 워크플로에서 내부 표
준으로 정의되므로 이러한 샘플의 경우
IS 확인란이 자동으로 선택됩니다. 다른
워크플로에서는 내부 표준이 아니므로 IS
확인란을 선택 취소해야 합니다.

숫자 N

IS Actual
Concentration

(IS 실제 농도) 현재 분석 물질과 관련된
내부 표준의 실제 농도를 표시합니다. 내
부 표준 또는 내부 표준이 없는 분석 물질
의 경우 이 값은 N/A(해당 없음)로 설정됩
니다.

숫자 N

IS Area (IS 면적) 현재 분석 물질과 관련된 내부
표준의 면적을 표시합니다. 내부 표준 또
는 내부 표준이 없는 분석 물질의 경우 이
값은 N/A(해당 없음)로 설정됩니다.

숫자 N

IS Area / Height (IS 면적/높이) 현재 분석 물질과 관련된
내부 표준의 IS Area 대 IS Height 비율을
표시합니다. 내부 표준 또는 내부 표준이
없는 분석 물질의 경우 이 값은 N/A(해당
없음)로 설정됩니다.

숫자 N

IS Baseline
Delta / Height

(IS 기준선 델타/높이) 피크 시작 지점과
종료 지점의 기준선 간 높이 차이의 절대
값과 내부 표준의 실제 피크 높이를 표시
합니다. 값이 0.1보다 크면 기준선이 올바
르게 통합되지 않았으며 피크를 검토해야
함을 나타냅니다.

숫자 N

IS Comment (IS 메모) 현재 분석 물질과 관련된 내부
표준에 대한 임의의 메모를 표시합니다.
내부 표준 또는 내부 표준이 없는 분석 물
질의 경우 이 값은 N/A(해당 없음)로 설정
됩니다.

텍스트 N
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IS End Time (IS 종료 시간) 현재 분석 물질과 관련된
내부 표준에 대해 획득이 끝나는 시간을
표시합니다. 내부 표준 또는 내부 표준이
없는 분석 물질의 경우 이 값은 N/A(해당
없음)로 설정됩니다.

숫자 N

IS Expected MW (IS 예상 분자량) 현재 분석 물질과 관련
된 내부 표준의 예상 분자량(Da)을 표시
합니다. 내부 표준 또는 내부 표준이 없는
분석 물질의 경우 이 값은 N/A(해당 없음)
로 설정됩니다.

질량 재구성 워크플로에만 적용할 수 있
습니다.

숫자 Y

IS Expected RT (IS 예상 머무름 시간) 현재 분석 물질과
관련된 내부 표준의 예상 머무름 시간을
표시합니다. 내부 표준 또는 내부 표준이
없는 분석 물질의 경우 이 값은 N/A(해당
없음)로 설정됩니다.

숫자 N

IS Height (IS 높이) 현재 분석 물질과 관련된 내부
표준의 높이를 표시합니다. 내부 표준 또
는 내부 표준이 없는 분석 물질의 경우 이
값은 N/A(해당 없음)로 설정됩니다.

숫자 N

IS Integration
Type

(IS 통합 유형) 현재 분석 물질과 관련된
내부 표준의 통합 유형을 표시합니다. 내
부 표준 또는 내부 표준이 없는 분석 물질
의 경우 이 값은 N/A(해당 없음)로 설정됩
니다.

텍스트 N

IS Mass Info (IS 질량 정보) 현재 분석 물질과 관련된
내부 표준의 질량 정보를 표시합니다. 내
부 표준 또는 내부 표준이 없는 분석 물질
의 경우 이 값은 N/A(해당 없음)로 설정됩
니다.

텍스트 N

IS MW (IS 분자량) 현재 분석 물질과 관련된 내
부 표준에 대해 발견된 분자량(Da)을 표
시합니다. 내부 표준 또는 내부 표준이 없
는 분석 물질의 경우 이 값은 N/A(해당 없
음)로 설정됩니다.

질량 재구성 워크플로에만 적용할 수 있
습니다.

숫자 N
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IS MW Delta (Da) (IS MW 델타(Da)) 내부 표준에 대한 예상
분자량과 발견된 분자량 사이의 차이(Da)
를 표시합니다.

질량 재구성 워크플로에만 적용할 수 있
습니다.

숫자 Y

IS MW Delta
(ppm)

(IS MW 델타(ppm)) 내부 표준에 대한 예
상 분자량과 발견된 분자량 사이의 차이
(ppm)를 표시합니다.

질량 재구성 워크플로에만 적용할 수 있
습니다.

숫자 Y

IS Name (IS 이름) 현재 분석 물질과 관련된 내부
표준의 이름을 표시합니다. 내부 표준 또
는 내부 표준이 없는 분석 물질의 경우 이
값은 N/A(해당 없음)로 설정됩니다.

텍스트 N

IS Peak
Comment

(IS 피크 메모) 현재 분석 물질과 관련된
내부 표준에 대한 피크 메모를 표시합니
다. 내부 표준 또는 내부 표준이 없는 분석
물질의 경우 이 값은 N/A(해당 없음)로 설
정됩니다.

텍스트 N

IS Quality (IS 품질) 현재 분석 물질과 관련된 내부
표준의 품질을 표시합니다. 내부 표준 또
는 내부 표준이 없는 분석 물질의 경우 이
값은 N/A(해당 없음)로 설정됩니다.

숫자 N

IS Region
Height

(IS 영역 높이) 내부 표준 영역의 높이를
표시합니다. 내부 표준 또는 내부 표준이
없는 분석 물질의 경우 이 값은 N/A(해당
없음)로 설정됩니다.

숫자 N

IS Retention
Time

(IS 머무름 시간) 현재 분석 물질과 관련
된 내부 표준의 머무름 시간을 표시합니
다. 내부 표준 또는 내부 표준이 없는 분석
물질의 경우 이 값은 N/A(해당 없음)로 설
정됩니다.

숫자 N

IS Signal / Noise (IS 신호/노이즈) 현재 분석 물질과 관련
된 내부 표준의 신호 대 노이즈 비율을 표
시합니다. 내부 표준 또는 내부 표준이 없
는 분석 물질의 경우 이 값은 N/A(해당 없
음)로 설정됩니다.

숫자 N
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IS Start Time (IS 시작 시간) 현재 분석 물질과 관련된
내부 표준의 시작 시간을 표시합니다. 내
부 표준 또는 내부 표준이 없는 분석 물질
의 경우 이 값은 N/A(해당 없음)로 설정됩
니다.

숫자 N

IS Total Width (IS 총 폭) 현재 분석 물질과 관련된 내부
표준의 총 폭을 표시합니다. 내부 표준 또
는 내부 표준이 없는 분석 물질의 경우 이
값은 N/A(해당 없음)로 설정됩니다.

숫자 N

IS Width at 50% (50%의 IS 폭) 50% 지점에서 현재 분석
물질과 관련된 내부 표준의 폭을 표시합
니다. 내부 표준 또는 내부 표준이 없는 분
석 물질의 경우 이 값은 N/A(해당 없음)로
설정됩니다.

숫자 N

Isotope
Confidence

(동위 원소 신뢰도) 동위 원소 비율의 신
뢰 수준을 표시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

텍스트 N

Isotope Ratio
Difference

(동위 원소 비율) 수식에 기초한 이론적
동위 원소 패턴과 획득한 스펙트럼의 동
위 원소 패턴 간 차이를 식별합니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 N

LC Method (LC 방법) 데이터 획득에 사용되는 LC 방
법의 이름을 표시합니다.

텍스트 N

Library
Confidence

(라이브러리 신뢰도) 적중의 Library
Score를 기반으로 Library Hit의 신뢰 수
준을 표시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

텍스트 N

Library Hit (라이브러리 적중) 최적의 라이브러리 일
치, 즉 순도 점수가 가장 높고 요청한 수식
과 일치하는 수식을 가진 화합물의 이름
을 표시합니다.

이 값은 Peak Review Library Search
Result 그리드의 데이터를 사용하여 업데
이트할 수 있습니다. 정성적 워크플로에
만 적용할 수 있습니다.

텍스트 N

작동 지침—처리
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Library Score (라이브러리 점수) 라이브러리 일치가 발
견된 질량에 얼마나 잘 맞는지를 보여줍
니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 N

Mass Error
(ppm)

(질량 오차(ppm)) 발견된 질량과 추출 질
량 간의 차이를 백만분율(ppm) 단위로 표
시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 N

Mass Error
(mDa)

(질량 오차(mDa)) 발견된 질량과 추출 질
량 간의 차이를 milliDalton(mDa) 단위로
표시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 N

Mass Error
Confidence

(질량 오차 신뢰도) 질량 오차의 신뢰 수
준을 표시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

텍스트 N

Mass Info (질량 정보) 구성 요소와 관련된 질량 정
보를 표시합니다.

• MRM 실험의 경우 Q1/Q3이며 프로필
(전체 스캔) 실험의 경우 Start - Stop입
니다.

• UV, ADC 또는 DAD 실험에서는 파장
(DAD) 또는 채널 정보(UV/ADC)입니
다.

단편 질량이 있는 경우 이를 XIC 추출에
사용할 수 있습니다.

단편 질량이 없는 경우 전구체 질량을
XIC 추출에 사용해야 합니다.

텍스트 Y

Modified (수정됨) 피크 찾기 매개 변수가 수정되었
는지 여부를 표시합니다. 확인란을 선택
하면 Peak Review 창을 사용하여 처리 방
법의 피크 찾기 매개 변수가 수정되었음
을 나타냅니다.

숫자 Y

작동 지침—처리
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MS Method (MS 방법) 데이터 획득에 사용되는 MS
방법의 이름을 표시합니다.

텍스트 N

MW (MW) 재구성된 그래프에서 분석 물질의
발견된 분자량(Da)을 표시합니다.

질량 재구성 워크플로에만 적용할 수 있
습니다.

숫자 Y

MW Delta (Da) (MW 델타(Da)) 예상 분자량과 발견된 분
자량 사이의 차이(Da)를 표시합니다.

질량 재구성 워크플로에만 적용할 수 있
습니다.

숫자 Y

MW Delta (ppm) (MW 델타(ppm)) 예상 분자량과 발견된
분자량 사이의 차이(ppm)를 표시합니다.

질량 재구성 워크플로에만 적용할 수 있
습니다.

숫자 Y

Non-Targeted
Peak

(비표적 피크) Enhanced Peak Finder에
의해 피크가 발견되었는지 여부를 나타냅
니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 N

Operator Name (작업자 이름) 샘플을 획득한 기기 작업자
의 이름을 표시합니다.

텍스트 Y

Original
Filename

(원래 파일 이름) 파일 이름을 표시합니
다.

텍스트 Y

작동 지침—처리
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Outlier Reasons (이상값 이유) 정량화 방법에 이상값 자동
제거가 활성화된 경우 구성 요소에 대해
미리 정해진 한계를 벗어난 것으로 확인
된 기준을 표시합니다.

Outlier Reasons 열은 정량화 방법에서
이상값 자동 제거 규칙에 연결됩니다. 이
열은 Results Table에서 사전 설정된 열입
니다.

이상값에 플래그가 지정되는 이유:

• 정확도

• 농도

• 이온비

정량자 또는 정성자 중 하나에만 피크
가 있는 경우 두 구성 요소에 모두 이온
비 플래그가 지정됩니다. 모든 구성 요
소에 피크가 없는 경우 어느 구성 요소
에도 이온비 플래그가 지정되지 않습
니다.

• 예상 이온비를 계산할 수 없음

• 사용자가 생성한 플래그 지정 규칙 실
패

텍스트 N

Peak Comment (피크 메모) 행에 대한 임의의 메모를 표
시합니다.

텍스트 N

Plate Number (플레이트 번호) Batch Editor에 표시된 대
로 데이터 획득에 사용되는 오토샘플러의
플레이트 번호를 표시합니다.

텍스트 Y

Points Across
Baseline

(기준선에서 전체 요소) 피크 전체의 스캔
수를 표시합니다.

숫자 N

Points Across
Half Height

(절반 높이에서 전체 요소) 높이의 약
50%에서 피크 전체의 스캔 수를 표시합
니다.

숫자 N

Polarity (극성) 샘플 획득에 사용되는 실험의 극성
을 표시합니다.

텍스트 N

작동 지침—처리
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Precursor Mass (전구체 질량) 처리 방법에서 가져온 처리
입력 매개 변수를 표시합니다.

이 열은 Results Table에 항상 표시됩니
다. Column Settings 대화 상자에서 확인
란을 사용할 수 없습니다.

숫자 N

Proc. Method
Name

(처리 방법 이름) Results Table을 생성한
처리 방법의 이름을 표시합니다.

텍스트 Y

Quality (품질) 통합 피크의 품질을 표시합니다.
통합 피크 면적과 더 큰 RT 범위의 면적이
비교됩니다. 값이 0이면 피크가 제대로 통
합되지 않았거나 피크가 없음을 나타냅니
다. 값이 1.0이면 피크가 잘 통합되어 검
토할 필요가 없음을 나타냅니다.

숫자 N

Rack Number (랙 번호) Batch Editor에 지정된 대로 데
이터 획득에 사용되는 오토샘플러의 랙
번호를 표시합니다.

텍스트 Y

Region Height (영역 높이) 검출된 피크 주변에서 최대
피크의 피크 높이를 표시합니다. Quality
필드와 함께 사용하면 유용합니다. 품질
이 낮지만 Region Height 값은 적절한 피
크도 검토해야 합니다. Region Height 값
이 작으면 유의한 피크가 없습니다.

숫자 N

Relative RT (상대 RT) 내부 표준을 사용하는 분석 물
질의 경우 Retention Time 대 IS
Retention Time의 비율을 표시합니다.
내부 표준 또는 내부 표준이 없는 분석 물
질의 경우 이 값은 N/A(해당 없음)로 설정
됩니다.

숫자 Y

Reportable (보고 가능) 결과가 보고서, 내보내기 및
LIMS 전송에 포함되는지 여부를 표시합
니다.

숫자 Y

Retention Time (머무름 시간) 검출된 피크의 실제 머무름
시간(분)을 표시합니다.

숫자 Y

Retention Time
Delta (min)

(머무름 시간 델타) 질량에 정의된 머무름
시간과 실제 머무름 시간의 차이를 표시
합니다.

숫자 N

작동 지침—처리
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Retention Time
Error (%)

(머무름 시간 오차(%)) "Found at RT"와
"Expected RT" 간의 백분율 오차를 표시
합니다.

정성적 워크플로에만 적용할 수 있습니
다.

숫자 N

RT Confidence (RT 신뢰도) 머무름 시간의 신뢰도를 표
시합니다.

정성적 워크플로에만 적용할 수 있습니
다.

텍스트 N

Sample
Comment

(샘플 메모) 샘플에 대한 사용자 지정 메
모를 표시합니다.

텍스트 Y

Sample ID (샘플 ID) 샘플에 대한 사용자 지정 ID를
표시합니다. Sample ID는 획득을 위해 샘
플을 제출하기 전에 Batch Editor에서 지
정됩니다.

처리 방법에서 표준 추가 워크플로가 활
성화된 경우 Sample ID는 각 표준 추가
그룹의 그룹 ID로 사용됩니다. SCIEX OS
는 농도를 알 수 없는 분석 물질이 포함된
각 샘플을 알려진 다양한 농도의 동일 분
석 물질이 추가된 샘플에 연결합니다.

Sample ID는 최대 252자까지 포함할 수
있습니다. Sample ID에는 \ / : * ? " < > |=
같은 유효하지 않은 문자 또는 ASCII 테
이블의 0 ~ 31 문자를 사용할 수 없습니
다.

텍스트 Y

Sample Index (샘플 색인) 현재 샘플의 색인을 표시합니
다.

참고: 이 열은 잠겨 있으며 항상 Results
Table의 왼쪽에 표시됩니다.

숫자 Y

작동 지침—처리
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Sample Name (샘플 이름) 샘플에 대한 사용자 지정 이
름을 표시합니다. Sample Name은 획득
을 위해 샘플을 제출하기 전에 Batch
Editor에서 지정됩니다.

Sample Name은 1자에서 252자 사이여
야 합니다. Sample Name에는 \ / : * ? " <
> |= 같은 유효하지 않은 문자 또는 ASCII
테이블의 0 ~ 31 문자를 사용할 수 없습니
다.

참고: 이 열은 잠겨 있으며 항상 Results
Table의 왼쪽에 표시됩니다.

텍스트 Y

Sample Type (샘플 유형) 샘플 유형을 표시합니다. 텍스트 Y

Scanned
Barcode

(스캔한 바코드) 주입 전에 스캔한 바코드
를 표시합니다.

텍스트 Y

Signal / Noise (신호/노이즈) 검출된 피크의 피크 높이
대 크로마토그램에 있는 노이즈의 비율
추정값을 표시합니다.

AutoPeak 통합 알고리즘의 경우 계산된
상대 노이즈 및 피크 정점 위치의 기준선
을 사용하여 노이즈를 추정합니다. MQ4
알고리즘은 유사한 접근 방법을 사용하지
만 전체 크로마토그램을 이용하여 기준선
을 추정합니다.

숫자 Y

Slope of
Baseline

(기준선 기울기) 기준선에서 통합 피크의
기울기를 표시합니다.

((피크 중지 지점의 강도) – (피크 시작 지
점의 강도)) ÷ 피크 폭

숫자 N

Start Time (시작 시간) 검출된 피크의 시작 머무름
시간(분)을 표시합니다.

숫자 Y

Start Time at
10%

(10%에서 시작 시간) 피크 앞쪽에서 강도
가 피크 높이의 10%일 때의 시간(분)을
표시합니다.

숫자 N

Start Time at 5% (5%에서 시작 시간) 피크 앞쪽에서 강도
가 피크 높이의 5%일 때의 시간(분)을 표
시합니다.

숫자 N

작동 지침—처리
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Std Addition
Accuracy

(표준 추가 정확도) 다양한 농도의 표준을
추가하여 정량화된 알려진 농도의 샘플
정확도를 표시합니다. 처리 방법에서 표
준 추가 워크플로가 활성화되면 모든 샘
플의 Sample Type이 자동으로 Standard
로 설정됩니다. Sample Type가 다른 유
형으로 변경되거나, 표준 추가 워크플로
가 활성화되지 않으면 이 값이 N/A(해당
없음)로 설정됩니다. 배치의 품질 관리 샘
플과 같이 농도가 알려진 샘플의 경우
Std Addition Accuracy는 다음과 같이
정의됩니다.

100% x (Std Addition Calculated
Concentration)/(Std Addition Actual
Concentration)

숫자 N

Std Addition
Actual
Concentration

(표준 추가 실제 농도) 표준 추가로 정량
화된 샘플의 알려진 사용자 지정 예상 농
도를 표시합니다. 배치의 품질 관리 샘플
을 예로 들 수 있습니다. Sample Type가
Standard가 아니면 이 값이 N/A(해당 없
음)로 설정됩니다.

숫자 N

Std Addition
Calculated
Concentration

(표준 추가 계산된 농도) 가중치 없는 선
형 회귀를 통해 X 절편에 대해 표준 추가
곡선을 추론하여 역으로 계산된 농도의
값을 표시합니다. 표준 추가로 정량화된
샘플의 경우 Std Addition Calculated
Concentration은 다음과 같이 정의됩니
다.

Intercept/Slope

Sample Type가 Standard가 아니거나,
처리 방법에서 표준 추가 워크플로가 활
성화되지 않았거나, 표준 추가 그룹의 스
파이크되지 않은 샘플에 피크가 없으면
이 값이 N/A(해당 없음)로 설정됩니다.

숫자 N

Tailing Factor (대칭 인자) 피크 앞면 기울기와 뒷면 기
울기 사이의 거리를 피크 중심선과 앞면
기울기 사이 거리의 두 배로 나눈 값을 표
시합니다. 모든 값은 최대 피크 높이의
5%에서 측정됩니다.

숫자 N

Time Since First
Sample (min)

(첫 번째 샘플 이후 지난 시간(분)) 첫 번
째 샘플 획득이 시작된 후 경과한 시간
(분)을 표시합니다.

숫자 N
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레이블 설명 형식 LIS 지원

Time Since Last
Sample (sec)

(마지막 샘플 이후 시간(초)) 마지막 샘플
획득이 시작된 후 경과한 시간(초)을 표시
합니다.

숫자 N

Total Width (총 폭) 기준선에서 크로마토그래픽 피크
폭(분)을 표시합니다.

숫자 Y

Used (사용) 결과 사용 여부를 표시합니다.

• 모든 샘플의 경우 확인란이 선택되면
결과가 참조 값 계산 및 플래그 지정 규
칙 실행에 사용됨을 나타냅니다.

• 표준 샘플의 경우 확인란이 선택되면
결과가 교정 곡선 생성, 회귀 및 통계
계산에 사용됨을 나타냅니다.

• QC 샘플의 경우 확인란이 선택되면 결
과가 품질 관리 통계 계산에 사용됨을
나타냅니다.

• 다른 샘플 유형의 경우 확인란이 선택
되면 결과가 계산에 사용됨을 나타냅
니다.

숫자 Y

Vial Number (바이알 번호) 배치에 원래 지정된 대로
데이터 획득에 사용되는 오토샘플러의 바
이알 번호를 표시합니다.

텍스트 Y

Width at 10% (10%의 폭) 피크 높이의 10% 지점에서
측정한 피크 폭을 표시합니다.

숫자 N

Width at 5% (5%의 폭) 피크 높이의 5% 지점에서 측정
한 피크 폭을 표시합니다.

숫자 N

Width at 50% (50%의 폭) 검출된 피크에 대해 정점 강
도의 절반 지점에서 측정한 크로마토그래
픽 피크 폭(분)을 표시합니다.

숫자 Y

XIC Width (Da) (XIC 폭(Da)) 추출된 이온 크로마토그램
의 폭을 Da(달톤) 단위로 표시합니다.

숫자 Y

XIC Width (ppm) (XIC 폭(ppm)) 추출된 이온 크로마토그램
의 폭을 ppm(백만분율) 단위로 표시합니
다.

숫자 Y

수락 필터
Results Table 열에 Filter 메뉴의 Filter by Flag 옵션을 사용하여 수락 기준에 따라 열을 필터
링할지 여부를 선택합니다. Results Table을 다음과 같은 수락 기준에 따라 필터링할 수 있습
니다.
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• Pass: 처리 방법에 정의된 기준과 일치하는 행을 표시합니다.

• Fail: 처리 방법에 정의된 기준과 일치하지 않는 행을 표시합니다.

그림 6-26 Filter By Flag

플래그 지정 규칙이 적용된 열에 다음 수락 기준 및 수락 필터를 선택할 수 있습니다.

• Accuracy

• Accuracy Acceptance

• Asymmetry Factor

• Calculated Concentration

• Concentration Acceptance

• Integration Acceptance

• Quality

• Retention Time Delta (min)

• Retention Time Error (%)

• Total Width

신뢰도 신호등
수락 기준을 사용하여 선별 행을 정의할 수 있습니다. 선별 행은 수락 기준이 처리 방법에 정의
된 기준과 일치하는 행입니다.
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그림 6-27 선별 행

신호등은 Qualitative 규칙 또는 Ion Ratio Acceptance 규칙이 적용되는 각 행의 신뢰도 상태를
표시합니다. 플래그 지정 규칙에 대한 정보는 도움말 시스템 문서를 참조하십시오.

팁! 신뢰도 신호등 필터를 사용하여 Results Table을 필터링할 수 있습니다. Results Table을
신뢰도 필터와 일치하는 행 보기와 일치하지 않는 행 보기 간에 전환하려면 Qualify for Rules
Filters 확인란을 선택하십시오. 신뢰도 필터에는 Pass, Marginal, Fail 및 해당 없음가 포함됩
니다.

표 6-6 신뢰도 신호등

신호등 아이콘 설명

처리 방법에 정의된 신뢰 수준을 충족하는 구성 요소를 표시합니다.

어떤 구성 요소가 처리 방법에서 정의된 마진 백분율 차이 수준을 충족하는
지 나타냅니다.

어떤 구성 요소가 처리 방법에서 정의된 미수락 백분율 차이 수준을 충족하
는지 나타냅니다.

구성 요소에 적용되지 않는 신뢰도 매개 변수를 표시합니다.

구성 요소 및 그룹 목록
Results Table이 열리면 현재 구성 요소 및 그룹 목록이 주 창의 왼쪽에 나타납니다. 이 목록을
사용하면 연결된 Peak Review 또는 Calibration Curve 창뿐만 아니라 결과에 표시되는 구성
요소를 변경할 수 있습니다. 모든 정보는 처리 방법에 정의된 대로 표시됩니다.

작동 지침—처리

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
142/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



그림 6-28 구성 요소 및 그룹

목록에서 개별 항목을 클릭해 각 항목에 대한 구성 요소만 나타냅니다. 두 가지 특정 분석 물질
과 같이 여러 항목을 선택하려면 Shift+클릭 또는 Ctrl+클릭을 사용합니다.

팁! 창의 오른쪽 가장자리를 왼쪽 또는 오른쪽으로 끌어 목록의 폭을 변경할 수 있습니다.

Results Table에서 행 순서는 필터링에 영향을 받지 않습니다. 이 표는 처리 방법에 지정된 순
서에 따라 처음에 샘플별로 정렬된 후 구성 요소별로 정렬되도록 사전 설정되어 있습니다.
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표 6-7 옵션

레이블 설명

Show IS (IS 표시) Results Table에서 현재 선택된 분석 물질과 이에 해당하는 내부 표
준 둘 다에 대한 행을 표시하려면 클릭합니다. 이 옵션은 Ctrl 키를 누른 채로
분석 물질을 클릭한 후 내부 표준을 클릭하여 둘 다 선택하는 것과 같습니다.

Find (찾기) 지정된 텍스트와 일치하는 항목을 목록에서 찾으려면 클릭합니다.

피크 검토
선행 절차

• Results Table을 엽니다.

Peak Review 창을 사용하여 다음을 수행할 수 있습니다.

• 피크 찾기 프로세스의 품질을 확인할 수 있도록 원시 크로마토그램을 시각적으로 검사합니
다.

• 피크 찾기 매개 변수를 조정하거나 통합의 시작 및 종료 지점을 수동으로 선택하여 올바르
게 통합되지 않은 크로마토그램을 수정합니다. 크로마토그램이 재통합된 후, Results Table
은 새 피크 영역 및 다른 매개 변수와 함께 자동 업데이트됩니다.

• 통합 XIC에 대한 MS 및 MS/MS 스펙트럼을 육안으로 검사합니다.

• Formula Finding 결과와 Library Search 결과를 검토하고 필요한 경우 Results Table에서 수
동으로 결과를 업데이트합니다.

• (질량 재구성 워크플로) 평균 스펙트럼 및 재구성 스펙트럼을 시각적으로 검사합니다.

• (질량 재구성 워크플로) 피크 찾기 매개 변수를 조정하거나 XIC 영역을 수동으로 선택하여
XIC 영역이 올바르게 선택되지 않은 크로마토그램을 수정합니다. 새 XIC 영역이 선택되면
평균 스펙트럼과 재구성 스펙트럼이 다시 생성됩니다.

• (질량 재구성 워크플로) 질량 피크 선택 매개 변수를 조정하거나 질량 피크를 수동으로 선
택하여 올바르게 선택되지 않은 질량 피크를 수정합니다. 질량 피크가 변경되면 Results
Table이 새 피크 및 기타 매개 변수로 자동 업데이트됩니다.

1. Displays the peak review( )를 클릭합니다.

2. 왼쪽 창의 Components and Group 목록에서 구성 요소를 선택합니다.

3. (선택 사항) View 메뉴를 사용하여 Peak Review 창의 레이아웃을 사용자 지정합니다.
View 옵션에 대한 설명은 도움말 시스템 문서를 참조하십시오.

4. (선택 사항) Options > Peak review display settings를 클릭하여 Peak Review 창의 모
양을 변경합니다. 예를 들어 한 번에 표시할 크로마토그램 수를 선택합니다. 옵션에 대한
설명은 도움말 시스템 문서를 참조하십시오.
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그림 6-29 Peak Review Options 대화 상자

5. (선택 사항) 피크를 확대하려면 다음 방법 중 하나를 사용합니다.

• Options > Peak review display settings를 클릭한 후 Zooming을 클릭하여 피크의
확대/축소 매개 변수를 변경합니다.

• X 축 또는 Y 축에서 확대/축소할 영역 위로 커서를 끕니다.

6. (선택 사항) 피크를 확장하여 전체 Peak Review 창을 채우려면 피크를 선택한 후 Peak

magnifier( )를 클릭합니다.

팁! Peak Review 창의 아이콘이 검은색이면 해당 기능을 사용할 수 있습니다. 사용하지
않으려면 아이콘을 다시 클릭하십시오.

7. (선택 사항) 그래프에 노이즈 영역을 표시하고 조정하려면 Options > Show Noise
Regions를 클릭한 후 노이즈 영역을 조정합니다(해당하는 경우). 자세한 정보는 노이즈
영역 사용 섹션을 참조하십시오.

참고: Peak to Peak 또는 Standard Deviation 신호 대 노이즈 알고리즘이 사용 중인 경
우에만 노이즈 영역을 조정할 수 있습니다.

8. 크로마토그램 또는 재구성 그래프에 여러 피크가 있고 잘못된 피크가 통합된 경우 올바른
피크를 끌어 새 예상 머무름 시간 또는 예상 분자량을 설정합니다. 필요한 경우 피크 찾기
및 통합 매개 변수를 조정합니다.

9. (선택 사항) 새 매개 변수를 샘플 구성 요소 또는 그룹의 모든 샘플에 적용하려면 오른쪽
클릭 메뉴 옵션을 사용합니다. 자세한 정보는 Peak Review 창에서 피크 사용 섹션을 참조
하십시오.
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팁! 통합 피크를 보려면 Displays the peak review( )를 클릭합니다. Peak Review 창
에서 Options > Show navigation controls를 선택합니다. 그런 다음 탐색 아이콘을 클릭
합니다. 아이콘에 대한 설명은 도움말 시스템 문서를 참조하십시오.

팁! Set peak to "not found"( )를 클릭하면 통합이 취소됩니다. 사용자는 수동으로 피
크를 통합하기 전에 원시 데이터를 확인할 수 있습니다. 통합 매개 변수는 편집할 수 없습
니다.

10. Peak Review 창에서 Enable manual integration mode( )를 클릭하여 수동 통합 모드
를 사용합니다.

11. 관심 피크 한 쪽 기준에서 다른 쪽으로 커서를 끕니다.
이제 피크가 수동으로 통합되고 이전에 사용한 통합 매개 변수를 사용할 수 없습니다.

팁! 피크를 수정한 직후 마우스 오른쪽 버튼을 클릭하고 Revert Peak to Original
Method를 클릭하여 피크를 원래 방법으로 되돌릴 수 있습니다.

팁! 수동 통합을 지우고 통합 매개 변수 필드를 활성화하려면 Manual Integration 확인란

의 선택을 취소한 후 Enable manual integration mode( )를 다시 클릭하십시오.

12. (선택 사항) Explorer 작업 영역에 현재 피크를 표시하려면 Open data exploration( )
을 클릭합니다.

현재 확대/축소 수준이 유지됩니다.

참고: 피크 수동 통합은 사용자가 Peak Review 창에서 해당 피크의 통합을 변경하거나,
포함된 방법을 편집하여 구성 요소를 변경할 때까지 유지됩니다.

참고: 질량 재구성 워크플로에서 재구성 질량 피크가 수동으로 통합되면 사용자가 Peak
Review 창에서 해당 피크의 통합을 변경하거나, 포함된 방법을 편집하여 구성 요소를 변
경할 때까지 해당 XIC 영역과 평균 스펙트럼이 유지됩니다.
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Peak Review 창에서 피크 사용
표 6-8 Peak Review 기능

수행할 작업 방법

통합 매개 변수 복사 이 명령을 Paste Integration Parameters와 함께 사용하여 서로
다른 크로마토그램 간에 피크 찾기 매개 변수를 복사합니다. 이
명령은 여러 크로마토그램에 대해 매개 변수를 동일하게 조정해
야 하는 경우 사용할 수 있습니다.

1. 활성 크로마토그램이 열려 있는 그래프에서 마우스 오른쪽
버튼을 클릭한 후 Copy Integration Parameters를 클릭합
니다.

2. 구성 요소의 모든 크로마토그램에 변경 내용을 적용하려면
Update Processing Method for Component 명령을 사용
합니다.

3. 그룹의 모든 크로마토그램에 변경 내용을 적용하려면
Update Processing Method for Group 명령을 사용합니
다.

통합 매개 변수 붙여넣기 이 명령을 Copy Integration Parameters와 함께 사용하여 서로
다른 크로마토그램 간에 피크 찾기 매개 변수를 복사합니다.

1. 활성 크로마토그램이 열려 있는 그래프에서 마우스 오른쪽
버튼을 클릭한 후 Copy Integration Parameters를 클릭합
니다.

2. 다른 크로마토그램에서 마우스 오른쪽 버튼을 클릭한 후
Paste Integration Parameters를 클릭합니다.

구성 요소의 처리 방법 업
데이트

특정 크로마토그램에 대한 피크 찾기 매개 변수를 조정한 후 해
당 매개 변수를 구성 요소에 사용하기 위해 Results Table에 저장
된 처리 방법의 복사본을 수정하려면 이 명령을 사용합니다.

• 피크 찾기 매개 변수를 조정하고 마우스 오른쪽 버튼을 클릭
한 후 Update Processing Method for Component를 선택
합니다.

특정 구성 요소의 경우 모든 샘플이 자동으로 통합되어 새 매
개 변수를 사용하고 Peak Review 창과 Results Table이 업데
이트됩니다. 피크를 수동으로 통합한 경우에는 사용자에게 재
통합을 모든 피크에 적용할지 아니면 수동으로 통합된 피크에
만 적용할지 묻는 메시지가 나타납니다.
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표 6-8 Peak Review 기능 (계속)

수행할 작업 방법

그룹의 처리 방법 업데이
트

(질량 재구성 워크플로에는 적용되지 않음) Update Processing
Method for Component 옵션과 비슷하지만 현재 활성화된 크로
마토그램의 구성 요소와 동일한 그룹에 속한 모든 구성 요소에
통합이 적용됩니다. 사용자가 여러 그룹에 다양한 구성 요소를
할당하고 특정 그룹에 할당된 구성 요소의 머무름 시간이 동일할
것으로 예상되는 경우 이 명령을 사용하면 그룹의 모든 구성 요
소에 대해 예상 머무름 시간을 포함한 매개 변수를 한 번에 재설
정할 수 있으므로 유용합니다. 그룹의 구성 요소에 대한 머무름
시간이 동일하지 않으면 이 명령이 유용하지 않습니다.

• 피크 찾기 매개 변수를 조정하고 마우스 오른쪽 버튼을 클릭
한 후 Update Processing Method for Group을 선택합니다.

그룹의 처리 방법 업데이
트(Expected MW 제외)

(질량 재구성 워크플로만) Update Processing Method for
Component 옵션과 비슷하지만 현재 활성화된 크로마토그램 및
재구성 그래프의 구성 요소와 동일한 그룹에 속한 모든 구성 요
소에 통합이 적용됩니다. 사용자가 여러 그룹에 다양한 구성 요
소를 할당하고 특정 그룹에 할당된 구성 요소의 머무름 시간 및
통합 매개 변수가 동일할 것으로 예상되는 경우 이 명령을 사용
하면 그룹의 모든 구성 요소에 대해 예상 머무름 시간을 포함한
매개 변수를 한 번에 재설정할 수 있으므로 유용합니다. 그룹의
구성 요소에 대한 머무름 시간이 동일하지 않으면 이 명령이 유
용하지 않습니다. 이 명령은 Expected MW에는 적용되지 않습
니다.

• 피크 찾기 및 통합 매개 변수를 조정하고 마우스 오른쪽 버튼
을 클릭한 후 Update Processing Method for Group,
Excluding Expected MW를 선택합니다.

그룹 내의 샘플에 통합 매
개 변수 적용

(질량 재구성 워크플로에는 적용되지 않음) 특정 크로마토그램에
대한 피크 찾기 매개 변수를 조정한 후 변경된 화합물과 동일한
그룹에 속한 모든 샘플 화합물에 해당 매개 변수를 적용하려면
이 명령을 사용합니다.

• 크로마토그램에 대한 피크 찾기 매개 변수를 조정하고 마우스
오른쪽 버튼을 클릭한 후 Apply integration parameters to
sample within a group을 선택합니다.
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표 6-8 Peak Review 기능 (계속)

수행할 작업 방법

그룹 내의 샘플에 통합 매
개 변수 적용(Expected
MW 제외)

(질량 재구성 워크플로만) 특정 크로마토그램의 피크 찾기 매개
변수와 재구성 그래프의 통합 매개 변수를 조정한 후 변경된 화
합물과 동일한 그룹에 속한 모든 샘플 화합물에 해당 매개 변수
를 적용하려면 이 명령을 사용합니다. 이 명령은 Expected MW
에는 적용되지 않습니다.

• 크로마토그램의 피크 찾기 매개 변수와 디콘볼루션 질량 피크
의 통합 매개 변수를 조정하고 마우스 오른쪽 버튼을 클릭한
후 Apply integration parameters to sample within a
group, excluding Expected MW를 선택합니다.

피크를 원래 방법으로 되
돌리기

특정 크로마토그램에 대한 피크 찾기 매개 변수를 조정한 후
Results Table에 저장된 처리 방법의 복사본에서 원래 매개 변수
를 크로마토그램에 적용하려면 이 명령을 사용합니다.

• 활성 크로마토그램이 열려 있는 그래프에서 마우스 오른쪽 버
튼을 클릭한 후 Revert Peak to Original Method를 선택합니
다.

구성 요소의 모든 피크 되
돌리기

일부 크로마토그램에 대한 피크 찾기 매개 변수를 조정한 후
Results Table에 저장된 처리 방법의 복사본에서 원래 매개 변수
를 활성 크로마토그램과 동일한 구성 요소의 모든 크로마토그램
에 적용하려면 이 명령을 사용합니다. 피크를 수동으로 통합한
경우에는 사용자에게 재통합을 모든 피크에 적용할지 아니면 수
동으로 통합된 피크에만 적용할지 묻는 메시지가 나타납니다.

• 활성 크로마토그램이 열려 있는 그래프에서 마우스 오른쪽 버
튼을 클릭한 후 Revert All Peaks for Component를 선택합
니다.

노이즈 영역 사용
Peak to Peak 또는 Standard Deviation 신호 대 노이즈 알고리즘이 사용되는 경우 처리 방법
의 Integration 페이지와 Peak Review 창에서 노이즈 영역을 대화식으로 조정할 수 있습니다.

1. 그래프에서 노이즈 영역을 클릭하고 필요한 위치로 이동합니다.

2. 이중 화살표가 표시될 때까지 커서를 노이즈 영역의 왼쪽 또는 오른쪽 끝으로 움직입니
다. 그런 다음 필요한 위치로 가장자리를 끌어 노이즈 영역의 크기를 조정합니다.

라이브러리 검색 또는 Formula Finder 결과를 사용하여 피크 분석

팁! 창에 표시되는 행 수를 변경하려면 Options > Peak review display settings를 클릭하십
시오. 사용자는 Peak Review 창의 상단을 위로 끌어 창 크기를 늘릴 수도 있습니다.

1. Peak Review 창에서 View를 클릭한 후 XIC + MS, XIC + MS/MS 또는 XIC + MS +
MS/MS를 클릭합니다.
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검색 결과가 그래프 아래에 표시됩니다.

그림 6-30 라이브러리 검색 결과

2. 파란색 화살표를 클릭하여 Library Search Results를 확장하면 가능한 라이브러리 적중
수가 더 많이 표시됩니다.
선택한 라이브러리 일치 항목의 화학적 구조도 또한 표에 표시됩니다.

3. 화살표를 다시 클릭하면 표가 축소됩니다.
축소된 표에 표시된 결과는 Results Table에도 표시됩니다.

4. (선택 사항) 표에서 행을 선택한 후 을 클릭하여 특정 라이브러리 적중 항목을 분석에
사용할 수 있도록 Results Table 결과를 업데이트합니다.

5. (선택 사항) 을 클릭하여 처리 방법을 선택된 화합물의 정보로 업데이트합니다.

6. 라이브러리 데이터베이스에 스펙트럼을 추가하려면 다음 단계를 수행합니다.

a. 스펙트럼을 마우스 오른쪽 버튼으로 클릭한 후 Add spectrum to library를 클릭합니
다.
Add spectrum to library 대화 상자가 열립니다.

b. Compound Name, Library 및 Precursor m/z 필드를 업데이트합니다.

c. OK를 클릭합니다.
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7. 파란색 화살표를 클릭하여 Formula Finder Results를 확장하면 가능한 결과가 더 많이
표시됩니다.

그림 6-31 Formula Finder 결과

화합물이 ChemSpider에서 업데이트된 경우에는 선택한 Formula Finder 결과의 화학 구
조도 표에 표시됩니다.

8. 화살표를 다시 클릭하면 표가 축소됩니다.
축소된 표에 표시된 결과는 Results Table에도 표시됩니다.

9. 을 클릭하여 Results Table의 Formula Finder Results 열을 선택된 화합물로 업데이
트합니다.

10. 을 클릭하여 처리 방법을 선택된 화합물의 정보로 업데이트합니다.

팁! Options > Get Chemspider hit count를 클릭하면 그래프 아래의 표에 ChemSpider
Hit Count 열이 표시됩니다.

11. 을 클릭하여 ChemSpider 어플리케이션을 엽니다.
자세한 정보는 ChemSpider 섹션을 참조하십시오.

ChemSpider

참고: ChemSpider 데이터베이스에 액세스하려면 워크스테이션에 유효한 라이선스 파일이 있
어야 합니다.
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참고: 다음 그림에 표시된 정보는 예시 목적으로만 제공됩니다.

그림 6-32 ChemSpider 세션

항목 설명

1 결과 창: 선택한 공식과 일치하는 권장 화합물의 목록을 표시합니다. 결과
는 40개 화합물의 그룹으로 표시됩니다. 오른쪽 화살표를 사용하면 목록
의 다음 그룹으로 이동합니다. 왼쪽 화살표를 사용하면 목록의 이전 그룹
으로 이동합니다.

2 Spectra pane: 획득된 스펙트럼(빨간색) 및 일치하는 단편(파란색)을 표시
합니다. 파란색 단편이 많을수록 더 잘 일치됨을 의미합니다.

3 Structure pane: 결과 창에서 선택한 화합물의 화학적 구조를 표시합니다.

4 Fragment table pane, 단편 탭: 선택한 화합물에 대해 일치하는 총 단편 개
수를 표시합니다.

4 단편 표 창, 피크 탭: 총 피크 개수, 일치하는 피크의 개수 및 선택한 화합
물에 대한 전체 강도의 %를 표시합니다. Assigned 열의 확인란은 일치하
는 피크에 대해 자동으로 선택됩니다.

표 6-9 ChemSpider 기능

수행 작업 수행 결과

Filter XIC List 아이콘 옆의 필드에 정보
를 입력합니다.

결과 창이 새로 고침되면서 입력한 기준과 일치하
는 결과만 표시됩니다.

결과 창의 항목을 하나씩 클릭 나머지 창들이 새로 고침되면서 선택 항목과 연관
된 정보가 표시됩니다.
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표 6-9 ChemSpider 기능 (계속)

수행 작업 수행 결과

단편 표 창에 있는 Fragments 탭의 항목
을 하나씩 클릭

나머지 창들이 새로 고침됩니다. 스펙트럼 창에서
는 일치하는 단편(파란색)의 상단과 하단에 빨간색
화살표가 표시됩니다. 구조 창에서는 단편과 일치
하는 화학적 구조를 가진 화합물이 강조 표시(볼드
체)됩니다.

단편 표 창의 Peaks 탭에서 Assigned
항목을 클릭합니다.

나머지 창들이 새로 고침됩니다. 스펙트럼 창에서
는 일치하는 단편(파란색)의 상단과 하단에 빨간색
화살표가 표시됩니다. 구조 창에서는 단편과 일치
하는 화학적 구조를 가진 화합물이 강조 표시(볼드
체)됩니다.

ChemSpider results for 필드 오른쪽의
아래쪽 화살표를 클릭하고 ChemSpider
web site 옵션을 선택합니다.

탐색기 창에서 ChemSpider 웹 사이트
(www.chemspider.com)가 열립니다. 정보 액세스
에 대한 정보는 ChemSpider Help를 참조하십시
오.

ChemSpider results for 필드 오른쪽의
아래쪽 화살표를 클릭하고 Refresh 옵
션을 선택합니다.

모든 변경 내용이 취소되고 세션이 원래 검색 결과
로 되돌아갑니다.

Select를 클릭합니다. ChemSpider 세션에서 선택한 정보가 소프트웨어
세션의 Formula Finder Results 창에 복사됩니다.
ChemSpider 세션은 종료됩니다.

Peak Review 창에 대한 팁
• Results Table의 특정 열을 정렬하고, 표의 위쪽 또는 아래쪽으로 정렬된 크로마토그램만
검토합니다.

• Peak Review 창은 항상 해당 Results Table과 동기화되고 이 표와 동일한 순서로 동일한 피
크의 크로마토그램을 표시합니다. 행 정렬, 샘플 유형 필터링 또는 구성 요소 선택과 같이
Results Table에 대한 모든 변경 내용은 Peak Review 창에 자동으로 반영됩니다.

• 사용 가능한 크로마토그램을 스크롤하려면 창 오른쪽의 스크롤 막대를 사용합니다. Peak
Review 창이 활성화되어 있으면 키보드의 위쪽/아래쪽 화살표 키 또는 마우스 스크롤 휠을
사용하여 크로마토그램을 이동합니다.

• 첫 번째 열 왼쪽의 연한 파란색 영역을 클릭하여 Results Table에서 행을 선택하면 해당하
는 피크가 Peak Review 창에 표시됩니다. 사용자가 Peak Review 창에서 특정 크로마토그
램으로 스크롤하면 Results Table의 해당 행이 강조 표시된 후 보기에 나타납니다.

• 숫자 그룹화는 Analytics 작업 영역에서 지원되지 않습니다. 예를 들어 통합 매개 변수의 텍
스트 상자 또는 Results Table의 그리드에서 숫자를 그룹화하면 안 됩니다.

• 크로마토그램은 한 번에 하나만 활성 상태로 간주되며 제목이 굵은 글꼴로 표시됩니다. 특
정 크로마토그램 내에서 아무 곳이나 클릭하면 크로마토그램이 활성화됩니다.

주의: 잠재적 데이터 손실. 예상 머무름 시간이 조정되고 통합이 변경될 수 있으므로 크로마
토그램 내에서 커서를 끌지 않도록 주의하십시오.

작동 지침—처리

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템

153/325

http://www.chemspider.com


• 사용자가 크로마토그램에서 특정 피크를 끌면 Expected RT 통합 매개 변수가 피크의 실제
머무름 시간으로 업데이트됩니다. 그런 다음 새 머무름 시간이 자동으로 적용되고 소프트
웨어에서 피크가 다시 통합되어 Results Table이 적절하게 업데이트됩니다.

• (질량 재구성 워크플로) 사용자가 재구성 그래프에서 특정 피크를 끌면 Expected MW 매개
변수가 피크의 실제 분자량으로 업데이트됩니다. 그런 다음 새 분자량이 자동으로 적용되
고 소프트웨어에서 피크가 다시 통합되어 Results Table이 적절하게 업데이트됩니다.

• (질량 재구성 워크플로) Recentered on the largest XIC Peak를 선택하지 않으면 사용자
가 원하는 XIC 영역을 수동으로 선택할 수 있습니다. XIC 영역에 대한 중심의 시간이 예상
RT가 되고 XIC 영역 내에서 최대 피크의 RT가 발견된 RT가 됩니다.

• 사용자가 Manual Integration 모드에서 피크를 검토하는 경우 커서를 피크 위로 끌면 선택
한 피크가 수동으로 통합됩니다. Shift 키를 누른 상태에서 끌면 일직선을 유지할 수 있습니
다.

• 크로마토그램이 활성화되면 창의 왼쪽에 표시된 통합 매개 변수가 업데이트되어 새로 활성
화된 크로마토그램을 반영합니다. 사용자가 피크 통합 매개 변수를 조정한 후 Apply를 클
릭하면 현재 활성화된 크로마토그램이 영향을 받습니다.

• 사용자는 피크 검토 중에 피크 모양을 검사하여 포화 가능성이 있는 피크를 식별하고 부분
적 통합 또는 잘못된 통합으로 인해 농도가 잘못 보고되는 경우가 발생하지 않는지 확인해
야 합니다.

• 사용자는 피크 검토 중에 크로마토그램을 검사하여 시스템 문제를 나타낼 수 있는 과도한
노이즈 스파이크가 있는지 확인해야 합니다.

• Y 축을 전체 데이터 세트에서 강도가 가장 높은 피크로 조정하려면 Y 축 안쪽을 두 번 클릭
합니다. 축 안쪽을 끌어서 확대하면 강도 범위를 선택할 수 있습니다.

• 그래프를 모든 데이터가 표시되는 홈 보기로 되돌리려면 X 축 안쪽을 두 번 클릭합니다. 축
안쪽을 끌어서 확대하면 시간 범위를 선택할 수 있습니다.

• Results Table에서 샘플 간에 이동할 때 Results > Cache all chromatograms for faster
peak review를 클릭하면 성능이 향상됩니다.

농도가 매우 높은 샘플, 즉 최대 정량 한계(ULOQ)를 훨씬 초과하는 샘플은 왜곡되거나 분리된
모양을 가진 포화 피크를 점점 더 넓게 만들 수도 있습니다.

다음 그림은 선형 회귀를 사용하여 정량화할 수 있는 최대 농도를 보여줍니다.

그림 6-33 포화되지 않은 피크와 포화된 피크의 예
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항목 설명

1 정량화에 사용할 수 있는 허용 가능 피크를 표시합니다.

2 포화된 피크를 표시합니다. 이 피크를 생성한 샘플의 농도는 ULOQ보다
훨씬 높습니다. 피크는 포화될수록 더 넓어지고 이득 억제로 인해 피크 위
쪽이 반전됩니다. 부분적 통합으로 인해 농도가 잘못 보고될 수 있으므로
이러한 피크는 정량화에서 제외해야 합니다.

3 LC 피크가 두 개의 피크로 분리되는 최대 포화 상태를 표시합니다. 부분적
통합으로 인해 농도가 잘못 보고될 수 있으므로 이러한 피크는 정량화에
서 제외해야 합니다.

통계를 사용하여 데이터 분석
선행 절차

• Results Table을 엽니다.

Statistics 창을 사용하여 분석의 재현성과 관련된 정보를 볼 수 있습니다. 표의 각 행은 동일한
반응을 보일 것으로 예상되는 동일한 분석 물질의 관련 피크 그룹에 대한 정보(예: 평균, 표준
편차)를 요약합니다.

반복 프로세스를 통해 피크 통합, 교정 곡선 및 샘플 통계량을 검토합니다. Results Table의
Actual Concentration 필드에 설정된 정밀도는 통계 표에서도 사용됩니다.

참고: %CV 및 정확도를 포함한 통계량의 허용 값에 대한 정보는 실험실 표준 작업 절차를 참
조하십시오.

Results Table을 열고 Views > Statistics pane을 클릭합니다..

Statistics 창의 열

레이블 설명

Row (행) 행 번호를 표시합니다.

Component
Name

(구성 요소 이름) 분석 물질 이름을 표시합니다.

Sample Name/
Actual
Concentration

(샘플 이름/실제 농도) 샘플이 실제 농도별로 그룹화되면 농도를 표시합니
다. 샘플이 샘플 이름별로 그룹화되면 샘플 이름을 표시합니다.

Num. Values (개수: 값) m/n을 표시합니다. 여기서 n은 실제 농도의 샘플 또는 이름이
같은 샘플의 총 수이며 m은 계산에 사용되는 샘플 수입니다. 해당 피크가
통합되지 않거나 Used 필드가 수동으로 지워진 경우에는 샘플이 사용되
지 않습니다.

Mean (평균) 사용된 샘플의 평균을 표시합니다.
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레이블 설명

Standard
Deviation

(표준 편차) 사용된 샘플의 표준 편차를 표시합니다.

Percent CV (%CV) 변동 계수를 백분율(100 * Standard Deviation/Mean)로 표시합니
다.

Accuracy (정확도) 평균을 실제 농도로 나눈 값을 백분율(100 * Mean/Actual
Concentration)로 표시합니다. 이 필드는 실제 농도별로 그룹화할 때만 표
시되며 샘플 이름별로 그룹화할 때는 표시되지 않습니다.

Values (값) 추가 열에 샘플의 개별 값을 표시합니다. 해당 샘플을 통합할 수 없는
경우 N/A가 표시됩니다. Used 필드를 수동으로 지운 경우에는 값에 취소
선이 표시됩니다.

Group by (그룹화 기준) 통계 계산을 위해 주어진 분석 물질의 샘플을 그룹화하는
방법을 지정합니다. 다음 옵션을 사용할 수 있습니다.

• Group by Concentration for Standards(표준 샘플의 농도별 그룹화):
표준 샘플이 실제 농도별로 그룹화됩니다.

• Group by Concentration for QCs(QC의 농도별 그룹화): 품질 관리
샘플이 실제 농도별로 그룹화됩니다.

• Group by Sample Name for Standards(표준 샘플의 샘플 이름별 그
룹화): 반복되는 표준 샘플이 Sample Name 필드를 기준으로 그룹화
됩니다.

• Group by Sample Name for QCs(QC의 샘플 이름별 그룹화): 반복되
는 품질 관리 샘플이 Sample Name 필드를 기준으로 그룹화됩니다.

• Group by Sample Name for All Samples(모든 샘플의 샘플 이름별
그룹화): 반복되는 모든 샘플이 Sample Name 필드를 기준으로 그룹
화됩니다.

Metric 통계 계산에 사용되는 실제 메트릭을 지정합니다. 다음 옵션을 사용할 수
있습니다.

• Calculated Concentration(계산된 농도): Results Table의 Calculated
Concentration 필드가 사용됩니다.

• Area(면적): Results Table의 Area 필드가 사용됩니다.

• Height(높이): Results Table의 Height 필드가 사용됩니다.

• Calibration Y-Value(교정 Y 값): 분석 물질에 대해 지정된 회귀 매개
변수가 사용됩니다. 해당하는 내부 표준이 없는 분석 물질에 대한 Area
또는 Height이거나, 내부 표준을 사용하는 분석 물질에 대한 Area
Ratio 또는 Height Ratio입니다.

Save Results
and Export

(결과 저장 및 내보내기) 결과를 저장하고 통계 테이블을 내보내려면 클릭
합니다. Export Statistics 대화 상자가 열립니다.
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Statistics Pane에 대한 팁
• Statistics 표의 모든 분석 물질에 대한 항목을 보려면 Components and Groups 목록에서

All Components를 선택합니다. 해당 분석 물질의 항목만 보려면 개별 구성 요소를 선택합
니다. 사용자가 목록에서 개별 내부 표준을 선택하면 Statistics 표가 비어 있습니다. 자세한
정보는 구성 요소 및 그룹 목록 섹션을 참조하십시오.

• Results Table에서 분석 물질 및 샘플에 해당하는 행을 선택하려면 Statistics pane에 표시
되는 행의 Value 셀 중 하나를 클릭합니다. Peak Review 창이 표시된 경우 Results Table에
연결되고 해당 셀을 클릭하면 업데이트됩니다.

• 열 머리글 중 하나를 클릭하여 통계를 정렬합니다.

• 행을 선택한 후 Ctrl+C를 눌러 전체 Statistics 표 또는 관심 있는 행만 복사합니다.

• 통계 계산을 위해 주어진 분석 물질의 샘플을 그룹화하는 방법을 지정하려면 Group by 목
록을 사용합니다.

• 계산된 농도, 면적 등 통계 계산에 사용되는 메트릭을 지정하려면 Metric 목록을 사용합니
다.

• 열 폭을 조정하여 표시를 최적화합니다. 이 폭은 다음에 Statistics pane이 표시될 때 유지됩
니다.

• Statistics 표의 형식과 정밀도를 변경하려면 Results Table에서 해당 값을 변경합니다. 자세
한 정보는 Results Table 사용자 지정 섹션을 참조하십시오.

• 개별 값의 Use Peak 옵션을 변경하려면 Statistics pane의 셀을 마우스 오른쪽 버튼으로 클
릭하고 Use Peak를 선택합니다. Results Table의 Use Peak 열이 업데이트됩니다.

교정 곡선 보기
선행 절차

• Results Table을 엽니다.

교정 곡선을 사용하면 알 수 없는 샘플을 농도가 알려진 표준 샘플 세트와 비교하여 알 수 없는
샘플에 포함된 물질의 농도를 결정할 수 있습니다. 자세한 정보는 교정 곡선 섹션을 참조하십
시오.

1. Displays the Calibration Curve( )를 클릭합니다.

2. 회귀 옵션을 설정하려면 Regression을 클릭합니다. 자세한 정보는 도움말 시스템 문서를
참조하십시오.

교정 내보내기
Export Calibration을 사용하여 활성 Results Table과 관련된 모든 분석 물질의 교정 방정식 복
사본을 외부 파일(mqcal)에 저장할 수 있습니다. 이를 통해 한 표준 샘플 세트의 교정을 동일한
Results Table의 일부가 아닌 다른 샘플에 적용할 수 있습니다.

일반적인 워크플로는 다음과 같습니다.

1. 표준만 포함하는 Results Table을 생성합니다.
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2. Peak Review 창을 사용하여 통합이 완료되었는지 확인합니다.

3. Calibration Curve 창에서 Options > Export calibration (and save results)을 클릭하여
교정 복사본을 저장합니다.

4. 농도를 알 수 없는 샘플이 포함된 새 Results Table을 생성합니다.

5. Calibration Curve 창에서Options > Assign external calibration을 클릭하여 내보낸 교
정 방정식을 새 Results Table에 적용합니다.

참고: 사용자는 새 Results Table에 적용할 교정 파일(mqcal)을 지정할 수도 있습니다.

표준 샘플과 함께 원래 Results Table을 변경한 경우 업데이트된 교정 방정식을 저장하려면
Results Table을 다시 내보내야 합니다. 이전에 내보낸 교정은 자동으로 업데이트되지 않습니
다.

메트릭 플롯을 사용하여 데이터 분석
선행 절차

• Results Table을 엽니다.

Metric Plot을 사용하여 행 번호 또는 다른 열에 대한 Results Table 열의 값을 플롯에 표시할
수 있습니다. 이러한 플롯은 시각적 데이터 검토를 위한 유용한 보조 도구입니다.

하나의 열을 선택한 경우 결과 플롯에 해당 열의 값이 표의 행 번호에 대한 함수로 표시됩니다.
두 개의 열을 선택한 경우에는 두 열의 값이 서로에 대해 각각 플롯에 표시됩니다. 선택할 두
열 중 첫 번째 열에는 X 값이 포함되고 두 번째 열에는 Y 값이 포함됩니다.

1. Results Table에서 하나 또는 두 개의 열을 선택합니다.

팁! 두 번째 열을 선택하려면 Ctrl 키를 누른 채로 열 머리글을 클릭하십시오.

2. More > Create Metric Plot with new settings를 클릭합니다.

3. Metric Plot 창에서 Link를 클릭한 다음 Link to results table columns 또는 Link to
results table rows를 클릭하여 Results Table의 스크롤을 메트릭 플롯에 연결합니다.
Link 메뉴에 대한 자세한 정보는 도움말 시스템 문서를 참조하십시오.

4. 메트릭 플롯을 업데이트하려면 Results Table에서 원하는 행을 선택한 후 Metric Plot 창에
서 Link > Plot selected rows only를 클릭합니다.

팁! 여러 행을 선택하려면 Ctrl 키를 누른 채로 행을 선택하십시오.

5. (선택 사항) Options 메뉴에서 옵션을 선택하여 Metric Plot 옵션을 사용자 지정합니다. 옵
션에 대한 설명은 도움말 시스템 문서를 참조하십시오.

메트릭 플롯에 대한 팁
• 사용자가 데이터 요소를 마우스 왼쪽 버튼으로 클릭하면 Results Table의 해당 행이 자동으
로 선택되고 보기로 스크롤됩니다. 또한 Peak Review 창이 열려 있으면 해당 크로마토그램
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을 표시하도록 창이 업데이트됩니다. 여기에서는 이상값의 피크 검토를 수행하는 편리한
방법이 제공됩니다.

• 제목 영역은 항상 활성 트레이스의 이름을 표시합니다. 여러 구성 요소의 트레이스가 중첩
된 경우 제목 왼쪽의 더하기 기호(+)를 클릭하여 제목에 모든 트레이스 정보 표시와 활성 트
레이스 정보만 표시 간에 전환하십시오. 제목 또는 해당 제목 왼쪽의 색 스폿을 클릭하거나,
메트릭 플롯에서 데이터 요소를 선택하여 특정 트레이스를 활성화할 수 있습니다.

• 메트릭 플롯을 사용하면 내부 표준 샘플이나 QC 샘플의 피크 면적을 플롯에 표시하여 가능
한 편차 또는 추세를 모니터링할 수 있습니다.

보고서 템플릿 편집
주의: 잠재적 데이터 손실. 사용자가 템플릿을 수정할 수 없게 하려면 Reporter 템플릿이 시스
템 관리자만 쓸 수 있는 읽기 전용 보안 폴더에 있어야 합니다.

사용자는 사용자 지정 템플릿의 유효성을 검사해야 합니다.

1. docx 템플릿을 엽니다.

팁! 템플릿은 C:\ProgramData\SCIEX\Analytics\Reporter에 있습니다.

영역을 선택하면 오른쪽에 Reporter 템플릿 편집기가 열립니다. 템플릿 편집기에 태그 정
보가 자동으로 채워집니다.

그림 6-34 Reporter Template Editor

항목 설명

1 현재 태그를 표시하는 보고서 템플릿입니다.
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항목 설명

2 아이콘:

• Add new tag.

• Add picture tag.

• Show content area.

• View document change log.

3 Created with: 태그 정보를 제공하는 소프트웨어의 이름을 표시합니다.

4 Field Type: 소프트웨어에 해당되는 필드 유형을 표시합니다.

5 선택한 필드 유형을 기반으로 사용 가능한 특성 목록을 표시합니다. 예를
들어 태그 이름과 숫자 형식이 표시됩니다.

6 Save Tag Parameters: 변경 내용을 저장하려면 클릭합니다. 변경 내용
이 저장되지 않으면 사용자에게 변경 내용을 저장할지 묻는 메시지가 표
시됩니다.

2. 다음 표의 절차를 사용합니다.

표 6-10 Reporter 기능

수행할 작업 방법

필드 유형 변경 태그 안쪽을 클릭하고 새 필드 유형을 선택한 후 특성을 선택
합니다.

필드 유형의 특성 변경 탭 안쪽을 클릭한 후 필요에 따라 특성을 변경합니다.

태그 추가 Add new tag 아이콘을 클릭하고 필드 유형을 선택한 후 특
성을 선택합니다.

그림 추가 Add picture tag 아이콘을 클릭한 후 특성을 선택합니다.

태그 시작 및 종료 위치 표시 Show content area 아이콘을 클릭합니다.

문서 변경 로그 표시 View document change log 아이콘을 클릭합니다.

태그 복사 및 붙여넣기 선택한 태그를 복사하여 새 위치에 붙여 넣고 필드 유형 특성
을 업데이트합니다.

특성은 복사되지 않으므로 선택해야 합니다.

태그 간 탐색 왼쪽 및 오른쪽 화살표 키를 사용하여 태그 간에 이동합니다.

태그 삭제 다음 중 하나를 수행합니다.

• 커서가 태그 왼쪽에 있으면 Delete 키를 누릅니다.

• 커서가 태그 오른쪽에 있으면 Backspace 키를 누릅니다.

3. 변경한 후 Save Tag Parameters를 클릭합니다.
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팁! 필수 정보는 필드 왼쪽에 깜박이는 빨간색 느낌표가 표시됩니다.

Reporter 템플릿
사용자는 사용자 지정 보고서 템플릿의 유효성을 검사해야 합니다.

일부 보고서 템플릿은 쿼리를 사용합니다. 사용자는 보고서에서 Results Table의 데이터를 평
가, 조작 및 표시하기 위해 Microsoft Excel 기반 수식을 사용하여 쿼리를 생성할 수 있습니다.
보고서 템플릿의 Metafield 태그는 보고서가 사용해야 하는 query 파일 이름을 보고서에 제시
합니다. 쿼리를 사용하려면 보고서 템플릿의 MetaField 태그에 쿼리 파일 이름을 지정해야 합
니다. 쿼리는 쿼리로 인식되도록 ".query" 확장자를 포함해야 합니다. 쿼리는 보고서 템플릿이
저장되는 Reporter 폴더에 저장되어야 합니다.

사용자는 Reporter 템플릿 사용 시 특히 템플릿에 쿼리가 사용될 때 생성된 결과에 대한 유효
성을 검사하는 것이 바람직합니다. 유효성 검사 후에 보고서 템플릿을 수정하는 경우에는 보
고서 템플릿에 대해 다시 유효성을 검사해야 합니다. 보고서 템플릿 변경에는 Reporter 태그
또는 쿼리에 대한 수정이 포함됩니다.

표 6-11 기본 템플릿

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

All Peaks Qual 각 샘플에 대한 File Information,
Sample Information, Analyte
Results Table 및 모든 분석 물질과
내부 표준 물질에 대한 중첩된 크로
마토그램이 포함된 섹션을 제공하는
보고서입니다. Analyte Results
Table은 Results Table에 표시된 대
로 인쇄됩니다. 모든 정성적 신뢰도
신호등이 테이블의 시작 부분에 나
열됩니다.

해당 없음

Analyte 20
percent 보고서

각 분석 물질에 대한 File
Information과 각 공시료, 표준, QC
및 모든 알 수 없는 샘플의 20%에
대한 XIC 테이블이 포함된 섹션을
보여 주는 보고서입니다.

이 템플릿은 쿼리, 즉
Analyte20percent.Query가 첨부된
예제 보고서 템플릿입니다.

Analyte
Summary

배치에서 특정 분석 물질 및 관련된
내부 표준에 대해 모든 샘플의
Sample Name, Calculated
Concentrations 및 Outliers를 보여
주는 결과 테이블입니다.

해당 없음
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표 6-11 기본 템플릿 (계속)

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

Calibration
Curve

분석 물질에 대한 File Information,
Statistics Table(표준) 및 Calibration
Curve를 분석 물질당 한 페이지씩
보여 주는 보고서입니다.

• Reportable 확인란의 선택이 취
소된 표준은 데이터 테이블에 보
고되지 않습니다. Reportable 상
태는 통계에 영향을 주지 않습니
다.

• 보고서에는 Analytics 작업 영역
의 Calibration Curve 창에 표시
및 계산된 것과 같이 Used 열 상
태를 기반으로 회귀 수식과 그래
프가 표시됩니다.

Intact Quant All
Peaks and
Graphs

각 샘플에 대한 Results Table 항목
을 보여 주는 보고서입니다. Results
Table에 있는 모든 열이 보고서에 표
시됩니다. 또한 각 샘플 및 분석 물
질에 대한 XIC 크로마토그래프, 평
균 스펙트럼 및 재구성 스펙트럼도
보고서에 포함됩니다.

이 보고서는 질량 재구성 워크플로
에 한정됩니다.

Intact Quant
Analyte
Summary and
Calibration
Curve

각 분석 물질에 대한 Results Table
항목, 교정 곡선 및 통계 데이터를
보여 주는 보고서입니다. Results
Table에는 Sample Name, Sample
Type, Analyte Name, Actual
Concentration, Area, Height,
Expected MW, MW, MW Delta,
Calculated Concentration 및
Accuracy가 포함됩니다.

이 보고서는 질량 재구성 워크플로
에 한정됩니다.

Intact Quant
Sample
Summary

모든 샘플에 대한 Results Table 항
목을 보여 주는 보고서입니다.
Results Table에는 Sample Name,
Sample Type, Analyte Name,
Actual Concentration, Area, Height,
Expected MW, MW, MW Delta,
Calculated Concentration,
Accuracy 및 Accuracy Acceptance
가 포함됩니다.

이 보고서는 질량 재구성 워크플로
에 한정됩니다.

Metric Plot 각 분석 물질에 대한 File
Information 및 분석 물질 피크 면적
메트릭 플롯이 포함된 섹션을 표시
하는 보안 보고서입니다.

Reportable 확인란의 상태는 보고
서 내용에 영향을 주지 않습니다. 확
인란의 선택이 취소된 경우에도 모
든 데이터 요소가 포함됩니다.
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표 6-11 기본 템플릿 (계속)

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

MQ Analyte
Report 1

각 분석 물질에 대한 File
Information과 Sample Results
Table 및 각 샘플에 대한 XIC 테이블
이 포함된 섹션을 보여 주는 보고서
입니다. 대개 8개 미만의 샘플에 대
해 분석 물질당 두 페이지를 인쇄합
니다.

해당 없음

MQ Analyte
Report 2

각 분석 물질에 대한 File
Information과 알 수 없는 각 샘플에
대한 XIC 테이블이 포함된 섹션을
보여 주는 보고서입니다. 대개 8개
미만의 샘플에 대해 분석 물질당 두
페이지를 인쇄합니다.

알 수 없는 샘플만 보고됩니다.

MQ Analyte
Report 3

각 분석 물질에 대한 File
Information과 Unknown Samples
Summary Table이 포함된 섹션을 보
여 주는 보고서입니다.

알 수 없는 샘플만 보고됩니다.

MQ Analyte
Report
condensed table

알 수 없는 각 샘플에 대한 File
Information, Sample Info 및 Results
Summary Table이 포함된 섹션을 보
여 주는 보고서입니다. 테이블은 페
이지당 더 많은 샘플을 나타내기 위
해 두 개의 열로 표시됩니다.

알 수 없는 샘플만 보고됩니다.

MQ Analyte
Report with
chromatograms

각 분석 물질에 대한 File
Information과 Sample Results
Table 및 각 샘플에 대한 소형 크로
마토그램이 포함된 섹션을 보여 주
는 보고서입니다.

알 수 없는 샘플만 보고됩니다.

MQ Blank
Template

해당 없음 머리글 정보, 로고 및 페이지 번호만
보고서에 표시됩니다.

MQ Pep Quant 해당 없음 Peptide Quantitation 데이터 세트와
함께 사용합니다. 자세한 정보는
MultiQuant 소프트웨어의 사용자 안
내서에서 두 번째 예제인 절대 정량
화 예제를 참조하십시오.

MQ QC
Summary 1 with
flags

File Information, 분석 물질당 QC
Summary Table(CV가 20%를 초과
하는 값이 강조 표시됨) 및 QC
Detailed Results Table(정확도가
80% ~ 120%를 벗어나는 값이 강조
표시됨)을 보여 주는 보고서입니다.

Reportable 확인란의 선택이 취소
된 Quality Controls는 보고서에 포
함되지 않으며 계산에도 사용되지
않습니다.
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표 6-11 기본 템플릿 (계속)

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

MQ Sample
Report 1

각 샘플에 대한 File Information,
Sample info, IS info, Analyte
Results Table 및 XIC 테이블(IS와
각 분석 물질 포함)가 포함된 섹션을
보여 주는 보고서입니다. 대개 8개
미만의 샘플에 대해 샘플당 두 페이
지를 인쇄합니다.

해당 없음

MQ Sample
Report 2

알 수 없는 각 샘플에 대한 File
Information, TIC, Sample Details,
Analyte XIC 및 결과 테이블이 포함
된 섹션을 보여 주는 보고서입니다.
대개 8개 미만의 샘플에 대해 샘플
당 두 페이지를 인쇄합니다.

알 수 없는 샘플만 보고됩니다.

MQ Sample
Report 3

알 수 없는 각 샘플에 대한 File
Information, Sample Info 및 Results
Summary Table이 포함된 섹션을 보
여 주는 보고서입니다.

알 수 없는 샘플만 보고됩니다.

MQ Sample
Report
condensed table

알 수 없는 각 샘플에 대한 File
Information, Sample Info 및 Results
Summary Table이 포함된 섹션을 보
여 주는 보고서입니다. 테이블은 페
이지당 더 많은 분석 물질을 나타내
기 위해 두 개의 열로 표시됩니다.

알 수 없는 샘플만 보고됩니다.

MQ Sample
Report with
chromatograms

각 샘플에 대한 File Information,
Sample Info, Analyte Results Table
및 각 분석 물질에 대한 소형 크로마
토그램이 포함된 섹션을 보여 주는
보고서입니다.

알 수 없는 샘플만 보고됩니다.
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표 6-11 기본 템플릿 (계속)

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

MQ Sample
Report with
Concentration
Threshold

알 수 없는 각 샘플에 대한 File
Information, Sample Info 및 Results
Sum이 포함된 섹션을 보여 주는 보
고서입니다.

• 연결된 쿼리 파일은 Sample
Report with Concentration
Threshold.query입니다.

• 구성 요소 이름은 "Cmpd X #"이
어야 합니다. 여기서 X는 A부터
F까지의 문자이고 #은 숫자 값입
니다.

예: 보고서에서 "Cmpd A 1" 구성
요소는 Compound Group A 아
래에 표시되고 "Cmpd B 1" 구성
요소는 Compound Group B 아
래에 표시됩니다.

• 같은 그룹에 여러 구성 요소가 있
으면 그룹의 첫 번째 구성 요소
(사전순)만 보고서에 포함됩니다.

예 1: "Cmpd B 25"와 "Cmpd C
1"이 모두 "Grp" 그룹에 속한 경
우 "Cmpd C 1"이 보고서에 포함
되지 않습니다.

예 2: "Cmpd A 1", "Cmpd A 2"
및 "Cmpd A 3"이 그룹에 할당되
지 않은 경우 "Cmpd A 2"와
"Cmpd A 3"이 보고서에 포함되
지 않습니다.

예 3: "Cmpd A 1", "Cmpd A 2"
및 "Cmpd A 3"이 각각 그룹 1, 2,
3에 할당된 경우 3개의 구성 요소
가 모두 보고서에서 Compound
Group A 아래에 표시됩니다.
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표 6-11 기본 템플릿 (계속)

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

MQ Sample
Report with
MRM ratios 2

알 수 없는 각 샘플에 대한 File
Information, Sample Info 및 Results
Summary Table이 포함된 섹션과 모
든 XIC 중첩을 보여 주는 보고서입
니다. Expected Ion ratios는 사용 가
능한 모든 표준을 이용하여 자동 계
산됩니다. 비율 값은 Results Table
내 사용자 지정 열에 배치됩니다. 예
상 값의 20%를 벗어난 값은 플래그
가 지정됩니다. 정량자 분석 물질 이
름은 공백으로 끝나고 뒤에 숫자 1
이 와야 합니다. 비율 이온 분석 물
질 이름은 공백으로 끝나고 뒤에 2
와 9 사이의 숫자가 와야 합니다.

해당 없음

MQ Sample
Report with
MRM ratios EU

알 수 없는 각 샘플에 대한 File
Information, Sample Info 및 Results
Summary Table이 포함된 섹션을 보
여 주는 보고서입니다. Expected
Ion ratios는 사용 가능한 모든 표준
을 이용하여 자동 계산됩니다. 비율
값은 Results Table 내 사용자 지정
열에 배치됩니다. 예상 값을 벗어난
값은 플래그가 지정됩니다(비율 허
용 오차에 대한 EU 지침 사용). 정량
자 분석 물질 이름은 공백으로 끝나
고 뒤에 숫자 1이 와야 합니다. 비율
이온 분석 물질 이름은 공백으로 끝
나고 뒤에 2와 9 사이의 숫자가 와야
합니다.

연결된 쿼리 파일은
MRM ratios EU.query입니다.

MQ Sample
Report with
MRM ratios MQ
EFAB 03

알 수 없는 각 샘플에 대한 File
Information, Sample Info 및 Results
Summary Table이 포함된 섹션을 보
여 주는 보고서입니다. Expected
Ion ratios는 사용 가능한 모든 표준
을 이용하여 자동 계산됩니다. 비율
값은 Results Table 내 사용자 지정
열에 배치됩니다. 예상 값의 20%를
벗어난 값은 플래그가 지정됩니다.
정량자 분석 물질 이름은 공백으로
끝나고 뒤에 숫자 1이 와야 합니다.
비율 이온 분석 물질 이름은 공백으
로 끝나고 뒤에 2와 9 사이의 숫자가
와야 합니다.

해당 없음
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표 6-11 기본 템플릿 (계속)

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

MQ Sample
Report with
MRM ratios

알 수 없는 각 샘플에 대한 File
Information, Sample Info 및 Results
Summary Table이 포함된 섹션을 보
여 주는 보고서입니다. Expected
Ion ratios는 사용 가능한 모든 표준
을 이용하여 자동 계산됩니다. 비율
값은 Results Table 내 사용자 지정
열에 배치됩니다. 예상 값의 20%를
벗어난 값은 플래그가 지정됩니다.
정량자 분석 물질 이름은 공백으로
끝나고 뒤에 숫자 1이 와야 합니다.
비율 이온 분석 물질 이름은 공백으
로 끝나고 뒤에 2와 9 사이의 숫자가
와야 합니다.

연결된 쿼리 파일은
MRM ratios.query입니다.

MQ Sample
Report with
standards, QC,
and blanks

각 샘플에 대한 File Information,
Standards Summary Table, QC
Summary Table, Blanks Results
Table이 포함된 섹션과 알 수 없는
각 샘플에 대한 File Information,
Sample Info, IS Info, Analyte
Results Table, XIC 테이블(IS 및 각
분석 물질 포함)가 포함된 섹션을 보
여 주는 보고서입니다. 대해 8개 미
만의 분석 물질에 대해 샘플당 두 페
이지를 인쇄합니다.

Reportable 확인란의 선택이 취소
된 Standards 및 Quality Controls는
보고서의 각 요약 테이블에 표시되
지 않으며 통계 계산에도 사용되지
않습니다.

MQ Tutorial
Dataset Heavy
Light

해당 없음 이 보고서는 Tutorial Dataset Heavy
Light 데이터 세트와 함께 사용하기
위한 것입니다. 자세한 정보는
MultiQuant 소프트웨어의 사용자 안
내서에서 두 번째 예제인 상대 정량
화 예제를 참조하십시오.

Per Sample
Quant-Qual

선택한 각 샘플에 대한 File
Information, Sample Information 및
선택한 분석 물질에 대한 Analyte
Results Table이 포함된 섹션을 제공
하는 보고서입니다. Analyte Results
Table은 Results Table에 표시된 대
로 인쇄됩니다. 모든 정성적 신뢰도
신호등이 테이블의 시작 부분에 나
열됩니다.

해당 없음
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표 6-11 기본 템플릿 (계속)

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

Per Sample
Quant-Qual
Visible Rows
Using Visible
Analyte

선택한 각 샘플에 대한 File
Information, Sample Information 및
선택한 분석 물질에 대한 Analyte
Results Table이 포함된 섹션을 제공
하는 보고서입니다. Analyte Results
Table은 Results Table에 표시된 대
로 인쇄됩니다. 모든 정성적 신뢰도
신호등이 테이블의 시작 부분에 나
열됩니다.

행의 숨김 상태가 Reportable 확인
란 상태보다 우선합니다.
Reportable 확인란을 선택했지만
행이 숨겨져 있으면 해당 행이 보고
되지 않습니다.

Per sample
Quant-Qual with
statistics

WYSIWYG 테이블을 사용하여 각
샘플에 대한 구성 요소를 보여 주는
보고서입니다. XIC, MS 및 MS/MS
가 표시됩니다. 영역에 대한 통계 요
약 테이블이 보고서의 끝에 표시됩
니다.

• 구성 요소 테이블에 UV 구성 요
소가 있는 경우 보고서에서 XIC
그래프 아래에 UV 트레이스가 보
고됩니다.

참고: uv 접미사는 UV MS Qual
보고서와 연결되므로 UV 구성 요
소 이름이 [compound_nameuv]
또는 [uv] 형식인 경우 UV 트레이
스가 보고되지 않습니다.

• 샘플에 QC 레이블이 지정되고
샘플이 2개 이상 있는 경우 평균,
STDEV 및 %CV가 계산되어 보
고서 끝에 나오는 QC 요약 테이
블에 포함됩니다.

• QC 행에 대한 Reportable 확인
란의 선택을 취소할 경우 해당 행
은 QC 요약 테이블의 계산에 사
용되지 않습니다.

Per Analyte
Quant-Qual

각 분석 물질에 대한 File
Information, Results Table,
Calibration Curves, 내부 표준 및 각
분석 물질을 포함한 크로마토그램이
포함된 섹션을 표시하는 보고서입니
다. 이 템플릿은 그룹이 정의되어 있
는 Results Table에 적합합니다.

해당 없음
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표 6-11 기본 템플릿 (계속)

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

Positive Hits
Qual

선택한 각 샘플에 대한 File
Information, Sample Information, 선
택한 분석 물질에 대한 Analyte
Results Table, 모든 분석 물질, 내부
표준 물질 에 대한 중첩된 크로마토
그램, XIC, Acquired/Theoretical MS
spectra, 선택한 각 분석 물질에 대
한 Acquired/Library MS/MS spectra
등이 포함된 섹션을 제공하는 보고
서입니다. Analyte Results Table은
Results Table에 표시된 대로 인쇄됩
니다. 모든 정성적 신뢰도 신호등이
테이블의 시작 부분에 나열됩니다.

해당 없음

Qual CSV report 각 샘플에 대한 File Information,
Sample Information 및 Analyte
Results Table이 포함된 섹션을 보여
주는 csv 형식의 보고서입니다.

보고서 형식에 CSV 옵션을 사용하
는 것이 좋습니다.

Sample
Summary

각 샘플에 대한 Analytes Summary
Table 섹션을 보여 주는 보고서입니
다. 이 보고서 템플릿은 그룹이 있는
Results Table에 적합합니다.

해당 없음

작동 지침—처리

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템

169/325



표 6-11 기본 템플릿 (계속)

템플릿 템플릿 설명(Create Report 대화 상
자에 표시됨)

추가 참고 사항

UV MS Qual
report

각 샘플에 대해 WYSIWYG 테이블
을 사용하여 샘플의 구성 요소 및 해
당 UV 구성 요소를 보여 주는 보고
서입니다. XIC, MS 및 MS/MS가 UV
데이터와 함께 표시됩니다. 영역에
대한 통계 요약 테이블이 보고서의
끝에 표시됩니다.

• UVMS 데이터는 질량 분석계
(MS) 구성 요소에 대한
compound 1(문자열) 명명 규칙
과 해당 UV 구성 요소에 대한
compound 1uv(문자열 뒤에 uv)
명명 규칙을 사용하여 처리해야
합니다.

• 질량 오차, 단편 질량 오차, RT 신
뢰도, 동위 원소 신뢰도 및 라이
브러리 신뢰도 신호등만 표시됩
니다.

• compound 1의 XIC, MS1 트레이
스, MS/MS 트레이스 및 머리글
정보와 compound 1uv의 UV 트
레이스를 포함하여 Results Table
의 각 구성 요소를 표시하기 위해
그래프 테이블이 생성됩니다. 자
세한 정보는 그림 6-35에서 확인
하십시오.

• 분석 물질 그래프는 UV 실험이
아니라 MS 실험에 대해서만 반
복됩니다.

• 샘플에 QC 레이블이 지정되고
샘플이 2개 이상 있는 경우 평균,
STDEV 및 %CV가 계산되어 보
고서 끝에 나오는 QC 요약 테이
블에 포함됩니다. 자세한 정보는
그림 6-36에서 확인하십시오.

• QC 행에 대한 Reportable 확인
란의 선택을 취소할 경우 해당 행
은 QC 요약 테이블의 계산에 사
용되지 않습니다.
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그림 6-35 그래프 테이블

그림 6-36 통계 테이블
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이벤트 7
Central Administrator Console (CAC) 소프트웨어는 문제가 발생하면 화면에 표시되는 오류
보고서 및 경고를 기록합니다. Event Log 작업 영역에는 오류, 경고 및 메시지를 포함한 시스
템 이벤트 로그가 포함됩니다.

이 작업 영역을 열려면 홈 페이지에서 Event Log 타일을 클릭합니다.

표 7-1 Event Log 작업 영역 열

레이블 설명

Current (현재)각 하위 시스템의 현재 이벤트 목록입니다.

Severity (심각도)정보, 오류 또는 경고와 같은 이벤트 유형입니다.

Time (시간)이벤트가 발생한 시간입니다.

Subsystem (하위 시스템)이벤트가 발생한 하위 시스템입니다.

Event (이벤트)이벤트에 대한 설명입니다. 이 정보를 사용하여 시스템 문제를 해
결할 수 있습니다.

User (사용자)사용자 이름 및 이벤트가 발생한 시스템입니다.

참고: 결정 규칙에 의해 트리거된 이벤트의 경우 배치를 제출한 사용자입
니다.

이벤트 로그
다음 로그를 사용할 수 있습니다.

• All(모두)

• Device(장치)

• LC(LC)

• Mass Spectrometer(질량 분석계)

• Workspace(작업 영역)

• Batch(배치)

• Explorer(탐색기)

• Devices(장치)

• General(일반)

• LC Method(LC 방법)

• MS Method(MS 방법)
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• MS Tune(MS 조정)

• Analytics(분석)

• Queue(대기열)

• Users(사용자)

• Configuration(구성)

이벤트 로그에 20,000개의 레코드가 포함되면 SCIEX OS에서 자동으로 레코드를 보관하고
새 이벤트 로그를 시작합니다. 자세한 정보는 이벤트 로그 보관 섹션을 참조하십시오.

로그 보기
1. Event Log 작업 영역을 엽니다.

2. 왼쪽 패널의 목록에서 로그를 볼 항목을 클릭합니다.

로그 보관
1. Event Log 작업 영역을 엽니다.

2. Archive > Archive Log를 클릭합니다..

그림 7-1 Archive 메뉴: Archive Log

그림 7-2 Archive Log 대화 상자

3. Archive event log items older than 필드에서 날짜 아이콘을 클릭한 후 날짜를 선택합니
다.

4. Archive를 클릭합니다.
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보관된 로그 보기
1. Event Log 작업 영역을 엽니다.

2. Archive > Open Log Archive를 클릭합니다..

그림 7-3 Archive 메뉴: Open Log Archive

3. 필요한 파일을 엽니다.

4. Archive > Close Log Archive를 클릭합니다..

그림 7-4 Archive 메뉴: Close Log Archive

로그 인쇄
1. Event Log 작업 영역을 엽니다.

2. (선택 사항) 보관된 로그를 엽니다. 자세한 정보는 보관된 로그 보기 섹션을 참조하십시오.

3. Print를 클릭합니다.
Print 대화 상자가 열립니다.

4. 프린터를 선택한 후 Print를 클릭합니다.

이벤트 로그 보관
이벤트 레코드는 이벤트 로그에 누적되어 탐색 및 관리하기 어려운 큰 파일이 생성될 수 있습
니다.

이벤트 로그의 레코드 수가 20,000개가 되면 해당 내역이 보관됩니다. 최종 이벤트 레코드가
이벤트 로그에 추가된 후 이벤트 로그의 유형과 날짜 및 시간을 나타내는 파일 이름으로 저장
됩니다. 새 이벤트 로그가 생성됩니다. 새 이벤트 로그의 첫 번째 레코드는 이벤트 로그가 보관
되었음을 보고합니다.
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이벤트 로그 보관 파일은 C:\ProgramData\SCIEX\Clearcore2.Acquisition 폴더에
저장됩니다. 파일 이름은 <logfile>Archive_<YYYYMMDD>_<HHMMSS>.data 형식입니다. 예
를 들면 CustomerLogArchive_20220427_172915.data입니다.
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감사 8
이 섹션에서는 감사 기능을 사용하는 방법에 대해 설명합니다.

오디트 트레일 레코드 보기
1. Audit Trail 작업 영역을 엽니다.

2. 워크스테이션의 오디트 트레일을 보려면 왼쪽 창에서 Workstation을 클릭합니다.

3. 프로젝트의 오디트 트레일을 보려면 왼쪽 창에서 프로젝트를 선택합니다. 그리고 다음 중
하나를 선택합니다.

• General Events: 오디트 맵 변경 및 샘플 획득과 같이 전체 프로젝트에 적용되는 오디
트 레코드를 표시합니다.

• Analytics: Results Table에 대한 오디트 레코드를 표시합니다.

• All Project Events: 일반 이벤트와 처리 이벤트 둘 다에 대한 오디트 레코드를 표시합
니다.

키워드 검색을 사용하여 감사된 이벤트 필터링
사용자는 키워드 검색을 사용하여 감사 내역의 감사된 이벤트를 필터링할 수 있습니다. 검색
된 모든 텍스트 항목은 강조 표시됩니다.

1. Audit Trail 작업 영역을 엽니다.

2. 검색할 감사 내역을 선택합니다. 자세한 정보는 오디트 트레일 레코드 보기 섹션을 참조
하십시오.
감사 내역 레코드가 표시됩니다.

3. Find in Page 필드에 찾을 단어를 입력합니다.
페이지에서 찾은 모든 단어 항목이 강조 표시됩니다.

4. Next( ) 및 Previous( ) 버튼을 사용하여 일치 항목 간에 이동합니다.

지정된 기준 세트를 사용하여 감사된 이벤트 필터링
사용자는 일련의 지정된 기준을 사용하여 감사 내역의 감사된 이벤트를 필터링할 수 있습니
다.

1. Audit Trail 작업 영역을 엽니다.

2. 필터링할 감사 내역을 선택합니다. 자세한 정보는 오디트 트레일 레코드 보기 섹션을 참
조하십시오.
감사 내역 레코드가 표시됩니다.

3. Filter( )를 클릭합니다.
Filter Audit Trail 대화 상자가 열립니다.
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4. 목록을 사용하여 필수 필터 기준을 정의합니다.

그림 8-1 Filter Audit Trail 대화 상자

항목 설명

1 <No Filter> 목록에서 필터링할 필드를 선택합니다. 다음 필드를 필터링
할 수 있습니다.

• Description

• Sample Name

• Full User Name

• E-Signature

• Reason

2 정확히 일치하는 단어 또는 구를 필터링하려면 선택합니다.

3 부분적으로 일치하는 단어 또는 구를 필터링하려면 선택합니다.

4 다음과 같이 필터링할 텍스트를 지정합니다.
• 전체 텍스트 문자열을 입력합니다. Is를 선택합니다(항목 2).

• 텍스트 문자열 일부를 입력합니다. Contains를 선택합니다(항목 3).

• Yes 또는 No를 선택합니다.

5 특정 날짜 및 시간 동안 발생한 이벤트를 필터링하려면 선택합니다.

5. 필터를 지우려면 다음 단계를 수행합니다.
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a. Filter( )를 클릭합니다.

b. Clear를 클릭하여 모든 필터 기준을 No Filter로 재설정합니다.

c. OK를 클릭합니다.

감사 내역 인쇄
1. Audit Trail 작업 영역을 엽니다.

2. 인쇄할 감사 내역을 선택합니다. 자세한 정보는 오디트 트레일 레코드 보기 섹션을 참조
하십시오.

3. Print를 클릭합니다.
Print 대화 상자가 열립니다.

4. 프린터를 선택한 후 Print를 클릭합니다.
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작동 이론—소프트웨어 A
이 절에서는 소프트웨어에 사용되는 개념을 설명합니다.

데이터 처리
SCIEX OS 소프트웨어를 사용하려면 Windows 7(64비트) 또는 Windows 10(64비트) 운영 체
제를 실행하는 컴퓨터가 필요합니다. 컴퓨터와 관련 시스템 소프트웨어는 시스템 컨트롤러 및
관련 펌웨어와 함께 작동하여 시스템과 데이터 획득을 제어합니다. 시스템 작동 중에 획득한
데이터는 SCIEX OS 소프트웨어로 전송되어 전체 질량 스펙트럼, 시간에 따른 단일/다중 이온
강도 또는 시간에 따른 총 이온 전류로 표시될 수 있습니다.

스캔 기술
이 시스템은 액상 샘플 스트림에 대한 액체 크로마토그래피 질량 분광분석법 분석을 수행하여
화합물을 식별, 정량화 및 검사하는 안정된 다용도 시스템입니다.

이 시스템은 다음과 같은 질량 분광분석법 기술을 이용하여 샘플을 분석합니다.

• 단일 질량 분광분석법(Mass Spectrometry, MS)의 두 가지 모드:

• 사극자 기반 단일 질량 분광분석법(Q1 교정에만 해당)

• 비행 시간법 기반 단일 질량 분광분석법

• 한 가지 모드의 직렬식 질량 분광분석법(MS/MS):

• 생성 이온 질량 분광분석법

다양한 데이터 보기
크로마토그램
크로마토그램은 반복 실험에서 시간에 대한 수량 변화를 표시합니다. 기기가 주어진 질량 스
펙트럼 스캔 세트를 여러 번 반복하도록 프로그래밍된 경우를 예로 들 수 있습니다. 크로마토
그래픽 데이터는 데이터 강도가 0인 경우에도 연속적입니다. 크로마토그램은 기기에 의해 바
로 생성되지 않으며 질량 스펙트럼에서 생성됩니다.

크로마토그램 그래프에서 강도(초당 카운트 수(cps))는 X 축의 시간에 대해 Y 축에 표시됩니
다. 피크에는 자동으로 레이블이 지정됩니다.

크로마토그래픽 피크는 주어진 샘플에 대한 크로마토그래픽 조건의 변화에 따라 머무름 시간
과 강도가 변할 수 있습니다.

소프트웨어에는 다음과 같은 유형의 크로마토그램이 표시됩니다.

• TIC: 총 이온 전류를 시간 함수로 나타내는 플롯입니다.
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그림 A-1 TIC의 예

• XIC: 단일 개별 질량 값 또는 일련의 질량 스펙트럼 스캔의 질량 범위에서 강도 값을 구하여
생성되는 이온 크로마토그램입니다. XIC는 지정된 질량 또는 질량 범위의 동작을 시간 함
수로 나타냅니다.
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그림 A-2 XIC의 예

스펙트럼
스펙트럼은 질량 분석계에서 직접 획득한 데이터이며 일반적으로 특정 질량 대 전하비(m/z)
값을 사용하여 검출된 이온 수를 나타냅니다. X 축의 m/z 값과 Y 축의 강도(cps)를 사용한 그
래프로 표시됩니다.

데이터를 스펙트럼으로 표시하면 화합물에 대한 질량별 정보를 얻을 수 있습니다. 스펙트럼은
특정 크로마토그래픽 피크에 해당하는 이온의 m/z 값을 제공합니다. 이러한 이온을 사용하여
더 구체적인 정보를 찾을 수 있습니다. 예를 들어 스펙트럼은 각 질량의 강도를 포함하여 피크
를 구성하는 모든 질량을 표시합니다.

스펙트럼 강도는 변할 수 있지만 화합물 질량은 변하지 않으므로 m/z 값은 고정되어 있습니다.

스펙트럼 데이터를 생성하는 방법에는 두 가지가 있습니다.

• 단일 스캔만 획득하는 경우 스펙트럼으로 데이터 표시

• 크로마토그램에서 생성

재구성 스펙트럼
처리된 스펙트럼은 MS 또는 MS/MS 스펙트럼에 디콘볼루션 알고리즘을 적용하여 생성됩니
다. 재구성 스펙트럼은 해당하는 강도를 가진 0 전하 또는 중성 질량으로 구성됩니다. 스펙트
럼은 대개 화합물에 대한 분자량 정보를 제공합니다. 스펙트럼 강도는 변할 수 있지만 분자량
정보는 변하지 않습니다.

일반적인 재구성 스펙트럼은 X 축의 질량(Da)과 Y 축의 강도로 표시됩니다.
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결정 규칙
Queue 작업 영역에서 배치가 처리되는 동안 소프트웨어는 지정된 분석 결과에 대한 반응으로
선별된 수정 조치를 수행할 수 있습니다. 예를 들어 샘플이 처리 방법에 정의된 수락 기준(분석
결과)에 맞지 않는 경우 소프트웨어에서 샘플을 다시 주입(수정 조치)하라는 지침이 나타날 수
있습니다.

이 기능은 결정 규칙으로 구현됩니다. 결정 규칙은 크게 다음과 같은 두 가지 부분으로 구성됩
니다.

• 플래그 지정 규칙. 분석 결과를 정의합니다.

플래그 지정 규칙은 처리 방법에 정의됩니다.

• 수정 조치. 처리 결과가 분석 결과 기준을 충족하지 못할 경우 적용됩니다.

수정 조치에는 다음이 포함됩니다.

• 대기열 중지

• 배치 중단

• 다른 샘플 주입

• 플래그 지정된 샘플 다시 주입

사용자는 배치를 생성할 때 배치에 대한 결정 규칙을 활성화한 후 사용할 결정 규칙을 선택할
수 있습니다.

Dynamic Background Subtraction 알고리즘
Dynamic Background Subtraction 알고리즘은 IDA(정보 종속 획득) 실험에서 전구체 이온 검
출 기능을 향상시킵니다. 이 알고리즘이 활성화되면 IDA는 조사 스펙트럼에서 직접 전구체를
선택하지 않고 배경 감산 스펙트럼을 사용하여 MS/MS 분석을 위한 관심 전구체 이온을 선택
합니다. 이 프로세스는 LC 분석 중에 수행되므로 신호 강도가 증가하면 해당 종을 검출할 수
있습니다. 결과적으로 이 알고리즘은 LC 피크의 상승 부분에서 LC 피크의 맨 위 또는 약간 위
까지 전구체 이온을 검출하고 분석하는 데 중점을 둡니다.

정량적 분석
정량적 분석은 샘플에서 특정 물질의 농도를 찾는 데 사용됩니다. 소프트웨어는 알 수 없는 샘
플을 분석한 후 표준 샘플, 즉 동일한 물질을 포함하고 농도가 알려진 샘플과 비교하여 알 수
없는 샘플의 농도를 계산할 수 있습니다. 이 프로세스에서는 표준의 신호 응답 또는 응답 비율
을 사용하여 교정 곡선을 생성한 다음 알 수 없는 샘플의 농도를 계산합니다. 계산된 모든 샘플
의 농도는 Results Table에 추가됩니다.

정량적 분석은 대개 다중 감응 모니터링(MRM) 스캔을 사용하여 수행됩니다. MRM 스캔에서
는 전구체 이온 및 특유의 생성 이온을 사용하여 분석 물질에 매우 특정한 MRM 전이를 정의
합니다. MRM 전이는 액체 크로마토그래피 중에 분석 물질과 관련된 머무름 시간과 결합하여
정량화에 필요한 특이성을 제공합니다.

정량화는 검증된 MRM LC-MS/MS 획득 방법 사용, 교정 표준 곡선 획득, 관심 화합물과 관련
된 피크 통합을 통해 수행됩니다. 신호 응답과 농도 사이의 교정 곡선 관계를 사용하여 알 수
없는 샘플에서 특정 분석 물질의 양을 결정합니다.
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표준 추가
표준 추가 기능은 알려진 매트릭스 효과로 인해 일반 교정 곡선을 사용할 수 없는 샘플에서 화
합물의 농도를 결정하는 데 사용할 수 있습니다.

이 기능을 사용하면 소프트웨어에서 직접 표준 추가 계산을 수행할 수 있습니다. 정량화 워크
플로에서 표준 추가 기능이 활성화되면 통합 중에 표준 추가 계산이 수행되고 Results Table에
결과가 표시됩니다.

이 기능을 사용하도록 설정하면 다음 회귀 매개 변수를 사용할 수 없습니다.

• Regression Type

• Weighting Type

• Automatic Outlier Removal

표준 추가 기능 사용
1. Analytics 작업 영역을 엽니다.

2. Process Method > New를 클릭합니다.

팁! 기존 처리 방법을 편집하려면 Process Method > Edit embedded method를 클릭한
후 다음 단계를 사용하십시오.

3. Workflow 페이지를 선택한 후 하나 이상의 워크플로 및 참조 샘플을 선택합니다.

4. Components 페이지를 선택한 후 구성 요소 이름, 질량, 내부 표준, 그룹 등을 정의합니다.

팁! Components 표에 그룹이 정의된 경우 사용자는 전이에 대해 전구체 이온과 실험 색
인이 달라도 그룹의 이온을 합산하도록 선택할 수 있습니다. 합산된 이온은 표에는 표시
되지 않지만 Integration 페이지 및 Results Table에 <group name>_Sum으로 표시됩니다.
이 기능은 단백질 및 펩타이드의 정량화에 유용합니다.

팁! 구성 요소의 머무름 시간을 알 수 없는 경우 질량 또는 화학식의 Retention Time
Mode를 Find n peaks로 설정하십시오. 여기서 n은 1, 2, 5, 10 또는 모두입니다. 소프트
웨어는 피크 면적이 가장 큰 지정된 수의 형상을 식별하고 적절한 머무름 시간을 할당한
후 표적 피크 처리 워크플로를 수행합니다. 처리가 완료되면 Results Table의 포함된 방법
을 일반 표적 방법으로 저장할 수 있습니다.

5. Integration 페이지를 선택한 후 각 구성 요소에 대한 통합 매개 변수를 선택합니다.

6. Options > Quantitate by standard addition을 클릭합니다.

이 기능을 사용하려면 다음 배치 필드에 대한 특정 요구 사항을 충족해야 합니다.

• Sample ID: 동일한 표준 추가 그룹에 속한 모든 샘플의 샘플 ID가 같아야 합니다.

• Sample Type: 표준 추가를 사용하여 정량화할 모든 샘플의 유형이 Standard여야 합
니다.

• Actual Concentration: 이 필드는 표준 추가 그룹의 각 샘플에 추가된 알려진 표준 농
도를 포함해야 합니다. 예를 들어 표준이 추가되지 않은 샘플의 경우 0입니다. 이 열의
데이터는 교정 곡선에서 X 축으로 표시됩니다.
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이 기능을 사용하도록 설정하면 샘플에 대한 Standard Addition Calculated
Concentration을 Standard Addition Actual Concentration과 비교하는 새 Standard
Addition Accuracy 필드가 Results Table에 포함됩니다.

특정 샘플에 대한 교정 곡선의 동적 보기가 교정 곡선에 표시됩니다.

질량 재구성
큰 분자의 경우 일반적으로 MS 전체 스캔 스펙트럼에서 전하 상태 확산이 관찰됩니다. 사용자
는 질량 재구성 기능을 통해 소프트웨어에서 직접 스펙트럼 디콘볼루션을 수행한 후 디콘볼루
션 또는 0 전하 질량 피크를 기반으로 정량화를 수행할 수 있습니다. 정량화 워크플로에서 질
량 재구성 기능이 활성화되면 처리 중에 피크 찾기, 스펙트럼 디콘볼루션, 질량 피크 찾기 및
통합이 수행되고 Results Table에 결과가 표시됩니다.

질량 재구성 기능 사용

참고: 질량 재구성은 정량화 워크플로에서만 지원됩니다.

참고: 질량 재구성은 MQ4 및 Summation 통합 알고리즘에 대해서만 지원됩니다.

참고: 질량 재구성이 활성화되면 Options > Sum Multiple Ion이 비활성화됩니다.

1. Analytics 작업 영역을 엽니다.

2. Process Method > New.를 클릭합니다.

팁! 기존 처리 방법을 편집하려면 Process Method > Edit embedded method를 클릭한
후 다음 단계를 사용하십시오.

3. Workflow 페이지를 선택한 후 Quantitation 워크플로와 참조 샘플을 선택합니다.

4. Components 페이지를 선택합니다.

5. Options > Mass Reconstruction을 클릭합니다.

6. 필수 필드에 정보를 입력하여 구성 요소를 추가합니다.

참고: Expected MW 필드는 선택 사항입니다.

7. Integration을 클릭하여 통합 페이지를 보고 XIC 크로마토그래프, 평균 스펙트럼 및 재구
성 스펙트럼을 검토하고 목표 질량을 선택합니다.

8. 방법을 저장합니다.

이 기능을 사용하면 Results Table에 Expected MW, MW, MW Delta (Da), MW Delta
(ppm), IS Expected MW, IS MW, IS MW Delta (Da) 및 IS MW Delta (ppm) 등의 새 열이
포함됩니다.

정성적 분석
정성적 분석은 대상 또는 미확인 화합물을 식별하는 작업입니다. 질량 분광분석법에서 어떤
화합물이 존재하는지에 대한 결정은 질량 정확도, 머무름 시간, 동위 원소 패턴, 라이브러리 검
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색 및 공식 탐색을 사용하여 이루어집니다. 이러한 도구를 다함께 사용하여 미확인 샘플에 포
함된 대상 및 비대상 화합물의 식별에 신뢰도를 높일 수 있습니다.

질량 정확도
샘플 내에서 알려진 표적 화합물을 식별할 때 해당 화합물의 질량 정확도를 확인하여 이 화합
물에 대한 잠재적 일치 항목의 질량 정확도가 특정 허용 오차 내에 있는지 판별하는 것이 유용
합니다. 예를 들어 이마잘릴의 화학식은 C14H14Cl2N2O이며, 소수점 이하 네 자리까지 단일 동
위 원소 질량(296.0483)을 제공합니다. 양성화된 부가물은 일반적으로 질량 분석계를 사용하
여 검출되는 양전하 이온입니다. 이마잘릴의 양성화된 부가물은 297.0556의 질량 대 전하비
(m/z)를 갖습니다. 이마잘릴이 샘플에 있다고 의심되면 검색된 화합물의 m/z를 양성화된 이마
잘릴의 m/z와 비교하여 얼마나 근접하게 일치하는지 확인하십시오. 차이(ppm 또는 Da)가 작
을수록 검색된 화합물이 일치할 가능성이 높습니다.

머무름 시간
대부분의 질량 분석계는 크로마토그래피를 사용합니다. 화합물의 머무름 시간은 화합물의 알
려진 표준 물질 주입에 의해 결정됩니다. 머무름 시간을 사용하여 샘플에서 표적 화합물을 식
별할 수 있습니다. 의심되는 화합물이 알 수 없는 샘플에 있는 경우 머무름 시간이 표준의 머무
름 시간에 가까울수록 알 수 없는 화합물을 식별할 수 있는 가능성이 더 큽니다. 머무름 시간은
변경할 수 있으며 알려진 표준을 사용하여 자주 확인해야 합니다.

동위 원소 패턴
질량 분석계의 화합물에서 얻은 전체 스캔 질량 스펙트럼은 분자식에 따라 고유한 동위 원소
패턴을 가집니다.

이마잘릴의 동위 원소 패턴은 다음 그림을 참조하십시오.

그림 A-3 동위 원소 패턴 (이마잘릴)

이와 같은 이마잘릴의 동위 원소 패턴은 이 원소에 대한 서로 다른 질량 동위 원소로 구성됩니
다. 동위 원소 패턴은 이론적으로 계산된 후 미확인 화합물에 대해 실제로 획득한 것과 비교됩
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니다. 이론과 실제 동위 원소 패턴이 서로 더 가깝게 일치할수록 해당 화합물이 식별될 가능성
이 높아집니다.
라이브러리 검색
미확인 샘플에서 획득한 MS/MS 스펙트럼과 참조 스펙트럼을 가진 화합물 데이터베이스와의
상호 비교는 정성 분석에서 가장 강력한 도구입니다. 라이브러리 검색 알고리즘은 샘플의 미
확인 스펙트럼을 비교하여 데이터베이스에 있는 이미 알려진 화합물 및 스펙트럼과 일치되는
부분을 찾습니다. 더 가깝게 일치하고 보고된 점수가 더 높을수록 이미 알려진 화합물과 같을
확률이 높아집니다.

순도, 적합도 및 반전 적합도는 다음과 같이 계산됩니다.

• (감소된) 라이브러리 스펙트럼과 (감소된) 미확인 스펙트럼 모두에서 주어진 질량 위치에
피크가 나타나며 강도 비율이 사용자가 지정한 한계 내에 있는 경우, 라이브러리 스펙트럼
의 피크 강도는 비확인 스펙트럼에서의 강도와 동일하게 설정됩니다.

• 순도는 다음과 같이 계산됩니다.

100.0 (ULtotal)2/(Utotal•Ltotal) 여기서:

Utotal = ∑ Um•Um

Ltotal = ∑ Lm•Lm

ULtotal = ∑ Um•Lm

합계에는 강도 Um 및 Lm 이 가중치가 매겨진 감소된 항목, 미확인 항목 및 라이브러리 항목
의 제곱근인 모든 질량이 포함됩니다. 순도는 반드시 0 ~ 100 사이의 범위에 속하게 되며
라이브러리 스펙트럼과 미확인 스펙트럼간 유사성을 측정하는 항목입니다.

• 라이브러리 스펙트럼에 나타나는 질량만 합계에 포함된다는 점을 제외하면 적합도는 순도
와 동일한 방법으로 계산합니다. 이 합계에서 항이 삭제되지 않으므로 Ltotal 또는 ULtotal 에
는 영향을 주지 않습니다. 적합도는 라이브러리 스펙트럼이 미확인 스펙트럼에 포함되는
정도를 측정하는 항목입니다. 고적합도 및 저순도인 경우는 미확인 스펙트럼이 순도는 낮
지만 라이브러리 화합물을 포함하고 있을 가능성을 나타냅니다.

• 미확인 스펙트럼에 나타나는 질량만 합계에 포함된다는 점을 제외하면 반전 적합도도 순도
와 동일한 방법으로 계산합니다. 반전 적합도는 미확인 스펙트럼이 라이브러리 스펙트럼에
포함되는 정도를 측정하는 항목입니다.

수식 찾기
질량 값을 사용하는 수식 찾기 알고리즘은 질량 분석계에서 생성된 MS 및 MS/MS 스펙트럼을
기반으로 화합물의 화학식을 예측하려고 합니다. 여러 수식이 질량 오차 내에서 일치하는 경
우가 종종 있기 때문에 수식 찾기 점수가 높아도 샘플의 화합물이 수식 찾기 알고리즘에 의해
식별된 것이 아닐 수도 있습니다. 수식 찾기를 사용하여 화합물을 식별하기 전에 주의가 필요
하며 확인용 검사가 별도로 수행되어야 합니다.

참고: 공칭 질량 시스템으로 수식 찾기를 수행하는 것은 권장되지 않습니다.

수식 찾기 알고리즘은 질량 정확도를 위해 신호등 설정을 사용합니다. 빨간색 ppm 오차는 0점
을 얻고 완벽하게 일치하는 항목은 100점을 얻습니다.
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MS 스펙트럼은 최종 수식 찾기 점수에서 67%를 차지하고 MS/MS 스펙트럼은 33%를 차지합
니다. 결과적으로 MS 질량을 예측하는 수식의 능력이 점수에 영향을 미치는 주요 요인입니다.
그러나 MS/MS 단편 일치도 점수에 영향을 줍니다.

동위 원소 패턴은 검색한 수식 목록을 생성하는 데 사용되지만 최종 점수를 생성하는 데는 사
용되지 않습니다. 따라서 동위 원소 패턴이 잘못된 수식은 목록에 포함되지 않을 수 있습니다.

가능한 수식 목록은 전구체 질량 정확도, 동위 원소 패턴 및 MS/MS 단편화를 사용하여 결정됩
니다. 제안된 수식은 전구체 질량 정확도 및 일치하는 단편의 평균 MS/MS 질량 정확도에 따라
점수가 부여됩니다.

통합
정량적 또는 정성적 분석에서 통합은 관심 화합물에 대한 크로마토그래픽 피크 면적 또는 높
이를 생성하는 것을 나타냅니다. 처리 방법은 데이터를 처리하는 데 필요한 모든 정보를 포함
합니다.

주어진 샘플 세트에 대한 정량적 또는 정보가 취합된 것을 Results Table이라고 부릅니다.
Results Table 참조

소프트웨어에는 다음과 같은 세 가지 통합 알고리즘이 있습니다.

• MQ4: 최저 농도는 아니지만 낮은 농도의 표준 또는 품질 관리 샘플이 분석 실행을 위한 대
표 샘플로 자동 선택됩니다.

• AutoPeak: 포화 농도는 아니지만 높은 농도의 표준 또는 품질 관리 샘플이 분석 실행을 위
한 대표 샘플로 자동 선택됩니다.

• Summation: 일반 피크 검색을 수행하지 않지만 피크가 예상 머무름 시간에 가까이 있다고
가정합니다.

알고리즘이 놓친 피크를 수동으로 통합할 수도 있습니다.

AutoPeak 통합 알고리즘 매개 변수
다음 매개 변수는 관심 피크를 식별하고 보고하는 데 사용됩니다.

사용 가능한 매개 변수의 전체 목록은 도움말 시스템을 참조하십시오.

• Local peak baseline: 소프트웨어에서는 전체 크로마토그램에 대한 기준선을 계산하는 대
신, 국부적으로 피크 주변 기준선의 변화를 평가합니다.

• 선형 피크 기준선: 소프트웨어는 피크 아래에 비선형 기준선을 가지는 것이 아니라 특정 피
크 그룹의 시작점과 끝점 사이에 선을 적합시킵니다.

Saturation correction: 알고리즘이 피크가 포화 상태인 것으로 감지하면 검출기가 포화되지
않았을 때의 예상 피크 모양을 예측하는 모델을 사용합니다. 이렇게 하면 획득할 수 있는 반응
에 근접하도록 프로필이 피크 맨 위를 지나 확장됩니다. 이를 통해 교정 곡선의 선형 동적 범위
를 확장할 수 있습니다. 이 옵션은 처리 방법 생성 또는 개별 피크 검토 도중이 아닐 때 전체 알
고리즘 기본값을 설정하는 경우에만 사용 가능합니다. 이 설정을 일부 피크에만 사용하는 것
은 유용하지 않기 때문입니다.
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Minimum Signal/Noise
아래 그림의 왼쪽 그래프와 같이 최소 신호 대 노이즈 값이 7로 설정되면 피크가 보고되지 않
습니다. 오른쪽 그래프와 같이 최소 신호 대 노이즈 값이 2로 설정되면 피크가 보고됩니다. 이
매개 변수는 통합에 영향을 주지 않습니다.

그림 A-4 S/N 임계값

신뢰도 임계값
이 매개 변수는 가양성인 잠재적 피크를 필터링할 때 사용합니다. 기본값은 50%이며 대개 이
값이 적합합니다. 그러나 사용자는 노이즈를 많이 포함한 데이터 또는 피크 폭이 샘플별로 크
게 다른 데이터에는 더 큰 값을 사용할 수 있습니다.

다음 두 그림은 Confidence Threshold가 식별되는 피크 수에 어떤 영향을 주는지 보여줍니
다. Confidence Threshold가 50%로 설정된 경우 숄더가 작은 피크가 하나의 피크로 식별됩
니다. Confidence Threshold가 16%로 낮아지면 SignalFinder 알고리즘이 두 개의 피크를 찾
습니다. 해당하는 두 피크를 표시하려면 두 피크 영역을 끄십시오.

이 단일 피크에 존재할 수 있는 다른 피크를 확인하려는 경우 올바른 Confidence Threshold
를 알 수 없으면 Ctrl 키를 누른 후 관심 피크 영역을 끄십시오. 이렇게 하면 Confidence
Threshold가 50%로 설정되었을 때 존재하지 않는 두 번째 관심 피크가 표시되도록
Confidence Threshold가 자동으로 낮아집니다.

그림 A-5 50% 신뢰
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16% 신뢰일 때 두 개 피크가 발견됩니다. 두 피크를 식별하려면 피크 영역을 끄십시오.

그림 A-6 16% 신뢰

그림 A-7 신뢰 임계값 매개 변수

로컬/전역 피크 기준선 비교
피크 기준선은 로컬 또는 전역일 수 있습니다. 로컬 옵션을 선택하면 정량화 소프트웨어가 기
준선 변경 사항을 로컬로 평가합니다. 전역 옵션은 전체 크로마토그램을 기준선으로 사용합니
다.

로컬 기준선을 사용해야 하는 경우를 보여 주는 예는 다음 그림을 참조하십시오. 왼쪽 그래프
는 로컬 기준선을 이용하여 적절히 통합된 크로마토그램을 보여 줍니다. 오른족 그래프는 전
역 기준선을 이용하여 적절히 통합된 크로마토그램을 보여 줍니다.

작동 이론—소프트웨어

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템

189/325



그림 A-8 전역 기준선 사용

선형/비선형 피크 기준선 비교
피크 기준선을 선형 또는 비선형으로 설정할 수 있습니다. 비선형 옵션은 각 피크 아래에서 기
준선을 추정합니다. 선형 옵션은 특정 피크 그룹의 시작 지점과 끝 지점 사이에 선을 맞춥니다.
동시에 용리되는 피크에 대한 선형 기준선과 비선형 기준선의 예는 그림 A-9 및 그림 A-10에
서 확인하십시오. 1번 ~ 4번 항목은 나선형 피크입니다. 5번 항목은 여러 옵션으로 파생된 기
준선을 보여줍니다.

피크가 여러 개일 때 비선형 기준선을 사용하는 것이 좋습니다. 단일 피크의 경우 선형 기준선
과 비선형 기준선의 차이는 중요하지 않습니다.
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그림 A-9 선형 기준선 예시
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그림 A-10 비선형 기준선 예시

MQ4 통합 알고리즘 매개 변수
다음 매개 변수는 관심 피크를 식별하고 보고하는 데 사용됩니다. 사용 가능한 매개 변수의 전
체 목록은 도움말 시스템을 참조하십시오.

노이즈 백분율
이 매개 변수는 크로마토그램의 노이즈 수준을 추정하는 데 사용됩니다. 강도가 가장 작은 데
이터 요소 중 지정된 백분율의 요소가 노이즈로 간주됩니다.

일반적인 값 범위는 20%~60%입니다. 더 큰 피크가 존재하는 상태에서 작은 피크가 발견되지
않는 경우에는 노이즈 백분율을 낮춰야 합니다. 다음 그림은 매우 큰 피크가 있을 때 작은 피크
의 예를 보여줍니다. 이 피크는 노이즈 백분율이 90%로 설정되면 찾을 수 없지만 노이즈 백분
율이 40%로 설정되면 찾을 수 있습니다.
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그림 A-11 관심 피크

다음 그림에서 왼쪽 그래프는 40%로 설정된 노이즈 백분율을 보여줍니다. 오른쪽 그래프는
90%로 설정되었습니다.

그림 A-12 노이즈 수준

Baseline Subtract Window
크로마토그램은 다듬기 후 다른 처리를 시작하기 전에 데이터에서 위로 볼록한 부분을 제거하
기 위해 감산되는 기준선입니다. 각 데이터 요소에 대해 기준선은 최소 강도의 현재 점에서 왼
쪽과 오른쪽에 있는 데이터 요소를 둘 다 사용하여 계산됩니다.

이 매개 변수의 값이 예상 피크 폭보다 몇 배 이상 크게 설정되어 있으면 정확한 값은 중요하지
않습니다.

다른 그림에서 왼쪽 그래프는 0.1분으로 설정된 기준선 감산 범위를 나타내고 오른쪽 그래프
는 1분으로 설정된 기준선 감산 범위를 나타냅니다.
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그림 A-13 기준선 감산 범위

피크 분할
이 매개 변수는 노이즈 가능성이 있는 피크가 단일 피크인지 아니면 두 개 이상의 개별 피크인
지를 제어합니다. 두 잠재적 피크 간 차이가 지정된 값보다 작은 경우에는 한 개의 단일 피크가
발견됩니다. 그렇지 않은 경우에는 두 개의 피크가 발견됩니다.

이 매개 변수를 큰 값으로 설정하면 노이즈를 포함한 피크가 분리되어 두 개의 개별 피크로 발
견되지 않습니다. 그러나 가까이 용리(겹침)되는 별개의 두 피크가 존재하는 경우에는 더 작은
값을 사용해야 합니다.

다음 그림에서 왼쪽 그래프는 두 개의 점으로 설정된 피크 분할을 보여줍니다. 오른쪽 그래프
는 세 개의 점으로 설정된 피크 분할을 보여줍니다.

그림 A-14 피크 분할

회귀
분석 물질 피크의 면적 또는 높이는 교정 곡선과 메트릭 플롯에서 알려진 농도에 대해 표시됩
니다. 이후 선은 지점에 맞춰집니다. 이 회귀선은 알 수 없는 샘플의 농도를 계산하는 데 사용
됩니다.
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회귀 수식
이 절에서는 회귀 곡선을 계산하는 데 사용되는 수식을 설명합니다. 다음 수식에서 x는 표준
샘플의 분석 물질 농도를 나타내고 y는 해당 피크 면적 또는 높이를 나타냅니다. 회귀에 사용
되는 정확한 변수는 다음 표에 나타난 대로 내부 표준이 사용되는지 여부와 피크 면적 또는 피
크 높이가 사용되는지 여부에 따라 다릅니다.

표 A-1 회귀 변수

내부 표준 사용 면적 사용 x y

예 예 Ca / Cis / DF Aa / Ais

예 아니요 Ca / Cis / DF Ha / His

아니요 예 Ca/ DF Aa

아니요 아니요 Ca/ DF Ha

여기서:

• Ca = 실제 분석 물질 농도

• Cis = 내부 표준 농도

• DF = 희석배율

• Aa = 분석 물질 피크 면적

• Ais = 내부 표준 피크 면적

• Ha = 분석 물질 피크 높이

• His = 내부 표준 피크 높이

가중치 유형
다음 표에서는 7개의 각 가중치 유형에 대해 가중치 계수(w)를 계산하는 방법을 보여줍니다.

표 A-2 가중치 유형

가중치 유형 중량(w)

없음 항상 1.0입니다.

1 / x |x| < 10-5이면 w = 105, 그렇지 않으면 w = 1 / |x|입니다.

1 / x2 |x| < 10-5이면 w = 1010, 그렇지 않으면 w = 1 / x2입니다.

1 / y |y| < 10-8이면 w = 108, 그렇지 않으면 w = 1 / |y|입니다.

1 / y2 |y| < 10-8이면 w = 1016, 그렇지 않으면 w = 1 / y2입니다.

ln (x) x < 0이면 오류가 발생합니다. x < 10–5이면 w = ln 105, 그렇지 않으면 w =
|ln (x)|입니다.

ln (y) y < 0이면 오류가 발생합니다. y < 10–8이면 w = ln 108, 그렇지 않으면 w =
|ln (y)|입니다.
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상관 계수
회귀 수식에서 x, y, w는 앞에서 정의한 그대로입니다. 모든 합계는 사용되지 않는 것으로 표시
된 표준 샘플을 제외한 모든 표준 샘플에 대해 계산됩니다.

상관 계수는 다음과 같이 계산됩니다.

여기서:

•

• yc = 회귀 유형에 적합한 수식을 사용하여 계산된 Y 값

•

회귀 유형
Analytics 작업 영역에서 다음과 같은 회귀 유형을 사용할 수 있습니다.

• 평균(Metric Plot 창만 해당)

• 중앙값(Metric Plot 창만 해당)

• 선형(y = mx + b)

• 0 통과 선형(y = mx)

• 평균 감응 인자

• 이차(y = a2 + bx + c)

• 거듭제곱

• Wagner

• Hill

참고: Calibration Curve 창의 Regression Options 대화 상자에 있는 Remove outliers
automatically from the calibration curve 옵션은 선택한 관심 구성 요소에 이상값 자동 제거
규칙을 자동으로 적용합니다. 자세한 정보는 도움말을 참조하십시오.

선형

선형 교정 방정식은 다음과 같습니다.

y = mx + b

기울기와 절편은 다음과 같이 계산됩니다.
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여기서:

영점을 이용한 선형
영점 교정을 이용한 선형 방정식은 다음과 같습니다.

y = mx

기울기는 다음과 같이 계산됩니다.

평균 감응 인자
평균 감응 인자 교정은 다음과 같습니다.

y = mx

이 수식은 선형이지만 영점 교정인 경우와 동일합니다. 그러나 기울기는 다르게 계산됩니다.

또한 감응 인자의 표준 편차는 다음과 같습니다.

여기서:

참고: x 값이 0인 포인트는 총합에서 제외됩니다.

좌표로 이루어진 선에 일부 선형성 및 곡률이 있는 경우 선형 또는 이차 회귀 대신 거듭제곱 회
귀를 사용하여 이러한 적합 사이에 선을 생성합니다.

이차

이차 교정 방정식은 다음과 같습니다.

y = a2x2 + a1x + a0

다항식 계수는 다음과 같이 계산됩니다.

a2 = (b2/b0 - b5/b3) / (b1/b0 - b4/b3)

a1 = b5/b3 - a2b4/b3
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여기서:

거듭제곱

멱함수 교정 수식은 다음과 같습니다.

y = axp

선형 교정 수식은 위에 설명된 바와 같이 기울기(m)와 절편(b)을 계산하는 데 사용되지만 이
수식의 x가 In x로 대체되고 y가 ln y로 대체됩니다. 이 수식이 완료되면 a와 p가 다음과 같이
계산됩니다:

a = eb

p = m

x 또는 y 값 중 하나라도 음수이거나 0이면 오류가 보고됩니다.

Wagner
Wagner 교정 수식은 다음과 같습니다.

ln y = a2 (ln x)2 + a1 (ln x) + a0

이차 교정 수식은 위에서 설명한 대로 a0, a1및 a2를 계산하는 데 사용됩니다. 단, 수식에서 x가
ln x로 바뀌고 y가 ln y로 바뀝니다.

x 또는 y 값 중 하나라도 음수이거나 0이면 오류가 보고됩니다.

Hill
Hill 교정 수식은 다음과 같습니다.

y = (a + bxn) / (c + xn)

a, b, c, n에 해법 분석 기능을 제공하는 것은 불가능합니다. 그러나 반복 Levenberg-Marquardt
방법을 통해 계수가 결정됩니다.
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이상값 자동 제거
소프트웨어에서 선택적 기능을 사용하여 교정 곡선의 이상값을 자동으로 제거할 수 있습니다.
시간을 절약해 주는 이 기능은 선형 범위와 감도가 서로 다른 여러 화합물을 사용하는 적용 분
야에 유용합니다.

이 기능을 사용하도록 설정하면 소프트웨어가 모든 데이터 요소를 반복적으로 조사하여 시작
범위를 식별합니다. 연속하는 네 개의 점으로 구성된 시작 범위는 최상의 선형 회귀를 제공하
고 사용자가 지정한 이상값 제거 규칙을 충족합니다. 알고리즘은 시작점의 모든 순열에 대해
다중 회귀를 계산합니다. 사용자 지정 규칙을 충족하는 모든 유효한 회귀를 고려하고 전개 시
퀀스를 통해 모든 회귀를 가져옵니다. 유효한 모든 시작 범위에 대해 각 전개의 성공은 사용된
총 요소 수, 사용된 수준의 범위 및 전개 전후의 회귀에서 절대 정확도 오차가 가장 큰 요소에
따라 결정됩니다. 가장 큰 범위를 포함하고 규칙을 충족하는 회귀가 "최우선" 회귀입니다.

참고: 네 개의 데이터 요소를 사용할 수 없는 경우 소프트웨어는 세 개의 요소를 사용합니다.
데이터 요소가 세 개 미만인 경우에는 알고리즘이 적용되지 않습니다.

이상값 자동 제거 규칙은 처리 방법에 정의되며 다음을 포함합니다.

• 최소 상관 계수(r)

참고: 이 옵션은 결정 계수(r2)가 아니라 상관 계수를 사용합니다.

• 최소 정량 한계(LLOQ)의 표준 반복에 대해 허용되는 최대 정확도 오차

• LLOQ 초과 표준 반복에 대해 허용되는 최대 정확도 오차

• LLOQ에서 표준의 여러 반복에 대한 최대 백분율 변동 계수(CV)

참고: %CV가 지정된 값보다 크면 나머지 반복의 %CV가 이 값보다 작을 때까지 정확도 오
차가 높은 것부터 내림차순으로 반복이 제거됩니다.

• LLOQ를 초과하는 모든 수준에서 표준의 여러 반복에 대한 최대 백분율 CV

참고: %CV가 지정된 값보다 크면 나머지 반복의 %CV가 이 값보다 작을 때까지 정확도 오
차가 높은 것부터 내림차순으로 반복이 제거됩니다.

• 지정된 총 이상값 수에서 LLOQ 미만 이상값과 ULOQ(최대 정량 한계) 초과 이상값이 제외
되는지 여부

• 농도 수준에 대해 제거할 수 있는 최대 이상값 수

• 교정 곡선에서 제거할 수 있는 총 이상값 수

참고: 이 알고리즘은 수동으로 제외된 표준을 포함하여 모든 표준에 적용됩니다.

참고: 회귀를 생성하는 데 사용되는 반복 수가 각 표준 수준마다 다르면 이상값 자동 제거 기능
이 완벽하게 작동하지 않으며 시작점으로만 사용해야 합니다. 이 경우 각 교정 곡선을 수동으
로 검토하십시오.
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팁! 처리 방법의 수락 기준에서 표준 정확도에 대한 허용 오차 임계값이 Rules for
Automatically Removing Outliers for Calibration Standards 대화 상자의 임계값과 일치하는지
확인하십시오.

Results Table
Results Table은 샘플 세트와 관련된 정량적 정보와 정성적 정보의 모음입니다. 여기에는 농도
계산 및 표준 교정 곡선을 삽입한 결과로 결정된 정확도가 포함됩니다. 라이브러리 검색 결과,
수식 찾기 결과 및 기타 정성적 분석 결과도 Results Table에서 확인할 수 있습니다. 면적, 높이
및 기타 수치적 특성이 표시될 수 있습니다. 단순화하여 볼 수 있도록 Results Table의 열 수와
유형을 편집할 수 있습니다.

교정 곡선
표준 농도 곡선으로도 알려진 교정 곡선은 알려지지 않은 샘플과 알려진 농도의 표준 샘플 세
트를 비교함으로써 알려지지 않은 샘플 물질의 농도를 측정하는 방법입니다. 교정 곡선은 기
기가 분석 물질의 농도(측정하는 물질) 변화에 어떻게 반응(분석 신호)하는지 보여주는 플롯입
니다. 작업자는 알 수 없는 샘플에서 분석 물질의 예상 농도에 가까운 여러 범위의 농도에 대해
일련의 표준 물질을 준비합니다.

교정 곡선을 제작하기 위해 교정 표준 물질이 사용됩니다. 일부 교정 샘플에서의 올바르지 않
은 판독 또는 판독 누락으로 인해 분석 실행에 문제가 발생할 수 있습니다. 교정 곡선을 생성하
려면 참고문헌 및 규제 기관 지침에서 확인할 수 있는 허용 가능한 방법을 따르십시오. 다음은
교정 곡선을 준비하는 모범 사례의 예입니다.

• 분석 물질을 측정할 빈 매트릭스에서 교정 표준 물질을 준비합니다.

• 측정할 각 분석 물질에 대한 교정 곡선을 생성합니다.

• 일반적인 검체와 비정상 검체를 포함하여 분석 물질의 예상 농도 범위를 확인합니다.

• 6 ~ 8개의 표준을 사용하여 곡선을 생성합니다.

이 목록은 포괄적이지 않으며 실험실용 교정 곡선을 개발하는 최상의 방법을 결정할 때 다른
지침을 사용해야 합니다.

참고: 일부 분석 실행에서 단일 지점 교정 표준 물질이 사용됩니다. 매트릭스 블랭크 샘플 및
단일 표준 물질 농도를 통해 단일 지점 교정이 수행됩니다. 기기 반응과 분석 물질 농도의 관계
는 이 두 지점으로 생성된 선에 의해 결정됩니다. 획득 및 처리 방법은 둘 다 용도에 맞는지 먼
저 검증한 후 수락해야 합니다.

신호 대 노이즈 비율
정량적 질량 분석 데이터 처리를 수행하는 경우 주어진 피크의 유의성 여부를 판단하는 것이
중요합니다. 일반적으로 유의하다는 것은 배경 노이즈를 초과한다는 의미입니다.

상대 노이즈 및 신호 대 노이즈 계산
이 피크 높이는 보통 피크가 없는 영역에서 측정되는 배경 노이즈와 비교됩니다. 이 노이즈는
일반적으로 이 범위 내 데이터 요소 표준 편차의 1배 또는 3배로 추정됩니다. 이러한 접근 방
법은 다음과 같은 이유로 바람직하지 않습니다.
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• 노이즈 영역이 수동으로 선택되므로 주관적입니다.

• 피크가 없는 배경 영역이 존재하지 않거나, 영역이 너무 좁아 노이즈를 정확하게 추정할 수
없습니다.

• 피크 위치의 노이즈는 선택된 노이즈 영역의 노이즈와 크게 다를 수 있습니다.

• '1배 또는 3배'라는 비율도 주관적이며 각 기관마다 권장 사항이 다릅니다.

• 데이터가 사전 처리된 경우 명백한 노이즈가 변경될 수 있습니다. 예를 들어 다듬어지거나
임계값이 지정될 수 있습니다.

상대 노이즈(Rn) 개념을 사용하면 측정된 신호와 비교하기 위해 데이터의 어느 지점에서나 예
상 노이즈를 계산하는 간단한 방법을 쉽게 개발할 수 있습니다. 이 방법은 신호 대 노이즈(S/N)
를 계산하고 기기 및 분석 성능을 평가 및 비교하는 데 사용할 수 있는 견고하고 객관적인 메트
릭입니다. 상대 노이즈 개념 어플리케이션은 매우 다양한데, 그 중 한 가지가 S/N을 계산하는
것입니다.

기본 알고리즘은 다음과 같습니다.

1. 사용자가 데이터 레코드의 어느 지점에서나 예상 노이즈를 계산할 수 있는 노이즈 모델을
고안합니다(해당 지점에서 기본 신호의 수준이 주어진 경우).

노이즈 모델은 이론적 고려 사항을 기반으로 결정하거나 특정 시스템의 실제 측정을 통해
모델링할 수 있습니다. 펄스 계수 검출기의 경우 신호의 표준 편차와 예상 노이즈는 신호
의 제곱근에 비례하므로 신호에 따라 다릅니다. 다른 시스템에는 강도 종속적 구성 요소
와 결합될 수 있는 일정한 '화이트 노이즈' 구성 요소가 있습니다.

2. 측정된 신호에서 기본 신호를 추정합니다.

이 작업은 다양한 방법으로 수행할 수 있지만 다듬어진 데이터 버전을 생성하는 것이 가
장 간단합니다. 자세한 정보는 그림 A-15에서 확인하십시오.

그림 A-15 원시 데이터와 다듬어진 데이터 중첩

3. 모든 지점(피크와 배경 둘 다)을 사용하여 전체 데이터에서 실제 노이즈를 측정합니다.

이는 다듬어진 신호가 원래 신호에서 감산된 경우에 데이터의 각 지점에 대해 측정된 신
호에서 기본 신호 추정값을 감산하여 수행됩니다. 이 결과를 델타 노이즈라고 합니다. 노
이즈는 신호에 종속적이고 신호가 크면 노이즈도 더 크기 때문에 큰 피크가 있는 경우를
제외하고 델타 노이즈 범위는 일정한 편입니다. 자세한 정보는 그림 A-16에서 확인하십시
오.
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그림 A-16 각 데이터 요소의 델타 노이즈 값 플롯

4. 각 데이터 요소에 대해 측정된 노이즈 대 예상 노이즈 비율을 계산합니다.

즉, 모든 데이터 요소에 대해 3단계에서 측정한 노이즈를 노이즈 모델의 예측 값(이 경우
강도의 제곱근)으로 나눕니다. 노이즈 모델이 양호하면 소프트웨어는 주로 일부 한계에
의해 경계를 유지하는 일련의 값을 생성합니다. 다음 그림을 참조하십시오. 이 그림은 다
음 식에 대한 플롯도 보여줍니다.

참고: 이 단계는 델타 노이즈의 큰 변동을 줄이고 잘 제한된 값 세트를 생성합니다.

그림 A-17 노이즈 모델

5. 비율 값의 표준 편차를 계산합니다. 이 값은 실제 델타 노이즈와 모델이 예측한 노이즈 사
이의 관계에 대한 추정값인 Rn입니다. 위의 그림에서 이 값은 9.5입니다.

다음 그림에서는 상대 노이즈를 사용하여 S/N을 계산할 수 있는 방법의 예를 보여줍니다.
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그림 A-18 원시 데이터, 기본 신호 추정값, 기준선 추정값 중첩

이전에 설명한 예의 경우:

이 예의 경우:

피크 정점이 신호로 사용되면 S/N이 34(4900/145)이고, 다듬어진 신호의 높이가 사용되면
S/N이 22(3150/145)입니다.

S/N을 보고할 때 MQ4 통합 알고리즘은 여기에 설명된 절차와 피크 정점을 신호로 사용합니
다. AutoPeak 통합 알고리즘은 모델을 피크에 맞추기 때문에 적합 프로필의 높이를 사용합니
다. 이로 인해 보고된 S/N이 더 작아집니다. 그러나 이 값은 가능한 노이즈 스파이크의 영향을
덜 받기 때문에 더 정확합니다. 또한 AutoPeak 통합 알고리즘에는 기준선 추정을 위한 더 정교
한 접근법이 있으므로 이러한 두 가지 이유에 따라 두 알고리즘에서 보고하는 S/N 값은 대개
유사하지만 동일하지는 않습니다.

요약하면 노이즈를 배경 영역의 표준 편차로 추정하는 일반적인 접근법에 비해 S/N 계산에 대
한 상대 노이즈 접근법은 다음과 같은 장점이 있습니다.

• 배경 영역을 수동으로 선택할 필요가 없으므로 훨씬 덜 주관적입니다.

• 크로마토그램에 피크가 없는 영역이 없어도 정확한 S/N을 예측할 수 있습니다.

• AutoPeak 및 Summation 통합 알고리즘의 경우 기준선과 노이즈가 관심 피크 근처에서 추
정됩니다. MQ4 통합 알고리즘의 경우 기준선은 사용자 지정 노이즈 백분율에서 데이터 요
소의 강도입니다. 예를 들어 사용자 지정 노이즈 백분율이 40%이고 데이터 요소가 100개
인 경우 MQ4 통합 알고리즘은 데이터 요소를 강도가 가장 작은 것부터 순서대로 정렬하고
40번째로 작은 데이터 요소의 강도를 사용합니다.

이는 일반적 접근법에 대해 선택된 배경 영역이 피크 근처의 배경보다 훨씬 더 조용할 수 있
으므로 보고되는 S/N 값에 큰 차이를 가져올 수 있습니다. 앞에서 설명한 대로 상대 노이즈
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방법을 사용하여 계산한 S/N은 일반적 방법보다 값이 작을 수 있습니다. 그러나 이 값은 더
정확하고 유용합니다. 자세한 정보는 그림 A-18에서 확인하십시오.

Results Table에 Signal / Noise 열을 표시하려면 Results Table 사용자 지정의 내용을 참조하
십시오.

AutoPeak 통합 알고리즘을 사용하는 경우 신호 대 노이즈에 대한 참고
AutoPeak 통합 알고리즘은 신호 대 노이즈를 더 정확하게 계산하여 CV를 더 정확하게 예측하
므로 1시그마 신호 대 노이즈 접근 방법을 사용하는 경우 실험실의 경험적 데이터에 기반하여
모든 표준 작업 절차(SOP)에서 허용되는 최소 신호 대 노이즈 값을 낮추는 것이 좋습니다.

피크 대 피크를 사용한 신호 대 노이즈
이 신호 대 노이즈 알고리즘이 사용되면 소프트웨어는 지정된 배경 시작 시간과 배경 종료 시
간 사이에 있는 모든 크로마토그래픽 데이터 요소의 표준 편차를 사용하여 신호 대 노이즈 비
율을 계산합니다. 소프트웨어는 활성 크로마토그램의 신호 대 노이즈 비율을 계산하고 선택한
피크에서 평균 배경 신호를 뺀 후 감산된 신호를 피크 대 피크 노이즈 수준으로 나눕니다. 그런
다음 각 영역의 최대 강도에 따라 노이즈 영역과 피크 영역을 구분합니다. 완료 후 활성 크로마
토그램에 신호 대 노이즈 비율이 레이블로 지정됩니다.

표준 편차를 사용한 신호 대 노이즈
이 신호 대 노이즈 알고리즘이 사용되면 소프트웨어는 크로마토그래픽 피크의 신호 대 노이즈
비율을 계산하고 이 비율로 레이블을 지정합니다. 이 알고리즘을 사용하려면 크로마토그램에
서 다음과 같은 두 영역을 선택해야 합니다.

• 노이즈 영역

• 관심 피크

그런 다음 소프트웨어는 각 선택에서 최대 강도를 기준으로 피크를 포함하는 영역과 노이즈를
포함하는 영역을 결정합니다. 소프트웨어는 피크 신호 강도에서 평균 배경 신호 강도를 뺀 후
감산된 신호를 사용자 지정 계수에 노이즈 영역의 표준 편차를 곱한 값으로 나눕니다.

노이즈 영역 정의
표준 편차 또는 피크 대 피크 알고리즘이 사용되는 경우 이 절차를 사용하여 노이즈 영역을 정
의할 수 있습니다.

참고: 하나의 Results Table에서 신호 대 노이즈 알고리즘을 하나만 사용할 수 있습니다. 데이
터에 다른 신호 대 노이즈 알고리즘을 적용하려면 프로젝트 기본값을 변경한 다음 새 Results
Table을 생성하십시오.

1. 프로젝트 기본 설정에서 Standard Deviation 또는 Peak-to-Peak 신호 대 노이즈 알고리
즘을 선택합니다.

팁! 프로젝트 기본 설정을 열려면 Projects > Project default settings를 클릭하십시오.

2. 처리 방법을 생성합니다.

3. Integration 페이지에서 Options > Show Noise Regions를 클릭합니다.
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4. (필요한 경우) 마우스를 사용하여 노이즈 영역을 조정합니다.

참고: 각 전이에 대해 노이즈 영역을 설정해야 합니다.

5. 데이터를 처리합니다.

6. Peak Review 창에서 Options > Show Noise Regions를 클릭합니다.

7. (필요한 경우) 마우스를 사용하여 노이즈 영역을 조정합니다.

계산 열
계산 열은 Results Table에 추가할 새 사용자 지정 열을 생성하는 수식입니다. 수식이 생성되
고 데이터가 처리 또는 재처리되면 수식 결과가 새 사용자 지정 열에 표시됩니다.

계산 열 인터페이스 탐색
계산 열은 처리 방법에서 생성됩니다. 나중에 사용하거나 공유하기 위해 frml 파일로 가져오
거나 내보낼 수 있습니다.

다음 그림에서는 수식 편집기의 인터페이스를 보여줍니다.

그림 A-19 계산 열 UI

항목 설명

1 처리 방법 워크플로의 Calculated Columns 단계입니다. 클릭하면
Calculated Columns 페이지가 열립니다. 그런 다음 Add Formula(표시되
지 않음)를 클릭합니다.

2 Formula name 필드입니다. 여기에 수식 이름을 입력합니다.

참고: 수식 이름에는 계산기의 함수 이름, 대괄호 또는 둥근 괄호를 사용
할 수 없습니다.

3 Formula 필드입니다.
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항목 설명

4 일반적으로 사용되는 함수 및 연산자가 포함된 계산기입니다. 다음과 같
은 추가 연산자를 수식 필드에 입력할 수 있습니다.
• >(보다 큼)

• >=(보다 크거나 같음)

• <(보다 작음)

• <=(보다 작거나 같음)

• !=(같지 않음)

이러한 연산자 및 함수에 대한 자세한 정보는 도움말 시스템을 참조하십
시오.

5 사용 가능한 회귀 매개 변수 및 Results Table 열입니다.
참고: 이 목록은 qsession 테이블에서 사용할 수 없습니다.

6 사용자는 Treat resulting text values as 메뉴를 사용하여 텍스트 항목의
처리 방식을 구성할 수 있습니다. 이 옵션은 숫자 출력과 텍스트 출력을 모
두 포함할 수 있는 Results Table 열에서 중요합니다.

예를 들어 계산된 농도 열에는 숫자 값이 N/A, degenerate(중복 제거) 및
infinity(무한대)와 같은 숫자가 아닌 값과 함께 포함될 수 있습니다.

참고: 사용자가 샘플 배열을 사용하는 수식의 입력을 시작하면 샘플 선택 항목을 사용할 수 있
게 됩니다.

비기본 정보의 단순 추출
사용자는 계산 열 기능을 통해 Results Table에서 기본적으로 사용할 수 없는 정보를 표시할
수 있습니다.

예를 들어 R2을 Results Table의 열로 표시하려면 R2과 동일한 수식을 생성할 수 있습니다.
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그림 A-20 계산 열을 사용하여 사용자 지정 열 생성

단순 산술 연산
기본적인 수학 연산을 수행하기 위해 단순한 수식을 생성할 수 있습니다.

예: R2

[r]*[r]

이 예에서는 R 값을 제곱하기 위해 곱하기 연산자(*)를 사용하여 R2 값을 재현합니다.

예: 수집된 초당 요소 수

[Points Across Baseline]/(([End Time]-[Start Time])*60)

이 예에서는 기준선의 전체 요소 수를 통합 크로마토그래픽 피크의 시작부터 끝까지 해당하는
시간(초)으로 나눕니다. 이 수식에는 나누기(/), 곱하기(*) 및 빼기 (–) 연산자가 사용됩니다.

복합 함수
다른 함수 및 제어 구조가 많이 있습니다. 일반적으로 MEAN(), MAX() 및 MIN()이 자주 사용되
고 수식 표시줄 아래의 계산기에 표시됩니다.

구문 세부 정보, 연산자 및 함수의 전체 목록은 도움말 시스템을 참조하십시오.
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예: Standards(표준 샘플)에 대한 MEAN([Area])

모든 값에 대해 작동하는 함수를 사용하는 경우 사용자는 계산에 포함할 샘플을 선택할 수 있
습니다.

그림 A-21 Standard(표준) 샘플의 피크 면적 평균만 구하기

예: 함수 결합

단순 산술 함수와 복합 함수를 결합할 수 있습니다. 예를 들어 수집된 초당 평균 요소 수를 계
산하려면 다음 수식을 사용합니다.

MEAN([Points Across Baseline]/(([End Time]-[Start Time])*60))

IF 문
IF 함수는 논리 테스트를 수행하여 true 결과에 대한 특정 값과 false 결과에 대한 다른 값을 반
환합니다. 둘 이상의 조건을 테스트하려면 중첩 IF 함수를 사용합니다. IF 함수를 and 및 or와
같은 다른 논리 함수와 결합하여 논리 테스트를 확장할 수 있습니다.

참고: "&&"와 "||"를 각각 and와 or에 사용할 수 있습니다. and 및 or 연산자는 앞뒤에 공백이
있어야 하지만 && 및 || 연산자는 그럴 필요가 없습니다.

IF 문의 기본 구문은 다음과 같습니다.

if(<condition>;<value if true>;<value if false>)

• <condition>은 true/false로 평가할 수 있는 값 또는 논리 식입니다.

• <value if true>는 <condition>이 true로 평가될 때 반환되는 값이며 해당 Results Table 열에
표시됩니다.
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• <value if false>는 <condition>이 false로 평가될 때 반환되는 값이며 해당 Results Table 열
에 표시됩니다.

참고: IF 함수 기호는 계산기에서 선택하거나, 입력하거나, 다른 소스에서 복사할 수 있습니다.
if 또는 IF 구문에서 사용할 수 있습니다.

IF 함수를 사용하면 MEAN, STDEV 등의 다른 수치 함수를 <condition>, <value if true>또는
<value if false> 식의 수식 내에 사용할 수 있습니다.

예: <condition>

다음은 <condition>에 대한 몇 가지 예입니다.

[Peak Area]>5000

[Component Name]='Analyte 1'

[Retention Time]> 1 and [Retention Time]<2

예: <value if true> and <value if false>

<value if true> 및 <value if false>는 숫자 또는 텍스트일 수 있습니다.

if([Retention Time]> 1 and [Retention Time]<2; '1-2 min RT 
window'; 
'not applicable')

예: Internal Standard(내부 표준) 면적의 평균 값

이 예에서는 원하는 샘플에 대해 IS(내부 표준) 면적의 평균 값을 계산하여 1e6 값과 비교합니
다. MEAN ([IS Area]) 값이 1e6보다 큰 경우, 즉 <condition>이 true이면 평균 IS 면적 값이 해
당 Results Table 열에 표시됩니다. MEAN ([IS Area]) 값이 1e6보다 작은 경우, 즉 <condition>
이 false이면 Results Table 열에 Review IS performance가 포함됩니다. 이 값은 <value if
false>에 해당합니다.

IF(MEAN([IS Area])>=1e6;'MEAN([IS Area])';'Review IS performance')

참고: IF 함수만 여러 계산을 포함할 수 있습니다.

결과 텍스트 값 처리 방법
Treat resulting text values as 옵션은 텍스트 또는 숫자와 텍스트 조합을 포함하는 사용자 지
정 Results Table 열에서 텍스트를 해석하는 방식을 결정합니다. 예를 들어 Sample Type 열에
는 텍스트만 포함되고 Precursor Mass 열에는 숫자 값만 포함되며 Calculated
Concentration 열에는 숫자 값과 텍스트가 모두 포함될 수 있습니다.

수식에 사용된 함수에 따라 Treat resulting text values as 옵션을 사용하여 계산 기반 열의
텍스트 값을 구체적으로 해석할 수 있습니다. 다음 옵션을 사용할 수 있습니다.

• Zero
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• Ignore (blank)

• Error (N/A)

• Original text

참고: 이러한 옵션에 대한 자세한 정보는 도움말 시스템을 참조하십시오.

계산이 COUNT, MAX, STDEV, SUM, MIN, MEDIAN, GET, GETGROUP, SLOPE,
INTERCEPT, MAD 또는 GETSTAT 함수를 기반으로 하는 경우 Zero, Ignore (blank) 또는
Error (N/A) 옵션을 사용하는 것이 좋습니다. 수식에 숫자 값이 예상되는 열이 포함된 경우 IF
문에서도 이러한 옵션이 권장됩니다.

Original text 옵션은 IF 문에서 <condition>, <value if true>및 <value if false> 식의 구성 요소
가 숫자와 텍스트 둘 다 가능한 경우, 특히 추가 함수가 사용되는 경우에 권장됩니다.

참고: IF 문에 둘 이상의 <condition>이 있는 경우하나라도 <condition>이 true로 평가되지 않
으면 사용자 지정 결과 표 열에 <value if false> 출력이 표시됩니다.

예

이 예에서는 수식에 사용된 열에 텍스트 값과 숫자 값이 모두 포함될 수 있습니다. 따라서
Original text 옵션을 사용하는 것이 좋습니다.

IF([Sample Type]='Unknown'&&(GET([Calculated Concentration];
'Analyte 1')+GET([Calculated Concentration];'Analyte 2'))<=15;
'Low Range';IF([Sample Type]='Unknown'&&(GET([Calculated 
Concentration]
;'Analyte 1')+GET([Calculated Concentration];'Analyte 2'))
<=65;'Normal Range';'Over normal range'))

이 IF 수식에는 Sample Type 열과 Calculated Concentration 열이 모두 포함됩니다.
Sample Type 열의 값은 Original text로 처리되어야 합니다. Calculated Concentration 열
의 경우 <0 및 Degenerate와 같은 숫자가 아닌 값을 Zero로 처리해야 할 수도 있습니다.

숫자가 아닌 값은 다르게 처리해야 하므로 이러한 값을 보다 세부적으로 제어하려면 사용자가
수식을 여러 개의 작은 수식으로 분할하는 것이 좋습니다.
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접점 폐쇄로 구성된 시스템 교정 B
시스템에 접점 폐쇄가 구성된 경우 배치 모드와 수동 모드에서 모두 시스템을 교정하는 데 사
용할 수 있습니다.

• 배치 모드: CDS 또는 LC 방법을 사용하여 시스템을 교정할 수 있습니다. 자세한 정보는 배
치 모드에서 시스템 교정에서 확인하십시오.

• 수동 모드: CDS 또는 LC 방법을 사용하여 시스템을 교정할 수 있습니다. MS Method 작업
영역에서 Start 또는 Start with LC를 클릭하여 방법을 시작합니다. 상태가 Load로 변경되
면 LC 장치에서 주입을 시작합니다.

참고: MS Tune 작업 영역은 접점 폐쇄 기능을 지원하지 않습니다. MS Tune은 접점 폐쇄 신호
를 기다리지 않습니다.

배치 모드에서 시스템 교정
CDS 또는 LC 방법을 사용하여 시스템을 교정할 수 있습니다.

CDS를 사용하여 시스템 교정
시스템이 접점 폐쇄를 사용하여 외부 장치와 통신하는 경우 다음 지침에 따라 CDS를 사용하
여 시스템을 교정하십시오.

• 교정 간 샘플 수를 포함하여 자동 교정 속성을 구성합니다.

• LC 시스템의 방법과 질량 분석계를 동기화하여 샘플 간 교정 시간을 허용합니다. 다음 절에
서는 이를 수행하기 위한 두 가지 옵션을 설명합니다.

• 배치를 제출한 후 초기 교정이 완료될 때까지 기다렸다가 시스템이 Loading 상태로 전환되
면 외부 장치에서 주입을 시작합니다.

옵션 1
LC 시스템과 질량 분석계를 동기화하려면 LC 방법이 질량 분석계 방법보다 최소 2분 이상 길
어야 합니다.

다음 예에서는 SCIEX OS의 배치 및 대기열과 세 번째 샘플 이후에 교정이 수행되는 배치에
대한 외부 장치의 해당 일정을 보여줍니다.

접점 폐쇄로 구성된 시스템 교정
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그림 B-1 CDS 교정: 배치 예

그림 B-2 CDS 교정: 대기열 예

표 B-1 외부 장치의 샘플 시퀀스

시간(mm:ss) 주입

00:00 샘플 1

12:00 샘플 2

24:00 샘플 3

36:00 샘플 4
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표 B-1 외부 장치의 샘플 시퀀스 (계속)

시간(mm:ss) 주입

48:00 샘플 5

60:00 샘플 6

옵션 2
이 옵션은 짧은 LC 방법을 사용하는 워크플로에 적합합니다.

다음 지침에 따라 LC 시스템과 질량 분석계를 동기화합니다.

• 배치의 첫 번째 교정을 제외한 모든 교정에 대해 교정을 수행하도록 예약될 때마다 공시료
를 주입하도록 외부 장치를 구성하십시오. 예를 들어 교정 간에 세 개의 샘플이 획득된 경우
네 번째 주입은 항상 공시료여야 합니다.

• 외부 장치의 공시료 실행 시간이 2분 이상인지 확인하십시오. CDS 교정에 2분이 소요됩니
다. 방법 지속 시간은 주입 간격보다 작거나 같아야 합니다.

다음 예에서는 SCIEX OS의 배치 및 대기열과 세 번째 샘플 이후에 교정이 수행되는 배치에
대한 외부 장치의 해당 일정을 보여줍니다.

그림 B-3 CDS 교정: 배치 예
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그림 B-4 CDS 교정: 대기열 예

표 B-2 외부 장치의 샘플 시퀀스

시간(mm:ss) 주입

00:00 샘플 1

02:00 샘플 2

04:00 샘플 3

06:00 Blank

08:00 샘플 4

10:00 샘플 5

12:00 샘플 6

LC 시스템을 사용하여 시스템 교정
시스템이 접점 폐쇄를 사용하여 외부 장치와 통신하는 경우 다음 지침에 따라 외부 장치를 사
용하여 시스템을 교정하십시오.

• 질량 분석계 속성에서 외부 장치를 시뮬레이트하도록 밸브를 구성합니다.

• 밸브에 대한 LC 방법을 생성합니다.

• 방법 지속 시간은 외부 장치의 주입 간격보다 작거나 같아야 합니다.

• 배치에 대한 자동 교정 속성을 구성합니다(예: 이온 참조표 선택 및 교정 주기 설정).
Calibrant delivery의 경우 밸브에 대한 LC 방법을 선택하고 MS method의 경우 사용할
MS 방법을 선택합니다.
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그림 B-5 LC 교정: Automatic Calibration Editor

참고: 참조표에 각 펩타이드에 대한 머무름 시간을 입력해야 합니다.

• 배치를 제출하고 대기열을 시작합니다. 대기열의 항목이 외부 장치의 일정 항목과 일치하
는지 확인하십시오.

• 외부 장치에서 주입을 시작합니다.

다음 예에서는 SCIEX OS의 배치 및 대기열과 세 번째 샘플 이후에 교정이 수행되는 배치에
대한 외부 장치의 해당 일정을 보여줍니다. MS 방법의 지속 시간은 1분입니다. 교정 방법의 지
속 시간도 1분입니다.
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그림 B-6 LC 교정: 배치

그림 B-7 LC 교정: 대기열

표 B-3 외부 장치의 샘플 시퀀스

시간(mm:ss) 주입

00:00 교정물질

01:00 샘플 1

02:00 샘플 2
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표 B-3 외부 장치의 샘플 시퀀스 (계속)

시간(mm:ss) 주입

03:00 샘플 3

04:00 교정물질

05:00 샘플 1

06:00 샘플 2

07:00 샘플 3

수동 모드에서 교정
이 절에서는 MS Method 작업 영역에서 수동으로 방법을 실행하는 경우 접점 폐쇄를 사용하여
시스템을 교정하는 방법에 대해 설명합니다.

CDS를 사용하여 시스템 교정
1. MS Method 작업 영역에서 실행할 방법을 엽니다.

2. Advanced > Calibrate를 클릭합니다.

3. 방법의 극성에 따라 Ion Reference Table 필드에서 X500 Positive Calibration Solution
또는 X500 Negative Calibration Solution을 선택합니다.

4. Apply Calibration을 선택합니다.

5. OK을 클릭합니다.

6. Start를 클릭합니다.

LC 방법을 사용하여 시스템 교정
시스템이 접점 폐쇄를 사용하여 외부 장치와 통신하는 경우 다음 지침에 따라 외부 장치를 사
용하여 시스템을 교정하십시오.

• 질량 분석계 속성에서 외부 장치를 시뮬레이트하도록 밸브를 구성합니다.

• 밸브를 포함하고 기간이 MS 방법의 기간보다 작거나 같은 LC 방법을 생성합니다.

1. MS Method 작업 영역에서 실행할 MS 방법을 엽니다.

2. Start with LC를 클릭하고 LC 방법을 선택합니다.

3. 시스템 상태가 Loading으로 변경되면 LC 장치에서 주입을 시작합니다.
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정확한 질량 및 화학식 C
레세르핀

표 C-1 레세르핀 정확한 질량 (C33H40N2O9)

설명 질량

분자 이온 C33H41N2O9 609.28066

단편 C23H30NO8 448.19659

단편 C23H29N2O4 397.21218

단편 C22H25N2O3 365.18597

단편 C13H18NO3 236.12812

단편 C10H11O4 195.06519

단편 C11H12NO 174.09134

펩타이드 ALILTLVS

표 C-2 펩타이드 ALILTLVS 정확한 질량

이름 시퀀스 질량 전하 상태

전구체 이온 ALILTLVS 829.5393 1+

b8 ALILTLVS 811.5288 1+

b7 ALILTLV 724.4967 1+

b7-18 ALILTLV 706.4862 1+

b6-18 ALILTLV 607.4178 1+

y5 LTLVS 532.3341 1+

b5 ALILT 512.3443 1+

b5-18 ALILT 494.3337 1+

b4 ALIL 411.2966 1+

b3 ALI 298.2125 1+

내부 단편 y|b IL 또는 LI 227.1754 1+

내부 단편 y|b LT 또는 TL 215.139 1+

b2 AL 185.1285 1+

a2 AL 157.1335 1+

정확한 질량 및 화학식
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표 C-2 펩타이드 ALILTLVS 정확한 질량 (계속)

이름 시퀀스 질량 전하 상태

임모늄 이온 I 또는 L 86.09643 1+

정확한 질량 및 화학식
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탐색기 자습서 D
소개
이 문서는 일부 도구 및 소프트웨어에서 사용 가능한 기능에 대한 사용 지침 프로그램 개요를
제공합니다. 사용 가능한 모든 작동에 대한 세부 설명을 제공하지는 않지만 소프트웨어가 해
결할 수 있는 보다 일반적인 작업 흐름의 일부를 설명합니다.

조직
일부 기능 및 작업은 특정 어플리케이션 및 작업에 적합하지만 대부분은 일반적이며 정성적
데이터를 분석할 때 자주 사용됩니다. 이 섹션의 문서는 소프트웨어 개념에 대한 간략한 소개
및 가장 일반적인 일부 및 필수적인 작업에 대한 설명을 제공합니다. 이후 섹션에서는 특정 워
크플로에 대한 접근 방식을 설명하고 소프트웨어와 함께 제공된 샘플 데이터 파일을 사용합니
다.

샘플 파일은 sciex.com/software-support/software-downloads의 SCIEX OS resources 아래에
제공됩니다. 전체 프로젝트를 컴퓨터의 D:\SCIEX OS DATA 폴더에 복사합니다. 이 자습서
의 예에서는 다음 샘플 파일이 사용됩니다.

• Bromocrip_IDA-DBS alone_T=1.wiff

• Bromocrip_IDA-DBS in plasma_T=0.wiff

• Bromocrip_IDA-DBS in plasma_T=1.wiff

• DataSET61.wiff

• DataSET62.wiff

• DataSET63.wiff

• DataSET64.wiff

• DataSET65.wiff

• DataSET66.wiff

• Rp_digests. wiff

• RP_Intact.wiff

• Bromocriptine.mol

브로모크립틴 파일은 쥐 간 마이크로솜을 통한 네거티브 모드 IDA 잠복기 분석에서 비롯되었
습니다. Bromocrip_IDA-DBS alone_T=1.wiff는 1시간 지점에서 확보되었지만 나머지 두 개는
혈장에 투여된 0 및 1시간 지점에 적합했습니다. Bromocriptine.mol 파일에는 브로모크립틴에
적합한 분자 구조가 포함되어 있습니다. DataSET61 ~ DataSET66은 로라타딘과 그 불순물에
서 수집한 파일입니다. 다른 데이터세트는 다른 농도 레벨을 나타냅니다. RP_Intact.wiff 파일
은 원형 미오글로빈을 분석하여 만들었습니다. Rp_digests.wiff 파일은 트립신을 통해 소화되
는 미오글로빈을 분석하여 만들었습니다.
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옵션
소프트웨어는 명령에 따라 수행할 수 있는 방법을 미세 조정하는 많은 옵션을 제공합니다. 그
림 D-1에서 볼 수 있는 것과 같이 일부 소프트웨어는 Shift 키를 누르고 있는 경우에만 대화 상
자를 표시할 수 있는 체크 박스를 제공합니다. 이를 통해 매개 변수를 변경할 필요가 없는 경우
대화 상자와 상호 작용할 필요를 없애줍니다. 이런 명령 메뉴에는 위쪽을 가리키는 화살표가
포함되어 있습니다.

그림 D-1 옵션

창
소프트웨어는 정보 노출 및 수신에 창(window)을 사용하지만 기본 사용자 인터페이스 구성 요
소는 창(pane)입니다. 창(window)은 하나 이상의 창(pane)을 포함할 수 있지만 창(pane)은 한
번에 하나만 활성화할 수 있습니다. 창은 메뉴 및 도구 모음에서 명령을 수신합니다. 메뉴 및
도구 모음은 이들이 포함하고 있는 창 및 데이터를 이용할 수 있는 방법을 제공합니다.

창은 스펙트럼 및 크로마토그램, 히트맵 또는 표뿐만 아니라 보다 특별한 화면 등의 그래프를
포함할 수 있습니다. 일반 처리 작업에 있어 정보를 보여주기 위해 창을 생성하거나 창 내에 표
시된 데이터에 작업을 합니다. 모든 창은 일반적인 단일 및 두 개 창 도구를 포함합니다. 대부
분의 창은 창의 유형에 따라 지정된 추가 도구가 있습니다. 추가 도구는 보다 일반적인 명령에
액세스를 제공합니다.

일반적인 창의 사례는 그림 D-2에서 확인할 수 있습니다. window에는 두 개의 활성 pane, 크
로마토그램 및 색채를 입힌 테두리와 도구 모음이 있습니다.
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그림 D-2 Panes Within a Window에 대한 사례

일반적인 창 작업은 일반 창 도구 모음 및 두 개창 도구 모음에 요약되어 있습니다. 창별 작업
은 그래프에 요약되어 있습니다.

일반 창 도구 모음
일반 단일 창 작업을 사용하려면 아이콘을 클릭합니다.

표 D-1 일반 창 도구 모음 아이콘

아이콘 이름(툴팁)

이 창 삭제

활성 창을 확장해 창을 채움

이 창 숨김

다른 모든 창 숨김

현재 숨겨진 모든 창 표시
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표 D-1 일반 창 도구 모음 아이콘 (계속)

아이콘 이름(툴팁)

다른 모든 창 삭제(해당 창 다음의 창만 삭제하려면 Ctrl 키를 누른 상태에서 수행)

참고: 메뉴 바 바로 아래에 위치한 마스터 도구 모음에서 유사한 아이콘 또한 사용할 수 있습니
다. 마스터 도구 모음에 있는 아이콘들 중 하나를 클릭하는 것은 활성 창에 있는 아이콘을 클릭
하는 것과 동일한 효과가 있습니다. 이 도구 모음은 활성 창 크기를 조정한 후 아이콘 중 일부
가 보이지 않을 때 유용하게 사용할 수 있습니다.

이 창 삭제

창이 여러 개 열려 있는 경우 이 아이콘을 사용하여 해당 창을 삭제합니다. 창이 하나만 열려
있을 때는 아이콘을 사용할 수 없습니다.

활성 창을 확장해 창을 채움

이 아이콘을 사용해 전체 창을 채우기 위해 창을 확장하거나 기존 크기 창으로 되돌아갑니다.
창에 여러 내부 창이 있는 경우 이 아이콘은 일시적으로 내부 창 하나에 초점을 맞춥니다.

각 창의 경우 창의 상단에 별도 탭이 표시됩니다. 적절한 탭을 클릭해 창 간에 전환합니다.

참고: 창의 제목이 긴 경우 모든 탭이 보이지 않을 수 있습니다. 탭의 오른쪽의 화살표 버튼을
사용해 스크롤합니다. 모든 창을 표시하는 기존 화면으로 돌아가려면 아이콘을 다시 클릭합니
다.

그림 D-3 확장된 창에 대한 사례
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이 창 숨김

이 아이콘을 사용해 창(window) 내의 나머지 창(pane)들이 사용 가능한 공간을 채울 수 있도록
해당 창(pane)을 숨깁니다. 이 아이콘은 창의 하위 세트를 보기만 하고 다른 창을 영구적으로
삭제하고 싶지 않을 때 유용합니다.

다른 모든 창 숨김

해당 창을 제외한 모든 창을 숨기려면 이 아이콘을 사용합니다. 결과는 활성 창을 확장해 창을
채움 아이콘을 클릭했을 때와 유사합니다. 그 이유는 두 경우 모두 해당 창을 유지한 상태에서
공간만을 채우기 때문입니다 또 다른 창이 이후에 생성되는 경우 차이점은 명백합니다. 확장
된 창의 경우에 새로운 창이 활성화되어 사용 가능한 공간을 채웁니다. 숨겨진 창의 경우에 두
개의 창(기존 활성 창 및 새로운 창)을 모두 볼 수 있습니다.

현재 숨겨진 모든 창 표시

이 아이콘을 사용해 숨겨진 모든 창을 표시합니다.

다른 모든 창 삭제

Ctrl 키를 누르지 않은 경우 이 아이콘은 해당 창을 제외한 모든 창을 삭제합니다. 이 옵션은 샘
플을 정리 및 재처리하는 데 유용합니다. 현재 숨겨진 어떠한 창도 삭제됩니다.

Ctrl 키를 누른 경우는 해당 창 다음에 있는 창만 삭제됩니다. 이 옵션은 창이 여러 개 열려 있
는 경우 초기에 연 창 몇 개만 필요할 때 유용합니다. 이 경우에 숨겨진 창은 삭제되지 않습니
다.

두 개창 도구 모음
아이콘을 드래그하여 두 개창 작업을 합니다(사용 가능 여부는 창 유형에 의해 좌우됨). 소스
창은 선택한 아이콘이 포함된 창이고 대상 창은 두 번째 창입니다.

표 D-2 두 개창 도구 모음 아이콘

아이콘 이름(툴팁)

드래그 및 드롭으로 창을 재배열합니다.

또 다른 그래프에 드래그하여 활성 데이터를 그래프의 활성 데이터에 추가합니다
(다른 그래프의 모든 데이터 세트에 활성 데이터를 추가하려면 Ctrl 키를 누른 상
태에서 수행).

또 다른 그래프에 드래그하여 목표 그래프의 활성 데이터에서 활성 데이터를 뺍
니다 (목표 그래프의 모든 데이터 세트에서 활성 데이터를 빼려면 Ctrl 키를 누른
상태에서 수행하고 Shift 키를 길게 눌러 음의 값을 유지.)

또 다른 그래프에 드래그하여 목표 그래프에 있는 활성 데이터에 겹치도록 합니
다 (활성 데이터 하나가 아닌 모든 데이터 세트에 겹치도록 하려면 Ctrl 키를 누른
상태에서 수행).

드래그 및 드롭으로 창을 재배열

이 아이콘은 각 창의 상단 오른쪽 모서리에서 볼 수 있으며 관련된 창의 위치를 변경하는데 사
용됩니다. 내부 창 하나의 아이콘을 클릭하여 두 번째 내부 창의 상단, 하단, 왼쪽 또는 오른쪽
부분으로 끌어갑니다. 마우스를 놓는 위치에 따라 첫번째 내부 창의 위치가 두번째 내부 창을
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기준으로 변경됩니다. 커서를 끌 때 두 번째 내부 창의 한 면이 빨간색으로 강조 표시되어 첫
번째 내부 창이 표시된 위치를 나타냅니다. 그림 D-4는 상단 창의 아이콘을 하단 창의 오른쪽
부분으로 드래그 했을 때의 결과를 보여줍니다.

그림 D-4 상단 창의 아이콘을 하단 창의 오른쪽 부분으로 드래그 했을 때의 결과

참고: 내부 창은 한 창에서 다른 창으로 드래그 할 수 있습니다.

다른 그래프에 드래그하여 다른 그래프의 활성 데이터에 활성 데이터를 추가

이 아이콘을 사용해 두 개의 데이터 세트를 하나씩 합산합니다. 소스 데이터(원래 클릭했던 창
에서 얻음)가 목표 데이터(아이콘에서 손을 뗄 때 위의 창)에 추가되었습니다. 수정 데이터의
제목이 업데이트되어 수정되었다는 것을 표시합니다.

참고: 유형이 동일한 두 데이터 세트만 하나로 결합할 수 있습니다. 예를 들어 스펙트럼은 크로
마토그램에 추가할 수 없습니다.

참고: 목표 그래프에 하나 이상의 중첩된 추적이 포함되어 있는 경우 소스 데이터는 기본적으
로 활성 목표 데이터에만 추가됩니다. Ctrl 키를 누른 경우 소스 데이터는 목표 내 모든 데이터
세트에 추가됩니다.

다른 그래프에 드래그하여 목표의 활성 데이터에서 활성 데이터를 빼기

이 아이콘을 사용해 목표 데이터에서 소스 데이터를 뺍니다. 이 아이콘은 배경에서 질량 스펙
트럼을 빼는 경우에 가장 유용합니다.

참고: 목표 그래프에 하나 이상의 중첩된 추적이 포함된 경우 소스 데이터는 자동으로 활성 목
표 데이터에서만 차감됩니다. Ctrl 키를 누른 경우 소스는 목표 내 모든 데이터 세트에서 차감
됩니다.

팁! 일반적으로 소스의 강도가 목표보다 큰 경우의 모든 데이터 포인트는 기록되지 않습니다.
이는 음의 y값이 폐기된다는 것을 의미합니다. Shift 키를 누른 경우 음의 강도를 가진 포인트
가 기록됩니다.
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목표 그래프에서 활성 데이터에 겹치도록 또 다른 그래프에 드래그하기

이 아이콘을 사용하여 목표 그래프에서 소스 그래프 내 활성 데이터를 겹치도록 합니다. 작업
을 완료한 후 목표 그래프에는 목표 데이터의 사본이 들어 있는 새로운 시리즈가 포함되어 있
습니다.

참고: 소스 그래프에 하나 이상의 중첩된 추적이 포함된 경우 자동으로 활성 데이터 사본만 목
표 그래프로 이동합니다. Ctrl 키를 누르고 있는 경우 소스 그래프 내의 모든 데이터 세트 사본
이 목표 그래프에 겹쳐집니다.

그래프
그래프는 데이터 시각화 및 상호 작용을 가능하게 하는 창입니다. 여러 작업은 모든 그래프에
일반적이지만 다른 작업은 나타나는 데이터 유형에 좌우됩니다.

그림 D-5 그래프

일반 명령은 다음과 같이 요약됩니다.

• 커서를 그래프의 x축 또는 y축 영역에 드래그함으로써 확대/축소 및 스크롤을 수행할 수 있
습니다. 더블 클릭하여 축을 기존 범위로 재설정하고 Shift 키를 누르면서 축을 클릭하면 그
래프가 이전 화면으로 전환합니다(확대/축소 및 스크롤의 경우 취소)
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• 드래그하여 임계값 표시기를 배치할 수 있습니다. 임계값은 일반적으로 어떤 피크에 라벨
이 붙는지 결정하고 어떤 피크가 처리되는지 결정하는데 사용됩니다.

• 데이터 영역에서 드래그함으로써 선택할 수 있습니다. 선택 영역을 통해 데이터의 일부가
사용되거나 처리되도록 정의합니다. 드래그하면서 Shift 키를 눌러 여러 영역을 선택합니
다. Ctrl 키를 눌러 x 및 y축 모두에서 선택합니다.

그래프별 도구 모음
표 D-3 그래프별 도구 모음 아이콘

아이콘 이름(툴팁)

확대/축소된 그래프가 홈 화면으로 되돌아 감

확대/축소 선택으로 전체 보기

'확대/축소' 그래프 표시(현재 확대/축소 추적용). 그림 D-6 내용을 참조하십시오.

선택된 피크에 적합한 화살표 기호 추가

백분율 y축을 사용합니다.

모든 중첩된 추적에 라벨링

피크 채우기

창에서 그래프의 x축을 다른 축(동일한 단위 가짐)에 연결(Control 키를 길게 눌러
현재 모든 그래프에 적용)

이전 실험을 사용하기 위해 데이터 전환

다음 실험을 사용하기 위해 데이터 전환

선택된 실험을 사용하기 위해 데이터 전환

선택한 스펙트럼 표시

배경 분리 범위 설정

참고: 창 아이콘 삭제로 시작하는 이 도구 모음 내 최종 여섯 개 아이콘은 일반 창 도구 모음에
서 설명합니다.

확대/축소된 그래프가 홈 화면으로 되돌아 감

등고선도를 확대/축소한 경우 이 아이콘을 사용해 x 및 y축이 기본 범위를 표시하고 사용 가능
한 모든 데이터를 볼 수 있는 홈 화면으로 되돌아 갑니다. x축을 더블 클릭하면 그래프가 홈 화
면으로 되돌아 갑니다. y축을 더블 클릭하면 이 축만 전체 범위로 되돌아 갑니다.
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확대/축소 선택으로 전체 보기

이 아이콘을 사용해 등고선도를 확대/축소하여 선택된 영역이 전체 가용 공간을 채우도록 합
니다. 이 아이콘을 선택하기 전에 등고선도 내에 드래그하여 선택을 합니다. 등고선도의 x축
(또는 y축)에서 직접 드래그하여 확대/축소할 수도 있습니다.

'확대/축소' 그래프 표시(현재 확대/축소 추적용)

이 아이콘을 사용해 그림 D-6에서 표시된 것과 같이 기본 그래프 아래에서 작은 그래프 사본을
표시합니다. 이 개요 그래프는 사용 가능한 전체 범위를 항상 나타내며 분홍색 선택 부분을 통
해 기본 그래프 확대/축소 영역을 표시합니다. 기본 그래프가 확대/축소되면 선택 영역도 이에
따라 업데이트됩니다.

피크 선택 부분을 새 위치로 드래그하면서 필요에 따라 기본 그래프를 스크롤합니다. 선택 부
분의 왼쪽 또는 오른쪽 가장자리 부근을 드래그하여 폭을 조정합니다. 이 때 주 그래프를 필요
에 따라 확대/축소합니다.

필요한 세부 사항을 보기 위해 꽤 멀리 확대/축소해야 할 때가 종종 있기 때문에 이 기능은 고
분해능 질량 스펙트럼에 유용합니다. 개요 그래프는 확대/축소된 영역을 전체 질량 범위와 관
련해 추적하는 데에도 사용할 수 있습니다.

그림 D-6 개요 그래프 표시

선택된 피크에 적합한 화살표 기호 추가

이 아이콘을 사용해 지금 선택한 그래프 영역 내에서 가장 큰 피크에 화살표를 추가합니다. 그
림 D-7은 보여지는 바와 같이 829 피크(대략)를 선택한 경우 이 아이콘을 클릭하는 결과를 보
여줍니다.
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그림 D-7 단일 화살표 기호 추가

화살표는 데이터에서 참조점의 역할을 합니다. 화살표와 인접하지 않은 피크는 가장 가까운
화살표에서의 거리로 자동으로 레이블이 붙습니다. 가장 큰 x값을 가진 화살표 인근 피크는 실
제 x값으로 레이블이 붙습니다. 마지막이 아닌 화살표 인근의 피크는 보다 높은 x값을 가진 화
살표에 관련하여 라벨이 붙습니다. 그림 D-7에서 약 829 Da에서 피크는 실제 m/z 값으로 라벨
이 붙고 동위 원소 피크는 이 피크에서의 거리로 라벨이 붙습니다. 화살표 왼쪽 피크(보이지 않
음)는 음 라벨 값을 가지게 됩니다.

화살표는 대부분 스펙트럼을 통해 사용되며 MS/MS 스펙트럼 등에서 동위 원소, 중성 손실 등
질량 차이 기대치를 찾기 위한 편리한 방법을 제공합니다. 그림 D-8은 화살표가 아미노산 잔기
중성 손실과 일치하는 값에 추가되었던 MS/MS 펩타이드 스펙트럼을 보여줍니다. 예를 들어
99.02로 라벨이 붙은 피크는 1050.73 Da 피크에서 발린 손실이 있을 수 있고 114.03으로 라벨
이 붙은 다음 피크는 아스파라긴 등의 추가 손실이 있을 수 있습니다. -113.08로 라벨이 붙은
피크는 129.02로 라벨이 붙은 피크로부터 류신 또는 이소류신 손실이 있을 수 있습니다(709
Da에 가까운 실제 m/z 속도 갖춤).

그림 D-8 여러 화살표 기호 추가

이 상대 피크 라벨링이 사용되지 않으면 의 Use Arrows for Relative Peak Labeling 메뉴 항
목을 지웁니다.그림 D-9 이 경우 특정 관심 피크를 표시하는데 화살표를 사용합니다.

그림 D-9 Add Arrow Marker Menu
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사용자는 화살표를 새 위치로 드래그할 수 있습니다. 화살표를 등고선도 안으로 드래그하면
드래그 동작이 취소됩니다. 화살표를 그래프 외부로 드래그하면 화살표가 삭제됩니다. 의 메
뉴에서 Remove All Arrows를 선택하여 화살표를 삭제할 수도 있습니다.그림 D-9

퍼센트 Y축 사용

이 아이콘은 y축 스케일링을 측정합니다. 선택된 경우 중첩된 추적을 측정해 각 추적에 대한
최대값이 100%가 되도록 합니다. 중첩된 추적의 절대 등급이 매우 다른 경우 퍼센트 y축을 사
용하는 것이 편리합니다.

모든 중첩된 추적에 라벨링

여러 추적이 중첩된 경우 활성 추적에 라벨이 자동으로 붙습니다. 이 아이콘을 클릭해 모든 추
적에 라벨을 붙입니다. 다시 아이콘을 클릭하여 라벨을 제거하고 기존 화면으로 전환합니다.

피크 채우기

이 아이콘을 클릭해 어둡게 채우거나 밝게 채우는 것을 교대로 하여 활성 데이터의 피크를 채
웁니다. 이 기능은 피크의 시작점과 중지점을 정확하게 찾는 데 유용합니다. 다시 아이콘을 클
릭하여 채우기를 제거하고 기존 화면으로 전환합니다.

그래프의 X 축을 범위 내에서 같은 단위를 사용하는 다른 축에 연결

한 그래프에서 축을 확대/축소하는 경우 나머지 축이 동일한 범위를 표시하기 위해 자동 조정
될 수 있도록 두 개 이상의 그래프 축을 연결할 수 있습니다. 이 기능을 사용하면 이러한 그래
프에서 데이터를 비교할 때 유용할 수 있습니다. 동일한 그래프에서 데이터 세트를 중첩하는
것도 방법이 될 수 있습니다. 그러나 이것이 항상 바람직한 것은 아닙니다.

연결할 각 그래프에서 Links graph's x-axis to others (with same units) in the window 아
이콘을 클릭합니다. Ctrl 키를 누른 상태에서 아이콘을 클릭하면 동일한 범위에서 활성 그래프
와 X 축 단위가 같은 모든 현재 그래프가 연결됩니다. 예를 들어 스펙트럼이 3개 표시된 경우
이 중 하나에서 Ctrl 키와 Links graph's x-axis to others (with same units) in the window
아이콘을 동시에 클릭하면 3개의 스펙트럼이 모두 서로 연결됩니다.

참고: 이 예에서 이후에 생성되는 새 스펙트럼은 다른 스펙트럼과 연결되지 않습니다. 새 스펙
트럼을 연결하려면 관련된 Links graph's x-axis to others (with same units) in the
window 아이콘을 클릭해야 합니다.

기본적으로 그래프의 X 축만 연결됩니다. 이 경우 한 그래프가 수동으로 확대/축소되면 보기
내의 피크가 가용 공간을 채우도록 다른 그래프의 Y 축이 자동으로 확대/축소됩니다.

그래프의 연결을 해제하려면 해당 그래프에서 Links graph's x-axis to others (with same
units) in the window 아이콘을 클릭합니다. Ctrl 키를 누른 상태에서 이 작업을 수행하면 동
일한 범위에서 X 축 단위가 같은 모든 그래프의 연결이 해제됩니다.

다음 실험을 사용하기 위해 데이터 전환

그래프의 활성 데이터가 마지막이 아닌 특정 실험과 관련 있는 경우 이 아이콘은 데이터를 다
음 실험이 아닌 동일한 유형의 데이터로 교체합니다.

예를 들어 실험 2의 TIC가 활성 상태이면 이 아이콘을 클릭해 실험 3의 TIC로 전환합니다. 주
어진 시간에서의 스펙트럼이 실험 2에 대해 활성 상태인 경우 이 아이콘을 클릭해 실험 3에 대
해 동일한 시간의 스펙트럼으로 전환합니다.
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이전 실험을 사용하기 위해 데이터 전환

그래프의 활성 데이터가 첫 번째 실험을 제외한 특정 실험과 관련이 있는 경우 이 아이콘은 데
이터를 동일한 유형의 데이터로 대체하지만 이전 실험의 경우로 제한합니다.

예를 들어 실험 3의 TIC가 활성인 경우 이 아이콘을 클릭해 실험 2의 TIC로 전환합니다. 실험
3에 해당하는 주어진 시간에서의 스펙트럼이 활성인 경우 이 아이콘을 클릭해 실험 2에 해당
하는 동일한 시간의 스펙트럼으로 전환합니다.

선택된 실험을 사용하기 위해 데이터 전환

이 아이콘을 사용하면 실험을 하나씩 스크롤하지 않고 사용할 특정 실험을 선택할 수 있습니
다. 아이콘을 클릭하면 사용 가능한 모든 실험이 나열되는 대화 상자가 열립니다. 활성 샘플이
강조됩니다. 목록 내 실험을 클릭해 선택한 후 OK를 클릭합니다. 그림 D-10 내용을 참조하십
시오.

그림 D-10 Select Experiment 대화 상자

선택한 스펙트럼 표시

이 아이콘을 사용해 그래프에서 현재 선택한 시간 범위의 평균 질량 스펙트럼을 생성합니다.
선택 영역 내에서 더블 클릭하여 동일한 결과를 달성할 수 있습니다.

배경 분리 범위 설정

이 아이콘을 사용해 크로마토그램에서 생성된 스펙트럼용 자동 배경 분리를 수행합니다.
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스펙트럼별 도구 모음
표 D-4 스펙트럼별 도구 모음 아이콘

아이콘 이름(툴팁)

선택할 수 있는 XIC 표시

참고: 확대/축소된 그래프를 홈 화면 아이콘으로 돌려 보내기로 시작하는 이 도구 모음의 첫 열
한 개 아이콘은 그래프별 도구 모음에서 설명합니다.

참고: 창 아이콘 삭제로 시작하는 이 도구 모음 내 최종 여섯 개 아이콘은 일반 창 도구 모음에
서 설명합니다.

선택한 XIC 표시

이 아이콘을 사용해 그래프에서 현재 선택한 질량 범위에 걸쳐 총합인 이온 추출 크로마토그
램(XIC)을 생성합니다.

오버레이
그래프는 동일한 축을 공유하며 중첩이라고 불리는 다른 추적을 포함할 수 있어 쉽게 비교가
가능하도록 합니다. Drag to another graph to overlay the active data in the target graph
를 드래그함으로써 그래프를 생성할 수 있고 일부 창 생성 명령을 통해 자동으로 생산됩니다.
크로마토그램 및 스펙트럼 내용을 참조하십시오.

그림 D-11에서 그래프는 선택된 모든 중첩된 추적에 라벨링 아이콘이 있는 네 개의 스펙트럼
을 포함합니다. 그래프의 헤더 영역은 두 개의 스펙트럼 및 채색된 원에 대한 제목을 나타내며
추적 컬러를 표시합니다. 활성 추적은 볼드체로 표시됩니다. 이 추적은 임계값 데이터, 다듬기
등의 모든 처리 작업에 대한 목표이며 일반적으로 라벨이 붙은 유일한 작업입니다. 제목 왼쪽
의 아이콘을 클릭함으로서 아이콘이 변경되며 활성 추적 제목만 표기되도록 합니다. 이 기능
은 중첩이 여러 개일 때 유용합니다. 아이콘을 다시 클릭해 프로세스를 역순으로 진행합니다.
많은 추적이 있고 커서가 제목 위로 이동하는 경우 커서는 양방향 화살표로 변경되며 드래그
하는 경우 스크롤 막대의 기능을 하여 모든 제목에 액세스할 수 있도록 합니다.
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그림 D-11 선택된 모든 중첩된 추적 아이콘 라벨링을 갖춘 네 개의 스펙트럼이 포함된 그래프

활성 추적을 전환하는 여러 방법이 있습니다.

• 채색된 원을 제목 옆에 클릭

• 제목 자체 클릭

• 추적에 데이터 지점 클릭(추적 자체가 아님)

중첩된 그래프에 오른쪽 버튼을 클릭하면 사용 가능한 명령이 포함된 콘텍스트 메뉴가 나타나
표시된 추적을 시각적으로 편집할 수 있습니다. Remove Active Trace 및 Remove All
Traces Except Active 옵션이 예상대로 작동합니다.

파일 열기
그림 D-12에서 확인할 수 있는 바와 같이 소프트웨어는 다른 유형의 데이터 파일을 열 수 있으
며 명령을 통해 단일 또는 여러 샘플을 열 수 있습니다.
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그림 D-12 파일 메뉴

한 샘플 파일 열기
Open Sample 옵션으로 Select Sample 대화 상자를 엽니다. 그림 D-13 내용을 참조하십시
오.

이 대화 상자를 통해 단일 파일을 선택할 수 있습니다. 결과 화면은 선택한 명령에 좌우되는데
single .scan 파일은 스펙트럼 또는 총 이온 크로마토그램(TIC)을 표시하고 multiple scan .wiff
파일은 TIC(하나 이상의 실험이 있는 경우 모든 실험의 총합)를 표시합니다.

그림 D-13 Select Sample 대화 상자

.wiff 파일의 왼쪽에 있는 아이콘을 클릭하면 파일 내 모든 샘플이 나타나며 이후 필요한 파일
명을 선택합니다. 파일 내 하나의 샘플만 있는 경우 파일명을 선택하고 OK를 클릭합니다.
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여러 샘플 파일 열기
Open Multiple Samples 및 Open Heat Map TICs from Wiff 옵션으로 Select Samples 대화
상자가 열립니다. 그림 D-14 내용을 참조하십시오.

왼쪽 패널은 폴더를 탐색하고 파일을 지정할 수 있는 Open 대화 상자에 해당하며 오른쪽 패널
은 OK를 클릭하면 열리는 파일을 표시합니다. 다음과 같이 샘플을 왼쪽에서 오른쪽으로 전송
할 수 있습니다.

• wiff 파일을 확장하고 샘플을 선택한 후 오른쪽 방향의 화살표를 클릭합니다.

• wiff 파일을 확장하고 샘플을 선택한 후 오른쪽 패널로 드래그합니다.

• wiff 파일을 확장한 후 샘플을 더블 클릭합니다.

파일에 여러 샘플이 포함된 경우 wiff 파일을 선택하고 오른쪽 방향 화살표를 클릭함으로써 또
는 .wiff 파일을 선택한 후 오른쪽 패널에 드래그함으로써 샘플 모두를 전송할 수 있습니다.

다음과 같이 샘플을 오른쪽에서 왼쪽으로 전송할 수 있습니다.

• wiff 파일을 확장하고 샘플을 선택한 후 왼쪽 방향의 화살표를 클릭합니다.

• wiff 파일을 확장하고 샘플을 선택한 후 왼쪽 패널로 드래그합니다.

• 샘플을 더블 클릭합니다.

그림 D-14 샘플 대화 상자 선택

크로마토그램 및 스펙트럼
총 이온 크로마토그램(TIC), 스펙트럼 및 이온 추출 크로마토그램(XIC)은 데이터를 탐색 및 검
토하는 데 가장 널리 이용되는 데이터 보기입니다. 소프트웨어는 이런 데이터 화면 간 연결을
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제공해 사용자가 빠르게 스펙트럼 및 XIC를 생성하여 스펙트럼 내 피크가 하나 이상의 크로마
토그래피 피크에서 비롯되는지의 여부를 측정할 수 있도록 합니다.

총 이온 크로마토그램(TIC)
이것은 스캔 또는 멀티 스캔 .wiff 파일이 열린 경우에 표시되는 기본 화면입니다. 표시된 TIC
는 각 스펙트럼에서 모든 이온의 강도를 합산하고 합계를 머무름 시간의 함수 그래프로 나타
냄으로써 생성된 크로마토그램과 일치합니다.

루프 실험을 통해 샘플이 확보된 경우 표시된 TIC는 두 실험의 강도 합계와 일치하며 이것을
표시하기 위해 x축에서 특별한 화살표 표시가 그려집니다. 그림 D-15 내용을 참조하십시오.
화살표 표시를 더블 클릭하는 경우 각 실험에 대해 증첩된 개별 TIC를 표시하는 새로운 창이
나타납니다.

그림 D-15 TIC

샘플에 IDA 데이터가 포함된 경우 선택된 전구체의 질량 및 머무름 시간을 표시하는 그래픽
방식인 IDA 탐색기 또는 기존 TIC를 선택합니다. 기존 TIC 옵션을 선택하면 IDA 조사 및 IDA
종속 합계에 대한 별도의 TIC가 표시됩니다.

Show > Total Ion Chromatogram (TIC)을 클릭하여 언제든지 TIC를 표시함으로써 어떠한 실
험이든 선택할 수 있는 대화 상자가 열립니다. 기간 1 선택은 모든 실험에 대한 TIC를 표시하
지만 나머지 입력 항목은 개별 TIC에 해당합니다. 하나 이상 선택하려면 Shift+ 또는 Ctrl+ 클
릭을 사용합니다.

스펙트럼

파일에 단일 스펙트럼만 포함된 경우 파일이 열린 시기를 스펙트럼이 보여줍니다.

스캔이 여러 개 포함된 데이터의 경우는 크로마토그램을 선택하고 크로마토그램 안쪽을 두 번
클릭하거나 선택한 스펙트럼 표시 아이콘을 클릭해 크로마토그램에서 스펙트럼을 표시합니
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다. 새로운 영역을 보여주는 스펙트럼을 업데이트하려면 크로마토그램에서 선택 직사각형을
드래그합니다.

첫 번째 선택을 완료한 후 Shift 키를 눌러 여러 영역을 선택합니다. 중첩된 스펙트럼이 포함된
새로운 스펙트럼 창을 생성하려면 이런 선택에서 더블 클릭하거나 선택한 스펙트럼 표시 아이
콘을 클릭합니다.

IDA의 경우 안내를 통해 모든 종속 스펙트럼을 중첩되게 하거나 첫 번째 스펙트럼 오픈을 보
여줍니다. 후자의 경우 나머지 스펙트럼을 나타내려면 왼쪽 및 오른쪽 화살표 키를 사용합니
다.

참고: 이 대화 상자에는 shift 키를 눌렀을 때만 창을 표시하는 체크 박스가 있습니다.

두 가지 방법으로 배경이 없는 스펙트럼을 생성합니다.

• 피크 및 배경 영역에 적합한 별도의 스펙트럼을 생성한 후 배경 스펙트럼에서 배경이 없는
두 개창 아이콘을 피크 스펙트럼으로 드래그합니다.

• 크로마토그램에서 하나 또는 두개를 선택하고 배경 분리 범위 설정 아이콘을 클릭함으로써
함으로써 배경 영역을 정의합니다. 배경 영역이 정의될 때 생성된 모든 스펙트럼은 자동으
로 배경 분리됩니다. 배경 영역은 크로마토그램에서 빨간 선택 직사각형으로 표시되며 표
시된 데이터를 변경하기 위해 이 뿐 아니라 모든 스펙트럼 선택 영역을 이동시킬 수 있습니
다. 배경 영역이 정의된 경우 아이콘 옆의 화살표를 클릭한 후 분리 범위 지우기를 선택하여
제거할 수 있습니다.

참고: 피크 라벨은 화살표로 표시된 가장 가까운 피크와 관련이 있을 수 있기 때문에 화살표 기
호는 스펙트럼에서 유용합니다. 여기에서 손실 또는 부가물 질량을 측정하기 위해 신속한 방
법을 제공합니다. 여러 중첩이 있으며 중첩된 모든 추적에 라벨로 표시하기 아이콘을 선택한
경우 화살표와 관련하여 각 중첩에 라벨이 붙습니다.

이온 추출 크로마토그램 (XIC)
XIC를 두 가지 방법으로 생성할 수 있습니다.

• Show > Extracted Ion Chromatogram (XIC) 을 클릭함으로써.

이 작업 진행 시 모드에 따라 시작 및 중단 질량 또는 중앙 및 폭값을 입력할 수 있는 대화
상자가 열립니다. 대화 상자 내에서 오른쪽 버튼을 클릭하여 콘텍스트 메뉴에서 이를 변경
할 수 있습니다. 또한 콘텍스트 메뉴는 기본 폭 설정 및 질량 목록 가져오기 또는 내보내기
등의 다른 유용한 명령에 대한 액세스를 제공합니다. 또한 사용자는 질량값이 제거될 때까
지 자동으로 사용될 수 있도록 값을 영속화할 수 있습니다.

• 스펙트럼에서 하나 이상의 선택을 한 후 여러 개 중 하나에서 더블 클릭하거나 Displays an
XIC for selection 아이콘을 클릭함으로써.

이러한 작업은 각 선택에 해당하는 XIC를 생성합니다. 프로그램은 자동으로 각 선택 범위
에서 가장 큰 피크를 측정하고 XIC를 피크에 적합한 절반 높이 로우 및 높은 질량값으로 자
동 설정합니다. Ctrl 키를 누른 경우 전체 선택 폭을 사용할 수 있습니다.

두 가지 경우에서 각 선택에 대해 하나의 중첩을 포함하는 그래프가 표시됩니다. 선택 부분이
링크로 바뀝니다. 링크를 드래그하여 XIC를 업데이트합니다.
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참고: XIC는 일반적으로 계산되며 전체 크로마토그래피 범위에 맞게 표시되는데 여러 선택을
할 수 있으며 고분해능 기기로부터 데이터를 얻거나 및 많은 스캔을 포함하는 경우 프로세스
가 느리게 진행될 수 있습니다. XIC 범위를 생성하는데 사용되는 스펙트럼의 머무름 시간에
있어 이 범위를 작은 창으로 제한하는것이 유용한 기능입니다. 편집 > 옵션 > XIC 탭을 클릭한
후에 나타나는 대화 상자의 XIC 탭에서 이를 설정할 수 있습니다.

등고선 플롯 및 히트맵
LC/MS 등고선도(Show > LC/MS Contour Pane)는 단일 창의 LC/MS 샘플에서 모든 데이터
를 표시합니다. 그림 D-16의 사례는 TIC 및 강도 컬러 코드화를 나타내며 이는 코딩된 강도 색
상으로 머무름 시간 대비 m/z 속도 지도를 보여줍니다. 이 경우에 색상 제어 또한 표시되지만
보기에서 오른쪽 버튼을 클릭하고 Show Appearance Controls 옵션을 지움으로써 숨길 수
있습니다. 등고선도 및 크로마토그램이 동일한 x축을 가지고 있기 때문에 비교 용도로 확대/축
소 및 스크롤이 두 화면에 유사하게 영향을 미칠 수 있도록 함께 연결할 수 있습니다.

그림 D-16 TIC 및 해당 등고선 지도

색상 제어는 min % 및 max %로 정의된 범위 내 강도를 표시하기 위해 256 색상 팔레트를 사
용합니다. min % 이하의 강도는 < min를 사용해 그려지며 max % 이상의 강도는 > max를 사
용해 그려집니다. < min에 사용된 색상과 데이터가 동일하지 않은 경우(여기에서) min % 이
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하의 어떠한 데이터 포인트도 사라집니다. 이것은 시각 임계화의 형식으로 Figure 1-11에서 확
인할 수 있는 것과 같이 등고선도를 단순화할 수 있으며 여기에서 min % 값이 0.5%로 증가되
었습니다. 색상 제어에 대한 자세한 정보는 시스템 사용자 안내서를 참조하십시오.

그림 D-17 최소 % 값이 0.5% 증가된 등고선 지도

색상 팔레트가 보다 작은 강도 범위를 포괄할 수 있도록 max %를 줄임으로써 저강도 피크를
강조할 수 있지만 이 값보다 큰 모든 피크는 동일한 색상을 갖습니다. Log Scale 체크 박스를
선택함으로써 이것 또한 강조할 수 있습니다. Log Scale을 활성화 하는데 있어 min %(예, 1
또는 0.1)에 대한 0이 아닌 값이 필요하며 이후 색상을 퍼센트 강도의 로그에 표시합니다.

소프트웨어 내 멀티 샘플 시각화 도구에는 TIC, XIC 및 개별 히트맵 시리즈로서 여러 샘플에
대한 스펙트럼을 표시하는 기능이 포함되어 있어 샘플 비교를 지원할 수 있습니다. 그림 D-18
은 여섯 개의 분석 물질에서 비롯된 TOF 크로마토그램 시리즈용입니다. 여러 샘플로 작업 내
용을 참조하십시오.
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그림 D-18 히트맵 크로마토그램

크로마토그램 및 스펙트럼을 통해 작업
이 섹션은 가장 일반적인 처리 옵션 중 일부를 설명합니다. 사용된 파일은 많은 루프 실험을 거
친 IDA 파일이지만 이 사례에서는 첫 번째 조사 실험을 사용하여 간단한 LC/MS 분석을 시뮬
레이션합니다. 다음 섹션에서 IDA 기능에 대해 알아봅니다.

데이터 파일 열기
1. 메인 도구 모음에서 Open Sample 아이콘을 클릭합니다.

Select Sample 대화 상자가 열립니다.
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그림 D-19 Select Sample 대화 상자

2. Sample Data 폴더가 아직 선택되지 않은 경우 Browse를 클릭하여 Sample Data 폴더를
탐색합니다. 설치 데이터 파일 위치에 대한 정보는 조직을 참조하십시오.

3. 파일 내 모든 샘플을 나타내려면 Bromocrip_IDA-DBS alone_T=1.wiff 파일의 왼쪽에 있는
아이콘을 클릭합니다.
Bromocrip_IDA-DBS alone_T=1.wiff 파일에 하나의 샘플만 있습니다.

4. 샘플 이름을 선택한 후 OK를 클릭합니다.
이것은 IDA 파일이기 때문에 소프트웨어는 선택된 샘플을 여는 방법을 지정할 수 있도록
안내합니다.

그림 D-20 Open IDA Sample

5. As a standard TIC를 클릭한 후(선택되지 않은 경우) OK를 클릭하여 그림 D-21과 같이
TIC를 생성합니다.
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그림 D-21 TIC

이 창에는 조사 스캔 TIC(파란색)에 대해 하나의 중첩이 있고 종속(생성 이온) 스캔 총합에
대해 또 다른 중첩이 있습니다. 이 경우에 조사 TIC만 나타내는 조사 데이터를 처리하기
원합니다.

하나의 실험에 적합한 TIC 표시
1. x축 중앙에 있는 Double-click to overlay individual TICs for all experiments아이콘을

더블 클릭해 모든 실험에 적합한 중첩된 TIC를 생성합니다.
새로운 크로마토그램은 활성 창입니다. 조사는 첫 번째 실험이기 때문에 활성 추적은 헤
더의 볼드 제목을 통해 표시됩니다.
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그림 D-22 중첩된 TIC

2. 활성 크로마토그램 창 내에서 오른쪽 버튼을 클릭한 후 Remove All Traces Except
Active를 클릭해 조사 TIC만 남도록 합니다.

그림 D-23 오른쪽 버튼 클릭 메뉴

3. 동일한 창에서 조사 TIC만 남겨두려면 다른 모든 창 삭제 아이콘을 클릭합니다.
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그림 D-24 조사 TIC

알고 있는 분자식에 대한 XIC 나타내기
이 데이터에서 4분에서 7분 범위는 작은 피크 몇 개가 확실하게 보이지만 많은 피크가 꽤 강렬
한 배경 신호에 의해 모호해 졌을 수 있습니다. 이 샘플은 브로모크립틴의 마이크로솜 잠복기
에 해당하므로 피크 위치에 대한 초기 안내서로 예상되는 분자 이온의 m/z 속도를 사용하십시
오. 브로모크롭틴의 분자식은 C32H40N5O5Br이고 이 데이터가 네거티브 모드 데이터이므로
(M – H)– 이온을 볼 수 있을 것으로 예상됩니다.

1. Show > Mass Calculators를 클릭합니다.

2. Mass Calculators창에서 Mass Property 탭을 클릭합니다.

3. Formula필드에서 분자 식을 입력합니다.

4. Charge state 필드에서 유형 -1을 입력합니다.

5. 'H+' charge agent (else electron)를 선택합니다.

6. Calculate를 클릭합니다.

참고: 분자식에서 수동으로 하나의 전자를 제거하고 'H+' 전하 매개체(이외 전자) 체크 박
스를 선택하지 않는 것 또한 가능합니다
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다음과 같은 단일 동위 원소 포함, 평균 등 많은 질량값을 보여주기 위해 대화 상자가 새로
고침됩니다.

그림 D-25 질량 계산기 창

참고: 이러한 질량값으로 동위 원소가 쉽게 해결됩니다. 따라서 동위 원소 포함 m/z 값이
가장 적합한 값입니다.

7. Monoisotopic m/z을 선택한 후 Ctrl+C를 눌러 값을 클립보드에 복사합니다.

8. Deletes this pane아이콘을 클릭해 Mass Calculators창을 삭제하거나 Hides this pane
아이콘을 클릭해 창을 숨깁니다.

9. Show > Extracted Ion Chromatogram (XIC)을 클릭해 Specify XIC Ranges 대화 상자
를 엽니다.
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그림 D-26 Specify XIC Ranges 대화 상자

10. Specify XIC Ranges 대화 상자에서 오른쪽 버튼을 클릭해 콘텍스트 메뉴를 엽니다.

11. 콘텍스트 메뉴에서 다음을 행합니다.

a. Start/Stop Mode 옵션이 선택되지 않았는지 확인하여 XIC 값이 중앙값 및 폭으로 입
력되도록 합니다.

b. Set Default Width를 클릭한 후, 0.05를 입력하고 OK를 클릭합니다.

c. Persist Ranges for Future Use를 클릭하여 다음 대화 상자 사용 시에 값을 기억하
도록 합니다.
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그림 D-27 콘텍스트 메뉴

12. Specify XIC Ranges대화 상자로 돌아갑니다.
각 관심 XIC에 대해 하나의 질량만 입력하고 기본 폭이 사용되도록 지금 대화 상자를 설정
합니다.

13. Center아래에 있는 첫 번째 셀을 선택한 후 Ctrl+V를 눌러 7단계의 질량값을 붙여넣기합
니다.

14. OK를 클릭합니다.

참고: 기본 폭이 설정되었기 때문에 개별값을 입력할 필요가 없습니다.

창에는 여러 피크를 보여주는 브로모크립틴의 예상 분자 이온에 대한 TIC 및 XIC가 포함
되어 있습니다.
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그림 D-28 브로모크립틴의 예상 분자 이온에 대한 TIC 및 XIC

스텍트럼 생성 및 상호 작용
1. TIC 창을 숨기고 XIC에서 가장 큰 피크 주위를 선택한 후 Displays a spectrum for

selection 아이콘을 클릭해 이 영역에 적합한 평균 스펙트럼을 생성합니다.
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그림 D-29 XIC 내 가장 큰 피크에서 발생한 스펙트럼

참고: 그림 D-29에서, Options 대화상자(Edit > Options에서 사용 가능)의 Peak Labeling
& Finding 탭에서 Label 필드는 Mass (Charge)로 설정되어 있습니다.

2. x축을 630 Da에서 700 Da로 드래그하여 스펙트럼을 이 영역으로 확대/축소합니다.

참고: 여기에는 두 가지 단계가 완료되어야 합니다.

기대값인 652.2140과 매우 가까운 652.2199에 피크가 있고 이는 또한 브롬 동위 원소 유
형을 표시하지만 668.2158에서 시작하는 두 번째 브롬 동위 원소 집단이 있습니다. 정확
한 m/z 속도값은 XIC에서 선택된 정확한 머무름 시간 범위에 따라 다릅니다.

참고: 여기에서 사용된 라벨링 양식은 m/z 속도 및 괄호 내 전하 상태 추정치를 표시합니
다(피크 간 간격에 따름). 동위 원소가 포함된 것으로 보이는 피크는 또한 별표로 표시됩니
다. 라벨링 알고리즘은 13C 외의 동위 원소를 식별하지 못하고 81Br 동위 원소가 단일 전
하를 띄게 되지만 동위 원소를 포함한다는 것을 올바르게 표시하지 않습니다.

3. Edit > Options를 클릭하고 Peak Labeling & Finding 탭을 탐색 하며 Label 필드에서
Mass / Charge로 설정을 변경함으로써 라벨링 양식을 기본 양식으로 변경합니다.

4. OK를 클릭합니다.
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그림 D-30 다른 라벨링 양식을 가진 스펙트럼

5. 확장된 스펙트럼에서 652.2199에서의 피크 주위를 선택한 후 Adds arrow markers for
selected peaks 아이콘을 클릭합니다.

그림 D-31 선택된 피크에서 스펙트럼 표시 

질량 라벨링은 선택된 피크와 관련이 있기 때문에 질량 피크 간 차이가 표시됩니다.
668.2158에 있는 피크의 라벨은 산소의 질량에 해당되는 15.9959로 표시되며, 이 피크는
히드록시 브로모크롭틴 대사 물질일 가능성을 시사합니다.

팁! 화살표를 또 다른 피크로 드래그함으로써 이동시킬 수 있고 화살표 아이콘과 인접한
목록에서 Remove All Arrows를 선택함으로써 제거할 수 있습니다.

6. 15.9959로 피크 라벨이 표시된 주위를 선택한 후 선택용 XIC 표시 아이콘을 클릭합니다.

7. XIC Selection Ranges 대화 상자에서 OK를 클릭합니다.
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그림 D-32 XIC 선택 범위 대화 상자

그림 D-33 XIC

이것은 XIC를 상호 생성할 수 있는 유용한 방법입니다. XIC에 사용되는 폭은 절반 높이에
서의 질량 피크 폭이며 스펙트럼에서 선택 링크가 자동으로 표시됩니다.

8. 선택 링크를 드래그하여 표시된 XIC를 업데이트하고 단계를 반복함으로써 추가합니다.

9. 새로운 크로마토그램 내 Drag to another graph to overlay the active data in the
target graph 아이콘을 클릭한 후 이들이 중첩되도록 크로마토그램을 기존 XIC 창으로 드
래그합니다.
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그림 D-34 중첩된 XIC

10. 두 번째 크로마토그램 창과 스펙트럼을 숨기거나 삭제한 후 4분에서 5분 주위의 영역이
표시되도록 중첩된 크로마토그램을 확대합니다.
4.4분 주위에는 각 XIC에서 하나씩 생성된 두 개의 피크가 있으며, 가까이 용리되었지만
머무름 시간이 똑같지는 않습니다. 또한 668.216 크로마토그램에서 많은 피크가 발생했
으며 이는 아마도 다른 히드록시 대사 물질의 존재가 있다는 것을 표시합니다.

11. 4.40분에서 크로마토그램 창을 두 번 클릭해 단일 스캔에서 발생한 스펙트럼을 생성합니
다.
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그림 D-35 단일 스캔에서 발생한 스펙트럼

XIC에서 파선은 이와 같은 스캔을 표시합니다(그림 D-35에서 화살표로 표시). 선을 드래
그하면 4.40분 주위의 영역을 탐색할 수 있도록 스펙트럼이 업데이트됩니다. 한 번에 하나
의 스캔을 이동시키려면 전방 및 후방 화살표 키를 사용합니다. 668.215 이온에 대한 신호
가 0(여기에서 배경이 꽤 높을 수 있음)인 영역으로 파선을 이동함으로써 652.214 m/z 속
도의 피크에 대해 클린 스펙트럼을 달성할 수 있지만 후자에 해당하는 클린 스펙트럼은
이 방법으로 달성할 수 없습니다.

12. 스펙트럼 창을 삭제합니다.

13. 크로마토그램 창에서 652 피크의 왼쪽 측면을 포함하지만 668 피크를 피해가는 좁은 영
역을 선택한 후 배경 분리 범위 설정 아이콘을 클릭합니다.

선택 영역이 분홍색으로 변합니다.

분리 범위가 정의된 경우 이후 생성된 모든 스펙트럼에서 자동으로 분리됩니다. 분리 범
위는 분리 범위 설정 아이콘 오른쪽의 화살표를 클릭한 후 목록에서 분리 범위 지우기를
선택하여 제거할 수 있습니다.

14. 크로마토그램에서 668 피크의 정점을 포함하지만 652 피크는 가능한 조금 포함하는 또
다른 영역을 선택한 후 선택에 대한 스펙트럼 표시 아이콘을 클릭합니다.
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그림 D-36 668 피크용 배경 분리된 스펙트럼

결과는 668 피크에 대한 배경 분리된 스펙트럼으로 652 피크를 거의 포함하지 않습니다.
비록 배경이 보이지 않지만 크로마토그램에서 두 개의 선택 영역은 각 스펙트럼에 연결되
어 있으며 크로마토그램의 다른 부분으로 이동할 수 있습니다. 스펙트럼 표시 영역의 이
동을 통해 표시된 스펙트럼을 업데이트할 수 있지만 배경 영역은 변경되며 이후 생성된
스펙트럼에만 적용됩니다.

15. Hides all other panes 아이콘을 클릭하고 단일 스펙트럼 TIC를 클릭한 후 Deletes all
other panes 아이콘을 클릭해 TIC만 표시되도록 합니다.

16. TIC 창이 삭제된 경우 Show > Total Ion Chromatogram (TIC)을 클릭하고 Period 1,
Experiment 1을 선택한 후 OK를 클릭합니다.

등고선 플롯 사용
데이터 세트(크로마토그램 또는 스펙트럼)의 일부를 볼 수 있는 대안으로 등고선도를 사용해
실험의 전체 개요를 확보합니다. 등고선도는 매우 유용할 수 있지만 최고의 결과를 얻기 위해
종종 시각 매개 변수를 조절해야 합니다. 이 경우 전구물질 화합물은 브롬과 화합하며 등고선
도는 브롬 동위 원소 유형을 통해 피크를 찾는 방법을 제공합니다.

1. 단일 실험 TIC 활성을 통해 Show > LC/MS Contour Pane을 클릭한 후 결과 등고선도 도
구 모음에서 Expands active pane to fill window 아이콘을 클릭하여 유일 창이 보이도
록 합니다.
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2. 모양 제어(하단 왼쪽 모서리의 컬러 상자)가 보이지 않는 경우 창에서 오른쪽 버튼을 클릭
하고 Show Appearance Control을 클릭합니다. 등고선 플롯 및 히트맵 및 참조 안내서를
참조하십시오.

그림 D-37 등고선도

팁! 실제 피크를 어둡게 하는 낮은 수준의 피크 및 잡음이 지배하기 때문에 기본 매개 변수
를 통한 보기는 매우 유용하지 않습니다. 다음을 통해 보다 나은 보기 생성:

• 표시할 최소 강도를 변경. 이를 통해 데이터를 볼 수 없는 지점과 동일한 색깔로 표기된
이 레벨 이하의 모든 데이터 포인트가 변경됩니다.

• 컬러 매핑을 변경하여 사용 가능한 컬러가 작은 피크의 가시성을 향상시키는 보다 좁
은 강도 범위를 포괄하도록 합니다.

3. min % 값을 0.01로 변경합니다. 이는 기본 피크의 0.01% 이하의 강도를 가진 모든 데이
터 포인트가 사라지게 합니다.
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그림 D-38 등고선도

데이터에서 훨씬 더 많은 구조가 표시됩니다. 공극 부피 및 컬럼 세척 영역은 알아보기 쉽
고 모든 머무름 시간에 존재하고 수직선으로 표시되는 수 많은 배경 피크가 있습니다.

4. Log scale 체크 박스를 선택합니다.
낮은 피크 강도(예: 질량이 600에서 700 범위인 4분에서 4.5분 주위의 집단)를 향상시키는
효과가 있는 강도 로그에 (기본 피크 강도의 백분율로) 선택한 색상이 매핑됩니다.

5. 이 영역을 선택한 후 Zooms selection to full view를 클릭합니다.

팁! 여느 때와 마찬가지로 x 및 y 축을 독립적으로 확대/축소할 수도 있습니다.
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그림 D-39 등고선도

화면은 이 영역에 79Br 및81Br 동위 원소 및 13C 동위 원소와 일치하는 네 개의 평행선 세
트를 통해 구별할 수 있는 수많은 브롬 처리된 피크가 있다는 것을 보여줍니다.

6. 컬러 컨트롤 설정으로 실험하고 화면 상의 효과를 관찰합니다.

7. 종료되면 창을 닫습니다.
데이터 파일도 닫습니다.

요약
이 섹션에서는 다음 작업에 대해 논의했습니다.

• TIC를 나타내는 데이터 파일 검색 및 열기

• 화면을 변경해 하나의 실험만 사용되도록 합니다.

• 질량 계산기를 사용해 요소 구조에서 이온의 질량을 확인하고 질량을 사용해 XIC를 생성합
니다.

• 스펙트럼 및 크로마토그램의 양방향 생성 및 스펙트럼 상에서 화살표 기호 사용으로 피크
간 질량 차이를 표시합니다.

• 스펙트럼이 차감된 배경 생성

• 등고선도를 사용해 데이터 세트의 개요를 생성합니다.

이런 작업은 표시되는 데이터 유형에 관계 없이 모든 양방향 데이터 처리의 기본입니다.
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IDA 탐색기로 작업
IDA 실험에서 하나 이상의 조사 스펙트럼(MS3으로 예상됨)이 특정 기준을 충족하는 경우
MS/MS 스펙트럼 데이터가 자동 수집됩니다. 특정 시간동안 전구체 질량(트리거로 작용할 수
없도록 함)을 배제함으로써 동일한 LC 피크에서 비롯된 여러 스펙트럼의 수집을 방지하기 위
해 매개 변수를 설정하는 것은 일반적입니다. 가끔씩 불필요한 스펙트럼이 수집되는 경우가
있습니다. 이와 더불어 피크가 기준을 충족하는대로 IDA 트리거가 작동하기 때문에 일반적으
로 LC 피크 초기에 스펙트럼을 생성하며 최고의 품질을 제공하지 않을 수 있습니다.

소프트웨어에는 IDA 데이터를 표시하고 필터링하며 처리하는 도구가 포함되어 있습니다. 이
섹션에서 일부 도구에 대해 알아봅니다.

시작 전 열린 모든 창을 닫습니다.

스펙트럼 표시 및 병합
1. 메인 도구 모음에서 Open Sample 아이콘을 클릭합니다.

Select Sample 대화 상자가 열립니다.

2. Sample Data 폴더가 아직 선택되지 않은 경우 Browse를 클릭하여 Sample Data 폴더를
탐색합니다.

3. Bromocrip_IDA-DBS alone_T=1.wiff 파일을 선택한 후 OK를 클릭합니다.

4. Open IDA Sample 대화 상자에서 With the IDA Explorer를 클릭한 후 OK를 클릭합니
다.
프로그램은 데이터 파일 내 모든 스펙트럼을 검사한 후 다음 그래프를 생성합니다.

그림 D-40 IDA 뷰어
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왼쪽 패널은 Graph 탭 및 Table 탭을 포함합니다. Graph 탭은 모든 데이터 포인트가 머
무름 시간을 나타내며 전구체 이온으로 선택되었던 이온의 m/z 속도를 나타내는 가상 등
고선도를 표시합니다. Table 탭은 가상 등고선도에서 데이터 포인트의 표 보기를 보여줍
니다. 오른쪽 패널은 선택된 데이터 포인트의 스펙트럼을 보여줍니다. 처음에 MS/MS 스
펙트럼이 나타납니다.

등고선도는 피크 강도를 반영하기 위해 컬러 강도를 사용합니다. 짙은 컬러는 강도가 더
센 피크를 표시합니다. 가능한 경우 라벨이 표기되어 데이터 포인트가 서로 중첩되지 않
도록 합니다. 등고선도를 주밍해 영역을 보다 자세하게 검사하고 더 많은 라벨을 보여줍
니다.

5. 왼쪽 패널에서, 이전에 브로모크립틴과 관련된 피크가 발견된 4분에서 5분까지, 640 Da
에서 700 Da까지의 영역을 확대/축소합니다.

왼쪽(그림 D-41) 그림은 왼쪽 패널만 보여줍니다. 현재 화면이 다른 경우 Show Options
아이콘을 클릭하고 Options의 General 탭 대화 상자에서 Merge spectra with similar
precursor masses 체크박스를 지웁니다.

많은 수의 MS/MS 스펙트럼이 이 영역에서 수집되었고 크로마토그래피 피크가 매우 협소
함에도 불구하고 이런 피크는 동일한 피크에서 비롯됩니다. 또한 동위 원소 집단의 각 피
크에 대해 MS/MS 스펙트럼이 수집되었습니다.

6. 그래프에 보다 자세히 확대/축소하여 668 Da ~ 672 Da m/z의 속도로 피크 클러스터에 집
중합니다. 그림 D-41의 오른쪽 패널을 참조하십시오.

그림 D-41 IDA 뷰어

7. 669.2197 피크의 처음을 선택(위의 오른쪽 패널에 별표로 표시)한 후 Displays an XIC
for selection 아이콘을 클릭하면 조사 스캔에서 전구체 질량에 대한 XIC를 보여줍니다.

초기에 피크를 선택함으로써 해당 MS/MS 스펙트럼이 나타나게 됩니다.
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그림 D-42 조사 스캔에서 전구체 질량에 대한 XIC

등고선도에서 라벨이 붙지 않은 데이터 포인트가 있는 경우 생성 이온 스캔 시간이 조사
크로마토그램과 관련되도록 커서를 옮겨 m/z 속도 및 머무름 시간 라벨을 표시하도록 합
니다.

669.2 피크에서, 처음 세 개의 스캔은 4.21분의 첫 번째 XIC 피크와 관련된 것이고, 여기서
668.2 스캔도 생성되었습니다. 이후 두 개의 스캔은 4.27분의 피크와 관련된 것이고, 마지
막 스캔은 4.42분의 피크(669.2177/4.46)와 관련된 것입니다. 4.52분의 669.2 피크에는 스
캔이 수행되지 않았지만 670.2 피크에는 스캔이 확보되었습니다.

참고: 비록 동일한 조사 스캔에서 검출되었더라도 순서에 따라 확보되었기 때문에 스캔
시간은 약간 다릅니다. 작은 동위 원소 피크는 큰 동위 원소만큼 빨리 검출되지 않을 수 있
습니다.

8. 처음 다섯 번의 669.2 스캔 주위에 선택 직사각형을 그리고 오른쪽 버튼을 클릭한 후
Select Points in Graph Selection을 선택합니다.

이를 통해 스펙트럼 창이 모든 MS/MS 스펙트럼을 겹치게 할 수 있습니다.
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시스템이 필요한 것보다 더 많은 스캔을 확보했습니다. 너무 가까이에 있어 다른 화합물
이 될 수 없는 화합물의 처리 및 융합을 위해 스펙트럼의 숫자를 줄임으로써 고품질의 결
과를 확보할 수 있습니다. 이런 스캔 측정을 위해 융합 시 질량 및 머무름 시간 모두를 사
용합니다.

9. Show Options 아이콘을 클릭하고 Merge spectra with similar precursor masses를 선
택한 후 Mass tolerance를 10 ppm으로 RT gap tolerance를 0.03분으로 설정합니다. (이
분석 내 피크는 대략 2초 간격 입니다).

10. OK를 클릭합니다.

참고: 이 대화 상자 부분을 통해 사용자는 XIC가 추출되는 방법 또한 정의할 수 있습니다.
질량 폭은 기기의 분해능 또는 피크 폭과 일치해야 하며 이는 처리를 가속화하기 때문에
사용된 시간 범위를 제한하는 것이 유용합니다.

이러한 방법으로 데이터를 병합하면 4.21분, 4.28분 4.46분에 세 개의 669.2 피크가 생성
됩니다. IDA 보기 창 하단의 상태 표시줄은 데이터 융합 과정을 보여주고 융합이 완료된
후에 종속 스펙트럼의 총 수를 보여줍니다.

11. 670.2149/4.26에서 데이터 포인트를 클릭한 후 Ctrl 키를 누르고 668.2162/4.27에서 포인
트를 클릭합니다.

12. MS/MS 스펙트럼 창에서 Expands active pane to fill window 아이콘, Use percent y-
axis 아이콘 및 Label all overlaid traces 아이콘을 클릭한 후 x축에 확대/축소해 340 ~
680의 영역을 나타낼 수 있도록 합니다.

그림 D-43 스펙트럼: 340 ~ 680 m/z의 영역에 확대/축소
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두 개의 전구체가 Br 동위 원소에 해당하기 때문에 스펙트럼은 Br 원자를 보유하는 이온
을 제외하고 동일해야 합니다. Br 원자는 두 개의 Da로 분리되는 한 쌍의 피크로 표시됩니
다. 이 사례의 경우 344.0441, 625.1765 및 637.1712에서 단편(668.2 추적)은 Br 원자를
보유한 반면 340.1925, 367.1796 및 588.2877에서는 그러하지 못했습니다.

588.2877 피크에 화살표를 표시하면 668 피크와 670 피크가 Br 동위 원소 플러스 1의 질
량으로 라벨이 표시되는 것으로 봐서 588.2877은 HBr의 손실을 나타냅니다.

13. 스펙트럼에서 화살표를 제거하고 Expands active pane to fill window 아이콘을 클릭한
후 모든 데이터 포인트를 보려면 등고선도를 줌아웃합니다.

IDA 데이터 필터링
IDA 탐색기에는 시각화하거나 처리할 수 있는 데이터의 양을 줄이는데 사용 가능한 많은 필터
가 포함되어 있습니다. 이 섹션에서 이들에 대해 설명합니다.

1. 등고선도에서 Expands active pane to fill window 아이콘을 클릭한 후 도구 모음 바로
아래에 있는 Filtering Controls 옆의 아이콘을 클릭합니다.

그림 D-44 Filtering IDA Data

이 창에는 슬라이더와 체크 박스가 여러 개 표시되며, 각각은 표시되는 데이터 양을 조정
하기 위해 사용할 수 있는 다양한 필터링 조건에 해당됩니다. 머무름 시간(시간) 및 m/z 속
도(m/z)를 여기에서 또는 화면을 확대/축소함으로써 선택할 수 있습니다.

나머지 필터는 다음과 같습니다.

• TIC: MS/MS 스펙트럼에서 피크 강도 총합에 대한 제한을 설정합니다. 이것은 대개 작
은 잡음 스캔을 제거하는데 사용됩니다.

• Quality: 1 카운트의 등가물보다 더 큰 강도 총합에 대한 일부로 잡음이 될 가능성이 거
의 없으며 이를 통해 스펙트럼 품질을 추산할 수 있습니다.
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• Matched Int. (%): Fragment Matching을 사용할 경우 알고 있는 단편 수와 중성 손실
로 표시된 강도 총합의 일부를 평가합니다.

• Similarity: 기준 스펙트럼이 설정된 경우에 사용 가능합니다. 이 기능은 기준 스펙트럼
에서 일반적인 단편과 중성 손실에 해당되는 강도 총합의 일부를 측정합니다. 기준 스
펙트럼 사용 내용을 참조하십시오.

• Mass Defect: 질량의 일부분에 대한 단일 범위를 설정합니다. 일반적인 대사 수정(O,
O2 등)에서는 전구체 분자의 결손을 크게 변화시키지 못하므로 결손에 가까운 범위를
이용하면 가능한 대사 물질이 표시될 수 있어 이 기능은 대사 물질을 찾을 때 유용합니
다.

• Defect in Range: 단일 질량 결손 범위와 더불어 소프트웨어를 통해 사용자는 다른 질
량 범위에 적용되는 여러 결손을 정의할 수 있습니다. 이런 범위가 정의된 경우 이 체크
박스를 통해 사용자는 필터의 적용 여부를 결정할 수 있습니다. Options 대화 상자의
Mass Defect 탭에서 범위를 설정할 수 있습니다.

• Isotope pattern: 이 체크 박스를 사용해 사용자는 MS 조사 데이터에 하나 이상의 동
위 원소 유형 필터를 적용할 수 있습니다. 다시 말해, 선택된 전구체 이온에 원하는 유
형이 적용되어 있을 때에만 해당 데이터 포인트가 표시됩니다. 이런 유형은 Options
대화 상자의 Isotope Pattern 탭에서 정의됩니다.

각 샘플 필터에는 두 개의 슬라이더가 있어 범위를 정의할 수 있습니다. 슬라이더를 두 번
클릭한 후 값을 직접 입력합니다.

2. 슬라이더 설정을 실험하고 TIC (예를 들어, 1e3) 또는 Quality (1)값에 대한 최저 설정에서
도 놀라운 결과가 발생하는지 주목합니다. 하단 TIC 필터는 2e3으로 나머지 모든 장치는
0으로 설정합니다.

브로모크립틴의 질량 결손은 약 0.22로서 단순 대사 물질이 이것 또는 훨씬 큰 값을 가질
가능성은 거의 없습니다.

3. Mass Defect 필터를 0.18과 0.23으로 설정하고 나머지 피크가 4.5분 및 650 Da 가까이에
있고 이 범위(4.40분)에 652.2211 m/z 비율에서 생성된 하나의 데이터 포인트만 있는지
확인합니다.

4. Filtering Controls 옆에 있는 아이콘을 클릭함으로써 필터링 제어 장치를 숨깁니다.

팁! 표시할 필터를 변경하려면 필터 영역에서 마우스 오른쪽 버튼을 클릭하고 Filters를
선택한 후 원하는 필터를 선택합니다.

기준 스펙트럼 사용
1. 등고선도 내 652.2211/4.40(브로모크립틴 자체)에서 데이터 포인트를 클릭한 후 기준 스

펙트럼 설정(유사성 점수용) 아이콘을 클릭합니다.

참고: 우선 그래프를 확대/축소하는 것이 필요할 수 있습니다.

2. 기준 스펙트럼 설정(유사성 점수용) 아이콘 옆의 화살을 클릭한 후 기준 스펙트럼 중첩이
선택되었는지 확인하십시오.

3. 654.2185/4.39에서 데이터 포인트를 클릭합니다.
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정의된 기준 스펙트럼 및 기준 스펙트럼 중첩 선택을 통해 표시된 어떠한 스펙트럼도 중
첩된 기준 스펙트럼을 가지고 있어 쉽게 비교할 수 있도록 합니다. 이것은 피크의 이동 여
부를 결정하는 빠른 방법을 제공하기 때문에 대사 물질로 작업할 때 유용합니다.

낮은 질량의 브롬 동위 원소(기준)에 대한 전구체 이온의 MS/MS 스펙트럼을 생성하고 여
기에 높은 질량의 동위 원소에 대한 스펙트럼을 중첩시켰기 때문에 이전에 668.2 피크에
대해 생성된 것과 유사한 화면이 나타납니다. 즉, 두 개의 Da가 따로 떨어져 있는 피크의
존재로 브롬을 포함한 이온을 식별할 수 있습니다.

4. 활성 창을 확장해 창을 채움아이콘을 클릭한 후 등고선도에서 Table Filtering Controls
를 클릭합니다.

참고: 필요한 경우 표(드래그 및 드롭으로 창 재배열 아이콘) 아래에 있는 스펙트럼 창을
이동해 모든 칼럼이 보이도록 합니다.

표는 그래픽 탐색기와 동일한 정보를 표시하지만 추가 세부 사항을 제공합니다. 표는 또
한 필터링 제어 장치에 응답해 두 화면이 동일한 스펙트럼을 포함하도록 합니다. 열 선택
을 통해 스펙트럼을 업데이트할 수 있도록 표가 스펙트럼 화면에 연결되며 칼럼 헤더를
클릭함으로써 열을 분류할 수 있습니다.

기준 스펙트럼이 정의되는 경우 두 개의 추가 칼럼이 표시됩니다. Delta m/z는 기준 물질
전구체 질량 및 열과 일치하는 스펙트럼 간 차이점을 보여줍니다. Similarity는 두 스펙트
럼의 유사성을 표시합니다.

5. Delta m/z를 클릭해 표를 분류한 후 약 15.995(산소 질량)씩 차이가 나는 여러 피크와 히
드록시 브로모크롭틴 대사 물질일 가능성이 있는 31.990(O2) 피크 하나가 표에 들어 있는
지 확인합니다.

6. 표에서 열을 클릭해 관련 스펙트럼을 표시합니다.

참고: 이런 스펙트럼은 전구체 질량이 포함된 스캔에서 두 개 Da 이상인 것과 같이 높은
유사값을 가지고 있으며 이는 81 브롬을 포함한 이온으로부터 획득되었습니다.

요약
이 섹션에서는 다음 작업에 대해 논의했습니다.

• 그래픽 및 표 형태의 IDA 탐색기 뷰어를 사용하여 IDA 파일을 검사합니다.

• 이것이 필요하다는 것을 결정한 이후에 관련 스펙트럼을 융합합니다.

• TIC 및 질량 결손 필터를 사용해 표시된 스펙트럼 수를 필터링합니다.

• 비교 가능하도록 스펙트럼을 겹칩니다.

• 기준 스펙트럼을 정의하고 표를 사용해 가능성 있는 대사 물질을 찾습니다.

이런 작업은 IDA 데이터를 처리하는데 있어 핵심입니다.

다음 섹션에서는 브로모크립틴의 MS/MS 스펙트럼을 통해 구조 도구를 사용하는 방법을 설명
합니다.
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구조 도구로 작업
소프트웨어는 이온 질량을 구조(.mol 파일로 저장)에 연결하고 생체 내 변화에 대한 잠재적인
위치를 검색하는데 도움을 주는 도구를 포함하고 있습니다.

구조를 MS/MS 스펙트럼으로 연결
1. 브로모크립틴의 MS/MS 스펙트럼, 652.2211/4.40을 지정합니다. IDA 탐색기로 작업을 참

조하십시오.

2. 등고선도에서 Hides all other panes 아이콘을 클릭하여 스펙트럼만 볼 수 있도록 합니
다.

3. File > Open Mol File을 클릭합니다.

4. Select Mol File 대화 상자에서 Bromocriptine.mol 파일을 선택한 후 Open을 클릭합니
다. 설치 데이터 파일 위치에 대한 정보는 조직을 참조하십시오.
스펙트럼 아래에 구조 및 도구를 보여주는 새로운 창이 열립니다.
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그림 D-45 브로모크립틴 구조

5. 구조 창에서 Show options dialog를 클릭하고 Zoom spectrum (if any) on selection
및 Mark selected fragment mass with arrows 체크 박스를 선택했는지 확인한 후 OK를
클릭합니다. 다른 매개 변수는 변동 없이 그대로 있을 수 있습니다.
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그림 D-46 Structure Options 대화 상자

구조 창이 생성된 경우 스펙트럼이 활성화되었기 때문에 스펙트럼 및 구조는 자동 연결됩
니다. Displays a spectrum for selection 아이콘을 적절한 스펙트럼에 드래그함으로써
구조를 스펙트럼에 수동으로 연결합니다.

구조 창에서 드래그를 하면 커서를 따라 선(라쏘)이 이동하며 사용자가 이 선으로 구조의
일부 또는 전체를 선택하면 굵은 면이 작성됩니다. 연결된 스펙트럼이 있기 때문에 확대/
축소 및 스크롤하여 선택된 하위 구조의 질량 주변 영역을 표시합니다.

6. 분자 전체 둘레에 라쏘를 그리면 (M – H)– 이온에 해당하는 652.2177의 m/z 비율에서 피
크를 표시하도록 보기가 변경됩니다.

Mark selected fragment mass with arrows 체크 박스가 선택되었기 때문에 빨간 화살
표를 피크 위 및 아래에 표기하여 이것이 선택된 영역과 일치하는 이온의 기대 질량임을
표시합니다(즉, (M – H)-, 이 데이터가 네거티브 모드이기 때문).

참고: 구조 창의 제목은 선택과 일치하는 요소 구조 및 중성 화합물의 질량을 표시합니다
(즉, 653.2213 Da 질량을 갖춘 C32H40N5O5Br).

Mark selected fragment mass with arrows가 선택된 경우 구조 창에 아무 것도 선택되
지 않았을 때 녹색 화살표가 652.2177 피크에 표기됩니다. 이것은 녹색 화살표가 현재 선
택의 보완물을 표시하며 선택되지 않은 경우 보완물이 전체 분자이기 때문입니다.

7. 브롬 원자를 제외한 전체 분자를 선택합니다. 그림 D-47 내용을 참조하십시오.
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그림 D-47 브로모크립틴 구조

참고: 브롬 원자는 일반 서체로 된 단 하나이며 구조 창의 제목은 질량이 574.3029 Da인
C32H40N5O5 요소를 표시합니다. 스펙트럼에서 빨간색 화살표는 선택 부분의 예상 질량
(즉, 브롬 질량을 뺀 (M – H)– 분자 이온 질량)을 표시하며 양쪽에 1 Da 떨어진 곳에 화살
표가 있습니다. 분열 중 추가 수소 원자가 증대 또는 손실되는 것은 일반적이며 소프트웨
어는 균열된 각 결합에 대해 파란색 화살표 한 쌍을 +1 및 –1로 그림으로써 이 가능성을
표시합니다. 이 경우에서 하나의 결합이 균열됨에 따라 두 개의 추가 화살표만 남게 됩니
다.

스펙트럼의 실제 피크는 이 화살표 중 하나와 일치하며, 수소 원자 즉, HBr의 추가 손실을
표시하므로 이온 질량은 (M – H – HBr)–을 나타냅니다.
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단편으로 사용
소프트웨어에는 결합을 해제함으로써 형성된 종의 질량 및 수소 원자를 추가 또는 제거함으로
써 형성된 종의 질량을 생성할 수 있는 단편 이온 예측 변수가 포함되어 있습니다.

참고: 이 예측은 완전히 산술이며 화학 논리가 사용되지 않고 생성되는 단편을 과대평가하는
경향이 있지만 유용한 단편 분석 도구입니다.

1. 구조 창 활성화를 사용해 Show > Fragments Pane을 클릭합니다.
Fragment Options 대화 상자의 설정에 따라 진행 표시줄을 표시할 수 있습니다. 그림
D-48 내용을 참조하십시오.

2. Show options dialog 아이콘을 클릭하고 그림 D-48에서 보여지는 것과 같이 매개 변수
를 설정한 후 OK를 클릭합니다.

그림 D-48 Fragment Options 대화 상자

작고 단순한 단편 세트가 생산될 수 있도록 옵션을 설정한 후 관찰된 이온을 설명하는데
있어 필요에 따라 결합 수 및 유형을 증대시킵니다. 결합 해제를 허용함으로 프로그램 속
도가 느려지고 가능성이 없는 많은 단편을 생성할 수 있습니다.
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Fragment Options 대화 상자 내 대부분의 매개 변수는 참조 안내서에 설명되어 있지만
다음 사항을 숙지해야 합니다.

• Automatically recalculate on-the-fly 체크 박스를 선택한 경우 스펙트럼의 어떠한 변
경 사항(다른 스펙트럼으로 전환, 매개 변수 조정) 또는 선택을 통해 단편을 재계산해야
할 수 있습니다. 이것은 일반적으로 원하는 행동이지만 많은 단편을 생산하기 위해 옵
션을 설정하는 경우 분석 속도에 영향을 미칠 수 있습니다. 이 옵션을 사용하지 않는 경
우 Fragment 아이콘을 클릭합니다.

• Constrain using peak list는 소프트웨어가 스펙트럼 내에서 적절한 허용 오차를 가진
피크와 일치하는 단편만을 보여준다는 것을 의미합니다.

• Require evidence for previous step when breaking bond는 하나 이상의 결합을 해
제하는 경우에만 효과적입니다. 우선 프로그램은 하나의 결합을 해제한 후 결과 조각
에서 결합 해제를 고려합니다. 이 옵션을 선택한 경우 추가 해제 작업 전의 조각에 해당
하는 이온이 반드시 있어야 합니다.

이러한 매개 변수를 통해 화면은 그림 D-49와 유사해야 하지만 임계값 설정(또는 라벨링)
을 넘어서는 피크만 고려되기 때문에 약간 다를 수 있습니다.

그림 D-49 브로모크립틴 구조
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참고: 단편 탭의 피크와 일치하는 할당된 피크(파란색) 및 할당되지 않은 피크(빨간색)를
표시하기 위해 스펙트럼 내 피크에 색상을 입힙니다.

단편 창에는 두 개의 탭이 포함됩니다.

• Fragments: 이 사례에서, 이러한 조건에서는 많은 수의 단편이 생성되지 않고
Constrain using peak list 체크 박스가 선택되었기 때문에 스펙트럼 내에서 피크와
일치하는 몇 개의 단편만 보여주므로 목록이 짧습니다.

• Peaks: 스펙트럼 내에서 임계값을 넘어서는 피크, 피크 강도 및 단편에 할당된 여부를
나열하는 표를 표시합니다. 할당된 피크의 경우 질량 오류 또한 보여줍니다.

그림 D-50 Fragments Pane

3. Fragments 탭에서 324.1929의 m/z 속도에 해당하는 열을 선택합니다. 피크는 이것이 기
대 질량이라는 것을 보여주기 위해 빨간 화살표로 표시되고 해당 하위 구조는 구조 창에
서 볼드체로 표기됩니다.
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그림 D-51 Fragmentation Dialog

참고: 구조 창 제목의 구조 및 질량은 이제 중성 화합물의 질량이 아닌 이온의 질량을 반영
합니다.

4. 다른 단편에 할당된 구조를 검사합니다.

이들 구조는 분자의 두 개의 고리형 부분을 분리하는 중앙 아미드 결합과 모두 관련이 있
으며 가능성 또한 있어 보입니다.

참고: 할당된 요소 구조는 79Br 및 81Br을 포함한 분자 이온 스펙트럼을 비교함으로써 단
편 내에 Br이 존재하는지를 추론한 기준 스펙트럼 사용에서 생성된 중첩된 스펙트럼과 일
치합니다.

5. 전체 질량 범위를 볼 수 있도록 스펙트럼을 확대/축소합니다.
다수의 피크 중 두 개 즉, 분자의 두 측면에 해당하는 324.1970 m/z와 344.0430 m/z가 할
당되고 파란색으로 표시됩니다. 하지만 많은 피크가 여전히 할당되지 않습니다.

6. Options 대화 상자를 연후 Maximum number of bonds to break을 2로 변경합니다.
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참고: 이 옵션은 임계값 설정에 따라 작은 피크 몇 개는 할당시키지만 보다 많은 피크(예:
114.0584, 209.1337 및 227.1431 m/z 비율)는 할당시키지 못합니다. 스펙트럼이 빨간 화
살표와 관련하여 라벨이 붙는 경우 구조 창에서 모든 선택 사항을 클릭하여 지워 절대 질
량값을 보여주도록 합니다.

7. Break ring bonds 체크 박스를 선택한 후 OK를 클릭합니다.
이제 209.1337 및 227.1431 m/z에서의 이온을 포함해 많은 수의 이온이 추가로 일치됩니
다. Fragments 창에서 새로운 질량을 선택해 하위 구조를 강조하면 이러한 현상이 분자
의 고리형 펩티드 부분에서의 고리 분열과 관련이 있다는 것을 보여줍니다. 이런 이온은
이 영역에서 대사 수정 위치를 결정하는데 있어 유용할 것으로 예상됩니다.

하위 구조를 스펙트럼으로 추가
구조의 일부를 선택 후 선택한 부분을 이용해 향후에 필요 시 참조할 스펙트럼 주석을 추가합
니다. 스펙트럼 창 크기에 따라 구조 창 내 Options 대화 상자를 사용해 복사용 Target Bond
Length를 조절합니다.

1. Fragment Options 대화 상자에서 Break ring bonds 체크 박스를 지워 단편 수를 단순
화합니다.

2. 단편 창에서 더 풍부한 이온들 중 하나와 일치하는 열을 선택해 해당 하위 구조를 강조합
니다.

3. 구조 창 내에서 클릭합니다.

4. Edit > Copy를 클릭합니다.

5. 활성 스펙트럼 창에서 오른쪽 버튼을 클릭한 후 Paste Image를 클릭합니다.
이를 통해 하위 구조 이미지를 스펙트럼 창에 붙여넣기할 수 있습니다.

6. 원하는 위치로 드래그하여 이미지를 이동시킵니다. 오른쪽 버튼을 클릭하여 Delete
Image를 선택함으로써 이미지를 완전히 삭제할 수 있습니다.
이미지는 스펙트럼, 즉 질량 강도 위치에 연결되어 있어 사용자가 스크롤 및 확대/축소할
수 있습니다.

7. 그림 D-52과 유사한 최종 이미지를 생성하려면 다른 단편 이온에 대해 2 ~ 6단계를 반복
합니다.
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그림 D-52 하위 구조가 추가된 스펙트럼

8. 하위 구조의 위치를 확인하려면 File > Print > Print Preview Window를 클릭합니다.
일치된 이온은 파란색으로 표시되어 있기 때문에 해당 구조와 쉽게 결합됩니다.

9. 이미지를 복사한 후 묘화 프로그램에 붙여넣기하여 선 또는 다른 기능을 추가합니다.

관련된 MS/MS 스펙트럼으로 작업
일부 어플리케이션에서 수정된 화합물, 예를 들어 대사 물질의 스펙트럼과 전구체 화합물의
스펙트럼 및 구조를 비교하는데 유용합니다.

1. IDA 탐색기를 사용해 등고선도를 다시 보여줍니다. 668.2176/4.21에서 피크를 선택한 후
등고선도를 숨깁니다.

구조 및 단편 창이 스펙트럼과 연결되어 있기 때문에 이들이 업데이트되어 새로운 스펙트
럼을 반영하지만 구조는 전구체 화합물에서 확보되는 반면 스펙트럼은 추가 산소 원자를
가진 화합물에서 확보되었습니다(질량에서 16 Da 이상). 많은 경우 여전히 일치되는 일부
분이 있어 변화되지 않은 분자의 부분을 표시하지만 이 경우에 중요한 이온 중 그 어떤 것
도 일치되지 않고 빨간색으로 표기됩니다.

구조 창에는 일부 간단한 그림 도구를 포함하고 있어 일치점을 발견할 수 있는 경우 구조
에 대한 수정을 확인할 수 있습니다.

2. 구조 창의 왼쪽 측면에는 요소 기호가 있는 그리드가 포함됩니다. O를 클릭한 후 메인 구
조를 향해 드래그합니다.
원자가 구조와 가까운 경우 구조와 가깝게 드래그하여 커서를 따르는 결합에 통합됩니다.

3. O 기호를 드래그하여 구조(에르고린)의 아래 부분까지 결합을 작성한 후 마우스 버튼을
놓습니다(예: 페닐기 링에 새로운 원자를 배치). 그림 D-53는 프로세스를 보여줍니다.
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그림 D-53 Structure Pane

스펙트럼이 다시 업데이트되고 두 일치점(668.2089에서 분자 이온과 588.2828에서 HBr
의 손실을 나타내는 이온)이 표시됩니다. 이것으로 이제 전체 요소 구조는 정확하지만 다
수의 단편이 일치하지 않는 사실로 봐서 원자가 분자의 올바른 부분에 추가되지 않았다는
것을 제시합니다.

4. OH 그룹을 클릭해 추가한 후 구조의 상단 부분에 있는 피롤리딘 환에 드래그합니다. 이동
한 원자만 볼드체로 표기된다는 것을 확인하십시오. 그렇지 않으면 강조된 전체 하위 구
조가 이동하게 됩니다.
그림 D-54에서 확인할 수 있는 것과 같이 이를 통해 340.1927, 366.1722, 및 367.1797에
서의 이온이 일치되며 해당 하위 구조는 전구체 화합물의 스펙트럼에서 일치되는 히드록
실 이온 형태입니다.
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그림 D-54 브로모크립틴에서 비롯된 스펙트럼

일치되지 않는 많은 저질량 피크는 전구체 스펙트럼에 존재했거나 또는 알고리즘에서 링
결합을 해제하도록 허용한 경우 일치했던 히드록실 동등물이지만 637.1725에는 단순한
단편화 단계로 인한 것이며 아직 일치되지 않을 가능성이 큰 고질량 이온이 있습니다.

5. Fragments탭에서 668.2089에 해당하는 열을 선택하여 라벨로 표시하고 나머지 이온도
이와 관련하여 라벨로 표시되도록 합니다.
이것은 637.1725의 피크는 전구체 분자에서 31.0364의 손실에 해당되므로 CH3NH2 또는
CH3O이 될 수 있음을 보여줍니다. 전구체 분자 스펙트럼에서는 이 이온이 관찰되지 않았
기 때문에 구조의 고리형 펩티드 부분에 있는 메틸기 중 하나에서 발생하는 수산화 과정
에서 이 이온이 생겼을 가능성이 높아 보입니다.

6. 구조 창에서 두 번 클릭해 구조를 선택 해제한 후 새로운 OH 그룹을 구조 오른쪽에 있는
메틸기 중 하나에 드래그합니다.

7. Fragment Options대화 상자를 열고 Mass tolerance를 30 ppm으로 설정한 후 OK를 클
릭합니다.
637 이온은 이제 일치가 되었고 단편 창에서 이 열을 선택하는 것은 이온이 메톡시기 모이
어티의 손실에 해당할 수 있다는 것을 보여줍니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
276/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



8. Fragment Options 대화 상자를 열고 Break ring bonds 체크 박스를 선택한 후 OK를 클
릭합니다.
세 개의 결합이 해제되도록 허용되는 경우에만(추가 산소 원자 손실 이외에 전구체 분자
에 필요한 두 개의 결합) 209에서 이온을 일치시킬 수 있지만 지금은 다수의 단편을 일치
시킬 수 있습니다.

참고: 이제 Fragments창에는 637.1905와 같은 몇 가지 질량에 해당하는 여러 행이 포함
됩니다. 각 행은 각각의 단편에 해당됩니다(결합 해제가 허용된 경우는 더 많은 행이 생성
됩니다). 단편 창의 Peaks탭에는 질량 정확도, 해제된 결합 수, 단편이 radical인지 여부 등
을 기반으로 최상이라고 할 수 있는 일치점만 표시됩니다. 이 경우에 최고의 일치는 전구
체 화합물을 위해 생성될 수 있었던 단편에 해당하지만 관찰되지 않았으며 이에 따라 단
편 탭에서 확인할 수 있는 추가 옵션은 명백하지 않은 잠재적 경로를 제안하는데 유용할
수 있습니다.

요약
이 섹션에서는 다음 작업에 대해 논의했습니다.

• 구조를 .mol 파일에 입력한 후 스펙트럼에 연결합니다.

• 구조의 일부를 선택 후 해당 질량 피크의 존재 여부를 확인합니다.

• 단편 창을 생성한 후 매개 변수를 설정하여 간단한 단편을 관찰합니다.

• 일치하는 구성, 하위 구조 및 질량 피크를 나타내기 위해 Fragments 및 Peaks 탭으로 작업
합니다.

• 더욱 복잡한 단편화 경로를 허용할 수 있도록 Fragment Options을 변경합니다.

• 하위 구조를 스펙트럼 창에 추가합니다.

• 구조를 변경해 대사 물질 등의 관련된 분자의 단편화를 분석합니다.

일반적으로 관찰된 이온을 설명하는데 있어 필요에 따라 단순한 단편화 프로세스 및 추가 단
편화 옵션을 허용함으로써 시작하는 것은 우수한 사례입니다. 이것은 이온 단편이 일반적으로
일련의 단계에서 세분화된다는 사실과 일치하며 보다 단순한 단편이 여러 결합을 깨뜨리는 일
치된 단계에서보다 먼저 형성된다는 사실과 일치합니다. 단순한 단편이 불안정적일 수 있고
즉시 추가로 단편화하여 관찰이 되지 않을 수 있습니다. 또한 많은 수의 단편화 단계 지원에는
많은 처리 시간이 필요하고 완료하는데 많은 시간이 걸립니다.

관련된 분자를 비교하는 경우 참조 스펙트럼(전구체 분자) 및 수정된 형태를 중첩시키는 것이
도움이 될 수 있습니다. 이후 화면을 구조 또는 단편 창에 연결하고 이는 활성 창이 바뀜에 따
라 업데이트됩니다. 하지만 중첩이 있는 경우 일치된 및 일치되지 않은 이온에 적용되는 컬러
링은 식별이 어려울 수 있어 프로그램 및 화면에 익숙해질 때까지 단일 스펙트럼으로 작업하
는 것을 권장합니다.

여러 샘플로 작업
단일 샘플로 작업하는 것이 일반적이지만 한 번에 여러 샘플을 비교 또는 시각화함으로써 추
가 정보를 얻을 수 있는 경우가 있습니다. 이 섹션은 우선 소프트웨어에서 두 개의 샘플 및 이
후에는 여러 샘플에 대해 사용 가능한 일부 도구를 설명합니다.
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샘플 두 개로 작업
일반적인 작업 흐름은 변화 측정을 위해 다른 조건하에서 확보된 두 개의 샘플을 비교하는 것
입니다. 예를 들어 의약품 투여 후 두 개의 다른 시간 지점을 비교합니다. 이 작업(T=0시간 및
T= 1시간)의 경우 쥐 간 마이크로솜이 포함된 브로모크립틴 혈장 투여 잠복기에서 비롯된 데
이터를 비교합니다.

시작 전 열린 모든 창을 닫습니다.

1. File > Open Multiple Samples를 클릭한 후 샘플 데이터를 포함하는 폴더를 탐색합니다.

2. Bromocrip_IDA-DBS in plasma_T=0.wiff 및 Bromocrip_IDA-DBS in
plasma_T=1.wiff 파일을 선택한 후 파일을 창의 오른쪽 측면으로 드래그합니다.

3. OK를 클릭합니다.

그림 D-55 여러 샘플 선택

여러 IDA 파일을 통해 조사 및 종속 스캔하는 경우 별도의 TIC를 확인할 수 있는 단일 IDA
파일을 여는 것과 대조적으로 모든 샘플의 경우 모든 데이터의 단일 TIC를 확인할 수 있습
니다. 이 경우 그림 D-56에서 표시된 것과 같이 두 개의 TIC가 있습니다.
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그림 D-56 TIC

4. Select Experiment 대화 상자를 열려면 Show > Total Ion Chromatogram (TIC)을 클릭
합니다.

5. Period 1, Experiment 1 - TOF MS (100 - 2000)를 선택한 후 OK를 클릭합니다.

그림 D-57 Process All Overlays 대화 상자

중첩된 추적이 처리될 때마다 표시되는 Process All Overlays 대화 상자를 통해 사용자
는 모든 추적을 처리할지 활성 상태의 추적만 처리할지 선택할 수 있습니다. 후속 작업이
모든 추적(샘플)에 영향을 미치기 때문에 모든 추적을 처리하는 것이 유용합니다.

6. All Overlaid를 선택합니다.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템

279/325



7. Only show the dialog again if the shift key is down 체크 박스를 선택해 이를 기본 동
작으로 선택합니다.

8. OK를 클릭합니다.
조사 TIC의 중첩을 포함하는 창이 생성됩니다. 크로마토그램은 재현성이 매우 높고 대사
물질의 피크가 강렬해 크로마토그램을 확대/축소하고 비교함으로써(약 6분 동안 영역을
검사) 확인할 수 있으나, 일반적으로 추가 작업이 필요합니다. 보다 쉽게 비교할 수 있도록
화면을 생성하는 방법이 많이 있습니다. 예를 들어 기본 피크 크로마토그램이 사용됩니
다.

참고: File > Open Heat Map TICs from Wiff를 클릭한 경우 중첩된 크로마토그램을 먼저
확인할 필요 없이 스트립 화면을 직접 생성할 수 있습니다.

9. 기존 TIC 창을 숨긴 후 Show > Base Peak Chromatogram (BPC).을 클릭합니다.

10. BPC Options 대화 상자에서 필요에 따라 설정을 변경해 그림 D-58의 값과 일치시킨 후
OK를 클릭합니다.

그림 D-58 BPC Options 대화 상자

기본 피크 크로마토그램은 머무름 시간 기능으로서 각 스캔 시 가장 큰 피크 강도를 표시
함으로써 구성됩니다. 추가 정보를 제공하기 위해 기본 피크 질량이 이 대화 상자에 지정
된 질량 허용 오차보다 훨씬 큰 경우에 각 추적은 일반적인 컬러 및 회색 간에 전환합니다.

옵션으로 고려되는 질량 범위를 제한할 수 있으며 이를 통해 예를 들어 잡음 배경 피크로
인해 야기된 인공물을 방지할 수 있으며 머무름 시간 범위를 설정하여 처리를 빠르게 할
수 있습니다. 브로모크롭틴의 질량이 대략 652인 것을 알기 때문에 단순한 대사 물질의 속
도는 500 m/z 이하가 아님을 알 수 있습니다.

11. Process All Overlays 대화 상자에서 All Overlaid 옵션을 선택한 후 OK를 클릭합니다.
새로운 창은 기존 TIC보다 훨씬 비교가 간단하고 용이한 BPC를 보여줍니다.
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그림 D-59 BPC

T=0 샘플(파란색)에 비해 1시간 샘플(분홍색)을 감소시키는 것으로 보이는 두 개의 피크
(빨간색 화살표로 표시)가 있습니다. 이것은 브로모크립틴(6.09분) 및 이성질체와 일치합
니다. T=1 샘플에는 있지만 T=0에는 없는 세 개의 피크(파란색 화살표) 또한 있습니다. 이
는 잠재 대사 물질입니다.

참고: BPC는 매우 유용할 수 있지만 가장 강렬한 이온 행동만을 반영합니다(선택된 질량
범위 내에서). 기본 피크가 결코 되지 않는 질량 피크는 결코 표시할 수 없으므로 샘플 간
차이를 찾는 경우 다른 도구를 사용하십시오.

12. TIC 창을 숨깁니다.

13. 6.09분에 BPC 창을 더블 클릭합니다.

14. Process All Overlays 대화 상자에서 All Overlaid를 선택한 후 OK를 클릭합니다.
이것은 두 개의 중첩된 스펙트럼을 생성합니다.

15. 스펙트럼 창에서 클릭 및 확대/축소 하여 652 m/z의 속도에서 동위 원소 집단을 표시합니
다. 그림 D-60 내용을 참조하십시오.

스펙트럼 창은 쉽게 비교할 수 있는 두 샘플의 중첩된 스펙트럼을 포함하고 있습니다. 이
사례에서 T = 1 hr 샘플(분홍색)에서의 강도가 T = 0 샘플에서의 강도보다 약한 것이 명확
합니다.
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개요 그래프는 전체 스펙트럼의 가시성을 유지하면서 세부 사항을 볼 수 있는 방법을 제
공하기 때문에 이와 같은 고분해능 데이터를 살펴보는 것은 매우 가치 있습니다.

그림 D-60 약 652 m/z의 속도에서 동위 원소 집단

16. 크로마토그램 창에서 라인 위로 커서를 옮기면 스펙트럼 시간을 표시합니다(이전 더블 클
릭).

17. 커서가 양방향 화살표로 변경되는 경우 피크를 약 5.8분에 드래그합니다.

스펙트럼은 확장된 질량 범위를 계속 표시하지만 이것은 잡음 및 작은 피크에 지나지 않
습니다. 주 창에서 대형 분홍색 피크를 표시하려면 아래 검정색 화살표에 따라 개요 그래
프에 있는 분홍색 직사각형을 드래그합니다. 마우스에서 손을 떼면 화면은 다시 정상화됩
니다.

그림 D-62의 경우 Label all overlaid traces 아이콘이 선택되었습니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
282/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



그림 D-61 BPC 및 스펙트럼
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그림 D-62 모든 중첩된 추적 라벨 붙이기 옵션을 갖춘 BPC 및 스펙트럼 적용

이런 피크에는 T=0 샘플이 없습니다.

18. 진행하기 전에 모든 창을 닫습니다.

두 개 이상 샘플로 작업
두 개 이상의 샘플 중첩을 통해 창은 혼란스러워질 수 있으며 차이로 인해 올바른 샘플과의 결
합이 더욱 어려워질 수 있습니다. 소프트웨어에는 많은 샘플의 데이터를 보여주는데 도움을
주는 다른 도구들이 포함됩니다.

실험에 사용된 데이터 세트는 여섯 개의 다른 데이터 세트의 불순물 프로필 분석에서 비롯됩
니다.

1. File > Open Multiple Samples를 클릭합니다.

2. DataSet61.wiff ~ DataSet66.wiff 파일을 선택한 후 Selected 패널로 이동시킵니다.
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그림 D-63 Multiple Samples Selected

3. OK를 클릭합니다.

4. Show > Total Ion Chromatogram (TIC)을 클릭합니다.

5. Select Experiment 대화 상자에서 Period 1, Experiment 1을 선택합니다.
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그림 D-64 Select Experiment 대화 상자

6. OK를 클릭합니다.

7. Process All Overlays 대화 상자에서 All Overlaid를 선택한 후 OK를 클릭합니다. 그래
프는 파일 내 각 샘플에 대한 TIC 크로마토그램의 중첩을 표시합니다.
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그림 D-65 Overlaid TICs from Experiment 1 of DataSet61.wiff through
DataSet66.wiff

활성 추적 제목은 볼드체로 표시됩니다. 이 제목의 왼쪽에 있는 아이콘을 클릭하면 헤더
가 단일선으로 접혀 정보에 대한 많은 공간이 제공됩니다.

8. Show > Overlaid Traces as Heat Map을 클릭한 후 결과 창에서 색상 제어를 설정해
min%가 0.5가 되고 max%가 100이 되도록 합니다.

팁! 오른쪽 버튼을 클릭한 후 색상 제어가 보이지 않는 경우 Show Appearance Control
을 선택합니다.

9. 크로마토그램 창 내부를 클릭한 후 Hides all other panes 아이콘을 클릭합니다.
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그림 D-66 Heat Map Chromatogram

강도에 따라 TIC 컬러 코드를 나타내는 단일 수평 스트립을 통해 각 샘플이 보여집니다.
위의 색채 조합을 통해 노란색은 데이터 확보를 하지 못하거나 강도가 모든 샘플 내 가장
큰 강도의 0.5% 미만인 지점을 나타내며 파란색은 0.5%인 지점을, 빨간색은 가장 큰 강도
신호를 나타냅니다.

창에는 여섯 개에서 일곱 개의 피크(4.5분에서 6.5분 사이)가 표시되어 있으며 6.5분의 피
크를 제외하고 피크의 반응이 다양하게 나타나고 있습니다.

피크의 순서는 샘플이 확보된 순서와 동일하지만 이상적이지 않을 수 있습니다. 이 예에
서는 순서가 적합합니다.

10. 창에서 오른쪽 버튼을 클릭한 후 Show Samples Table을 클릭합니다. 초기에 히트맵의
오른쪽에 샘플 표가 표시됩니다. Drag and drop to rearrange the panes 아이콘을 드래
그하면 창을 히트맵 하단으로 드래그하여 기존 창 아래에 있는 표를 이동시킬 수 있습니
다.
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그림 D-67 히트맵 크로마토그램용 샘플 목록

표에는 각 샘플과 관련된 다양한 텍스트 필드열이 포함됩니다. Display Name 열은 편집
가능하지만 나머지 열은 읽기 전용입니다. 모든 열을 사용해 표를 분류하고 샘플 보기를
할 수 있습니다.

11. Imp STD 10에서 5.5분 주위를 선택한 후 안쪽을 두 번 클릭합니다.
새로운 히트맵 스펙트럼 창이 생성되며 전체 질량 범위가 x축에 표시됩니다.
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그림 D-68 히트맵 스펙트럼

스펙트럼을 보면 몇 개의 질량(400 m/z에서 460 m/z 사이)으로 인해 선택된 시간 영역에
서 강도가 높아지는 것을 확인할 수 있습니다.

12. Imp STD 10 샘플에 대해 Mass/Charge Da 401 주위 질량을 선택한 후 오른쪽 버튼을 클
릭하여 Show Spectra for Selected Samples를 선택합니다.
이것은 선택된 샘플에 대한 스펙트럼을 생성합니다. 이 시점에서의 스펙트럼이 표시됩니
다. 그림 D-69 내용을 참조하십시오.

13. 히트맵 XIC를 생성하려면 히트맵 스펙트럼에서 Mass/Charge Da 401 주위 질량을 더블
클릭합니다.
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그림 D-69 스펙트럼

요약
이 섹션에서 다음 작업에 대해 논의합니다.

• 소프트웨어에서 사용할 수 있는 여러 샘플 도구와 협력합니다.

• 두 개 샘플과 중첩된 크로마토그램 및 인터랙티브 스펙트럼을 비교합니다.

• 여러 샘플과 히트맵 화면을 비교합니다.
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바이오 도구 키트 기능으로 작업
이 섹션은 소프트웨어의 바이오 도구 키트 메뉴 항목에서 사용 가능한 일부 옵션을 설명합니
다.

참고: 이 기능에 액세스하려면 바이오 도구 키트 마이크로앱 기능을 반드시 활성화해야 합니
다 활성화가 완료될 때까지 사용가능한 옵션은 펩타이드 단편, 수동 재구성 하이라이트 추가
및 수동 재구성 하이라이트 제거로 제한됩니다. 릴리스 노트 문서에서 바이오 도구 키트 마이
크로앱 기능 활성화를 참조하십시오.

수동 시퀀스
이 옵션을 사용해 소화된 단백질 샘플에서 MS/MS 스펙트럼 데이터를 수동으로 시퀀스합니
다.

1. 메인 도구 모음에서 Open Sample 아이콘을 클릭합니다.
Select Sample 대화 상자가 열립니다.

2. Sample Data 폴더가 아직 선택되지 않은 경우 Browse를 클릭하여 Sample Data 폴더를
탐색합니다.

3. RP_digests.wiff 파일을 선택한 후 OK을 클릭합니다.

Open IDA Sample 대화 상자가 열립니다.

그림 D-70 Open IDA Sample 대화 상자

4. With the IDA Explorer 옵션이 선택되었는지 확인한 후 OK를 클릭합니다.
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그림 D-71 RP_digests.wiff에서 비롯된 스펙트럼

5. Table 탭을 클릭합니다.

6. Time 12.73에서 m/z 471.2398을 선택합니다.

7. 스펙트럼 창 활성화를 사용해 Graph > Duplicate Graph를 클릭합니다.
선택된 전구체(471.2)에 대한 새로운 스펙트럼 창이 열립니다. IDA 탐색기 창 및 관련 스
펙트럼 창이 삭제될 수 있습니다.
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그림 D-72 머무름 시간 12.73에서 전구체 471.2398에 대한 스펙트럼

8. 738.3833로 라벨 표시된 피크를 선택합니다.

9. Bio Tool Kit > Manual Sequence를 클릭합니다.
Sequence Options 대화 상자가 열립니다.
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그림 D-73 Sequence Options 대화 상자

참고: 동위 원소 무시 및 전하 상태 체크에 대한 체크 박스가 선택된 경우 동위 원소 및 올
바르지 않은 전하 상태를 갖춘 어떠한 피크라도 후속 아미노산을 제안하는 소프트웨어에
의해 무시될 수 있습니다.

10. OK를 클릭합니다.
Create Sequence 대화 상자가 열립니다.
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그림 D-74 Create Sequence 대화 상자

참고: 이 대화 상자를 통해 사용자는 y 및 b 시리즈 이온과 파일이 수동 시퀀스된 이후의
전하 상태에 대해 내려진 가설을 변경할 수 있고 추론을 통해 데이터에 최고의 일치를 제
공하는지 살펴볼 수 있습니다.

11. Create Sequence (for Peptide Fragments Pane) 체크 박스가 선택되었는지 확인합니
다.

12. Precursor charge 필드에 2를 입력합니다.

13. Fragment charge 필드 내 수동 시퀀스 트리를 따르려면 선택된 피크의 전하값을 입력합
니다.

14. OK를 클릭합니다.
소프트웨어가 새로 고침되어 빨간 수직선을 갖춘 업데이트된 스펙트럼 창을 표시하고 스
펙트럼 데이터에서 확보 또는 손실된 첫 번째 세트의 잠재적인 아미노산을 표시합니다.
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그림 D-75 수동 시퀀스된 스펙트럼 — 초기 가능성

15. 추가로 시퀀스되도록 빨간 수직선의 캡션을 더블 클릭합니다.
소프트웨어가 새로 고침되어 스펙트럼 데이터에서 첫 번째 세트의 아미노산을 표시합니
다.

16. 잠재적인 모든 아미노산이 추천될 때까지 단계 15를 반복합니다.
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그림 D-76 수동 시퀀스된 스펙트럼

참고: 그림 D-76에서 캡션을 클릭한 순서는 F > G > I/L > E > Y입니다.

팁! 소프트웨어에서 하나 이상의 잠재적인 아미노산을 추천하며 초기에 추천된 것과 다른
브랜치를 따르고 싶은 경우 그래프를 홈 화면으로 돌려보내고 이 절차를 반복해 아미노산
라벨과 일치하는 대안을 선택합니다.

펩타이드 단편과 연결된 수동 시퀀스
1. Bio Tool Kit > Peptide Fragments를 클릭합니다.

펩타이드 단편 창이 열리며 수동 시퀀스된 스펙트럼과 연결됩니다.
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그림 D-77 수동 시퀀스된 스펙트럼과 연결된 펩타이드 단편 창

참고: 실험 데이터와 일치하는 아미노산은 표 탭의 칼럼에서 빨간색 볼드체로 표시됩니
다. 실험 데이터와 일치하지만 다른 목표 단편 전하를 가진 아미노산은 표 탭의 칼럼에서
빨간색 이탤릭체로 표시됩니다.

2. List탭을 클릭합니다.

3. Show > Mass Calculators를 클릭합니다.

4. AA Property탭을 클릭합니다.
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그림 D-78 질량 계산기 — AA Property Tab

참고: 질량 계산기는 수동 시퀀스된 스펙트럼에 자동 연결됩니다. 스펙트럼에서 비롯된
아미노산 시퀀스는 AA sequence 필드에 표시됩니다.

5. 스펙트럼 창이 활성 상태일 때 Bio Tool Kit > Set Sequence Creation Parameters를 클
릭합니다.
Create Sequence 대화 상자가 열립니다.
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그림 D-79 Create Sequence 대화 상자

6. 다음과 같이 Create Sequence 대화 상자를 작성합니다.

• Create Sequence (for Peptide Fragments Pane)체크 박스가 선택되었는지 확인합
니다.

• Assume b-series옵션을 선택합니다.

• Precursor m/z 필드에 471.2398을 입력합니다.

• Precursor charge 필드에 2를 입력합니다.

• Fragment charge 필드에 1을 입력합니다.

7. OK를 클릭합니다.
펩타이드 단편 창 및 질량 계산기 창은 시퀀스 데이터 업데이트로 새로 고침됩니다.

8. Peptide Fragments창에서 Table 탭을 클릭합니다.
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그림 D-80 새로고침된 수동 시퀀스된 스펙트럼과 연결된 펩타이드 단편 창

9. 스펙트럼 창이 활성 상태일 때 Bio Tool Kit > Clear Manual Sequencing을 클릭합니다.
모든 수동 시퀀스 표시가 제거됩니다.

수동 재구성 하이라이트 추가 및 제거
Add Manual Reconstruct Highlights 옵션을 사용하면 스펙트럼에 해당 질량의 이론적인
m/z 위치를 나타내는 기호를 추가할 수 있습니다. 이 기능은 스펙트럼에 다중 대전된 구성 요
소가 포함된 경우 스펙트럼에서 특정 피크가 동일한 구성 요소에 해당되는지 여부를 확인할
때 유용합니다. Remove Manual Reconstruct Highlights 옵션을 사용해 기호를 제거합니다.

팁! 기호를 새로운 위치로 이동하려면 기호의 세로선을 새로운 m/z 값으로 드래그합니다.

팁! 기호를 활성화하려면 기호의 세로선 또는 해당 전하 상태 라벨을 클릭합니다. 활성화된 기
호가 m/z 위치를 표시합니다.

1. 메인 도구 모음에서 Open Sample 아이콘을 클릭합니다.
Select Sample 대화 상자가 열립니다.

2. Sample Data 폴더가 아직 선택되지 않은 경우 Browse를 클릭하여 Sample Data 폴더를
탐색합니다.

3. RP_Intact.wiff 파일을 선택한 후 OK을 클릭합니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
302/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



그림 D-81 RP_Intact.wiff 파일에서의 TIC

4. 미오글로빈의 경우 피크의 상단 영역(5.91 ~ 6.00분)을 사용해 평균 스펙트럼을 생성합니
다.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템

303/325



그림 D-82 평균 스펙트럼

5. Spectrum창이 활성 상태일 때 Bio Tool Kit > Add Manual Reconstruct Highlights.를
클릭합니다.
Add Manual Reconstruct Highlights to Graph 대화 상자가 열립니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
304/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



그림 D-83 그래프에 수동 재구성 하이라이트 추가

6. Value 필드에16950을 입력합니다.

7. Charge agent로 H+를 선택한 후 OK를 클릭합니다.
하이라이트를 포함하여 그래프는 새로 고침됩니다.

그림 D-84 추가된 하이라이트가 포함된 스펙트럼

8. Bio Tool Kit > Remove Manual Reconstruct Highlights를 클릭해 기호를 제거합니다.
하이라이트가 제거되며 그래프는 새로 고침됩니다.

단백질 소화
이 옵션을 사용해 지정된 단백질의 사용자 정의된 효소 분열로 인해 발생하는 이론적인 펩타
이드 시퀀스에 대한 정보를 확보합니다.

도구 모음
도구 모음에 있는 아이콘을 사용해 필요에 따라 보기를 조절합니다.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템

305/325



표 D-5 도구 모음 아이콘

아이콘 이름(툴팁)

시퀀스 내에서 찾아 바꾸기

대문자로 선택 전환

시퀀스 찾기

참고: 창 아이콘 삭제로 시작하는 이 도구 모음 내 최종 여섯 개 아이콘은 일반 창 도구 모음에
서 설명합니다.

시퀀스 내에서 찾아 바꾸기

이 옵션을 사용해 Sequence 필드에서 기존 텍스트를 찾아 새로운 텍스트로 바꾸십시오.

1. 시퀀스 내에서 찾아 바꾸기 아이콘을 클릭합니다.
Find and Replace Text 대화 상자가 열립니다.

그림 D-85 Find and Replace Text 대화 상자

2. Find 필드에서 대체될 정보를 입력합니다.

3. Replace 필드에서 적절한 정보를 입력합니다.

4. OK를 클릭합니다.
소프트웨어는 기존 텍스트를 사용자 지정된 대체 텍스트로 교체합니다.

대문자로 선택 전환

이 옵션을 사용해 Sequence 필드에서 소문자로 입력된 텍스트를 대문자로 전환합니다.

1. 적절한 텍스트를 선택합니다.

2. 대문자로 선택 전환 아이콘을 클릭합니다.
소프트웨어는 소문자 텍스트를 대문자 텍스트로 대체합니다.

시퀀스 찾기

이 옵션을 사용해 Sequence 필드에서 텍스트를 찾습니다.

1. 시퀀스 찾기 아이콘을 클릭합니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
306/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



Find Text 대화 상자가 열립니다.

그림 D-86 Find Text 대화 상자

2. Find 필드에서 적절한 정보를 입력합니다.

3. OK를 클릭합니다.
소프트웨어는 일치하는 텍스트를 강조합니다.

이론적인 단백질 소화
1. Bio Tool Kit > Digest Protein.을 클릭합니다.

Protein 창이 열립니다.

그림 D-87 단백질 창 - 단백질 및 펩타이드 탭

2. 제공된 필드에서 단백질 또는 펩타이드 시퀀스를 입력합니다.

참고: 이 사용 지침 프로그램의 경우 LSDGEWQQV LNVWGKVEAD IAGHGQEVLI
RLFTGHPETL EKFDKFKHLK TEAEMKASED LKKHGTVVLT ALGGILKKKG
HHEAELKPLA QSHATKHKIP IKYLEFISDA IIHVLHSKHP GDFGADAQGA
MTKALELFRN DIAAKYKELG FQG(미오글로빈 시퀀스)가 사용되었습니다.

3. Enzyme를 선택합니다.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
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참고: 이 사용 지침 프로그램의 경우 트립신이 사용되었습니다.

4. Max. missed cleavages를 선택합니다.

참고: 이 사용 지침 프로그램의 경우 0이 선택되었습니다.

5. Digest를 클릭합니다.
소프트웨어는 소화된 펩타이드 및 시퀀스에 대한 이론적 정보가 포함된 표를 입력합니다.

그림 D-88 이론적 정보가 입력된 단백질 창

6. Variable Modifications 탭을 클릭합니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
308/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



그림 D-89 Protein Pane - Variable Modifications Tab

7. Max. number of simultaneous modifications를 선택합니다.

참고: 이 사용 지침 프로그램의 경우 3이 선택되었습니다.

8. 적절한 수정의 경우 Use 열의 체크 박스를 선택합니다.

팁! 아이콘이 체크 박스 왼쪽에 나타나는 경우 전체 아미노산 목록 또는 해당되는 목록을
선택할 수 있습니다.

참고: 이 사용 지침 프로그램의 경우 [1Ac]에 대해 체크 박스가 선택되었습니다.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
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그림 D-90 선택된 수정 사례

9. Protein & Peptides 탭을 클릭합니다.

10. Digest를 클릭합니다.
표 결과는 사용자의 선택을 반영하도록 수정됩니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
310/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



그림 D-91 수정된 정보가 입력된 단백질 창

LCMS 펩타이드 재구성
LCMS 펩타이드 재구성은 스펙트럼 피크를 식별하고 식별된 스펙트럼 피크에서 디콘볼루션
을 수행합니다. LCMS 펩타이드 재구성 도구는 두 가지 단계로 작업이 이루어집니다. 첫째, 피
크 찾기 '강화' 알고리즘을 통해 피크를 찾을 수 있습니다. 둘째, 도구는 동위 원소 시리즈 및 전
하 시리즈를 형성하는 피크 집단을 찾으며 발견된 모든 구성 요소의 중성 손실을 보고합니다.

1. 메인 도구 모음에서 Open Sample 아이콘을 클릭합니다.
Select Sample 대화 상자가 열립니다.

2. Sample Data 폴더가 아직 선택되지 않은 경우 Browse를 클릭하여 Sample Data 폴더를
탐색합니다.

3. RP_digests.wiff 파일을 선택한 후 OK을 클릭합니다.

Open IDA Sample 대화 상자가 열립니다.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
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그림 D-92 Open IDA Sample 대화 상자

4. As a standard TIC 옵션이 선택되었는지 확인한 후 OK를 클릭합니다.

첫 번째 추적인 IDA Survey from RP_digests.wiff (sample 1) - Sample001이 볼드체로
표시되었는지 확인하십시오. 필요한 경우 이 추적을 선택합니다.

그림 D-93 IDA Survey from RP_digests.wiff

5. Bio Tool Kit > LCMS Peptide Reconstruct (with peak finding)을 클릭합니다.
LCMS Peptide Reconstruct Options 대화 상자가 열립니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
312/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



그림 D-94 LCMS Peptide Reconstruct Options 대화 상자

6. 제공된 필드에서 다음 값을 입력합니다.

• Minimum retention time 필드에서 9.00 분 입력

• Maximum retention time 체크 박스를 선택한 후 필드에서 유형 16.00을 입력

• Approximate LC peak width 필드에서 6.0초 입력

참고: 근사 피크 폭은 배경 분리 중 오프셋을 측정하는데 사용됩니다.

• Minimum intensity in counts 필드에서 5카운트 입력

• Chemical noise intensity multiplier필드에서 1.5 입력

• Mass tolerance 필드에서 0.100 Da 입력

• Maximum charge 필드에서 5 입력

참고: 전하 디콘볼루션 섹션 내 질량 허용 오차를 통해 재구성된 피크가 이론적으로 소화
된 단백질과 일치하는지 그리고 동일한 펩타이드에 속한 다른 m/z 값이 그룹화되는지 확
인합니다.

7. OK를 클릭합니다.
소프트웨어는 머무름 시간에 따라 분리되는 펩타이드에 대한 표를 보여줍니다. 다음은 나
열된 각 펩타이드를 위해 제공되는 정보입니다. Index, Ret. Time, Mass, Mass / Charge,
Int. Sum, 및 Num. Peaks.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
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그림 D-95 재구성된 피크 리스트

8. Filtering을 확장하여 사용 가능한 필터링 옵션을 표시합니다.

사용 가능한 필터링 옵션에 다음이 포함됩니다. Intensity threshold, Min. Num. Peaks,
및 Show matched peaks only.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
314/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



그림 D-96 Filtering Options

9. 하나 이상의 필터를 선택하여 필요에 따라 화면을 조정합니다.

참고: 이 사용 지침 프로그램에서 강도 임계값은 2.39e4 및 최소 숫자로 설정되었습니다.
Num. 피크는 4로 설정되었습니다.

그림 D-97 재구성된 피크 리스트 필터링됨

도구 모음
도구 모음에 있는 아이콘을 사용해 필요에 따라 보기를 조절합니다.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
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표 D-6 도구 모음 아이콘

아이콘 이름(툴팁)

스펙트럼 및 XIC 표시

IDA MS/MS 스펙트럼 표시

참고: 창 아이콘 삭제로 시작하는 이 도구 모음 내 최종 여섯 개 아이콘은 일반 창 도구 모음에
서 설명합니다.

스펙트럼 및 XIC 표시

스펙트럼 및 XIC 표시 아이콘을 선택한 경우 다음 스펙트럼 및 XIC 창이 열립니다.

그림 D-98 스펙트럼 및 XIC 결과 표시

생성된 MS 스펙트럼에 있어 펩타이드의 질량에 기여를 했던 화살표가 각 피크 아래에 표시됩
니다. 펩타이드 질량에 기여를 했던 각 m/z 피크에 대한 XIC는 오른쪽에 있는 창의 중첩으로
표시됩니다.

IDA MS/MS 스펙트럼 표시

IDA MS/MS 스펙트럼 표시 아이콘을 선택하는 경우 다음 스펙트럼 창이 열립니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
316/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



단백질 소화를 통한 LCMS 펩타이드 재구성
1. Bio Tool Kit > Digest Protein.을 클릭합니다.

Protein 창이 열립니다.

2. Protein창에서 Drag to a protein pane to set its peak list 아이콘을 Reconstructed
Peak List창으로 드래그합니다.

재구성된 피크 목록 내에 이들과 일치하는 단백질 창에서 펩타이드 시퀀스를 표시하며
Protein창이 새로 고침됩니다. 빨간색의 볼드체로 표시된 Protein창의 단편은
Reconstructed Peak List창에서 정확하게 일치를 갖춘 단편입니다. 빨간색 보통 글자체
로 표시된 단편은, 해당 단편이 Reconstructed Peak List창의 Match 컬럼에서 괄호 안
에 표시된 전하 상태를 할당받았을 경우 Reconstructed Peak List창에서 일치된 단편입
니다. 검정색 글자체로 표시된 단편은 Reconstructed Peak List창의 어떠한 단편과도 일
치하지 않습니다.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
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그림 D-99 재구성된 피크 목록과 연결된 단백질 창에 관한 이론적 정보

단백질 재구성
이 옵션을 사용해 온전한 단백질의 평균 질량(분자 무게)을 확보합니다.

1. 메인 도구 모음에서 Open Sample 아이콘을 클릭합니다.
Select Sample 대화 상자가 열립니다.

탐색기 자습서

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
318/325

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I



2. Sample Data 폴더가 아직 선택되지 않은 경우 Browse를 클릭하여 Sample Data 폴더를
탐색합니다.

3. RP_Intact.wiff 파일을 선택한 후 OK을 클릭합니다.

그림 D-100 RP_Intact.wiff 파일에서의 TIC

4. 5.93분의 속도에서 피크 영역을 사용해 평균 스펙트럼을 생성합니다. 그림 D-101 내용을
참조하십시오.

탐색기 자습서

소프트웨어 사용자 안내서
RUO-IDV-05-7560-KR-I

SCIEX OS 소프트웨어 X500 QTOF 및 ZenoTOF 7600
시스템
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그림 D-101 평균 스펙트럼

5. 스펙트럼 창이 활성 상태일 때 Bio Tool Kit > Reconstruct Protein을 클릭합니다.
Reconstruction Options 대화 상자가 열립니다.

탐색기 자습서
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그림 D-102 Reconstruction Options

6. 다음 옵션에 대해 적절한 값을 입력합니다.

• Start mass: 15000 Da

• Stop mass: 18000 Da

• Step mass: 1.0 Da

7. 적절한 Input spectrum isotope resolution: Moderate (10000)을 선택합니다.

참고: 사극자 시스템을 통해 확보한 데이터의 경우 입력 스펙트럼 동위 원소 분해능 매개
변수 대신 피크 폭 매개 변수가 표시됩니다.

8. 적절한 Charge agent: H+를 선택합니다.

9. OK를 클릭합니다.
소프트웨어는 해당 제목 Reconstruction, Input spectrum isotope resolution [user
selection]이 붙은 별도 창에서 재구성된 단백질 스펙트럼을 생성합니다.
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그림 D-103 Reconstruction Pane

참고: 사극자 시스템을 통해 확보한 데이터의 경우 창의 제목은 Reconstruction, Peak
width [value]입니다.

10. 재구성된 단백질 피크를 선택합니다.
선택된 스펙트럼에 수직 수동 재구성 하이라이트를 추가해 재구성된 단백질을 생성합니
다.
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그림 D-104 수동 재구성 하이라이트가 포함된 스펙트럼

요약
이 섹션에서 다음 작업에 대해 논의합니다.

• 소화된 단백질 샘플에서 MS/MS 스펙트럼 데이터를 수동으로 시퀀스합니다.

• 펩타이드 단편을 통해 수동으로 시퀀스된 스펙트럼을 연결합니다.

• 주어진 질량의 이론적인 m/z 속도 배치를 스펙트럼에 표시하는 기호(수동 재구성 하이라이
트)를 추가합니다.

• 스펙트럼에서 기호를 제거합니다.

• 지정된 단백질의 사용자 정의된 효소 분열로 인해 발생하는 이론적인 펩타이드 시퀀스에
대한 정보를 확보합니다.
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• LCMS 펩타이드 재구성을 통해 스펙트럼 피크를 식별하고 식별된 스펙트럼 피크에서 디콘
볼루션을 수행합니다.

• 재구성된 피크 목록을 갖춘 단백질 창에서 이론적인 정보를 연결합니다.

• 온전한 단백질의 평균 질량(분자 무게)을 확보합니다.
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문의하기

고객 교육
• 북아메리카: NA.CustomerTraining@sciex.com

• 유럽: Europe.CustomerTraining@sciex.com

• 유럽 및 북미 이외 지역의 연락처 정보는 sciex.com/education을 참조하십시오.

온라인 학습 센터
• SCIEX Now Learning Hub

SCIEX 지원 부서
SCIEX 및 전 세계 대리점은 충분히 교육을 받은 서비스 및 기술 전문가를 보유하고 있습니다.
이들은 시스템에 대한 질문 또는 발생할 수 있는 모든 기술적 문제에 대한 도움을 제공합니다.
자세한 내용은 SCIEX 웹 사이트(sciex.com)를 참조하거나, 다음 방법 중 하나를 사용하여 당
사로 문의하십시오.

• sciex.com/contact-us

• sciex.com/request-support

사이버 보안
SCIEX 제품의 사이버 보안에 대한 최신 지침은 sciex.com/productsecurity에서 확인할 수 있
습니다.

문서
이 문서가 이전 버전의 모든 문서를 대체합니다.

이 문서를 컴퓨터로 보려면 Adobe Acrobat Reader가 필요합니다. 최신 버전을 다운로드하려
면 https://get.adobe.com/reader로 이동하십시오.

소프트웨어 제품 문서를 찾으려면 릴리스 노트 또는 소프트웨어와 함께 제공되는 소프트웨어
설치 안내서를 참조하십시오.

하드웨어 제품 문서를 찾으려면 시스템 또는 구성품의 문서 DVD를 참조하십시오.

SCIEX 웹 사이트(sciex.com/customer-documents)에서 최신 버전의 문서를 확인할 수 있습니
다.

참고: 이 문서의 무료 인쇄 버전을 요청하려면 sciex.com/contact-us에 문의하십시오.
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